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1 Overview

The platform offers a comprehensive security solution tailored for general small to medium-sized campus
environments. It leverages advanced modular technology, enabling seamless integration of edge loT devices

for unified access, data processing, forwarding and storage. Additionally, it facilitates rapid integration of
various campus management subsystems, encompassing video management, pedestrian and vehicular traffic
monitoring, and overall security operations. The platform supports the integration and management of various
devices such as IPCs, NVRs, SmartBoxes, decoders, face recognition terminals, general access control devices,
video intercom devices, and third-party devices (alarms, access control). Beyond basic video services, it extends
to pedestrian management, vehicle management, and alarm management for fundamental campus applications.
Additionally, it offers comprehensive security functions including attendance management, guard patrol,
advanced operations and maintenance, and map. Its simple deployment, flexible scalability, and reliable stability
make it suitable for a wide range of applications, from local-area network (like campuses, buildings, schools,
hotels, venues) to wide-area network (such as networked retail).

e Efficient deployment: The platform integrates complete functions and does not require complex networking
setup. Simply power it on and connect to network.

e Simple operations: The platform provide visual business management through an intuitive client interface.
Based on different user roles and computer configuration, operations can be performed on B/S client, C/S
client and APP respectively to meet the use needs of different users.

2 B/S Login and Initial Configuration

Log in to the B/S client using a browser, and change the default password after the first login to ensure system
security.

Note:
Please use Google Chrome 89 or later.
1. Open a browser and enter the server IP address in the address bar.
[®> Note:
e The default IP addresses are as follows. Modify according to the actual networking:
¢ Network interface1 : 192.168.1.60
* Network interface2 : 192.168.2.60
* Network interface3 : 192.168.3.60
e Network interface4 : 192.168.4.60
e After login, you can change the IP address at System > Network >TCP/IP.

e If you want to log in via HTTPS, please enable HTTPS in System Config > Network Management >
Security Config.



Download Center  Email Address.

Scan to download app

Welcome

English

User Login
Please enter the username

@ Please enter the password

2. Enter the username and password.

¢ Login as system user: Select User Login.

Default administrator The system initially defaults to 2 administrator accounts: admin / loadmin;
the default password: admin_123.

E> Note:
e The administrator accounts have full privileges over the system.

e Upon first login with the default password, "admin" must follow the
security guide to change the password. For the loadmin, you can
Change Password in the upper-right corner after login.

Other users See user information in User Management.

e Loginas AD Domain user: Select AD Domain Login, and enter the domain user ID and password.

@ Note:
Please first complete the configuration of AD Domain User and import the AD domain user accounts.

3. Select | have read and agree to Privacy Policy. Click Login.

2.1 (For First Login) Set admin Password

When log in to the B/S client for the first time, please follow the instructions below to set a strong password for
the admin user to ensure security.

1. When open the login page for the first time, a page as shown below appears.



Create Password

) Please set the admin password at your first login

Username: admin

* New Password: Please enter the password et
Weak Medium Strong

* Confirm Password: | Please enter the confirmation password ot

9-32 characters, and include at least three of the four types: uppercase letters, lowercase
letters, digits, and special characters (&% . _# @)

Next

2. Set a password and confirm it.

@ Note:

For security concerns, you must set a strong password with 9-32 characters, including uppercase and
lowercase letters, digits, and special characters.

3. Click Next.

4. Set a verification method for security verification when resetting the password.
If not required, click Skip to complete the configuration. If skipped, the system will prompt admin to set up an
authentication method at each login, until one is configured.

Verification Method

) Please select a verification method and fill in the information in case you need to
reset the password

a Email Address \
Set an email address to receive the verification code

Security Questions

Set security questions for identity verification

Skip
Verification Operation Steps
Method
Email Click Email. A dialog box as shown below appears.




Verification
Method

Operation Steps

Email Address X

() Please set an email address in case you need to reset the password

* Email Address: | Please enter your email ad

Cancel Back

(1) Enter your email address and click Send Code.
(2) Enter the verification code you received in your email inbox.

(3) Click OK, and you will see a message confirming the successful setup.

Security Questions

Click Security Questions. A dialog box as shown below appears.
Set questions and answers, click OK.

Security Questions X

* Question1: | Where do you often use this platform? v
* Answerl: Please ente e @
# Question2: | What is the model of the computer you use for work? v
* Answer2: Please ente B @
* Question3: | In what situations do you usually use this platform? v
* Answer3: | Please enter your answer @)

2.2 (Optional) Reset admin Password

You can reset admin password via a security verification if you forgot the password.

@ Note:

e If you have not provided an email address or security problems for admin, you will not be able to reset
admin password here.

¢ If a non-admin user forgets password, they can contact admin user to modify in User Management.

e All users can click Change Password in the upper-right corner to change the password after login.
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1. Click Forgot Password in the lower-right corner of the login page.

2. Select the verification method: Email or security problems.

Forgot Password

@) Please select a verification method and fill in the information in case you need to reset the

password
Email Address N
Use email verification to reset the password
Security Questions N

Answer security questions to reset the password

Closed
Verification Operation Steps
Method
Email Click Send Code to send a verification code to the reserved email address. Enter the

verification code you received in your email inbox.

Email Address

@ To reset the password, enter the verification code that we sent to your email

* Email Addr...

* Verification .. | plaase enter the verification code. Send Code

Cancel Back

Security Questions | Input questions and answers, click OK.




Verification Operation Steps

Method
Security Questions X

) You can answer security questions to reset the password

* Question: Where do you often use this platform? v
* Answer] : Please enter your answer @
* Question2: What is the model of the computer you use for work? A
* Answer2: Please enter your answer @
* Question3: 1 what situations do you usually use this platform? hd
* Answer3: Please enter your answer @

Cancel Back

3. Reset the password.

Reset Password

* New Password: Please enter th

& Dassworec et
Weak Medium Strong
* Confirm Password: Please enter the confirmation password et

9-32 characters, and include at least three of the four types: uppercase letters, lowercase |etters,
digits, and special characters (& *. _# @)

3 C/S Client

You can install the C/S client on your PC.

Computer System Requirements

The C/S client can be installed on the following computers:



Item Requirements

Operating System | e Windows 11 64-bit
e Windows 10 64-bit

Memory 16GB or more, with at least 10 GB free memory.

Install C/S Client
1. Click Download Center in the upper-right corner of the login page of the Web interface.
2. After downloading the C/S client, double-click the .exe file to install.

3. Once installed, a shortcut will appear on your desktop. Double-click the shortcut to open the login window.

English ~
Welcome [
sever R - * | Server Configuration
User Lagin
Protocol
5 loadmin HTTP
(5] sassacnes 173 ip port
ip port

Remember password

have read and a... Privacy Policy

4. Click {63. Select the login protocol (HTTP/HTTPS), enter the IP address and port (default: 80) of the server.
[ Note:
e If you want to log in via HTTPS, please enable HTTPS on the B/S client.
e The server IP address is the IP address of the computer on which the B/S client is installed.

5. Enter the username and password.

@ Note:

e User Login: The username/password is same to the B/S client.

¢ AD Domain Login: enter the domain user ID and password. Please first complete the configuration of
AD Domain User and import the AD domain user accounts on the B/S client.

6. Select | have read and agree to Privacy Policy. Click Login.

3.1 Auxiliary Screen

Only the C/S client supports auxiliary screens.

On the C/S client, you can create auxiliary screens on any level-2 submenu page as independent video windows.
If your PC is connected to multiple monitors, you can drag the auxiliary screen to any of the connected monitors
to operate functions.

Click before the level-2 submenu to create an auxiliary screen.
The following uses the auxiliary screen of the Video Surveillance menu as an example:



Homepage (@ Video Surveillance X (3 Video Wall

) Video Surveillance sw-262a3045-6b15-0271-6e1a-8ef4682e5a33 = o X
ue 192.115.160_1 Fie Jedit View w

> 192115169 2

@ 1921152.122.1 ‘

® 1921152124 1

7o

® 1921152125 1 - -
N %W 192.115.1.69 1

® 1921152128 1 _
- B 1921151692

@ 192.1152.129 1 _
- @) 1921152.122 1

® 19211521301 _
- ® 1921152124 1
@) 192.1152.125 1
® 19211521281
®) 192.1152.129 1
® 19211521301

e The Video Surveillance menu supports creating up to 3 auxiliary screens, while other menus support a
maximum of 1 auxiliary screen. Services on each screen operate independently.

¢ You can drag, maximize, restore, or close the auxiliary screen.
e Operations on the auxiliary screen are the same as those on the main screen.

e After exiting and restarting the client, previously opened auxiliary screens will be closed.

4 Homepage

The homepage appears when you are logged in successfully, which consists of some function menus and global
buttons.

@ Note:
The interface may vary based on the purchased license, software version, user permissions, and custom

settings(such as Custom Function Navigation, Style Personalization). The following takes the default
interface as an example.

Homepage Device Management

Function Navigation Custom Function Navigation

Configuration Wizard

Cluster Configuration

Cluster Management
Basic Configuration

Alarm Center

‘ ﬂ Video Application

oam

Storage Configuration
Local Disk Network Disk

Server Management

User Management Storage Configura Map Configuration

Access&Attendance

Park Application
Video Management System
System Configuration

Fa = Add Device

Configure Storage Schedule
Personnel Manage. Community Mana.

Configure Video Wall

Alarm Center

Access Control System

vy Add Device Add Personnel

No. Description

@ Provides an overview of functions, including Function Navigation, Data Dashboard.




Description

Opened function menu. Click X to close it.

All functions: In any interface, use the drop-down list to display all level-1 and level-2 functions.
Supports keyword search for quick access.

Recording download task list: View the status of recording download tasks. You can also access the
download directory, start, stop, and delete tasks.

Alarm message: Displays the number of new alarms. Click the icon to enter the Real-time Alarm page.

@O ® ©OF

License
Management

Please refer to License Management.

Client
Configuration

Set real-time alarm notification methods, including pop-up alarm window and alarm
sound.

Language Change the system language.
Switching
Configuration| Show/hide Configuration Wizard.
Wizard
Customer View the customer service phone number.
Service
Center
Help View privacy policy, system version, user manual, etc.
@ Username The current logged-in user’s username.
Light/Dark Change the interface's background color: Choose Light (default) or Dark as needed.
Mode [E> Note:
All users can change the background color. The effective rules for the B/S client
and C/S client are different:
e B/SClient:
Modification is applied only to the current browser page. Refreshing or re-
logging in will revert the background color to the default setting.
e (/S Client:
Modification is permanently valid to the current client. Changing login user or
server address will not affect the set background color.
Change Modify the password for the currently logged-in user.
Password
Email Set the email address for identity verification if you want to reset the password.
Address
Security (For admin) Set security questions for identity verification if you want to reset the
Questions password.
Logout Log out the system and return to the login page.

4.1 Function Navigation

This page displays the function menus within the system. You can click on a function menu to enter the
corresponding function page.




Function Navigation Datz Dashboard 17 Custom Function Navigation

Recently Used: Device Ma

Basic Configuration Level' 1 Function Basic Configuration
Level-2 Function Alarm Center
i ﬂ E E Video Application
== \ O&M
Device User g Storage Configura. Map Configuration Personnel Manage. Community Mana... Access@Attendance

Park Application
Alarm Center A

41 2

System Configuration

Real-time Alarm History Alarm Alarm Configuration

Video Application

¢ Function menu: Displays the functions supported by the system. Click on the level-2 function menu to enter
the corresponding page.

Note:
The function menus are displayed according to the License specification and user permission and can be
customized to show/hide.

e Search: Enter the keywords of the level-1/level-2 function in the search bar to search for the function.

e Recently used: Displays 5 most recently used functions, with the latest used function listed first.

4.2 Custom Function Navigation

You can customize the function navigation by specifying which functions to show/hide. For example, hiding less
frequently used functions can simplify the navigation.

Custom Function Navigation Restore Defaults m Cancel
Basic Configuration
Video Application i
& Hide Al Alarm Center
| Video Application
2, o&M

~ @

Video Surveillance Media Configurati... Smart Live View Video Wall Data Search

Access8Attendance

Park Application

System Configuration

oaMm & Hide Al

Operation Logs Database Manage... System Diagnosis

((J

X

Access&Attendance & Hide All

| L a®l | | | |
1. Click Custom Function Navigation in the upper-right corner.

e Show: Click &3 in the upper-right corner of the card to show the menu; click Show All to show all menus
under the category.

¢ Hide: Click in the upper-right corner of the card to hide the menu; click Hide All to hide all menus
under the category.

e Adjust order: To reorder cards within a category, click and drag the card to the desired position. To swap
category positions, click and drag the category to the target location.

2. Click Save.
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Note:

To restore the system's default interface, click Restore Defaults, then save.

4.3 Configuration Wizard

On the right side of the homepage, a configuration wizard is provided, displaying the setup steps for commonly
used features. You can click on a setup step to navigate to the configuration page and configure the services.

Configuration Wizard

@ Cluster Configuration

Cluster Management

Storage Configuration
Local Disk Network Disk

Server Management

Video Management System
Add Device  Configure Storage Schedule

Configure Video Wall

Access Control System
Cloud-Edge Mode (7)
Add Device Add Personnel

Configure Access Permission

Configuration

Figure Service Configuration Steps
Module
Cluster Cluster Management

Storage
Configuration

Local Disk
Network Disk
Server Management

Video
Management
System

Add devices (Local Encoding Device, Cloud
Encoding Device, Local Decoding Device)
Configure storage schedule (Storage, Backup)
Configure video wall (Video Wall)

Access Control
System

¢ Cloud-edge mode: Cloud-Edge Configuration,
Add Device

¢ Non-Cloud-Edge mode: Add Device, Add
Personnel, Configure Access Permission
(Access Permission Config, Schedule Template)

Note:

The business modules displayed in the configuration wizard depend on license specifications, user
permissions, and Custom Function Navigation.

Show/Hide Configuration Wizard

You can show or hide the service modules displayed in the configuration wizard.

1. Click £3 in the top right corner of the configuration wizard.

@ Note:

If the configuration wizard is not displayed on the homepage, click @ in the top right corner and then

click Configuration Wizard.

2. Click the toggle to show or hide the service modules: @) (show,) or (hide).
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Configuration Wizard X

Configuration Wizard on Homepage (4/4)

@ Cluster Configuration

Cluster Management

|} storage Configuration

Local Disk Network Disk

Video Management System

Add Device Configure Storage Schedule

Access Control System
Cloud-Edge Mode (7)

Add Device Add Personnel

@ Note:

@

@

@

Server Management

@

Configure Video Wall

@

Configure Access Permission

For access control systems, please show or hide the cloud-edge mode based on whether it is integrated

with EZCloud.
3. Click OK.

5 Data Dashboard

Data dashboard integrates various types of service data in the system and displays data statistics in visual
diagrams. This facilitates users to view the status of service operations and enables users to take timely

management measures based on the data.

You can customize the data type and layout of the data dashboard to meet your needs.

5.1 Data Dashboard

After logging, click Data Dashboard Mode tab to switch to the dashboard view. To enlarge the dashboard to full

screen, click fff] in the upper-right corner.
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Figure 5-1: Example 1

» Online Status Statistics
Device

O

®0nline 1
Offline 1

» Visitor Statistics

Total 5

115

People Staying

3

Camera

O

®0nline 5

Offline 0

®Present 3

Departed 2

» Real-time Visitor Records

Name Sign In/Out Time

Bob 2025/01/22 17:49:42
2025/01/22 17:47:59

2025/01/22 17:37:45

»» Online Status Statistics
Device

@ Online 2

Offline 2290

»» Real-time Alarm Statistics (Today)

Total 2

» Real-time Visitor Records
Name
Anna

Bob

1300 1500 17:00

»» Vehicle Flow Counting

Camera

@ Online 9
Offline 9

Level 1
B Level2
[ JEVOE]
B Level 4

Level 5

»» Visitor Statistics
Sign In/Out Time
2024/12/09 21:19:32

2024/12/09 21:27:25

2024/12/09 21:27:08

Data Charts Description

»» People Flow Counting Ve

» Real-time Alarm Statistics (Today) \ore

N

O

Total 55

1 2

Visitors Staying

50 &)

Vehicles In&Out

System Diagnosis

55 4]

Real-Time Alarms

Level 1
@ Level2
@ Level 3
® Level 4

Level 5

» Alarm Trend Statistics

o £\
0100 0300 0500 0700 0300 11:00 1300 1500 17:00

» Vehicle Snapshot Info

7 2025/01/22 ‘ 7

R WAITENO
o 192.1211.220.1

Data Dashbc

el

»» Vehicle Snapshot Info

o — — S
= =

(= L=

»» CPU Usage (%)

100

A J

0
01:00 0200 03:00 0400 0500 0600 07:00 0800 09:00 1000 11:00

o  — 00000000
01:00 0200 0300 0400 0500 0600 07:00

» RAM Usage (GB)

Total 10

M Present 6
Departed 4

Category Statistical Item Data Description
Access Real-time Visitor Displays real-time visitor access records, including visitor name, sign
Management Records in/out time, and visit status (visiting/signed out).

Visitor Statistics

Displays the total number of visitors today/staying/departed.
Data source: Visitor Management.

e Visitors Staying refers to the number of visitors who haven't signed
out.

e Visitor Departed refers to the number of visitors who have signed
out.

People Flow Counting

Displays the number of people entered/exited per hour today.
For example, the value at 12:00 represents the number of people
entered/exited from 11:00 to 12:00.
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Category

Statistical Item

Data Description

Data source: Smart Live View > People Counting, reported from smart
IPCs/NVRs.

Visitors Staying

Displays the current number of visitors, i.e. the number of visitors
who have signed in today but have not yet signed out.

Daily Entry/Exit
Statistics by Area

Based on the entry and exit records of access control devices in each
area for the day, counts the number of people entering and leaving
each area.

3% Daily Entry/Exit Statistics by Area

Entered @ Exited

1,500

e Entered: The sum of entry records from access control devices
within the area.

e Exited: The sum of exit records from access control devices within
the area.
[E> Note:

e Configure the entry/exit direction of access control passages
in device management; passages without a direction are not
counted.

¢ Configure the access control devices under the area in Custom
Data Dashboard > Chart.

e Records that failed verification are not counted.

e Data refreshes approximately every 30 seconds.

Daily Department
Staff Count

Counts the number of on-duty and off-duty employees in each
department for the day.

¥ Daily Department Staff Count

Department Name

dept3

e Onduty: The last record is an entry.
e Off duty: The last record is an exit.

® Click {7 in the upper right corner of the chart to reset the
counting task, which sets all personnel to off-duty.
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Category

Statistical Item

Data Description

E> Note:

e Configure the entry/exit direction of access control passages
in device management; passages without a direction are not
counted.

¢ Configure the access control devices under the department
and area in Custom Data Dashboard > Chart.

e Records that failed verification are not counted.
e Department data includes its sub-departments.

e Data refreshes approximately every 30 seconds.

Daily Entry/Exit
Statistics by Time
Period

Counts the number of people entering and leaving per hour for the
day. For example: The entering count for 10:00 is the sum of entry
records from 09:00:00 to 09:59:59.

Daily Entry/Exit Statistics by Time Period

@ Entered @ Exited

01:00 03:00 05:00 07:00 09:00 11:00 13:00 1500 17:00 19:00 21:00

E> Note:

¢ Configure the entry/exit direction of access control passages
in device management; passages without a direction are not
counted.

e Configure the access control devices under the area in Custom
Data Dashboard > Chart.

e Records that failed verification are not counted.

¢ Data refreshes approximately every 30 seconds.

People
Management

People Snapshot Info

Displays the latest people snapshot, snapshot device, snapshot time,
and identity information. If there is a match between the captured
person and a person in the library, the dashboard will display the
matching record, the person name, and his/her department.

Data source: Smart Live View > Door Access Control and Smart Live
View > Face Recognition.

People Staying

Displays the current number of people across all areas.

Calculated as: People Staying = People Entered Today - People Exited
Today. If the result is negative, the value will display as 0.

Data source: Data Search > People Counting.

Vehicle
Management

Vehicle Snapshot Info

Displays the latest 2 snapshots of the vehicle, plate close-up, snapshot
device, plate number, and snapshot time.
Data source: Smart Live View > Vehicle Application.

Vehicle Flow
Statistics

Displays the number of vehicles entered/exited/violated per hour
today.

For example, the value at 12:00 represents the number of vehicles
from 11:00 to 12:00.

¢ Data source of vehicles entered/exited: Parking Management >
Vehicle Volume.

e Data source of vehicles violated: Comprehensive Search > Motor
Vehicle Search-By Violation.
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Category

Statistical Item

Data Description

Vehicles In&0ut

Displays the current number of motor vehicles.
Calculated as: Vehicles In&Out = Vehicles Entered Today - Vehicles
Exited Today. If the result is negative, the value will display as 0.

Alarm
Management

Real-Time Alarm
Statistics

Displays the total number of alarms today and alarms at different
levels.
Data source: Historical Alarm.

Alarm Trend Statistics

Displays the number of alarms generated per hour today.
For example, the value at 12:00 represents the number of alarms
generated from 11:00 to 12:00.

Real-Time Alarms

Displays the total number of alarms triggered today.

Device
Management

Device Status
Statistics

Displays the current number of online/offline devices(regardless of
the device type) and cameras, and the percentage of devices/cameras
online.

Central Recording
Storage Status

Statistics on the storage status of central recording schedules, with
data sourced from Storage.
»7¥: Central Recording Storage Status

® Recording © Not Recording

10.0
Excellent

Today's Rating

Camera

e Today's Rating = 8.0 + [Recording / (Recording + Not Recording)] x
2; base score 8 points, full score 10 points.
e <9isFair
e <9.6isGood
e >9.6is Excellent
e The proportion of schedules that are Recording and Not Recording.
E> Note:
Even if a recording schedule is in an enabled state, if it is not

actually storing due to device offline/stream disconnection, etc., it
is counted as Not Recording.

Server
Performance

RAM Usage (GB)

Displays the real-time RAM usage trend. (Statistics start from entering
the dashboard)

CPU Usage (%)

Displays the real-time CPU usage trend. (Statistics start from entering
the dashboard)

@ Note:

¢ You can hover the mouse over the diagram to view the detailed numerical values.

* You can click More in the upper-right corner of the diagram to redirect to the corresponding data record

page.

Quick Access

If using the default system template (refer to Example Image 1), you can click on the function bubble to quickly
access the corresponding module for detailed data.
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Note:

Supported functions: Personnel Management, Access Control, Attendance Management, Device
Management, and System Diagnosis.

Users will only see the function bubbles they have permission for. For permission configuration, please refer
to User Management.

5.2 Custom Data Dashboard

You can configure the data types and layout styles (including the number of charts, layout, title, background
image, and chart borders) displayed on the dashboard.

Note:
Only the super admin can configure the data dashboard.

1. On the Data Dashboard page, click Custom Data Dashboard in the upper-right corner.

Custom Data Dashboard

Add Template

Data Dashboard

2. Add new templates or modify existing templates as needed.

e Add template: Click Add Template, enter the template name (the title of the dashboard), and then click
OK.

e Modify existing template: Hover the mouse over the template you want to modify and click Edit.

@ Note:

¢ For existing templates: Hover the mouse over the template. You can click Preview to preview its
effect, click to edit its name, and click to delete it.

e Up to 20 templates are allowed.

(© Data Dashboard ElReference Line O\ Scale 100%

Data Chart Background  Chart

Select Background Image |
Access Management

" Online Status Statistics " Real-time Alarm Statistics (Tod...
Personnel Management

Vehicle Management > ) (-

Alarm Management

i ==
Davice Management > Visitor Statistics

-

W,

Server Performance

" Real-time Visitor Records.

*People Flow Counting = *Vehicle Flow Counting

3. Click Reference Line. Choose a suitable reference line template (you can customize the Row x Column or
select a preset option: 3*3, 3*4, 4*4, 5*5, 6*8, 8*8) to set the layout for charts.

Note:
In the central editing area, you can drag a reference line to adjust its position.

4. On the left side of the page, you can select the chart you want to display and drag it to the central editing
area. The system can automatically adjust the chart size according to the layout.

5. On the right side of the page, you can set the background and chart properties.

¢ In the Background tab, you can choose an existing background image or add a custom image
(recommended resolution: 1920px*1080px; max. size: 20MB).
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¢ Inthe Chart tab, you can select the chart border style and set whether to display the chart title.

Background  Chart
l Style

Dark Blue v

Display Chart Title

Apply to All

@ Note:
By default, chart property settings only apply to the currently selected chart. You can click Apply to All
to apply the set style to all charts in the current editing area.

¢ The Daily Department Staff Count, Daily Entry/Exit Statistics by Time Period, Daily Entry/Exit Statistics by
Area charts require configuration of the statistical scope and table headers. For details, please refer to
Data Charts Description.

6. Click Save.

7. Click @ in the upper-left corner to exit. Click the tick (V) in the upper-right corner of the template to set it as
the active template. Now, you can call it in Data Dashboard.

6 User Management

Go to Basic Config > User Mgt.

Manage the users who log in and use the system, and assign the service permissions to individuals to achieve
refined permission management.

The concepts involved are explained below:

' ™

Organization
An organizationis a virtual group used to manage various resources sucha
users and devices in the system.
|
e ~ N - _ ~ User _ ‘ User 2
| User, role, and Auseris anentity capable of managing and
( permission are \ operating the system. Once assigned a role, the
T}__ hound to each h __,,,‘;f':}:b user can perform the corresponding system ‘ User N
\‘---ﬂ-\ other. ,‘;,___7_,/" managementand operations. / i
NG Y, .

_____________ -

Role ; : Permission
Arole is a collection of operation
permissions.When assigned toa user, “
the user gains all the permissions 1 |
‘-_ defined within thatrole.

Permission refers to a user's rights to
view and operate resources such as
devices and services within the system.
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6.1 Organization Management

Organization is a virtual concept used to group and manage various system resources, such as users and devices.
With organizations, you can precisely manage users' operational permissions for different resources. It is
recommended that organizations plan according to the actual permission divisions.

Add Organization

@ Note: Up to 26 levels of organizations under the local domain are allowed (including the local domain).

1. Select a parent organization and then click + next to Organization List.

Figure 6-1: Add Organization

Add Organization X

*Qrganiz... | Please enter @
*Organiz...  Please enter @
*Parent ... = Local Domain

Descript..., Please enter ®

2. Enter the organization name, ID, and description.

@ Note: The organization ID must be unique.
3. Click OK.

Edit Organization

Right-click on an organization in the local domain and click Edit to edit the organization name and description.

Figure 6-2: Edit Organization
cloud

AL
Add Sub-Organization

Delete

Delete Organization

Right-click on an organization in the local domain and click Delete to delete the organization.

@ Note: If there are any users, roles, or sub-organizations under the organization, it cannot be deleted.

6.2 Role Management

Manage roles and role permissions.

Role is a collection of operation permissions. After a role is assigned to a user, the user has all permissions
defined in the role. Role management facilitates the management and assignment of user permissions.
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Figure 6-3: Role Management

User Management

Role Management

cloud
AAA

Organization List

+ Add Search Sub-Organization
Role Name Role Description Operation
Operator Operator Template
Admin Admin Template

NormalUser

Permissions for role follow these principles:

Principle Description

Depth First If different permissions are configured for both the child and parent organizations
simultaneously, the permissions granted to the child organization take precedence
when authenticating the child organization.

Inheritance If a parent organization has permissions configured and its child organization does not,
the child organization inherits the permissions of the parent organization.

Union If a user is granted multiple role permissions, the user's permissions are the union of
all assigned roles, with the highest priority role determining the precedence.

Add Role

1. Inthe organization list, select an organization, and then select the Role tab. (Roles only apply to users and
resources within the organization.)

2. Click Add.

3. Enter the role name, select organization and priority.
Role priority: 1-63 levels, the lower the number the higher the priority. In resource preemption scenarios,
roles with higher priority have superior preemption permission.

4. Select permission(s).

e Menu permission: Permission to view and operate the system application management menu. Menu
permissions should be preferentially configured. If not pre-configured, the configured function
permissions are still invalid.

Figure 6-4: Add Role-Menu Permission

* Role Name:

Organization:

Menu Permission

Al

v [ Select Al

Basic Configuration
Alarm Center

Data Search

Video Application
o&m
Access8Attendance
Park Application

System Configuration

® Description:

* Priority: 3 v

Global Permission  Resource Permission

¢ Global permission: Permission to operation functions and devices in the system, which includes the global
permission and resource permission.
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Figure 6-5: Add Role-Function Permission

* Role Name:

entel 6] Description: | 2

Organization: | Al * Priarity: 6 ~

Menu Permission Global Permission  Resource Permission

~ (W) Select All
» (W] Video Surveillance
- device
To Add
Edit
Delete
, Personnel (including departments, faces, face databases, visitors, and residents)

» Vehicles (including garage)

Resource Permission: Assign resource permissions to users by organization. If no organization is specified,
the user will have full access to all resources within the role's organization and its sub-organizations. If an
organization is specified, the user will only have access to resources within the specified organization and
its sub-organizations.

On the Resource Permission tab, click Configure Organization Resource Permission, and then select
organization(s).

@ Note:

Only organizations within the role's organization and its sub-organizations can be selected.

Figure 6-6: Add Role-Resource Permission

[Add Resource X
L

@ B
If not configured, all permissions will be grant% ,J-‘ Local Domain

1 Configure Resource Permission -~ cloud
AAA

* Role Name: | Please enter Description: | Please ente |
|

Organization * Priority : 6 v J

Menu Permission Global Permission  Resource Permission o
+ Add The current resource organization includes its subordinate organizations. Please enter the resource name
///
— .
Resource Name _— Operation
P
AAA jmj

5. Click OK.

Edit Role

Click /# in the Operation column to edit the role description and permissions.
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Edit

* Role Name: O, Description:
Organization: * Priority: 3]
Menu Permission Global Permission  Resource Permission
3 Basic Config
’ Alarm Center

v Video Application

J OamM

’ Access&Attendance
v Park Application

3 System Config

Delete Role
® Delete one by one: Click 7ii7 in the Operation column and confirm the deletion.

¢ Delete in batches: Select roles to delete, click Delete, and then confirm the deletion.

@ Note:

e The deleted role cannot be restored.

e Cannot delete roles that have been bound to any user.

6.3 User Management

Manage user information.

Users are entities that manage and operate the system. After being assigned role(s), user can log in to the system
and perform the allowed operations.

The system allows simultaneous login to the same account from multiple clients. This simplifies user
configuration and management, and allows normal operations with a small number of user accounts.
@ Note: The system has two default users: admin and loadmin.

e Both have the role of the super administrator and the highest privilege in the system.

e Admin can grant/revoke the super administrator privilege to/from other users.

e Neither admin nor loadmin can be deleted.

Figure 6-7: User Management
Organization List User Type: v Usemame: m Reset

+ Add O Refresh ok, Import Domain User | Search Sub-Organiz.. Online:7 user(s)

£, User Management

o
User Management 0
Userame User ID Organization  Role User Type Phone Number Lock Status Online Status ~ Operation
Configure AD Domain
Anna . Admin Common User Unlocke: « Online(1)

(@ Role Management

Bob 111 Admin Common User * Offline

asy asy Admin Common User * Offline

e e . AL Common User Unlocke * Offline

loadmin loadmin Super Admin. Common User * Online(s)
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Add User

1. Inthe organization list, select an organization, and then select the User tab.

2. Click Add.
o Basic Info
*Username: 6]
*Password: Please enter 6]
Organization:
Email: ®
Cancel

confirm password.

@ Note:

e The username and user ID must be unique.

e The password must be a strong password.

4. Click Next to go to the Permission Configuration page.

P
|~/ ) Basic Info
A

Link Role :  Admin x =+

Menu Permission Global Permission  Resource Permission

* Video Surveillance
Live
Flayback
PTZ
Broadcast
Play Video on Wall

Recording Download

Back

23

Permission Configuration

*User ID:

# Confirm Password: | Pleas

i
m
w

Phone Number:

Description:

3. Enter the basic user information (fields with * are required), including username, user ID, password, and

o Permission Configuration



(1) click next to Link Role to expand the role list. Select role(s). To create a new role, click New Role (see
operations in Role Management).

Note:
Only roles within the same organization (including sub-organizations) as the user can be bound.

(2) Click OK to assign role(s).

5. (Only admin users can configure) Click Next to configure the allowed login time and login PCs for users.

':'\', ) Basic Info ."\',"'. Permission Configut o Login Cenfig

| Login Time Settings

Valid Days : Permanently Valid ® Custom day(s)

Effective Time: Mon Tue Wed Thu Fri Sat Sun
Daily Login Period 1: Daily Login Period 2:
| Login Mgt

Binding Palicy Use Local Config v Bind IP Address Bind MAC Address

Login Method (® Multi-Client Login Legin Preemption

Bind IP Address Bind MAC Address

+ Add
Start IP End IP Opera...
Back Cancel m
Valid Days e Permanently Valid: The user can always log in to the system.

e Custom: Enter a number. After saving the configuration, the user will
automatically become invalid after the specified number of days, and invalid
users will not be able to log in to the system.

Effective Time Select the dates when the user is allowed to log in.
E> Note:
At least one date must be selected, otherwise, the user will not be able to log in
even if the user is within the validity period.
Daily Login Period Set the time periods during which the user can log in each day (supports two time
periods).

If no time period is set, the user is allowed to log in throughout the day.

Login Mgt » Use Global Config: The settings will follow the Global Login Management global
configuration.

e Use Local Config: Configure the binding policy and login method for the user
here.

Binding Policy Only allows the user to log in from specific IP addresses and MAC addresses.

¢ Bind IP Address: Add the allowed IP address range for login.

¢ Bind MAC Address: Add the allowed MAC addresses for login.

Login Method e Multi-Client Login: The same username can log in on multiple PCs
simultaneously.

e Login Preemption: The same username can only log in on one PC at a time.
When the user logs in on one PC, the login session on the other PC will be
forcibly logged out.

6. Click Finish.
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Edit User

Click /' in the Operation column to edit the user information.

@ Note:

e The user ID and organization cannot be edited.
* Only admin can edit the user information of other super administrators.

e Editing AD domain users' username/password information is not supported in this system.

Batch Configure Permission
Assign role(s) to multiple users in batches.

1. Select users (22) and click Batch Configure Permission.

—+ Add Ti] Delete % Batch Configure...
Username User 1D 0]
loadmin loadmin U
usr1 0oo u
usra 111 U
Batch Configure Permission

Link Role : Operator x  Admin x

Eff

ctive

m

Rules l Append (add in addition to an existing role)

Overwrite (replace a previously bound role, i.e., based on the currently selected role)

Menu Permission Global Permission  Resource Permission

»  Basic Config

» System Config

r Q&M

b Alarm Center

v Access8iAttendance
v Video Application

v Park Application

2. Click next to Link Role to expand the role list. Select role(s) as needed. To create a new role, click New
Role (see operations in Role Management).

3. Select an effect rule.
¢ Append: Retain the existing linked role(s) and add new role(s).
e Overwrite: Replace the linked role(s). i.e. The currently selected role(s) will take precedence.

4. Click OK.
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Lock/Unlock User

In the user list, click  in the Operation column to lock the user. Once locked, the user cannot log in to the
system. Click again to unlock.

Set as Super Administrator

After logging in as an admin, click ( | for the user to set the user as a super administrator. Click again to revoke.

Note:
Only admin can designate other users as super administrators.

Username User Type Phone Number Lock Status Online Status Super Administr... Operation
Anna Common Us... | Unlocked | ® Online(1) ﬁ : ET
Bob Common Us... | Unlocked | ® Offline () Z : ET

Global Login Management

The system supports globally restricting user login methods and login PCs. When the user login policy is set to
Use Global Config, the settings here will take effect.

Note:
Only admin can configure the global login rules.

1. Login as admin, and click Global Login Management.

2. Configure the login rules, and then click OK.
Global Login Mgt X
© By default, the following settings apply to users using global configurations.

Login Method (®) Multi-Client Login Login Preemption

Bind Address Bind IP Address Bind MAC Address

Bind IP Address  Bind MAC Address

] Delete
(m] Start IP End IP Operation
192.117.1.1 192.117.1.254

Login Method e Multi-Client Login: The same username can log in on multiple PCs
simultaneously.

e Login Preemption: The same username can only log in on one PC at a time.
When the user logs in on one PC, the login session on the other PC will be
forcibly logged out.

Bind Address Only allows the user to log in from specific IP addresses and MAC addresses.

e Bind IP Address: Add the allowed IP address range for login.
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¢ Bind MAC Address: Add the allowed MAC addresses for login.

3. For non-admin users, after logging in, hovering over the Global Login Management button will show the login
method.
Manage Online Users

The system supports viewing the number of online users and forcing users offline.

1. Click the Online Status column corresponding to an online user to view the user's login IP and login time.

Username Role User Type Phone Number Lock Status Online Status Operation

loadmin Super Admi... Comman Us... Unlocked | * Online(3)

User Online Information

No Username Login IP Login Time Operation
1 loadmin 192.160.183.103 2025-11-04 11:15:06 D

2 loadmin 192.115.1.115 2025-11-04 11:16:53

3 loadmin 192.115.1.96 2025-11-04 11:16:53

4 loadmin 192.115.1.138 2025-11-04 11:17:35

2. Click the corresponding to force a login session offline.

@ Note:

¢ If a user has logged in on multiple pages on the same PC, only the page corresponding to the login
time will be logged out. The login time is based on the server's time.

e After a user is forced offline, any further actions on the page will trigger an error message and
immediately log the user out. If no actions are taken, the user will be automatically logged out when
the page's keep-alive mechanism fails.

Delete User
* Delete one by one: Click [ii] in the Operation column and confirm the deletion.

¢ Delete in batches: Select user(s) to delete, click Delete, and then confirm the deletion.

@ Note:

e The deleted user cannot be restored.
¢ Only admin can delete other super administrators (excluding loadmin).

¢ Neither admin nor loadmin can be deleted.

6.4 AD Domain User

The system supports integration with AD Domain and importing AD Domain users, allowing login to the system
using AD domain user accounts.

AD Domain (Active Directory Domain) refers to the directory service used by Windows servers, which stores
company computer information, user accounts/passwords, groups, and other data. It acts as an organizational
unit. Companies can define security boundaries using AD Domain, and employees can authenticate and log in to
the company's domain system via domain accounts. While operating within the domain, employees must adhere
to the company's defined security policies. The domain manager allows remote management and configuration
across multiple regions, enabling centralized management.
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Once the company’s internal AD domain is integrated into this system, administrators can configure employee
permissions, allowing employees to log in to the system via domain accounts/passwords. This eliminates

the need for users to remember multiple usernames and passwords, facilitating secure and efficient login
management

Configure AD Domain
1. Go to User Management > User Management > Configure AD Domain.

Note: After configuring the AD domain, you can import AD domain accounts into the platform for use. The DN needs to be obtained separately.

User Management

* Domain Name...

oa.cn-uniview.com
User Management
* Hostname: 10.229.3.55
Configure AD Domain
* Port: 180
Role Management
* Username: Y LE]
*Password: | | L.eeees
* Base DN: QU=RD,0U=UserRoot DC=0a,DC=cn-univie... Get DN

2. Fill in the AD Domain information by referring to the table below.

Parameter Description

Domain Name AD Domain name, obtained from the AD domain side.

Hostname IP address or hostname of the AD domain server.

Port Port number of the AD domain server.

Username/Password Username and password of the AD domain administrator.
[ Note:

This user serves as the credential for interaction with the domain. Once
saved, do not modify the user's password in the AD domain, as this may
cause password errors when importing domain users.

Base DN Click Get DN to obtain the root directory name of the AD domain in order to
query the AD domain user list.
Once the base DN is correctly obtained, click Save to save the configuration.

3. After configuration, click Save to integrate with the AD domain.

Import Domain Users

1. Go to the User Management page.

2. Click Import Domain Users above the user list.

3. Follow the steps to add domain users, configure permissions, and set login rules.

(1) Add domain users: Select the domain users that need to be added to this system.
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< Import Domain User

° Basic Info Permission Configuration

Organization: UNV Guard

Domain User List Selected user(s): 1

By Clear All Q) Please enter username keywor

- [m| UserRoot
Username User ID Operation
~ m RD

|8 wintay

m11§6

Cancel Next

(2) Configure permissions: Bind roles to the domain users, granting them the permissions associated with
those roles.

< mport Domain User

[~ ) Basic Info o Permission Configuration

Link Role : Adminx | —+

Menu Permission Global Permission  Resource Permission

Video Surveillance

device

Personnel {including departments, faces, face databases, visitors, and residents)

Vehicles (including garage)

(3) (Only admin users can configure) Configure the allowed login time and login PCs for users.
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< Import Domain User

._'\/‘. Basic Info -_'\/“ Permission Configu e Login Config

I Login Time Settings

Valid Days: (®) Permanently Valid Custom
Effective Time: Mon Tue Wed Thu Fri Sat Sun
Daily Login Period 1: Start time End time Daily Login Period 2: Start time

| Login Mgt
Binding Policy Use Global Config v

Login Method

Back Cancel

Domain User Login

On the login page, select AD Domain Login as the account type. Enter the imported AD domain user credentials
(user ID/password), and after successful verification, you can log in.

7 Device Management

Go to Basic Config > Device Mgt.

You can add various park devices to platform and configure them. For supported device types, see Supported
Devices.

7.1 Frontend Device

Frontend devices include cameras, access control devices, network video recorders, etc., which are used to
access the image and video data collected in the field, as well as the target attributes and alarm data generated
by intelligent analysis.

Choose a way to add your device:

e Device Discovery: Discover devices on the same LAN automatically and select them one by one or in batches
from the search results for adding.

e Add One by One: Enter information such as the device's IP address or device ID to add devices one by one.

e Batch Add: Import devices in batches using a template.

Al

Protocol: | All x Search Type: | Device Name Search Keywords: Reset
+ Add Device [\ ) Refresh . Batch Export 2 BatchEdit | v Z Edit Channel Info

RO

ment  Search Sub Organiza,
A2

Device ID 1P Address Device Type Device Model Video Status Image Status  Operation

NVR NVR-322-2280  Online

 Online

HICs) « Online

Note:

In the device list, the Video Status column displays the online status of the video channel, while the Image
Status column displays the online status of the image channel. For offline channels, hover over ? to view the
causes of the offline status.
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7.1.1 Device Discovery

Discover and add devices (camera, LPC, LPR, NVR, face recognition terminal, general access control device, access
controllers, indoor station, outdoor station, speed gate & turnstile, radar, radar vision) in specified network
segments on the same LAN as the platform.

1. Click Device Discovery.

2. Specify the network segment to search by setting the start and end IP address. Up to 8 network segments are
allowed, i.e., 192.168.1.1-192.168.9.255.

3. Click Search.

4. Click 4+ in the Operation column to add devices one by one or select multiple devices and click Batch Add to
add devices in batches.

e Protocol Type: ONVIF/Private.

e Username/Password: Username and password of device login.

Batch Add

Frotocal type: ONVIF Protocel

* Add to Organizal Local Domain

* User Name:

* Password:

Cancel

7.1.2 Add One by One

Add frontend devices one by one.

Go to Device Mgt > Frontend Device. Select an organization for the device in the left-side organization tree and
click Add Device > Add Device.

7.1.2.1 Private Device

Add devices such as camera, LPC (license plate capture camera), LPR (license plate recognition camera), NVR
(network video recorder), Smart Box (intelligent edge computing server), EIA (intelligent edge analysis server),
Radar, indoor station, door station, face recognition terminal, general access control device, access controller,
elevator controller, speed gate & turnstile, etc., via Uniview’s private protocol (LAPI).

1. Onthe Add Frontend Device page, select Video Device.

2. Set Protocol Type to Private Protocol.
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l Basic Info

*Device Name:

*Qrganization:

| Tag Info
Tag: ||

Private Device

Protocol: Private Protoco

Transfer Protocol:
*Username:
#1P/Domain Name:

Playback/Download Servi...

*Device ID:

Device Type: PC
Stream Transmission Prot.. TCP

*Password:

#Port:

Adaptive

Configure the required parameters. The parameters available may vary with device model. Please refer to the

actual interface.

Parameter

Description

Device Name

Device name.

Device ID

Unique device ID in the local domain. No format requirements.

[ Note:
The device ID must match the one on Device's Web interface. Otherwise, the
device cannot go online.

Organization

Organization that the camera belongs to.

Device Type

IPC, LPC, LPR, NVR, Smart Box, EIA, Radar, Radar-Video fusion camera,indoor
station, outdoor station (door station/zone station), face recognition terminal,
general access control device, access controller, elevator controller, speed gate &
turnstile.

[ Note:
e General access control device: Refers to the OER-SR12/22/42 series access
controllers.

e Access controller: Refers to the OER-601/602/604/501/502/504 serials
access controllers.

e Speed gate & turnstile: Refers to the OFP-B3-8501 serials speed gates.

Models are subject to change. Please contact the technical support for details.

Create directory with
the same name

Configurable when the device type is NVR.

¢ Selected: A sub-organization, named after the device, will be created under
the parent organization. The NVR will then be added to this identically named
organization. This facilitates locating the NVR in the organization tree by
searching the organization name.
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Parameter

Description

Device Type: | NVR

Create directory with the same name

v

| ™
L + Add Device W
At

# Edit Channel Info

Device Name

EI-

¢ Unselected: The NVR will be added directly under the parent organization.

Transfer Protocol

After selecting the device type, the system will show the transfer protocols
supported by the device.

e Regular radar/Radar-Video fusion camera: Select WebSocket.
¢ Visual intelligent alarm detector (ADRDV351, a radar device): Select HTTP.
e |PC/NVR and other devices: Select HTTP.
[ Note:
HTTP refers to ordinary network signaling interactions; while WebSocket

(also known as HTTP over WebSocket), is suitable for scenarios involving NAT
traversal.

Stream Transmission
Protocol

TCP or UDP. Please select it according to the actual network situations.

Username/Password

Username and password of device login (required).

IP Address/Domain
Name

IP address or domain name of the device.

Port No.

The registered port number of the device (default: 80).

4. Click Confirm.

5. (Optional) Click Next and fill in the optional information.

< Add Frontend Device

| Other Info

Private device_IPC

Media Service Pelicy:

Adaptive

Parameter

Description

Media Service Policy

¢ The default is Adaption. All MSs share the load (except when the client player or
decoder in the local domain adopts the Direct Connection First policy). When an
MS is available but has insufficient forwarding capacity, the Direct Connection
First policy will be adopted.
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Parameter Description
¢ You can choose whether to bypass the specified MS as needed. If you want to
forward multiple media streams, specify the MS.
6. Click OK.

7. In the Frontend Device list, select the device, and its channels are displayed below.

| Q 1921173120

|- TR W, B ] ® Online

Channel List

Channel Name

Channel ID Channel Type Status Operation

PTZ Camera Online

PTZ Camera Online

7.1.2.2 ONVIF Camera

Add cameras via the ONVIF protocol.

1. Onthe Add Frontend Device page, select Video Device.

2. Set Protocol Type to ONVIF.

I Basic Info

#* Device Name:

#QOrganization:

I Tag Info
Tag: | ]
Video Device
Protocel:
*IP Address:
*Username:

Stream Transmission Prot...

ONVIF

TCP

° Required Information Optional information (it can be skipped

#Device ID:

Camera Type: Fixed Camera
*Port:
*Password:

Playback/Download Servi... Adaptive

3. Configure the required parameters.

Parameter

Description

Device Name

Device name.

Device ID

Custom a unique device ID in the local domain. No format requirements.

Organization

Organization that the camera belongs to.

Camera Type

14 types available (Fixed Camera, PTZ Camera, Fixed HD Camera, HD PTZ Camera,
In-Vehicle Camera, Uncontrollable SD Dome Camera, Uncontrollable HD Dome
Camera, Isolate Video Access, Motorized Lens Camera, Ultra Clear Face Capture
Camera, Multi-eye Splicing Camera, Access Control Device, Fixed Dome Camera,
Vari-Focal Fixed Dome Camera).

IP Address IP address of the camera.
Port No. Port number on which the camera receives messages.
Username Camera's username (required when authentication is enabled).
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Parameter

Description

Password

Camera password (required when authentication is enabled).

Stream Transmission
Protocol

TCP or UDP. Please select it according to the actual network situations.

Playback/Download
Service Policy

Auto-Adaptation (default): The MS server automatically load balances the
stream sent by the IPC to the client (unless the client player and decoder in
the local domain is configured as Direct Connection First). If the forwarding
capacity of the MS server is insufficient, the IPC will send the stream directly to
the client.

You can choose whether the stream is forwarded via the MS server as needed. It
is recommended to use the MS server for forwarding if there are multiple media
streams.

4. Click Confirm.

5. (Optional) Click Next and fill in the optional information.

| Other Info
Video device ONVIF
Longitude: Latitude:
Height(cm): Live Video Media Service ... Adaptive
Protocol: ONV
Parameter Description
Longitude Longitude of the camera’s location.
Latitude Latitude of the camera’s location.
Height Height of the camera’s location.

Live View Service
Policy

Auto-Adaptation (default): The MS server automatically load balances the
stream sent by the IPC to the client (unless the client player and decoder in
the local domain is configured as Direct Connection First). If the forwarding
capacity of the MS server is insufficient, the IPC will send the stream directly to
the client.

You can choose whether the stream is forwarded via the MS server as needed. It
is recommended to use the MS server for forwarding if there are multiple media
streams.

6. Click OK.

7.1.2.3 VSS Single-Channel Camera

Add single-channel cameras via the VSS protocol.

1. Onthe Add Frontend Device page, select Video Device.

2. Choose VSS Protocol and Single-Channel Camera, as shown in the figure below.
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I Basic Info

# Device Name:

#Organization:

| Tag Info
Tag: [ |

Video Device

Protocol: VSS Protoco

*Device ID:

Camera Channel Type:

(®) Single-Chann...

Multi-channel ...

Camera Type: ed Camera Camera Subtype: Com Camera

Camera Capability: Commaon *@ Bitrate(Kbps): 2048
*Username: * Password:

Stream Transmission Prot... = TCP TCP Type:

TCP Direction: PC as Client Playback/Download Servi... Adaptive

Authentication: (®) Yes Mo

3. Configure the required parameters.

Parameter

Description

Device Name

Device name.

Device ID

Unique device ID in the local domain.
E> Note:

¢ The device ID must match the one on the camera's Web interface. Otherwise,
the device cannot go online.

¢ Follow the VSS code rules: 20 digits, digits 11-13 must be 119-129, 131, or
132.

Organization

Organization that the camera belongs to.

Camera Type

14 types available (Fixed Camera, PTZ Camera, Fixed HD Camera, HD PTZ Camera, In-
Vehicle Camera, Uncontrollable SD Dome Camera, Uncontrollable HD Dome Camera,
Isolate Video Access, Motorized Lens Camera, Ultra Clear Face Capture Camera, Multi-
eye Splicing Camera, Access Control Device, Fixed Dome Camera, Vari-Focal Fixed
Dome Camera).

Camera Subtype

Choose common camera, deep learning camera (to recognize pedestrians, non-motor
vehicles, motor vehicles, and extract structured attributes), private camera (camera
connected via private protocol to capture image data; the corresponding image asset
information is required).

Camera Capability

Choose the camera capability: Common/Support Area People Counting/Support
Tripwire People Counting/Support Area and Tripwire People Counting.

Bitrate Encoding rate. Calculate storage space based on the bitrate.

Username Camera's username (required when authentication is enabled).

Password Camera password (required when authentication is enabled).

Stream The default is TCP. If you choose TCP, you need to choose the TCP type (VSS2014/
Transmission VS$S52016) and TCP direction (IPC as Client or as Server). Please select it according to
Protocol the actual network situations.

Playback/Download
Service Policy

e The default is Auto-Adaption. All MSs share the load (except when the client
player or decoder in the local domain adopts the Direct Connection First policy).
When an MS is available but has insufficient forwarding capacity, the Direct
Connection First policy will be adopted.
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Parameter

Description

* You can choose whether to bypass the specified MS (group) as needed. If you want
to forward multiple media streams, specify the MS (group).

¢ This configuration takes effect only for playback and download.

Authentication

The default is Yes.

¢ Yes (authentication enabled): The IPC verifies the username and password stored
on the server when connecting to the server; the IPC can go online only when the
authentication is successful.

¢ No (authentication disabled): The IPC can go online without username and
password required.

4. (Optional) Click Next and fill in the optional information.

| Other Info

Video device V5§

Longitude:

Height:

Live Video Media Service .

Latitude:

NAT Cenfig: Without NAT

Auto-Adaptation

Parameter Description

Longitude Longitude of the camera’s location.

Latitude Latitude of the camera’s location.

Height Height of the camera’s location.

NAT Config e Ifthe IPCis behind the NAT and the local domain is in front of the NAT, choose

IPC Behind the NAT.

e |f the local domain is behind the NAT and the IPC is in front of the NAT, choose
IPC in front of the NAT.

¢ |f IPC and the external domain are behind different NATs, choose IPC and Local
Domain Behind Different NATs.

e [f data streams of the IPC do not need to traverse the NAT, choose Without NAT.

Live Video Media
Service Policy

¢ The default is Auto-Adaption. All MSs share the load (except when the client
player or decoder in the local domain adopts the Direct Connection First policy).
When an MS is available but has insufficient forwarding capacity, the Direct
Connection First policy will be adopted.

¢ You can choose whether to bypass the specified MS as needed. If you want to
forward multiple media streams, specify the MS.

e This configuration takes effect only for live videos.

5. Click Confirm.

7.1.2.4 VSS Multi-Channel Camera

Add multi-channel cameras via the VSS protocol. Multi-channel cameras have multiple video channels (multiple

lens).

1. Onthe Add Frontend Device page, select Video Device.

2. Choose VSS Protocol and Multi-Channel Camera, as shown in the figure below.
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I Basic Info

*Device Name:

+Organization:

I Tag Info
Tag: [ ]
Video Device
Protacol:
Camera Subtype:
* Username:

Authentication:

#Device ID:

Camera Channel Type: Single-Chann... (® Multi-channel ..
Camera *Camera Number: 2

*Password :

3. Configure the required parameters.

Parameter

Description

Device Name

Device name.

Device ID

Unique device ID in the local domain.

[ Note: The device ID must match the one on the camera's Web interface.
Otherwise, the device cannot go online.

Organization

Organization that the camera belongs to.

Camera Subtype

Choose common camera, deep learning camera (to recognize pedestrians, non-
motor vehicles, motor vehicles, and extract structured attributes), private camera
(camera connected via private protocol to capture image data; the corresponding
image asset information is required).

Username

Camera's username (required when authentication is enabled).

Password

Camera password (required when authentication is enabled).

Authentication

The default is Yes.

* Yes (authentication enabled): The IPC verifies the username and password
stored on the server when connecting to the server; the IPC can go online only
when the authentication is successful.

¢ No (authentication disabled): The IPC can go online without username and
password required.

4. (Optional) Click Next and fill in the optional information.

| Other Infe
Video device_VSS
NAT Cenfig: Without NAT
Parameter Description
NAT Config e If the IPC is behind the NAT and the local domain is in front of the NAT, choose
IPC Behind the NAT.
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Parameter Description

e [f the local domain is behind the NAT and the IPC is in front of the NAT, choose
IPC in front of the NAT.

e [f IPC and the external domain are behind different NATs, choose IPC and Local
Domain Behind Different NATs.

¢ |f data streams of the IPC do not need to traverse the NAT, choose Without NAT.

5. Click Confirm.

6. When the VSS multi-channel camera goes online successfully, click Obtain Resource to obtain the channels
under it.

w .l.l.l .:.-I
Configure Device

Reboot Device 2112

Oktain Resource

7. In the Frontend Device list, select the VSS multi-channel camera, and its channels are displayed below.

W 2 Click here 43 72.20.8143 WSS Multi-channel * Online(Video)
oo MNVR215 172.20.81.215 LAPI Device o Online(Video)
g 1722 A Fixed Camera Offline(Video)
g dasd\ 111 11111 192.168.20.23 ONVIF Offline(Videc)
Vg dasdsa ffdfsf 192.168.20.29 CNVIF Cffline(Videa)

total 12 |T‘ 20/ page

Camera List
Camera name Camera ID Camera Type Device Status
.;. 43 240418225113207182717 PTZ Camera Online
o M32 24041822571320719634 PTZ Camera Online

@ Note:

e VSSsingle-channel camera has only one channel, so the channel configuration and device configuration
are integrated.

e VSS multi-channel camera has multiple channels, so the channel configuration and device configuration
are separate.

7.1.3 Batch Add

Import devices in batches using a template.
1. Go to Device Mgt > Frontend Device. Select an organization for the device in the left-side organization tree
and click Add Device > Batch Add.

Add Device | v Refresh Device Discovery

Device ID IP

]
=}
o
.o
I
(%]
=}
o
Ire)
ra

2. Click Download Template. Fill in the device information as instructed in the template.
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@ Note:

e The template contains 2 sheets: onvif and private. Please enter the device information in the
appropriate sheet based on the protocol.

e Only xIsm files are allowed. Max. size: 10MB.

3. Click to upload the modified template from local, and click Import.
Batch Add X
o
Uplead File | | Import

v

rsf Download Template fill in the data according to the requirgd

mat, and then import the file.

2.0nly xlsx files are allowed. Max. size: T0MB. /

|#Device Name(LapiName}|#Device ID{LapiDevCode) Organization(0rgCode) #LAPT Device Type(la
1192, 140, 1. 196 1921211196 icesid 1
ez a1 202 A R icesid |

' | onvif |private @

4. The successfully imported devices are displayed in the device list. For devices that failed to import, you can
view the failure cause.

7.1.4 Edit Device Info

Edit device information one by one or in batches.

Edit One by One
1. In the device list, click ./ for the camera.

2. Edit the parameters as needed.

Batch Edit

1. Select devices in the device list, and click Batch Export to export the selected device information into a xIsm
file.

2. Modify the device information in the file.

3. Click Batch Edit. In the pop-up window, click Import File to upload the modified file from local, and then click

Import.
+ Add Device v 1] Delete ) Refresh () Device Discovery «» Move I, Batch Expart || 2 Batch Edit | v | 2 Edit Channel Info
[=]' Allocation Management Search Sub Organiza.. (_
2
Batch Edit X
Device Name Video Status Image Status  Operation

Q© s 1.Export t ting data to 3 file, modify the contents according to the required format, and 11 ca0 Ga vk e Online
Q 1921151130 2.0nly isx iles are allowed. Max. size: 10MB. « Offine®
Import File Import File | Import the modified file

7.1.5 Edit Access Control Device Type

An access control device can be set to face recognition terminal mode or outdoor station mode (door station/
zone station). The device type can be modified on the platform for access control or video intercom purposes.
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* Edit one by one: Click the corresponding /~ for the access control device to change its type to Outdoor
Station or Face Recognition Terminal.

o Required Information Optional information (it can be skipped)

I Basic Info
*Device Name: 192.117.1.231 *Device ID:
*Organization: =
I Tag Info
Tag: [ |
Private Device
Protocol: Device Type: Qutdoor Station
Transfer Protocol: Stream Transmission Prot..| Outdoor Station
*Username: admin *Password: Face Recognition Termina
#|P/Domain Name: 192.117.1.231 +Port: 80
Playback/Download Servi...  Adaptive

Edit in batches: Select multiple access control devices and click Batch Edit Access Control Device Type to set
their type to Outdoor Station or Face Recognition Terminal.

Batch Edit Access Control Device Type X

* Device Type: | ‘

Outdoor Station

Face Recognition Termina

7.1.6 Edit Channel Info

Edit information for channels under device one by one or in batches.

Edit One by One
1. Inthe device list, select a device to display the channels under it.
L] Device Name Device ID IP Address Device Type Device Model Video Status Image Status Operation
Q 192.115.1.119 o 119 192.115.1.119 PC HICH844- X41-F40-GB-VH1 e Online
toral 3 |T‘ 20/ page
Channel List
Channel Name Channel ID

Channel Type Status

Operation
® 19211511191 ° 591870950895518398-0-1 PTZ Camera prex

Online

® 19211511192

3

591870950895518398-0-2 PTZ Camera Online

2. Click /# for the channel to edit its information.

@ Note:

For video channels, you can edit its basic configuration and main/sub stream parameters.

For access control channels, you can edit the channel name and entry/exit direction.
Batch Edit
1. Click Edit Channel Info.

2. Select the channel type (Video Channel/Access Control Channel) you want to edit, and then click Export to
export the corresponding channel information table into a file.
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3. Modify channel information in the file and save it.
[®p Note:
¢ Video Channel: Only the channel name can be modified.
e Access control channel: Only the channel name and entry/exit direction can be modified.
¢ Do not modify the parameters displayed in gray in the table.

4. Click Import to upload the modified file.

+ Add Device | v (" Refresh ) Device Discovery I Batch Export £ BatchEdit | v

[=) Allocation Management | Search Sub Organiza... \d

Device Name Device ID IP Address Device Type Device Model Video Status

192.115.1.177 1921151 | il - onine

© Export the specified typ
access control channel’s na

annels you have selected to a file, modify video channel's name,

and direction accroding to the required format, and then import the

*Export Channels (®) Video Channel m o

Access Control Channel

Upload File me

Only xlsx files are allowed. Max. size: 10MB.

7.1.7 Move Device

Move devices to another organization.

@ Note:

¢ You can only move devices to another organization within the same domain (excluding the cloud
organization and organizations under alarm controllers).

e Cannot move shared devices.
1. Select device(s) in the device list, and click Move.

2. Select the destination organization, and click OK.

+ Add Device Refresh > Move

() Device Discovery

SIPP Select an organization K -
Q 19 ) 196
e - 0o 202

g Org2

Cancel OK

7.1.8 Allocate Device

Allocate devices from one organization to another. After allocation, the device will exist in both the new
organization and the source organization.

Click Allocation Management above the device list.
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€ Allocation Management

ot Device Status| Al Search Keywords | Camera name Reset
= 1
Hem2 [ Resource Allacation [ Deallocate Resource O Refresh | Search Sub Organization (]
Camera name Camera ID Camera Type Device Status Source of Resource Operation
® 192.112.1.89 1 553059667957661088-0-1 PTZ Camerz ® Oniine Original Resource E &
® 192112189 2 553059667967661058-0-2 PTZ Camera ® Online Original Resource =)
® 192.121.1.205.1 553041479925236000-0-1 PTZ Camera ® Online Original Resource =)
W 192.121.1.205_10 553041479925236000-0-10 Fixed Camera ® Online Original Resource =)
By 192.121.1.20511 553041479925236000-0-11 Fixed Camers ® Offline Original Resource = ®
W 192121120512 553041479925236000-0-12 Fixed Camers ® Online Original Resource = ®

Allocate Resource
1. Select device(s) and then click Resource Allocation above the list; or click [ for the device.

2. Select a destination organization.

Resource Allocation X

oA

Cancel Confirm

3. Click Confirm.

Cancel Allocation
For devices allocated from other organizations, you can also cancel the allocation.

1. In a destination organization (where the device has been allocated to), select device(s), and then click
Deallocate Resource; or click [ for the device.

2. Confirm the operation to remove device from the organization.

7.1.9 Others

Search, delete, export, and go to device web.

Search
e Search frontend devices by device type, device name, device ID, device model, and IP address.

¢ Select Search Sub Organization to search devices under sub organizations.

Delete

Select device(s) in the device list, and then click Delete.

Batch Export

Select device(s) in the device list, and then click Batch Export.

Go to Device Web

In the device list, click > corresponding to the device to access its web interface.
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7.2 Cloud Device

Cloud devices refer to devices added on EZCloud Service, used in WAN networking scenario. After adding devices
such as IPC, NVR, and face recognition terminal to EZCloud, you can log in to the cloud account on the platform
and manage the devices under that cloud account (must be online).

Logged-in cloud accounts: 4 online, 0 offline. | [l Cloud Account List | % LogIn Go to EZCloud Official Website

My Cloud Devices

Please enter ke
A Device Name | Please enter IPAddress | Please enter Deviee Type | All
e cloud Model Please enter Connection- | All N m Feset
" fos a
Pt + Add 3 Refresh |Searc WSLb-Grgs”'zamﬂ(j)
20
0 Device Name + IPAddress  + Organization + Device Type + Model 5 Connection-- v Status 5 Operation
10.10.200.75A 127.00.1 fostaza IPC IPC-B3A4-FW Direct Connect o Offline &
100.100 192.167.100.100 20 B IPC HIC28841-FW-- Direct Connect & Online £
100.14 127.001 feadaza IPC PKC2830 Direct Connect e Offline 2
100.9 127001 fsb Face Recogniti ET-B33H-M@R Direct Connect ® Offline 2 T
123 127.00.1 x10770 IPC IPC-B2A5-IR@P-+ TURN @ Online 2
192.167.11.42bbb 192.167.10.7 fodaiza IPC IPC-5245-FW@- - Direct Connect @ Online 2
20.13 127.0.0.1 izl IPC PKC2830 Direct Connect e Offline Z4an)
30.66 127.001 fodalila IPC TIC-5262-IR Direct Connect o Offline 2 W
70.63 127.0.0.1 fodas1a IPC PKC5301-ZD Direct Connect & Offline 2
88 127.001 fos a7 IPC PKC2840 Direct Connect o Offline &

Log In to Cloud Account

1. Click Log In in the center of the page. Enter the cloud account information and click Log In.

Cloud User Login X

Register Forgot Passw...

2. After successful login, the devices under the cloud account will be displayed in the list. Click Refresh to refresh
the device status.

@ Note:

You can also log in to multiple cloud accounts (no upper limit) to manage devices under them. When
logged in, you can click on the cloud account on the left organization tree to view the devices under it.

Manage Cloud Account
Click Cloud Account List to view the logged-in cloud accounts.

* Click = to refresh the organization and device information under the cloud account (you need to log in to
the cloud account again).

e Click 17 to log out from the cloud account.

Cloud Account

Name * Status & Operation

—_=

S S B Cnline =
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Add Cloud Device
You can add devices to online cloud accounts.
1. Click Add at the upper-left of the device list.
Add X

*Device Name:

=Register Code:

*Cloud Account; | BP0 N

2. Enter the device name and register code (can be find on device body or device's Web interface).

3. Click OK. The successfully added devices are displayed in My Cloud Devices list.

Edit Cloud Device
1. Click / forthe device.

192 57 40.71-TIC2621

*Device Name:

*Cloud Account:)

S;‘ nc to Cloud

2. Edit the device name.

If Sync to Cloud is selected, the modified device name will be synced to cloud; otherwise, only the device
name on the platform will be modified.

3. Click OK.

Delete Cloud Device

Click 7] for the cloud device to delete it from the current cloud account.

7.3 Edge Device

7.3.1 VSS NVR

You can add NVRs (Network Video Recorders) via the VSS protocol and view the camera resources under the NVR
on the management platform.

Add NVR

1. Click Add and configure device parameters.
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| Basic Settings

* Device Name: # Device ID:
* Stream Transmission Protocol @ Auto-Adaptation *SPM:
| Advanced Settings
* Authentication: (®) yes no
* User Name:
* Password: * Confirm Password :
Domain Mame: MNAT Config: Without NAT
* Playback/Download Service Polic Bypass M5 * Media Service Policy: Auto-Adaptation

Parameter

Description

Device Name

Customize the device name of the NVR for easy differentiation.

Device ID

Consistent with the device code of the NVR.

Stream Transmission
Protocol

e Auto-Adaption (default): This platform can receive TCP or UDP video streams
sent by the NVRs, which is determined by system negotiation.

e TCP: This platform can only receive TCP video streams sent by the NVR.

SPN

Select an SPN for NVR to push resources.

Authentication

If enabled, the username/password of the NVR will be authenticated.

Domain Name

Optional. For VSS protocol authentication. If configured, it should be the same as
the domain name configured on the NVR.

NAT Config

Select the corresponding scenario depending on whether the NVR and the cameras
under it are in the same network with this platform.

Playback/Download
Service Policy

Configure the service policy for playing back or downloading resources of the NVR
on this platform:

e Auto-Adaption (default): If there is no MS available, the policy of Bypass MS will
be followed. If there is MS available, the policy of Not Bypass MS First will be
followed.

e Bypass MS: The playback/download will bypass the MS.

Note: Whether the media streams bypass the MS is determined based on multiple
configurations and MS deployment. See details in Local Config > Video Parameters
> Advanced Config > Playback/Download Service Selection Policy.

Media Service Policy

e Auto-Adaption (default): Whether the video streams bypass the MS is
determined by the system according to the media service selection policy of the
NVR and the MS deployment.

e Specified MS: The video streams will not bypass the specified MS.

¢ Specified MS Group: The video streams will not bypass the MS in the specified
MS group.

e Bypass MS: The video streams bypass the MS.

[ Note: If an MS is deployed but has insufficient forwarding capacity, then the
Bypass MS policy will be adopted.
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View/Delete Device Resources

Click |Z| on the left-side of the NVR to expand the list of cameras under it.

Device Name Device ID Device IP SPN Status Directory Subscription Alarm Subscription  Operation
test 340200000011... 172.20.81.225 spnserver Online subscribed subscribed
Camera List Refresh
Camera name Camera ID Operation

In the camera list, click Delete in the Operation column to delete the camera from the list and synchronously
delete the camera from the NVR.

Search Device Resource

You can manually obtain camera resources under the NVR.

Click in the Operation column and select Search Device Resource to obtain the latest device resources under
Device Name Device ID Device IP SPN Status Directory Subscription Alarm Subscription  Operation
340200000011.. 22001223 spnserver Online subscriped v SmEsrinas
|t Dizlete

Search Device Resource

Directory subscription cancelled,

Alarm subscription cancelled.

Subscribe to Directories
You can subscribe to directories to synchronize the status and name of the camera resources under the NVR.
Subscription Description

Click in the Operation column and select Subscribe to Directories.

Device Name Device ID Device IP SPN Status Directory Subscription Alarm Subscription  Operation

Configure
Delete
Diractory subscription cancelled.
Alamm subscription cancelled.
Cancel Subscription
To cancel the subscription to directories, click in the Operation column and select Cancel Subscription to
Directories.
Subscribe to Alarms
You can subscribe to the alarms generated by the NVR and the cameras under it.
Subscription Description
Click in the Operation column and select Subscribe to Alarms.
Cancel Subscription
To cancel the subscription to directories, click in the Operation column and select Cancel Subscription to

Alarms.
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Edit NVR

Click === in the Operation column and select Configure; or double-click on the device name to edit the basic
parameters.

Delete NVR

Click === in the Operation column and select Delete; or select multiple NVRs and click Delete at the top of the
list.

7.3.2 Third-party Host

The platform supports connection with third-party alarm controllers to receive alarms from alarm devices and
allow user to control these alarm devices, including arming/disarming and opening/closing doors.

Host List + ™
+ Add Batch Import Export Q Please enter keywords
ase enter keywords to search
- Securi Devi VM Devi VM Devi
B uozo 2 ecurity Device Name vice Point ID Area ID evice evice Status  Operation
Device ID Type D Type
D: 78946
. 5 .
157 oHOE5D 001 001 Aarm Po... - - 001_vmp 20000 BEE <20
B Gato P
b 79897454 002 002 Alarm Pa... - - 002_vmp 20000 [Online] P LW
Type: SAM300
B Meevi

ID: 79587457
Type: TBV-8205

7.3.2.1 Host Management
Add, edit, and delete hosts.
Add Host
Add one by one or in batches.
Add one by one

1. Click + in the upper-right corner of the host list.

Add Host X

Host Type: Alarm 4 * Host ID: Please enter
Host Vendor: ShangHai UCZ0 ~ * Host Name: Please enter
Host Model: UOZ0-S350 ~

Host Address: . . . Host Port:

Local Port:

The parameters are described below.

Parameter Description
Basic Host Type Includes alarm controllers, access controllers, intercom devices, and
configuration environmental sensors.

Host ID (required) | Enter a unique host ID.

Vendor Choose the vendor.
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Parameter

Description

Host Name
(required)

Enter the host name.

Host Model

Choose a model from the list.

Connection parameters

The parameters may vary depending on the type, manufacturer, and
model. Set according to the actual requirements.

2. Click OK. The added host appears.

Host List +

(Q Please enter keywords to search
B vozo £ T
1D: 789456

Type: UOZO-5350

B Gato
1D: 79897454

Type: SAM300

Batch import

1. click [, in the upper-right corner of the

host list.

Batch Import X

1. Please enter the data to be imported in the template.

<> Download Host Import Template

2. Please select the attachment to import.

T, Uploaded File | xlsx files only.

. Download the template.

Cancel

. Complete the required information according to the template.

2
3
4. Click Upload File and then select the file
5. Click to import the file.

Other Operations

you just completed.

* Edit host: Click / to modify the host information.

* Delete host: Click 7] to delete a host. If there are devices under the host, then the host cannot be deleted.
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7.3.2.2 Device Management

Add third-party security devices, for example, environmental sensors, access control devices, security scanners,
etc; and modify or delete devices.

Add Device
Add one by one

1. Choose the host for which you want to add the device.

2. Click Add.

Add Security Device

* Security Device ID: Please enter
* Security Device Name: | Please enter
Device Type: Alarm Point
Point ID: Please enter

Arez ID: Please enter

The parameters are described below.

Parameter Description
Security Device ID Enter a unique ID for the device.
(required)
Security Device Name | Enter a name for the device.
(required)
Device Type Choose the device type from the list.
Point ID Device’s area ID (zone ID), must be consistent with the area ID configured in the
host. Leave it empty if there’s no zone ID.
Area ID Host ID, must be consistent with the host ID configured in the host.
3. Click OK.

Batch import
1. Choose the host for which you want to add the device.

2. Click Batch Import.
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Batch Import

1. Please enter the data to be imported in the template.

&> Download Device Import Template

2. Please select the attachment to impart.

I, Uploaded File  xlsx files only.

Cancel

Download the device import template.

3
4. Complete the required information according to the template.
5. Click Upload File and then select the file you just completed.
6

. Click to import the file.

Other Operations
* Edit device: Click ./ to modify the device information.

* Delete device: Click 7|} to delete a device; or select devices and then click Delete.

7.4 Terminal Device

Terminal devices include decoders, video wall controllers, and network keyboards, which are used for playing
videos on video wall.

7.4.1 Decoder & Video Wall Controller

Decoders (DC & ADUS87 series) can convert digital signals from cameras or local channels into analog signals and
output them to the video wall for display.

Add Device
1. Select an organization for the device in the local domain.

2. Click Add.
AddDX Device

#MName:

* Device ID:
Stream Transmission Pro... TCP
Media Service Selection ... Auto-Adaptation

Asset Info
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3. Configure the parameters by referring to the table below.

Parameter Description
Name Device name.
Device ID Device ID.

Stream Transmission | ¢ TCP (default): The DX device only receives media streams carried by TCP.

Protocol . . . . .

e Auto-Adaptation: The DX device can receive media streams carried by UDP
or TCP, and the protocol is determined by the system through automatic
negotiation.

Media Service Choose whether IPC's media streams are forwarded to DX device via MS server.

Selection Policy e Adaptation (default): The system decides whether to forward IPC streams via

MS based on factors such as the forwarding capacity of MS server.

¢ Direct Connection First: IPC streams are directly sent to the DX device, bypassing
MS server.

7.4.2 Network Keyboard

Network keyboards are used with video wall and allow remote video control (such as play and pause) on the
video wall by associating keyboard keys with cameras.

Supported keyboard model: KB2100.

Note:
Enter the IP address of the platform on KB2100 to log in. When succeeded, the keyboard can obtain devices
and video wall resources from the platform directly, without adding the keyboard on the platform.

Keyboard Control Configuration
Camera Control Relationship

Set the correspondence between keyboard control numbers and camera IDs so users can control a camera with

a keyboard. One keyboard control number corresponds to one camera. For example, if set the number key 1 to
correspond to camera 1, then when you press the number key 1, the keyboard will control camera 1. You can also
press other function keys on the keyboard to perform operations such as playing live video on wall.

1. Go to the Camera Control Relationship tab.

2. Click Add.

Add X

3

Keyboard control number Camera name Camera ID Operation

m

T

3. Enter the keyboard control number. Select a camera, and the camera ID will be filled in automatically. To add
more items, click Add.

@ Note:

e The keyboard control number must be a number; the camera ID is the ID of the camera you want to
control using the keyboard.

¢ One keyboard control number corresponds to one camera ID.
4. Click Confirm.

Keyboard Key Description

The diagram below is for illustrative purpose only. The device functions may vary with version or model. Please
refer to the latest device document.
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S0
3
2 Sy e R
o o]
- |
(3]
No. Name Description
1 Function e PRESET: Set presets.
key .
e ADD: Play video on wall.
e Other keys are reserved. Please refer to the device's document.
2 Number key | e Digit (0-9) and decimal point.
e C(Clear: Clear input.
3 Touch View video on the touch screen or mirror video to an HDMI-connected display
screen device.
4 Dial Rotate the outer wheel to adjust the focus.
Rotate the inner wheel to adjust the iris.
5 4D joystick | Move the joystick up/down/left/right/upper-left/lower-left/upper-right/lower-
right to control the PTZ camera to rotate in all directions and quickly locate objects.

8 Video Storage Configuration

Go to Basic Config > Storage Config.

Configure video storage for cameras. Videos will be stored in the local disks or external storage devices connected
to the platform. During playback, the stored videos can be retrieved for viewing.

Scheduled storage, alarm-triggered storage, manual storage, and scheduled recording backup are supported.

@ Note:

e This chapter describes how to configure central recording storage (stored in the local disks or the external
storage devices).

* You can also configure storage on IPC or NVR if you don't want to use the central recording storage.

8.1 Add Storage Resource

The platform can use the local disks or external storage devices to provide recording storage for IPCs.

Configuration Steps
Please first configure local disks/RAID or add external IPSAN in System Config >Disk Configuration .
After configuration, the system will automatically create a storage resource for the usage.

At the Device Mgt > Server Mgt page, the following servers will be automatically added to the system:
Cloud Direct Storage (for storage management), Video on Demand Server (for video playback), and Backup
Management Server (for recording backup).
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+ Add ~ ) Refresh

v Cloud Direct Storage(5/5)

192.115.2.26 192.115.2.29
=== - - JEREEERART B 1921151057
) ( d ——
@ Server Mgt
> Media Server(2/2)
v Video on Demand Server(6/6)
GG}, VODJPSAN.192.... IG5}, VOD.IPSAN.192.... IG5}, VODJIPSAN.192. GG}, VODJPSAN.192....
B 192115002 [ 92.115.2.26 — | 92.115.2.27 B 192115229
v Backup Management Server(5/6)
[Em | BM.IPSAN.192.1... [Em | BM.IPSAN.192.1... [Em BM.IPSAN.192.1... [Em | BM.IPSAN.192.1...
CE 5112 g © 2.26 = 2.27 [t | 192 29

8.2 Storage

Go to Basic Config > Storage Config > Storage Config. You can allocate the size of the storage resource space to
cameras and configure different storage methods for cameras.

The following storage modes are available: manual storage, alarm-triggered storage, and scheduled storage.

e Manual storage: User starts/stops central recording manually.
e Alarm-triggered storage: Storage is triggered by alarms. You need to configure post-alarm recording time.

e Scheduled storage: Configure a storage schedule for the camera.

Configure Storage Resource

1. On the left-side organization tree, choose an organization, choose the target camera, click /4, or select
multiple cameras of the same type (IPC or EC) and then click Batch Add.

A page as shown below appears. (The parameters displayed may vary with camera. The figure below is an
example.)

Camera Direct Storage Configuration X

Storage Device Type: @) Cloud Direct Storage

Scheduled Recording ... @) Main Stream Sub Stream
Manual Recording Str.. 8 Main Stream Sub Stream
Alamm Recording Stre... ) Main Stream Sub Stream
“Storage Device:

Available Capacity: GB
*Allocated Capacity: SE
Data Cverwrite Policy: & Overwrite on Fu

Capacity Allocating M... 5, g

(uk)
]
[

y Capacity

M <cheduled Direct Storane Confinuration

2. Configure the parameters by referring to the table below.

(]
]
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Parameter

Description

Storage Device Type

Only support Cloud Storage.

Scheduled Recording
Stream

Choose main stream or sub stream. The selected stream type will be used for
scheduled storage.

Manual Recording
Stream

Choose main stream or sub stream. The selected stream type will be used for
manual storage.

Alarm Recording
Stream

Choose the stream type for alarm-triggered recording.

[ Note: Choose main stream or sub stream according to the encoding
parameters of the IPC or the encoder connected to the camera.

Direct Storage Device

Select recording storage resource (created in Disk Configuration).

Available Capacity

Available capacity on the storage device. The system reads the capacity
automatically after you select a direct storage device.

Allocated Capacity

Storage space assigned to the camera.

When HDD Full

Overwrite: When the storage space assigned to the camera is used up, new data
will overwrite the old data from the beginning repeatedly.

Capacity Allocating
Mode

e By Capacity: Allocate storage resource to the camera according to the allocated
space.

e By Day: Calculate the space to be allocated based on stream type, storage
days, and scheduled storage settings, and then allocate storage resource to the
camera.

[ Note: This parameter is displayed only when you are configuring a single
camera.

Storage Days

This parameter is required if you are configuring for a single camera and the
capacity allocating mode is By Day.

Set the storage days and then click Calculate. The system automatically calculates
the needed forward-and-storage space and displays it in “allocate capacity” or
“expansion capacity”.

[ Note: The video storage space needed by a camera is calculated using this
formula:
Needed space = N (hours) * 3600 (seconds) * encoder stream / IPC (bps) *
(1.08) / 8, where 1.08 is the needed space plus 8% margin.

For example, assume each video channel is 2M, so the space needed every hour

is 2048*3600*1.08/(8*%1024*1024)=0.95GB, so 22.8GB is needed for 24-hour
recording. If each camera records 30 days, then one VX1600 with 16 1TB HDDs can
satisfy space requirements of 16000/(22.8*30)=24 cameras at most.

3. Enable/disable scheduled recording (when enabled, the camera records video according to the schedule).
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Camera Direct Storage Configuration X

scheduled Direct Storage Configuration
Time Period: By Da
Mao. Start Time End Time Operation
0C:0C:00 & ” )
Enable E.. iE
Exceptionl  2025-04-01

4. (Optional) If scheduled direct storage is enabled, configure scheduled direct storage by referring to the table
below.

Parameter Description

Time Period You can set the storage schedule by day or by week.

[ Note: After completing the storage schedule for a day, you can click Copy to
copy and apply the schedule to other days.

Enable Exception If necessary, enable exception to set special time periods and perform special
storage during these periods. On special days, the system performs storage during
the set periods only; on other days, the system performs storage according to the
schedule.

[ Note:

¢ Click Add Exception to add an exception. Up to 16 exceptions are allowed.

* Click i to delete an exception.

® After completing the storage schedule for a day, you can click (] to copy
and apply the schedule to other days.

5. Click Confirm.

Capacity Expansion/Reduction
1. Choose the target camera, click /# in the Operation column.

2. In expansion capacity, enter the capacity you want to expand or reduce. A positive number means expansion.
A negative number means reduction.

@ Note:

¢ For capacity expansion, make sure the expansion is less than or equal to the capacity available.
e To reduce cloud storage capacity, make sure the modified capacity is greater than or equal to 16GB.

3. Click Confirm.

Start/Stop Storage

You can start or stop storage after completing storage resource configuration for a camera.
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Storage Type

Operation

Scheduled Storage

1. Click the organization on the left-side organization list, and then select the target
camera in the organization.

2. Click Start Scheduled Storage/Stop Scheduled Storage.

= o EE—

o

[ Note:
The system automatically starts the recording schedule when scheduled recording
is configured.

Manual Storage

You can perform manual storage after configuring storage resources for the camera.

Disable Schedule.

Recording Schedule Configu Real-time Recording Status  Scheduled Recording S...  Manual Recording Status  Operation

@
@
@

8.3 Backup

Go to Basic Config > Storage Config > Backup Config. Backup refers to storing the existing stored recordings
again, the purpose is to prevent the original recordings from being written or deleted, or the video data is very
important and needs to be stored twice.

Prerequisites

Please bind the backup server with recording backup resource first.

1. Go to Device Mgt > Server Mgt.

2. Click More > Configuring Storage Resource for a backup server.

3. Click Add.

57




v Backup Management Server(1/1)

e bmserver
= Configuring Storage Resource
Edit Delete hMore
Add Storage reso e of B
*Resource MNam.., Please Enter Resource Name
#Resource Type: Cloud Direct Storage
#Resource Usag.. Commaon resources
#Select Storage... Please Select Select Storage
Available Capa... Please Enter Available Capacity
*Allocated Cap... Please Enter Allocated Capacit
Resource Path: Please Enter Resource Path
Item Description
Resource Name Enter a custom resource name.
Resource Type Choose Cloud Direct Storage.

Select Storage Device | Select recording backup resource (created in Disk Configuration).

Available Capacity Automatically read by the system after selecting the storage device.

Allocated Capacity The capacity allocated to the backup resource.

Backup Configuration
1. Go to Storage Configuration > Backup.

2. Click the target organization on the left-side organization list.

3. Select multiple cameras (at least 2) in the organization, click Batch Add; or click /~ for the camera. A page as
shown below appears.
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Backup Configuration x

#Select Backup Device: bmserver

* Resource Occupying Mod...

Plan Backup Configuration

#Plan Backup Policy: (® Full-Frame Backup Frame Backup Only
Maximum Storage Days: 0 Day(s) @
Backup Duration: ( Day(s) @
Time Period: By Day
Time Period1: | 00:00:00 ~ | 23:59:59 Time Period2: ~
Time Period3: ~ Time Period4: ~
Parameter Description

Select Backup Device | Select a backup server to assign recording backup resources to the camera.

Resource Occupying | How the camera uses BM backup resources.
Mode
¢ Shared (only supported): All the cameras that are specified to use the BM device

share the backup resource.

4. Select whether to enable scheduled backup (Scheduled backup creates a backup schedule for recordings,
periodically backing up recordings from specified time periods).
If scheduled backup is enabled, configure the parameters by referring to the table below.

Parameter Description

Plan Backup Policy e Full-Frame Backup: Back up continuous frames. This option requires the
maximum space. Cameras shared by an external domain only support this
option.

e | Frame Backup Only: Back up | frames only. This option requires the minimum
space, but playback images will be discontinuous.

Backup Duration Used with Maximum Storage Days to determine the backup start time. If it is set to
Y, it means that after the schedule is created, BM will start backup from the video
recorded Y days ago.

[ Note:

¢ Valid range: 0-45. Must be greater than or equal to the maximum storage
days. The same value is used by default.

e The backup time span takes effect only when the backup schedule is
configured for the first time. Once saved, the setting cannot be changed.

Maximum Storage Used with Backup Duration, it defines the backup end time. If set to X, it means the
Days BM will stop backup after X days from the start time.
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Parameter

Description

[® Note: Valid range: 0; 3-45. Setting it to O indicates continuous backup. Setting
it to a value that is greater than or equal to 3 indicates backup for the specified
number of days.

Time Period

You can configure the backup schedule by day or by week. The system will
periodically back up recordings from the specified time periods according to this
schedule.

5. Click OK to save the settings.

@ Note: The system starts the backup schedule by default after the configuration is completed.

Start/Stop Backup Schedule

® To start or stop the backup schedule for a camera, click Stop /()Enable for the camera.

e To start or stop backup schedules for multiple cameras at a time, select the cameras and then click Start or

Stop.

9 Video Application

Based on the live videos collected from front-end devices, this function provides various options for live and
playback viewing and scenario-based applications. This allows users to view real-time situations and review past
events, replacing on-site security patrols and improving the efficiency of security management.

Functions

Menu

Description

Live View

Allows users to view real-time audio and video information collected by cameras
in video windows for on-site status and timely detection of any anomalies. You
can view the live video from a single camera or call the preset scene using camera
sequence, group display, and group sequence. During live view, operations such as
PTZ control, patrol, and video intercom are supported.

Playback

Allows users to search and download recordings stored on the storage resources
of the platform, camera's SD cards, and NVR disks, as well as backtrack historical
events with anomalies.

Video Wall

Allows users to create video wall layout on the client and bind video output
channels of decoders to play video images on a physical video wall.

Smart Live View

Allows users to view live videos of video channels under smart IPCs and NVRs, as
well as access control devices. The real-time snapshot data and alarms (face match
records, vehicle match records, and person/motor vehicle/non-motor vehicle data
from multi-target detection) are displayed when playing smart live view.

@ Note:

The Live View and Playback functions are integrated in the Video Surveillance page. For the same camera,
the unified right-click operation allows you to start live view or search recordings. Additionally, live videos
and recordings can be displayed on one screen simultaneously. The client display screen supports up to
64 split screens and allows for customized screen layouts, allowing you view more videos from different
channels at various times.

9.1 Live View

Go to Video Application > Video Surveillance.

View real-time audio and video information collected by cameras in video windows for on-site status and timely

detection of any anomalies.
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Workflow
1. Add cameras. See Device Management > Private Device or ONVIF Camera.
2. Start live view. See Camera Live View.

Camera Favorites Preset Scene

™ £4¥ Local Domain
B 192.1271.180_1
® 19212701181

wo 1921401222 1
®) 1921471222 10
w192 13n222 11
B 1921301222 12
wr 19218701222 13
B 192.1271.222 14
W 1921471222 2
@) 1921471222 3
@ 192.1311.222 4
@ 1921311222 5
B 1921371222 6
we 19218702227
® 1921471222 8
B 1921401222 9

@ 1921311227 1

9.1.1 Camera Live View

View real-time live videos collected from cameras.

Capture the live scene Play live videos on the monitor

with camera(s)

Media Stream

f:ﬂfﬁ?:F

Start Live View of Single Channel

e Select a window and double-click on an online camera.
e Dragthe online camera to a window.

Figure 9-1: Start Live View

Camera Favorites Preset Scene

v i‘- Local Domain
[ & 192.127.1.180_1
B~ 1921201181
| = 1921471222 1
m;: 1921471222 10
| = 192.1d%0.222 11
B~ 192.13%1.222 12
| = 192.127.1.222 13

e Select a window, right-click on an online camera, click Start Live View, and then select Start Live View or
Auto-Adaptation.
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Figure 9-2: Right-Click Menu
o> 192111180 1

‘/’ 192,121 1 10 4

Start Live View : Start Live View
| = 19212

Start Playback Auto-Adaptation
‘D 19212

Batch Start Live View

Select cameras, right-click on cameras, select Batch Start Live View, and then live videos of the selected cameras
will be played in an adaptive layout.

9.1.2 Camera Sequence

Play live videos of cameras in one window in sequence.

IPC2

IPC1 IPC3

\é/

Add Camera Sequence Resource
1. Click 4+ in the upper-right corner of the camera sequence resource list.

Figure 9-3: Add Camera Sequence

Add Camera Sequence X

*Camera Sequence Name:

Camera List Selected Cameras | Delete Stay Time: | 10s Stream Type: | Auto-Adaptation A
(@]
— Camera Name Stay Time(s)  Stream Type Operation
| 12 - P
1722042661 10 Auto-Adaptation T
12345
15 TN IT2AHEL 10 Auto-Adaptation & W =
(=)
@)1 h g . ==
® ~— 17230181212 10 Auto-Adaptation & W =

@ 1722m 145120 LAPLT
@ 17400 445.121 1
@ 173 451212

@ 172510566 1

:@ 1781 .

Organization:

“ canes

2. Set the camera sequence name (max 20 characters and must not contain & <> |)
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3. Select cameras from the left-side list (you can also select organization for batch selection) and then click 9
to add them to the camera sequence group. _

@ Note:

* You can also set the stay time and stream type display interval and stream type for them. When
added, you can click #* inthe Selected Camera List to modify.

=

You can click [ii to delete the camera or select cameras and click Delete to delete them in batches.

®* Youcandrag = to adjust its display order.

4. Choose an organization for the camera sequence resource.

5. Click OK.

Start Camera Sequence
Choose a way to start camera sequence:

¢ Select a window, and then double-click on the camera sequence resource.

¢ Dragthe camera sequence resource to a window.

¢ Select a window, right-click on the camera sequence resource, and then select Start.
Figure 9-4: Camera Sequence

Camera Favorites Preset Scene

Camera Sequence List +

Camera...

ED - 4% towut s

Group ... = CameraSequencel

=

Group ...

After double-clicking to enlarge a window in the camera sequence, you can click in the toolbar to
switch to the previous/next camera.
Manage Camera Sequence

Right-click on a camera sequence resource to edit, delete, or add to favorites.

9.1.3 Group Display

Group display is a kind of view in which multiple cameras are playing live videos in specific windows. By saving
commonly used video views as group displays, you can easily call them with one-click, allowing for quick and
convenient access to your preferred camera combinations.

Add Group Display

When live videos are playing, you can click . on the toolbar to save the ongoing live view services as a group
display.

@ Note:

If a camera sequence/group sequence is playing in the window, only the currently active live view services in
the window will be saved.

Start Group Display

Choose a way to start group display:
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¢ Double-click on a group display resource.
e Right-click on a group display resource and choose Start.

Figure 9-5: Group Display
Camera Favorites Preset Scene
Group Display List

Camera...
L_<'w EFA)

Group ... {7 GroupDisplay1
] |z GroupDisplay2

Group ..

|
After double-clicking to enlarge a window in the group display, you can click in the toolbar to switch to
the previous/next camera.

Manage Group Display

Right-click on a group display resource to delete or add to favorites.

9.1.4 Group Sequence

Cycle through live videos of multiple group displays at set intervals in multiple windows.

Add Sequence Resource
1. Click 4+ in the upper-right corner of the sequence resource list.

2. Set sequence parameters such as sequence name, and also create sequence groups.

@ Note:

The sequence name allows up to 20 characters and must not contain % <> |

Table 9-1: Sequence Configuration Description

Sequence Type Description

Group Display Sequence | Play multiple camera groups in sequence.

E> Note:
Prerequisite: You have Group Display resources configured.
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Sequence Type Description

GroupDisplay1

GroupDisplay2

to adjust the group display order.

*Sequence Name: | GroupSequence *Organization:
) Type: (8 Group Display Sequence Group Display T ® OnC
Group Display List Selected Group Displays | Delete
Group Display Name Stay Time(s) Operation
o ﬁ-‘ GroupDisplay1

(1) Select group display resources from the left-side list, set the duration of the

live video per group, and then click ( 5 )to add them to the sequence group.

(2) In the right-side list, you can: click to edit the group display stay time;

click to delete the group display from the group sequence group; drag

3. Click OK.

Start Group Sequence
In the group sequence list, double-click on a group sequence resource to start.

Figure 9-6: Group Sequence
Camera Favorites Preset Scene [} 5
= Group Sequence List +
e w 1

o
O

5roup ...

NO VIDEO NO VIDEO

Manage Group Sequence

Right-click on a group sequence resource to edit, delete, or add to favorites.
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9.1.5 Live View Operations

Use the right-click menu, live view toolbar, PTZ control panel to set live video parameters, take snapshots, etc.

Live View Right-Click Menu Operations

You can right-click on a live view window and then use the pop-up menu to close the window, close all windows,
maximize/restore the window.

Close Current Window

Close All Windows

MWaximize

Play Video on Wall

Live View Toolbar Operations

The toolbar appears when you hover the mouse over a window.

Figure 9-7: Window Toolbar

For toolbar buttons, please refer to the actual page.

Table 9-2: Toolbar Operations

Icon Function Description
@ Snapshot Capture the current image(s) in the window and save to local.
@ Continuous
Snapshots
Digital Zoom Zoom in on the area of interest on the image.
E Note: Use the scroll wheel to zoom in or out.
Preset Buttons for No.1 and other presets. Click to call the corresponding

preset and view images of the desired scene instantly.

3D Positioning

Perform 3D positioning, including click-to-position and drag-to-zoom.

e Click to position: Click anywhere on the image, and the camera
automatically centers on the point that you clicked to display the
image.

e Drag to zoom: Drag on the image from top left to bottom right to
zoom in, and drag in the opposite direction to zoom out.

Volume control

Click to use the slider to adjust the volume of the video.

Start/Stop Local
Recording

Record the live record a live window the live view image, and save it
to.

AcuSearch/AcuTrack

When a target of interest is identified in the live video you can select
the motor vehicle/non-motor vehicle/pedestrian target in the current
image to search the full video and image data for scenes where the
target appeared.

1. Click to freeze the current frame.
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Icon Function Description

Drag to select the person or vehicle you want to search for

N N

X
AcuSearch
AcuTrack

.

e 3

- : —— N -

2. Select the target to search for:

e Hold down the mouse and drag the area within the green box
to move its position.

e Hover the mouse over the edges or corners of the green box,
when the cursor changes to an arrow, hold and drag to resize
the green box.

¢ To exit the search, click X.
3. Choose a search mode. Two modes are available:

e Click the AcuSearch button at the top right corner of the
green box to go to the SeekFree page, where the system will
automatically search for all capture records of the target within
the green box (see Search by Image).

e Click the AcuTrack button at the top right corner of the green
box to go to the AcuTrack page, where you can search for
recordings containing the target in the green box.

] Start/Stop Broadcast | Click the icon to start one-to-one audio broadcast to the camera. The
broadcast is one-way.

Broadcast List

B Device name

B 192.115.1.89_2; Broadcasting: 00:00:04

E Two-way audio Click the icon to start one-to-one audio intercom with the camera. The
intercom is two-way.
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Icon Function Description

Audio bidireccional

192.115.1.89_2

e Audio: Sound from the camera to the client.
e Microphone: Sound from the client to the camera.

¢ Click Hang Up to end the two-way audio.

You may also use the toolbar at the bottom:

* -: Change the window layout. You can customize the number of windows, or choose

1/4/6/8/9/10/13/16/17/25/36/64 windows or corridor mode (intended for narrow scenes such as a corridor)
as needed.

Custom @

— . . :
. Save the current widow services as a group display.

¢ : Close all videos.

E: Play local videos in the window.

: View the broadcast records from the client to the camera.

PTZ Control Panel Operations

For PTZ cameras, you can click ﬂ in the live view toolbar to open the PTZ control panel.
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PTZ | 1

Figure 9-8: PTZ Control Panel

1) d i€ X

Patrol Home Po

Table 9-3: PTZ Control Panel Operations

Icon

Description

B

Lock or unlock the PTZ.

e When the PTZ is locked, only the super admin can control the PTZ. Other users must wait till
the PTZ is unlocked or till the auto release time expired.

e  When the PTZ is unlocked, a high-level user can preempt control from a low-level user.

e For parent and child domains that are connected via GB/T28181, the parent domain can lock
the PTZ in the child domain.

E> Note:

e Any user can control an idle PTZ. Default policy of PTZ control: a high-priority user can
preempt control from a low-priority user; a user in the parent domain can preempt
control from a user of the same priority level in the child domain; in other cases, the first
user operating the PTZ gains the control. The priority level of a local-domain user is the
priority level of the user’s role; the priority level of the external-domain user is priority
level of the user’s role in the external domain.

e The policy of PTZ control and PTZ auto release time are configured in the PTZ.

Release PTZ.
e The PTZis idle after being released and can be controlled by any user.

e The locked PTZ is automatically unlocked after being released.

Preset

Preset: You can set desired shooting angles or positions as presets to focus on areas of interest.
After being idle (without user action) for a certain length of time, the PTZ automatically goes to a
specified preset to view the key area.

Go to a preset.

Rotate the camera to a specified preset.

Add a preset.
Add a preset for cameras in the local or external domain, that is, adding the
current pan/tilt status to the preset list.

(i) Attention: Make sure the preset ID is not in use; otherwise, the current
preset status of the preset ID will be replaced by the new preset status.

Sync with front-end presets.

E> Note: This function is available to cameras connected via private, not to
cameras connected via ONVIF.

Delete a preset.

g E

Set the home position: Choose a preset position that the camera automatically
returns to after PTZ control is released.
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Icon

Description

e Setanidle time before the camera returns to the home position. By default,
the newly added preset is the home position; you may also choose an existing
preset as the home position.

e The camera automatically returns to the home position after PTZ control is
released and the idle time expired (no user operation during the specified
period).

e The home position mode can be single-home mode or multi-home mode. For
multi-home mode, you need to set a schedule (up to 8 periods) and assign a
period for each home position.

¢ If a home position already exists, it will be replaced by the new home position.

Patrol

Patrol route: The camera pans and tilts according to a sequence of preset actions.

Start patrol.

m

Stop patrol.

Add a patrol route.

Click the icon, and then add a patrol route in the pop-up window.

Add Patrol Route X|
Name: (@) Preset and Patrol
Action Preset StayTime  Speed KeepRotating Duration  Operation
Go to Pres.. TR il w >
Go to Pres.. B 1 1 [ 2

¢ To rotate the camera to a preset, you need to set the preset ID/description,
and the length of time that the camera stays at the preset.

¢ To rotate up/down/left/right, you need to set the rotation speed, whether to
keep rotating, and the rotation duration.
E> Note:

e A patrol route includes at least two actions, including going to a preset
and rotating up/down/left/right. It may include one action only when the
action is rotating up/down/left/right all the time.

e If the action is set to rotating up/down/left/right all the time, then actions
following it will not be performed.

Delete a patrol route.

Edit a patrol route.

E DA

Configure a patrol schedule.

Click the icon, and then add a patrol schedule in the pop-up window.
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Icon

Description

Schedule & Time J

Patrol Resuming Time

When fire is detected and fire alarm is reported, the camera pauses for | 0 seconds before

continuing patrol.
Patrol schedule

Patrol schedule: (_J

* Schedule Name:
Schedule Template:
Time Period: | By Day

No Start Time End Time Patrol Route Operation

1 00:00:00 23:59:59 m Cancel

=R

“ Cance'

Home Position

Set whether to enable home position.

To enable home position, click Set and then set the home position.

Set Home Position X

‘ @ Please set home position. Up to 8 presets are allowed. The time periods of presets must not overlap. ‘

Add Delete
No. Preset Start Time End Time Ope:'“"
- &
1 14:23:35 14:24:35 [T}
Auto Back 300 s * Must enter an integer in the range of 10-3600.
Home Time:
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Icon Description

Control rotation directions (by clicking triangle buttons) and stop patrol (by
clicking the square button in the center).

Zoom in/out.

Focus far/near.

Increase/decrease iris.

is the fastest.

[E> Note: The rotation speed supports 9 levels from 1 to 9. 1 is the slowest and 9

Turn on/off the light.

o Turn on /off the wiper.
m Turn on/off the IR.
H Turn on/off the heater.

9.1.6 Live View Resource Management

View information about camera resources, rename cameras, edit camera attributes, and view resource statistics.

Rename Camera
Right-click on the camera on the resource list and then choose Change Name to rename the camera.

Figure 9-9: Change Name
Rename X

Camera Mame:

* New Name: 192 80_1

View Camera Information

Right-click a camera on the resource list (or map), and then choose View Detailed Information to view the
camera name, type, device IP, organization, PTZ control protocol and PTZ address code (for PTZ camera).
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Figure 9-10: Detailed Camera Attributes
=

Camera Name | 1921 1801
Camera Type
Device [P

Organization Local Damain

Resource Statistics
View the statistical information of camera/camera sequence/group display/group sequence resources.

Right-click on an organization, and then choose Resource Statistics to view camera statistics of the organization,
including the number of online cameras, the total number of cameras in the organization. After resources have
been changed, you need to perform this operation again to update the statistics.

Figure 9-11: Resource Statistics

" £} LocalDomair(16/28)

B 1921211180 1
w> 1921211181

9.1.7 Favorites

Add resources such as cameras, camera sequences, group displays, sequences to favorites to find them easily.

Create New Favorites Folder
Up to 3 levels of favorites folders (including the parent favorites folder) are allowed.

1. Right-click on the parent folder, select Add Folder, enter the folder name, and then click OK.
2. When created, right-click on the parent folder, and then select Refresh to refresh the resource tree manually.

Figure 9-12: Create New Favorites Folder

Camera Favorites Preset Scene

v {L\ loadmin

, Add Folder

Refresh

Add Resources to Favorites

Right-click on the resource in the corresponding resource tree and select Add to Favorites.

Favorites Folder Operations

For resources added to favorites, you can perform the operations below. The following takes camera as an
example.
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Table 9-4: Favorites Folder Operations

Item Description

Edit Name Right-click on the folder, and then select Change Folder to rename the folder.

Delete Folder Right-click on the folder, and then select Delete Folder to delete the folder from the list.
Refresh Folder Click (% to refresh the favorites folder.

Remove from Right-click on the camera, and then select Remove from Favorites to remove the camera
Favorites from the favorites folder.

Batch Start Live Select cameras, right-click on any camera, and then select Batch Start Live View to play the

View live videos of the selected cameras simultaneously.

Synchronous Select cameras, right-click on any camera, and then select Synchronous Playback to play the
Playback recordings of the selected cameras simultaneously.

Auto Camera Select cameras, right-click on any camera, select Auto Camera Sequence, and then
Sequence configure parameters such as camera sequence interval and order, the live videos of the

selected cameras will be played in single window in sequence.

Auto Group Select cameras, right-click on any camera, select Auto Group Sequence, and then configure
Sequence parameters such as group sequence interval and order, the live videos of the selected
cameras will be played in all windows in sequence.

9.2 Playback

Go to Video Application > Video Surveillance.

You can search recordings stored on the storage resources of the platform, camera's SD cards, and NVR disks, as
well as backtrack historical events with anomalies.

Workflow
1. Add cameras. See Device Management > Private Device and ONVIF Camera.

2. Configure storage resources for cameras. See Video Storage Configuration. You can also configure storage on
cameras or NVRs.

3. Search recordings for playback. See Recording Playback.

9.2.1 Recording Playback

You can search recordings stored on storage resources for playback.

@ Note:

Prerequisite: You need to configure storage resources for cameras. See Storage.

Search and Playback

1. On the Video Surveillance page, right-click on a camera and select Start Playback; or select multiple cameras,
right-click and select Synchronous Playback.
“ 192.121.1.180 1

@ ArnfdAI68 1

Start Live View ® 192.121. Batch Start Live View
%
Start Playback I 192121, | Synchronous Playback
* wmie:
a) 192121, Search Backup Recording
Single camera Multiple cameras

2. Set the recording start and end time and other criteria (storage location, domain, and recording type).
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Playback

Start Time : 2024-07-02 00:00:00

End Time | 2024-07-02 23:59:59 Today

Storage L...: Edge Reco.. (®) Central Re Fuzzy Sear

Search D... : Search Re

Recordin., Scheduled... Alarm Rec... Manual Re...(®) All Recordi...

Cancel
Item Description
Start Time Start time of the recording.
End Time End time of the recording.
Domain Registered Search recordings saved on the storage resources of the platform
Domain where the camera is registered.

Current Domain

Search recordings saved on the storage resources in the local
domain.

Cloud Retrieval

Search recordings across all storage resources.

Storage Location

Edge Recording

Recordings saved on storage resources of IPC/NVR.

Central Recording

Recordings saved on central storage resources of the platform, for
example, IPSAN, CDS.

Fuzzy Retrieval

Search all recordings, including edge recording and central
recording.

Recording Type

Scheduled
Recording

Recordings that are saved according to the set schedule.

Alarm Recording

Alarm-triggered recordings.

Manual Recording

Recordings that are saved manually.

All Recordings

Includes scheduled recording, alarm recording, and manual
recording.

3. Click OK to start the playback.

Camera Favorites

AL [EY)]

By 1921511960 1

By 192121108 1
222.1
22210
19210022 1
1921211222 12
122,13
122,14
222
1921211222 3
11222 4
111225

1226

1227

28

2.9
118271

Preset Scene

You can use the window toolbar, playback toolbar, and playback progress bar to control the playback.
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172.20.133.123_1 ( v => 111... (0.93Mbps)

2025-11-21 14:06:22 / 2025-11-21 23:50:59 [ |
Recor... (172.20.133.123_1)

(=130 mins(®

Window Toolbar

The toolbar appears when you hover the mouse over a windows.

Table 9-5: Window Toolbar Operations

Icon Function Description
Snapshot Capture the current image(s) in the window and save to local.
Continuous
Snapshots
Digital Zoom Zoom in on an area of interest on the image in the window. Use
the scroll wheel to zoom in or out, and click again to stop digital
zoom.
H Volume control Click to use the slider to adjust the volume of the video.
[E] AcuSearch/AcuTrack | When a target of interest is identified in the recording, you can

select the motor vehicle/non-motor vehicle/pedestrian target
in the current image to search the full video and image data for
scenes where the target appeared.

1. Click [B] to freeze the current frame.

Drag to select the person or vehicle you want to search for

N ™ AcuSearch
- N - \ AcuTrack
. N\

X

.

=

= 3

2. Select the target to search for:

e Hold down the mouse and drag the area within the green
box to move its position.
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Icon

Function

Description

e Hover the mouse over the edges or corners of the green
box, when the cursor changes to an arrow, hold and drag
to resize the green box.

¢ To exit the search, click X.
3. Choose a search mode. Two modes are available:

e Click the AcuSearch button at the top right corner of the
green box to go to the SeekFree page, where the system
will automatically search for all capture records of the
target within the green box (see Search by Image).

e Click the AcuTrack button at the top right corner of the
green box to go to the AcuTrack page, where you can
search for recordings containing the target in the green
box.

Bottom Toolbar

Icon

Function

Description

Switch Window
Layout

Change the window layout. You can customize the number of windows,
or choose 1/4/6/8/9/10/13/16/17/25/36/64 windows or corridor mode
(intended for narrow scenes such as a corridor) as needed.

Close all videos

Close the video in all current windows.

Play local
recording

Select a video file from the computer to play.

Search locked

Search for locked recordings, and unlock them if necessary.

recording search
results

recordings E Note:
For descriptions about how to lock recordings, see Playback Toolbar.
Backup View the successful backup recording search results during the current

login session. See Search Backup Recording.

Recording search
results

View the successful recording search results during the current login
session.

Recording Search Results X

Normal alarm [l Tag

Clear Al

D & B a a

You can select a video clip and then perform the following operations:
play, download, backup, zoom in on the timeline, lock

Playback Toolbar

Click the window to display the playback toolbar.

Table 9-6: Playback Toolbar Operations

Icon Function Description
Play/Pause Play/pause the video.
@ 10 s D Forward/Rewind | Play the previous/next segment at the set interval (1-999s, default is 30s)

Next Frame

Play next frame.
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Icon Function Description

Forward Frame | Play one frame of image per second. Local recording does not support

by Frame this function.
Adjust Speed Choose a desired playback speed: ¥:x, 1x, 2x, 4x, 8x, 16x.
= Start screen Click to record the currently playing recordings. Click again to finish.
o recording The recorded file will be saved to the browser's designated download
directory.
= Back up Create a recording backup task to back up recordings within a specified
e Recording time period.

Lock Recording | When locked, other users cannot perform any operations to recordings.

Add Tag See Tag.

Playback Progress Bar
The playback progress bar shows the playback progress of recordings in the selected window.
Figure 9-13: Progress Bar

Recor... (172.20.133.123_1)

=130 mins(#] » Nor..

¢ Drag to adjust the playback progress, or double-click to skip to the time point, or click the current time (blue
text) to select a specific time point and skit to it.

*  Use [EEMINTHEIMM to adjust the time scale on the progress bar.

Alarm Recording

If you have configured recording storage function in Alarm Linkage, you can view recordings of alarm moments
here.

Select Alarm. The alarm linkages will be marked in red on the progress bar. Double-click on a red marker to locate
the recording.
Tag

You can tag recordings of significant moments, allowing for quick retrieval of recordings using these tags later on.

® Add tag: Click

+ Enter a tag name for this recording time period.

Add Tag X

:a-\:e “

e View tag: Select Tag. The added tags will be marked in green on the progress bar. Double-click a green tag to

locate the recording. You can also click F( >7‘ to switch to the previous/next tag.
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=130 mins(*] | Nor...

Previous MNext Double click to locate

9.2.2 Search Backup Recording

Search for recordings stored in backup resources.

@ Note:

Prerequisite: You need to configure backup tasks for cameras. See Backup.

1. Right-click on the camera in the camera list and then choose Search Backup Recording.

2. Specify a time period (cannot exceed 14 days) , click Search Backup.
Backup Recording X

Start Time ;

End Time : 2025-06-24 05:32:49

3. The backup recording records are displayed by cameras.

Backup Recording Search Results X

Today

-

Camera List [ Start Time End Time Locked Status Operation

B~ ONVIF198_1_1 2025-06-23 18:00:50 2025-06-23 18:30:50 m Unlacked A [}

BRI as 2 2025-06-23 18:20:50 2025-06-23 19:00:50 = Unlocked 4, 1]
2025-06-23 19:00:50 2025-06-23 19:30:50 m Locked &,
2025-06-23 19:30:50 2025-06-23 20:00:50 = Unlocked A, 1]
2025-06-23 20:00:50 2025-06-23 20:30:50 ® Unlocked oy 1]
2025-06-23 20:30:50 2025-06-23 21:00:50 ® Unlocked oy il
2025-06-23 21:00:50 2025-06-23 21:30:50 = Unlocked g (]

® Click [» to play the backup recording.

® Click to download the backup recording to local.

|L|

* Click ) to lock the backup recording. Click again to unlock. When locked, others cannot perform any
operations on the backup recording.

* Click Tii] to delete the backup recording from the storage resource.

9.2.3 Recording Download
Download recordings to local.

Note:
Supported recording download formats: ts, mp4. To set the format, go to Media Config > Recording.

Recording Download

1. Right-click the camera on the camera list and then select Recording Download.
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@) 17220 T

Start Live View

e) 172.2

o Start Playback
Search Backup Recording
Start Broadcast
Start Two-way Audio
Trigger Emergency Event

View Details

Recording Backup

Recording Download

Live View on Videa Wall
Add to Favorites

Edit Name

2. Specify a recording time period for downloading in the pop-up window, and set other parameters as needed.

Figure 9-14: Recording Download

Recording Download X

* Start Time: 2024-10-28 00:00:00 =
* End Time: 2024-10-28 09:54:22 E
Storage Location: Central Recording

Domain: Search Cloud

Recording Type: All Recordings

Download Speed: Ay

Download Start Time:| Select date H (@

=] | S

Cancel m
@ Note:

To schedule downloads during idle periods, you can set a start time for the download. The system will
begin downloading at the specified time. Ensure the client is logged in at the set start time.

3. Click OK. For non-delayed tasks, the task starts immediately.
4. Click ., in the upper-right corner to enter the Recording Download Task List page.

¢ Download task list: You can view details of ongoing recording download tasks such as the progress and
status. Up to 2 tasks are allowed simultaneously. You can also click ] to delete the task.

¢ Delayed task list: You can view details of the delayed recording download tasks such as the download start
time. You can also click [ii] to delete the task.
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Figure 9-15: Recording Download Task List

Recording Download Task List o

Download Task List ~ Delayed Task List

Tl Delete *Operations such as logout, refresh or closing the page may interrupt the download.Up to 2 cameras allowed.

< |

Camera Name Search Time Progress Status Action

a

201_1 2024-10-28 00:00:00-2024-10-28 09:54:22 " 1% Downloading

Total 1 items | 1 |

9.3 Video Wall

Go to Video Application > Video Wall.

You can create video wall layout on the client and bind video output channels of decoders to play video images
on a physical video wall.

e DC video wall: The video wall can only be bound to output channels of one decoder or video wall controller.
Playing live videos/recordings, local input, camera sequence, scene resources, and overlaying virtual LED are
supported.

e Multi-DC video wall: The video wall can be bound to output channels of more than one decoder or video wall
controller. Playing live videos/recordings and camera sequence are supported.

Workflow
1. Add decoders and video wall controllers. See Device Management > Decoder & Video Wall Controller.

2. Add videos and play videos on wall. See DX Video Wall and Multi-DC Video Wall.

9.3.1 DX Video Wall

Add a video wall and configure video resources to be played on it. The video wall can only be bound to output
channels of one decoder or video wall controller.

@ Note:

You need to first add decoders and video wall controllers in Device Management.

Add Video Wall

1. If no video wall has been created in the system, click to create a video wall; otherwise, click

. on the top of the right-side pane to add a video wall. Choose DX Video Wall.
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Figure 9-16: With Existing Video Wall

Camera v VideoWall - adas +

Screen C

o B & B &H | I B Window Auto Alignment

Stream Type

a P

coogoogtodttecdtflosde;

Close Window

2. Set the video wall name, size, organization, output format, etc.

Figure 9-17: Create Video Wall

Output Channel

m concel

¢ Video Wall Size: Number of video wall panels. After setting the video wall size, the panel below can show
the effect.

e Small Pixel Pitch LED: If the physical video wall consists of small pixel pitch LED displays, click Small Pixel
Pitch LED and then complete the settings.
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Figure 9-18: Small Pixel Pitch LED

Row: 2

Colummn: 2

(] Small pitch LED
LED Width: |0
LED Hight: |0
Special LED

width: 0

Special LED
high: 0

e OQutput Format: First select the decoders and video wall controllers in the output channel, then select the
output format.

e Output Positioning: When turned on, the actual channel name (in the format of "Device IP_Channel
Type_Channel Serial Number") will be displayed on the large physical screen, which is convenient for you
to configure the video wall intuitively.

3. Drag the unused channels from the left-side list to the right-side windows one by one.

@ Note:
Bind all channels with one-click: Select the video wall controller device on the left-side list, and then click

m in the lower-left corner. The idle channels of the device will be bound automatically to the video wall

windows. If some windows already have bound channels, the current bindings will be cleared. Click m
to delete all bindings.

4. Click OK. The video wall is created.

Note:
You can click the arrow right to the video wall name to edit, close, or delete the video wall.
Window Operations

¢ Open window: Drag a camera or sequence resource from the left-side tree to the video wall to open a
window; or drag with the right button on the video wall to open a window; or click EI on the toolbar to
open multiple windows.

® Close window: Click m in the window’s upper-right corner or click Close Window on the toolbar to close a
window; or click on the toolbar to close all windows.

* You can drag a window to move it, and drag the window border to resize the window.

Table 9-7: Other Toolbar Operations

Icon Description

Refresh the page.

Save the current video wall layout and video service (such as live video, sequence) as a
scene.
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Description

Audio control. Choose output audio to play in the channel.

Open windows with one-click. Set the number of rows and columns to open windows
for the entire video wall or to split windows for the selected window.

Open Windows X

B 29 36 64

1 4 9 16 25 36 B4

custom: 2 Fow X 2 Column

Open on Wall Open in Window Cancel

Open windows by setting coordinates, width, and height.

E> Note: This function is available when auto-alignment is disabled.
Open Window by Coordinates X

* Start Coordinatex:
* Start Coordinatey:
* Width:

* Height:

Close the window.

Close all windows.

Lock/unlock all windows. The position and shape of the locked windows cannot be
changed.

Enable/disable whether smart tripwires are displayed on the video screen.

Renumber all the windows according to their position (from top to bottom, left to
right). The window IDs after renumbering are displayed in the window’s upper-left
corner.

When selected, the new window automatically aligns with a grid line.

Choose a window layout: 1/2/3/4/5/6/7/8/9/10/13/16 windows.

Stop the video in the window.

Adjust sound volume in the selected window.

Start/stop live video in the selected window.
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Description

Set a window to display at the bottom of multiple overlapping windows.

Lock/unlock a window. The position and shape of a locked window cannot be changed.

e If the window is not split, clicking the button magnifies the window to the full size
of the video wall.

e If the window is split into multiple windows, clicking the button magnifies the split
window to the full size of the whole window.

Enable/disable alarm linkage for the window.
Click to enable/disable alarm linkage for the selected window. When alarm linkage is

enabled, the icon appears in the window's lower-right corner, and the window
starts to play live video when an alarm occurs. Click again to disable alarm linkage.

[E> Note: You need to configure alarm-triggered live video for the video wall on the
configuration platform first.

Recording

Switch live view to playback for the selected window, and then set search criteria as
shown below to search for the desired recording.

Close Window

Close the selected window.

Play Video Resources on Video Wall

Table 9-8: Play Different Video Resources on Video Wall

Resource Operation

Camera ¢ Play live video on video wall: Drag a camera to a video wall window; or click a window,
right-click the camera, choose Live View on Video Wall > Main Stream/Sub Stream/Auto
to start live video in the window.

e Playback on video wall: To play recordings of a camera in a video wall window, click the
window, right-click the camera and then choose Playback. In the pop-up window, set
search parameters and then click OK.

e Preview live video: Right-click a camera and choose Live Preview to view the live video of
the camera.

e Play on Screen: Select a window, select a camera, click #5, and select a stream type to
play it in the selected window.

e Play in Screen: Select a window, select multiple cameras, click 7/, and select a stream
type to play them in the selected window and subsequent windows.

Local Input Click a window, right-click the local input channel and choose Start to start the local input
resource on the video wall.

Camera Play live videos of cameras in one window in sequence.

Sequence

Add: Click 4 above the camera sequence list to add multiple cameras to a camera
sequence group.
E> Note:

e Stay Time: Set the time duration for each camera’s live video.

e Stream Type: Choose from Auto-Adaptation (determined by Auto-Switch to Sub
Stream setting in Media Configuration), Main Stream, Sub Stream, and Third
Stream.

® Display Order: Drag for a camera to adjust its display order.
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Resource Operation
* Camera Sequence Resource Name:  Enter uppercase or lowercase letters, digits: up to 80 character
Camera List Selected Cameras Delete
B Stay Stream .
Y 1001 ~ Camera Name Time(s) Type Operation
- 1781
\'_‘ fakeGE @ nvr_1 10 Auto
- nvrl
.; nvr_10
; nvr_11 nvr_10 10 Auto
Y nvr 2
o nvr_3
g nvrd
g nvr s
o nvi_b
o nvr 7 ~
Stay Time: 108 Stream Type:  Auto Organization :  plesee aniar
Cancel
e Start: Drag a camera sequence resource to a window to start camera sequence.
® Pause/Resume: Select a camera sequence window and click m to pause the camera
sequence (the ongoing live video on the video wall will still retain); click u to resume
the camera sequence (switch to the next camera's live video later than).
e Previous/Next: Select a camera sequence window, click [SIEJ on the toolbar to switch
to the previous or the next camera in the camera sequence group.
e Edit/Delete: Right-click on a camera sequence resource and select Edit/Delete.
Scene e Save: Right-click and then choose Save Scene to save the current video wall layout and

video service (such as live video, sequence) as a scene.
Start: Right-click on a scene and select Start Scene.

E> Note:
If there is an active group sequence (plan) on DX video wall, you need to stop the
group sequence (plan) before starting a scene.
Once a scene is started, the existing services on the video wall will be overwritten.

Rename: Right-click on a scene and select Change Name.

Scene Sequence

Cycle through multiple scenes on the video wall.

Add: Click 4 above the scene sequence list to add multiple scenes to a scene group.
E> Note:
¢ Time Interval: Set the time duration to switch to the next scene.

e Display Order: Select a scene and use the arrows above the list to adjust its
display order.
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Resource

Operation

Add Scene Group X

Scene Group Name: | Please ente

Scene List:

Scene Name Scene ID

scenel

scene2

sceneld

scened

scenes

sceneb

scene’l

scenad

Selected Scenes:

No.

1

2

Time Interval:

30

»

TT484W
Scene Name Time Interval
scenel 30
scene2 30

Cancel confirm

e Start: Right-click on a scene sequence resource and select Enable. A message "Scene
sequence is in progress." will display, indicating the successful operation.

E> Note:

If there is an active group sequence (plan) on DX video wall, you need to stop the
group sequence (plan) before starting a scene sequence.

Once a scene sequence is started, the existing services on the video wall will be

overwritten.

Scene sequence is in progress.

Scene seguence is in progress. SceneGroup:

1. scene’l

e Stop: Click Disable in the pop-up window to stop the scene sequence. The current scene
will remain displayed on the video wall, and the system will no longer switch to other

scenes.

¢ Modify/Delete: Right-click on a scene sequence resource and select Modify/Delete.

Group Sequence
on DX Video
Wall

Play live videos of multiple cameras in multiple video wall windows.

E> Note:

e If the number of cameras is less than or equal to the number of windows, their
positions remain fixed and are unaffected by the stay time.

¢ If the number of cameras exceeds the number of windows, the cameras will cycle
through the windows based on the stay time. For example, there are 4 windows in
the scene and 5 cameras in the group sequence group, the cameras will cycle through
the windows as follows: 1234, 5123, 4512, ...

a group sequence group.

Add: Click 4+ above the group sequence on DX video wall list to add multiple cameras to
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Resource

Operation

E> Note:

Add Group Sequence X

Group Sequence on DX Video Wall

Startup Mode: Non-preemption mode-The group sequence will not replace the
current video services at startup. Preemption mode-The group sequence will
replace the current video services at startup.

Stay Time: Set the time duration to switch to the next screen.

Select Video Wall: Select a video wall’s scene (scene determines the video wall’s
window layout; hover the mouse over a scene to preview its layout).

* Group Sequ.. * Stariup Mod... @) Non-Preemption Mode

# Stay Time: 10 @ * Select Video...

Camera List

Start: Right-click on a group sequence on DX video wall resource and select Enable.

E Note:
Only one group sequence is allowed at a time.

Once started successfully, the following operations are allowed:

* Previous/Next Screen: If the number of cameras in the group sequence group exceeds
the number of windows, the cameras will be divided into multiple groups as screens
for playing. You can right-click on a resource and select Previous Screen/Next Screen

to switch the camera group.

¢ Pause/Resume: Right-click on a group sequence resource and select Pause to retain
the current camera group on the video wall; select Resume to resume cycling.

e Stop: Right-click on a group sequence resource and select Stop to stop the current
video service.

Modify/Delete: Right-click on a group sequence resource select Modify/Delete.

Preemption Mode

Selected Cameras [i] Delete

Stream
Camera Name T Operation
Yo 1001 1 ype

o 1781

ey fakecs 100_1 Auto
- r_1

o W10 @

o et 1781 Auto
T nvT_2

Yo nvr_3

Yo mvr_4

Yo Vi3

Y V6

T V7

Group Sequence
Plan on DX
Video Wall

Set the play time for each group sequence resource on DX video wall to cycle through them.
Add: Click 4+ above the group sequence plan on DX video wall list.

&> Note:

Video Wall: Select a video wall to add its group sequence resources to the plan.

Period: By Day-Set time periods for each resource within a day; By Week-Set time
periods for each resource on each day of the week.

Enable Exception: If needed, for special dates, specify custom time periods for
resources.
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Resource Operation

Add Group Sequence Schedule x

# Schedule Mam Enter schedule name

* Video wall: Select video wa v
Time Period: By Day V
No Start Time End Time Eoiipientsne Operation
Resource
1 000000 @ 235959 O | Selectres. v [ save JORE

Enable Exception

Exception1 2025-06-24

Group Sequence
Resource

No Start Time End Time Operation

m Ca nce'

e Start: Right-click on a plan and select Enable. The corresponding group sequence will
automatically play at the set time.

E> Note:
Only one plan is allowed at a time.

e Stop: Right-click on a plan and select Stop. The plan and the group sequence service will
stop.

¢ Modify/Delete: Right-click on a plan and select Modify/Delete.

Configure Virtual LED

You can configure virtual LEDs to display custom contents on the video wall.
1. Open the Virtual LED page by clicking Virtual LED at the bottom.

2. Drag on the video wall using the right button to draw a virtual LED; or click -+ on the Virtual LED toolbar.

3. Inthe Virtual LED window, set the position, size, contents (Customize text or time), style and scroll mode, and
then click OK.
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Figure 9-19: Configure Virtual LED
Wirtual LED

Enabled: enable

start Coordinates: X 0 hi 0

Size: Width | 1920 Height 540

LED Contents: ©
o

Text Font: Sirn Sun

Text Size: Auto-Adaptation

Font Spacing: 1%

Alignment: Align Center Align Center

Background Color: I:l Font Color: _

Transparency: (@ Opague Transparent

Scroll Type: Mot Rolling

Mowving Speed:

Canfirm

@ Note:

e Avideo wall allows one scrolling virtual LED and 16 static virtual LEDs.
e If multiple virtual LEDs are configured, their positions must not overlap.
4. The virtual LED appears on the video wall.
Figure 9-20: A Virtual LED Example

Welcome

¥ Automatic window alignment
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Table 9-9: Virtual LED Operations

Function

Description

a virtual LED

Adjust the position/size of

Drag the virtual LED to move it, or drag its border to resize it.

LED

Enable/disable a virtual

® Click D/E in its upper-right corner to enable/disable the virtual LED.

® Hover over the name below Virtual LED on the toolbar, and then click D/E
to enable or disable the virtual LED.

* Click []/E in the toolbar to enable/disable all virtual LEDs.

Edit Virtual LED

Click [Zd in the upper-right corner; or select the virtual LED, and then click [ on
the virtual LED toolbar.

Delete a virtual

LED

* Click in the upper-right corner; or select the virtual LED, and then click @
on the virtual LED toolbar.

* Click @ in the toolbar to delete all virtual LEDs.

Screen Control

Screen control is used to manage serial ports to turn on/off video wall screens.

Figure 9-21: Screen Control

| Turn OnyOff Sereen Automatically:

Turn On At

Turn Off At

Delay Turn Off Screen:

Turn OffIn Minute

1. Go to DX Video Wall > Screen Control.

2. Configure the parameters by referring to the table below.

Table 9-10: Parameter Descriptions for Screen Control

Category | Parameter Description
Serial Port | Serial port Port type. Choose COM1 or COM2.
Protocol Serial port protocol. Choose LIA, LIA-A or MODBUS.
Turn Turn On Screen | Turn on all the screens on the video wall.
?cr;/eg;f Turn Off Screen | Turn off all the screens on the video wall.

[ Note: If you set to turn off screens with a delay, the screens will turn off
automatically when the set time is over.

Turn On At

When enabled, the screens will turn on automatically at the set time.

[® Note: If the set time is earlier than the current time, the task will be
performed at the set time on the following day.
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Category | Parameter Description

Turn Off At When enabled, the screens will turn off automatically at the set time.

[® Note: If the set time is earlier than the current time, the task will be
performed at the set time on the following day.

Turn Off Select the checkbox, and then input the countdown (unit: minute). Click Turn
Screens with Off Screen. The screens will turn off at the end of the set time.
Delay

[® Note: Clicking Turn On Screen will cancel the configured delayed
shutdown.

9.3.2 Multi-DC Video Wall

Add a video wall and configure video resources to be played on it. The video wall can be bound to output
channels of more than one decoder or video wall controller.

@ Note: You need to first add video wall controllers in Device Management and configure camera sequence
resource.

Add Video Wall

1. |f no video wall has been created in the system, click | =SS to create a video wall; otherwise, click

on the top of the right-side pane to add a video wall. Choose Multi-DC Video Wall.

Figure 9-22: With Existing Video Wall

MultipleWall

i
k

OO OC ;&

Window

2. Set the video wall name, size, organization, output format. The configured video wall appears in the pane
below.
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Figure 9-23: Add Video Wall

Jame: Video Wall Size: 5 v |2 Organizatior ocal Domain

Qutput Fermat

Qutput Channel
- /.\ ocal Domain

m ganes

3. Drag the unused channels from the left-side list to the right-side windows one by one. A video wall can be
created with channels of different video wall controllers.

Note:
Bind all channels with one-click: Select a video wall controller device on the left-side list, and then click

E in the lower-left corner. The idle channels of the device will be bound automatically to the video wall

windows. If some windows already have bound channels, the current bindings will be cleared. Click

to delete all bindings.

4. Click OK. The video wall is created.

@ Note:

You can click the arrow right to the video wall name to edit, close, or delete the video wall.

Window Operations

e Open window: Drag a camera or sequence resource from the left-side tree to the video wall to open a
window; or drag with the right button on the video wall to open a window.

® Close a window: Click in the window’s upper-right corner or click Close Window on the toolbar to close
the window.

Table 9-11: Other Toolbar Operations

Description

Refresh the page.

Save the current video wall layout and video service (such as live video, sequence) as a
scene.

Choose a window layout: 1/2/3/4/5/6/7/8/9/10/13/16 windows.

Stop the video in the window.

Adjust sound volume in the selected window.
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Icon Description

M Start/stop live video in the selected window.

E/ '_i\ Lock/unlock a window. The position and shape of a locked window cannot be changed.

Enable/disable alarm linkage for the window.
Click to enable/disable alarm linkage for the selected window. When enabled, the

icon appears in the window's bottom-right corner, and live video from the linked

camera will play in the window when an alarm occurs. To disable alarm linkage, click
the icon again.

[E> Note: You need to configure alarm-triggered live video for the video wall on the
configuration platform first.

Recording Switch live view to playback for the selected window, and then set search criteria as
shown below to search for the desired recording.

Close Window Close the selected window.

Play Video Resources on Video Wall

Table 9-12: Play Different Video Resources on Video Wall

Resource Operation

Camera e Play live video on video wall: Drag a camera to a video wall window; or click a
window, right-click the camera, choose Live View on Video Wall > Main Stream/
Sub Stream/Auto to start live video in the window.

e Playback on video wall: To play recordings of a camera in a video wall window,
click the window, right-click the camera and then choose Playback. In the pop-up
window, set search parameters and then click OK.

e Preview live video: Right-click a camera and choose Live Preview to view the live
video of the camera.

Camera sequence Drag a camera sequence resource to a window to start camera sequence.

Screen Control
Screen control is used to manage serial ports to turn on/off video wall screens.

Figure 9-24: Screen Control

=)
BHS

Video Wal | B

| Turn On/Off Sereen Automatically:

Turn On At

Turn Off At

Delay Turn Off Screen:

Turn OffIn Minute

1. Go to Multi-DC Video Wall > Screen Control.

2. Configure the parameters by referring to the table below.
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Table 9-13: Parameter Descriptions for Screen Control

Category Parameter Description
Serial Port | Serial port Port type. Choose COM1 or COM2.
Protocol Serial port protocol. Choose LIA, LIA-A or MODBUS.

Turn On/Off
Screen

Turn On Screen

Turn on all the screens on the video wall.

Turn Off Screen

Turn off all the screens on the video wall.

[ Note: If you set to turn off screens with a delay, the screens will turn
off automatically when the set time is over.

Turn On At When enabled, the screens will turn on automatically at the set time.
[E> Note: If the set time is earlier than the current time, the task will be
performed at the set time on the following day.
Turn Off At When enabled, the screens will turn off automatically at the set time.

[® Note: If the set time is earlier than the current time, the task will be
performed at the set time on the following day.

Turn Off Screens
with Delay

Select the checkbox, and then input the countdown (unit: minute). Click
Turn Off Screen. The screens will turn off at the end of the set time.

[® Note: Clicking Turn On Screen will cancel the configured delayed
shutdown.

9.4 Smart Live View

View live videos and snapshots of Face Recognition, Vehicle Application, Multi-Target Detection, People Counting,
Door Access Control.

9.4.1 Smart Live View

Go to Video Application > Smart Live View > Smart Live View.

Allows users to view live videos of video channels under smart IPCs and NVRs, as well as access control devices.
The real-time snapshot data and alarms (face match records, vehicle match records, and person/motor vehicle/
non-motor vehicle data from multi-target detection) are displayed when playing smart live view.

Prerequisite

e Smart IPC/NVR have been added to the platform. See Device Management > Frontend Device.

e Face recognition/vehicle recognition/people counting/multi-target detection function have been enabled on

the device.

¢ Face Monitoring and Vehicle Monitoring tasks have been configured.

Play Live View

Double-click on a camera in the channel list to view the live view of the camera in a window.

@ Note:

® Up to 4 cameras' live view can be displayed at the same time. You can click - in the lower-left corner to
switch to 1/3/4 windows.

¢ To perform operations on the live view, see Live View Toolbar.

e Face comparison records, vehicle comparison records, and the multi-target detection results can be
reported after the Live View started.
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Data Display

The face comparison records, vehicle comparison records, person/motor vehicle/non-motor vehicle information
from multi-target detection are displayed on the right side. You can select the target type from the drop-down list
to filter data.

@ Note:

You can customize the attributes displayed on the card as needed. See Card Attribute.

Click Details in the lower-right corner of the snapshot to view more details.

9.4.2 Face Recognition

Go to Video Application > Smart Live View > Face Recognition.

You can view live videos of video channels under smart IPCs and NVRs, face recognition data reported by devices,
face match/not match alarms, important person alarms, real-time passing persons, and abnormal persons.
Prerequisites

e Smart IPC/NVR have been added to the platform. See Device Management > Frontend Device> Private Device.
¢ Face recognition function has been enabled on the device.

e Face Monitoring task has been configured.
On the Smart Live View page, click ~ and select Face Recognition.

Play Live View

Double-click on a camera in the channel list to view the live video of the camera in a window.

@ Note:

® Up to 4 cameras’ live videos can be displayed at the same time. You can click in the lower-left corner
to switch to 1/3/4-window.

¢ To perform operations on the live view, see Live View Toolbar.
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The real-time face snapshots are displayed under the live view window.

16:12:01 16:11:32 16:10:00)

Snapshots Records

¢ Click a snapshot to view more details.

Snapshot Snapshot Info

24-08-08 16:24:39

Add to Face Library

Cancel

® For a stranger's snapshot, hover the mouse over the snapshot and click -} to add the stranger to Face
Library.

e Click More to redirect to the page and search the snapshots by attributes.

Alarm Records

The real-time face comparison records are displayed on the right side. You can select criteria from the drop-down
list to filter match/not match alarms.

¢ Click Details to view more details.
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Details

Snapshot Match Alarm Info

7 -

® For a stranger's snapshot, hover the mouse over the snapshot and click -} to add the stranger to Face
Library.

* Click [F in the upper-right corner to redirect to the Face Search page and search the snapshots by events.

Related Operation

You can customize the attributes displayed on the snapshot record and alarm record cards as needed. See Card
Attribute.

9.4.3 Vehicle Application

Go to Video Application > Smart Live View > Vehicle Application.

You can view live videos of video channels under smart IPCs and NVRs, vehicle recognition data and speeding
alarms reported by devices, match/not match alarms by monitoring task, real-time passing vehicles and
abnormal vehicles, as well as open gate manually.

Prerequisite
¢ Smart IPC/NVR have been added to the platform. See Device Management > Private Device.

¢ Vehicle recognition function has been enabled on the device.

e The pre-registered vehicle list and forbidden vehicle list have been configured. See Parking Mgt-Vehicle
Management.

¢ Speeding rules have been configured for speeding alarms. See details in Configure Alarm Rules.
On the Smart Live View page, click ~ and select Vehicle Application.

Play Live View

Double-click on a camera in the channel list to view the live video of the camera in a window.

@ Note:

® Up to camera's live videos can be displayed simultaneously. You can click - in the lower-left corner to
switch to 1/3/4 windows.

¢ To perform operations on the live view, see Live View Toolbar.

* To manually open/close the gate, click on the toolbar, or right-click the camera to select Open Gate
/ Close Gate.
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Vehicle Application Comparison

NO VIDEO Match % +2

No matches.

NO VIDEO NO VIDEO

12223
® 16:44:40

WA13345
Unknown V...
11223
© 164429

WAi3345

Snapshots Records
The real-time vehicle snapshots and vehicle plate images are displayed under the live view window.

¢ Click a snapshot to view more details.
Details X

Snapshot Info

Snapshot

Add to Vehicle Library

Previous Cancel

For an unknown vehicle's snapshot, hover the mouse on the snapshot and click 4 to add the unknown
vehicle to the Vehicle Library.

* Click [F in the upper-right corner to redirect to the Motor Vehicle Search page and search the snapshots by
attributes.
Alarm Records

The real-time vehicle comparison records are displayed on the right side. You can select criteria from the drop-
down list to filter match/not match alarms and speeding alarms.

¢ Click a comparison record to view more details.
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Details X

Snapshot Not Match Alarm Info

Add to Vehicle Library

Previous Cancel

For an unknown vehicle's snapshot, hover the mouse on the snapshot and click 4 to add the unknown
vehicle to the Vehicle Library.

¢ Click More to redirect to the Motor Vehicle Search page and search the snapshots by events or by violation.

Related Operation

You can customize the attributes displayed on the snapshot record and alarm record cards as needed. See Card
Attribute.

9.4.4 Multi-Target Detection

Go to Video Application > Smart Live View > Multi-Target Detection.

View the live videos of the video channels under the smart IPC/NVR and the motor vehicle/non-motor vehicle/
pedestrian/face recognition data reported by the device.

Prerequisite
e Smart IPC/NVR have been added to the platform. See Device Management > Private Device.

e Multi-target detection function has been enabled on the device.
On the Smart Live View page, click ~ and select Multi-Target Detection.

Play Live Video

Double-click on a camera in the channel list to view the live video of the camera in a window.

@ Note:

® Upto 4 live video windows can be displayed at the same time, you can click - in the bottom left corner
to switch to 1/3/4 windows.

¢ To perform operations on the live view, see Live View Toolbar.
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Snapshots Records

The latest pedestrian/motor vehicle/non-motor vehicle snapshots are displayed below the live view window. The
latest face snapshots are displayed on the right side.

@ Note:

You can customize the attributes displayed on the card as needed. See Card Attribute.

Click a snapshot, or click Details in the lower-right corner to view more details.

9.5 Media Configuration

Go to Video Application > Media Config.

Configure live, playback stream, snapshot, recording and PTZ parameters.

@ Note:

e B/S media configuration is globally effective, while C/S media configuration is effective only on the
current login PC.

e B/S and C/S media configurations do not affect each other; i.e., B/S configuration affects only B/S
services, not C/S services.
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9.5.1 Video

Video Application > Media Config > Video: Configure live and playback stream parameters.

| Video Parameters

Stream Service Selection Policy Adaptive
Stream Transmission Protocol Adaptive
Playback/Download Service Policy Adaptive

Recording Playback Transmission Protacol TCP
Auto-Switch to Sub Stream - 6 (1) When the number of windows exceeds the set value, the main stream automatically switches to the sub stream, Valid window range: 1-64.
Packets Reordering
Anti Packet Loss
GPU Decoding

| Intelligent Mark
Intelligent Mark

| Playback Preview

Playback Preview

@
@
m Restore

Parameter Description

Stream Service For live view streams:

Selection Policy ¢ Adaptive: The system selects the appropriate stream selection policy based on the

actual network conditions and server's forwarding capacity.

¢ Direct Connection Priority: Streams from encoders are preferably sent directly to
the client without passing through the server, reducing the server's forwarding
load.

Stream Transmission For live view streams:

Protocol ¢ When the Stream Service Selection Policy is set to Adaptive, then the Stream

Transmission Protocol must also be set to Adaptive. The system will select the
appropriate transmission protocol based on the network conditions and the
encoder's configuration.

e When the Stream Service Selection Policy is set to Direction Connection Priority,
then the Stream Transmission Protocol can be set either TCP or Follow Device.

e TCP: (the encoder's transmission protocol must be set to TCP) Offers better
video smoothness but may have some delay. It is recommended to choose it in
poor network conditions to ensure the complete reception of streams.

¢ Follow Device: Uses the same transmission protocol as the encoder.

Playback/Download For playback/download streams:

Service Policy e Adaptive: The system selects the appropriate service policy based on the actual

network conditions and server's forwarding capacity.

¢ Direct Connection Priority: Streams are sent directly to the client without passing
through the server, reducing the server's forwarding load.

Recording Playback For playback streams:

Transmission Protocol | TCP: Offers better video smoothness but may have some delay. It is recommended

to choose it in poor network conditions to ensure the complete reception of
streams.

e UDP: Offers better real-time performance but may result in frame loss.
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Parameter

Description

Auto-Switch to Sub
Stream

When the number of windows exceeds the set value, the main stream automatically
switches to the sub stream. Valid range: 1-64.

Packets Reordering

When enabled, the system will automatically detect and reorder any out-of-order
streams. Generally, reordering improves the image quality and smoothness, though
there might be a slight delay.

Anti Packet Loss

Packet loss can affect audio and video quality. If you encounter issues such as image
stuttering in live videos, we recommend enabling this function, though there might be
a slight delay.

GPU Decoding

When enabled, live videos and recordings are decoded using the GPU of the current
login PC, which reduces CPU load and improves the number of decoding channels and
video smoothness.

[ Note:

e The PC must be configured with an Intel or NVIDIA graphics card; AMD
graphics card is currently not supported.

¢ Enabling both GPU decoding and intelligent mark simultaneously may affect
the overlay of intelligent marks on live video.

Intelligent Mark

When enabled, the target detection box(es) of intelligent detection will be overlaid on
the live video.

[ Note:

The camera side needs to enable perimeter defense, mixed traffic detection, face
recognition, and vehicle recognition functions.

Playback Preview

When enabled, you can preview the playback thumbnail on the recording playback
timeline.

9.5.2 Snapshot

Video Application > Media Config > Snapshot : Configure the snapshot mode and parameters.

| Snapshot Parameters

Continuous Snapshot Interval 1 Second

Continuous Snapshots

Snapshot Format

3 snapshot(s)

® JPG PNG

Parameter

Description

Continuous Snapshot
Interval

Time interval between two snapshots.

Continuous Snapshots

Number of snapshots to take every time.

Snapshot Format

Set the format of snapshots, JPG or PNG
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9.5.3 Recording

Video Application > Media Config > Recording : Configure recording format (ts or mp4).

| Local Recording
Local Recording Format ts
| Downloaded Recoding

Downloaded Recording Format ~ ts

9.5.4 PTZ

System Config> Media Service Config > PTZ Mgt : Configure PTZ control parameters.

PTZ Release Configuration

PTZ Release Time(s): 300

Confirm

Preemption Policy Configuration
PTZ Services: Last-Come First-Served
Confirm

e PTZ release time: When the PTZ without being operated for a specified release time and enters the
idle status, any user can control it without preemption, and the originally locked PTZ will be unlocked
automatically.

e Preemption policy configuration: When multiple users attempt to operate the same PTZ simultaneously, the
system determines the preemption strategy based on user priority and the order of operations.

10 Room Management

Go to Basic Config > Community Mgt.

Manage the information of rooms and residents in the community. By establishing a community information file,
you can quickly learn about the rooms and residents in the community and improve the efficiency of community
management.
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Community Mgt

Phase

v
Building

~7

Unit

=7
Room

Owner %

Family Member

Tenant &:}

Community Room Management: Add phases/buildings/units/rooms to the community according to the actual
occupancy situation. You can also edit or delete community information here.

Resident Management: Associate residents with rooms based on their occupancy status (owner/family
member/tenant).

10.1 Community Room Management

Add phases/buildings/units/rooms to the community according to the actual occupancy situation. You can also
edit or delete community information here.

Go to Basic Config > Room Mgt.
Community -+ Add

Q Please enter keywords

No data

v

No rooms

Add Now

10.1.1 Add Room

1. Click Add Now. A page as shown below appears.
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Add X

Phase 1

2. Enter the community name, phase(1-20), phase name, building number range (1-99), units per building
(1-99), floors above ground (1-99), underground floors (0-99) and rooms per floor (1-99).

@ Note: Up to 5000 rooms can be added in total.
3. Click OK.

10.1.2 Manage Room

View the added rooms in the room list.

Batch Add - |Tuta\ Phases: 1 Total Buildings: 5 Total Units: 5 Total Rooms: 25 Total Residents: 3| Community Room Statistics
Community [nied Total Rooms: § Total Residents: 3| Room Statistics Selected Range
Room T f @ Add Resident ;1 Add from Personnel
P RobertOwner V4 MaryFamily Me... 2 ThomasTenant V4

Male Male Male
it +2m 3F-301 o Bo 0o EHo 0o Ho
2 AddEditDelete

No Image No Image No Image

2026/10/31

e Community room statistics: View the total number of phases, buildings, units, rooms, and residents in the
community.

e Room statistics in selected range: View the total number of rooms and residents within the selected phase/
building/unit.

e Edit name: Hover the mouse over a community/phase/building/unit/room name, and click ./ to edit the
name.

Add phase: Hover the mouse over a community and click <+ to add a phase and its subordinate level within
the community.

Add building: Hover the mouse over a phase and click -+ to add a building and its subordinate level within
the phase.

Add unit: Hover the mouse over a building and click -+ to add a unit and its subordinate level within the
building.

Add room: Hover the mouse over a unit and click + to add a floor and a room within the unit.
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¢ Delete community/phase/building/unit: Hover the mouse over a community/phase/building/unit and click
to delete it.

e Delete room: Select room(s), click [7] , and then confirm to delete the selected room(s).
Note:

Deleting a room will remove the room information of personnel associated with it, but it will not delete the

personnel themselves.

10.2 Resident Management

Associate residents with rooms based on their occupancy status (owner/family member/tenant).

@ Note:

e Each room can be associated with up to 10 residents, with only one resident can be specified as the
owner.

e A person can be associated with multiple rooms (no upper limit) and can be an owner, a family member,
or a tenant in different rooms simultaneously. However, a resident cannot be associated with a room

using different identities.

You can add residents using any of the following 3 methods.

[+) Batch Add |~ Total Phases: 1 Total Buildings: 5 Total Units: 10 Total Rooms: 60 Total Residents: 3

e Import Residents Unit 1 Total Rooms: 6 Total Residents: 3
Import Image -
P K Room =+ {21 Add Resident ‘ /. Add from Personnel
Export Template Please enter keywords
F-101
Building 1 1m0

10.2.1 Add Manually

You can enroll resident information, including identity information, room information, face image, vehicle
information, and card.

1. Select a room and click Add Resident. A page as shown below appears.

Resident Info .
* Name

Face Image
Mobile Phone
Vehicle Info
Card Email Address
Gender (®) Male Female Unknown

D Card Mumber | Passport v

I Room Information

-+ Add
* Room 1 IR 1= -
* Resident Type Owner o
X Cimrt Madn INIS AT 14 =

Cancel

2. Complete the resident information.
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Item Description

Identity Info Name (required), mobile phone number, email address, ID number (choose the ID
type from the list, and then input the ID number), and gender.

Room Info e Room: Select a specific room.
¢ Resident type: Owner, family member, and tenant.
e Start date: Cannot be earlier than the current time.

e Expiration date: Cannot be earlier than the start date. Required for tenants;
optional for owners and family members. No expiration date selected means
permanently valid.

If the resident has multiple rooms, you can click Add to add more room information.

3. (Optional) Upload the resident's face images.

@ Note:

Image verification is enabled by default. To disable it, see Face Image Verification.

Click Add Photo. Choose a way to add photos:

Face Image

¢ Upload: Select a photo of the person from the PC and upload it.

¢ Take a photo: Select a camera to view its real-time screen on the PC. Click Take a Photo to capture the
current frame. Click OK to save the photo, or click Retry to take another one.

Take a Photo

Camera HIK 2K Camera

Take 2 Photo

[ Note:
¢ Please first enable HTTPS and log in via the HTTPS protocol before taking photos.

e The camera device supports USB cameras and the built-in camera of the computer. If you are using
a USB camera, connect it to the PC in advance.

* Remote collection: Select a face recognition access control device and click Remote Collection. After
the device completes face collection, you can check the collected photo on the client. Click Re-Collect if
necessary, or click OK to complete the collection.
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Remote Collection

2716 k. 244

Collection Device

Remote Collection

@ Note:

Only some access control devices support remote collection.

4. (Optional) Add the person's vehicle information. Up to 6 vehicles are allowed per person.

(1) On the Vehicle Info tab, click Add.
I Vehicle Info
+ Add

Vehicle1

(2) Enter the license plate number and select a validity period.
@ Note:
Vehicles added/edited/deleted here will be automatically synced to Parking Mgt > Authorized Vehicle.
To sync vehicles to devices, see operations in Vehicle Data Sync. Only vehicles within the validity

period can access the gates at the entrance and exit.

5. (Optional) Add card information.
(1) Go to the Card tab.

Card Information

+ Add (1) Start ¢ Configure Card E--

=

cation Commen Card

@ This field is required

(2) Click Configure Card Enrollment, and configure parameters as needed. (It only needs to be configured
once and card information can be then read for multiple people.)
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card.

Read Description
Mode
Local Connect the card enroller to the PC’s port, and then place the card on the enroller to read/
enroll it.
[® Note:
On the PC, right-click Computer, select Manage> Device Manager > Ports (COM & LPT),
and check for the USB Serial Device (COMX), where X is the serial port number.
Common | Common card supports card reading only.
Card 1. Connect the card enroller to the PC's port.

2. Select the card enroller model: (O)EC-W1D-EMC or (O)EC-W2D-M.

3. To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.

[E> Note:
The configuration card is used to send the common card information to the
general access control device/access controller.
MIFARE | MIFARE card supports card reading and enrollment. And you can also encrypt
Card sectors to prevent from data leakage.
Read Mode @) Local Remote
rd Type MIFARE Card
= ort fo Serial Port1
I Card Encryption Config
Old Key
w Key
ector 10
Configuration Card |Sync Configuration Card (%)
Please |3|:-Ci the card on the collection cevice
1. Connect the card enroller to the PC’s port.
[® Note:
Only (O)EC-W2D-M supports reading the MIFARE card. So you don’t need to
select the card enroller model.

2. Card encryption configuration: Enter the card’s old key and sector number to
encrypt the specified sector. To change the key, please enter the new key.

3. To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.

[ Note:
The configuration card is used to send the encryption card information to
the general access control device/access controller.
Remote |Select an access control device as collection device, and then swipe a card on it to read the
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Read Description
Mode

[ Note:
This feature is only available to certain access control devices. Please refer to the actual
interface.

(3) Click Add to add cards.
@ Note:
Up to 8 cards can be added. The number of cards supported may vary with device; if the device's
capacity is less than the number of cards an individual has, only a portion of the cards can be synced
successfully.

Parameter Description
Card Verification e Common Card: Can open doors with access permissions normally without
Type triggering an alarm.

e Duress Card: Can open doors with access permissions normally while
simultaneously triggering a duress alarm.

Card Number Read or enroll the card.

[ Note:
Preparation: (Local)Place the card on the card enroller; (Remote)Swipe the
card on the access control device.

e Read card: Click Start to read the card.

¢ Enroll card (only when the MIFARE card is read locally): Enter the card number
manually and then click Start; or, click Start to read the physical card number.

Card Password Only cards for general access control devices need to be configured with a card
password. Card Password is hidden by default. You can enable it in Function
Switch.

6. Click OK to finish or click Save&Continue to add more resident information.

10.2.2 Add from Personnel

Select persons from Person Library and add them as residents.
1. Select a room and click Add from Personnel. An Add Resident page appears.
2. Select residents from the left person list and click 3> to add them to the selected list.

Note:
Up to 200 people can be displayed for each department. People not displayed can be found by search,
with up to 200 displayed.
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Person (1) Selected(2)
Clm ﬁce:t
- Resident
Ml o AA Name Department Start Date Expiration Date
- Type
i .. EE
- AA dept Owner -~ 2024-08-20 = Please select &
an CC
; BB dept Tenant ~ 2024-08-20 — 2024-08-31 —

“ Cancel
3. Select the resident type, start date, and expiration date for each person.
[®p Note:

e Start date: Cannot be earlier than the current time.

e Expiration date: Cannot be earlier than the start date. Required for tenants; optional for owners/
family members. No expiration date selected means permanently valid.

e Modifying the start/expiration date will be automatically synced to the person's Validity Period, while
modifying the person's validity period not affect start/expiration date.

4. Click OK.

10.2.3 Add in Batches

Import residents in batches using a template.

1. Prepare a template.
(1) Click the drop-down arrow next to Batch Add and select Export Template.

L |

A | B | [ | i | E | F | G | H | I | T | E |
Name (RequirdGender (RdNobile Number |Email (ID Card Number|Phase Name |Building Name [Unit Name |Room No [Resident Type |Start Date |ExpirationDate
zhangsan 1 LB0XIHE abe®a. con  3TRXAXXMIXILAXENLK Stagel Building! Uni t1 10t ¢! 2023/11/16 2023711417

LR

-3

(2) Complete the resident information in the template and save it.

(3) Name the resident images based on this format: Mobile Phone Number_No..jpg (e.g. 123456_3.jpg). Up to
6 images are allowed per resident. And then package all images into a .zip format file.

2. Import the template.
(1) Click the drop-down arrow next to Batch Add and select Import Residents.

(2) Click Upload File and select the modified template file from local.

Batch Import

1
L
m
[=1

i
[
-
T

[

Upload File | Only XLSX files allowed

(3) Click OK.
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@ Note: If the import failed, please modify the content according to the error message.

3. Import images.
(1) Click the drop-down arrow next to Batch Add and select Import Image.

(2) Click Upload File and select the prepared compressed package (.zip) from local.
Batch Import

Please select the file to import.

T, Upload File

(3) Click OK.

@ Note: If the import failed, please modify the content according to the error message.

10.2.4 Manage Resident

Select a room to view the residents under it. The displayed resident information includes name, resident type,
gender, mobile phone number, number of images, image feature extraction status, number of cards, and the
expiration date.

[+) Batch Add | ~ Total Phases: 1 Total Buildings: 5 Total Units: 10 Total Rooms: 60 Total Residents: 3
Community Unit 1 Total Rooms: 6 Total Residents: 3
Reaselenterkeyworts Room — (&} Add Resident ||, Add from Personnel
AAA Please enter keywords
AA (Owner B8 (Tenant CC (Family ...
1101 W@ { : 2 ¢ ! 2 (Lt £
Building 1 1E-102 5 Male 95 Female @5 Male
unit1 + T TRTE ® o0 B o % o0 Eo 9 o0 B o
Unit2 27201 2 ® Nolmage ‘2 ® Nolmage 2 ® Nolmage
Building 2 - O 20240831
Ut 2F-203
Unit 2
Building 3

Unit 1

Unit 2
¢ Unlink: Select a resident and click Delete to remove the resident from the room.
e Edit: Click /# inthe card’s upper-right corner to modify the resident information.

e Re-extract: Select a resident and click Re-extract to re-extract the feature from the resident image.

11 Personnel Management

Go to Basic Config > Personnel Mgt.

You can manage long-term residents within the area, such as company employees, residential community
inhabitants, school faculty and students, allowing functions like access control permissions management and
attendance management.

e Department Management: Create departments according to the actual organization structure to manage
personnel in different groups.

¢ Personnel Management: Add person information to departments one by one or in batches, including the
basic information, room information, face image, vehicle information, card, Custom Attribute, etc.
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Department Person ID

Plate Number

+ Add
PersonID
001 Jam
002 David
003 Ro

1D Card Nurn.

Enroliment List

Mobile... +

11.1 Department Management

You can create departments according to the actual organization structure to manage personnel in different

groups.

Feature Extr...
® Extracted
® Extracted

® Extracted

Valid Period | All

{& Search Criteria Config

Feature Extra..| All

Reset

Valdity.. $  Visit Validity Period Pla

® Valid

Perman: i sat

o Valid Permanently Valid a2

o Vaid Permanently Valid s 2

By default, there is a root department which cannot be deleted, but can be renamed. New departments are

added under the root departments.

@ Note: Up to 10 levels of departments are allowed.

Add a Department

Click 4 for the department, input the department name and then click OK, a sub-department will be added.

Department

() Please enter keywords

T Wdept [+]2 O

dept3 + £ T

deptl
dept?

Import Departments

Add Department X

* Department

Import departments in batches using template.

Cancel

1. Click Import, select Import Departments, download the spreadsheet template.

Department

- ﬁ dept

Department1
4 Department2
Department3

Department5

+ 2

Person ID

Plate Number

-+ Add

Person ID =
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Name ¥

Daniel

Matth...

Susan

Mame

o, Import |+ T, Export =

Gender ~ Import Departments N
Male Import Personnel Info
Male
Import Face Photo
Female
Import frem Child Domain




Import Departments X

1. Download the template and then fill in information following the e

xample.

) download template

2.Please select the file to import.

(T3 Upload File

Lo

nded to import no more than 1000 items at a time.Only XL5X file

2. Fill in the departments to be imported in the template. Fields marked with an asterisk (*) are mandatory.

[®p Note:
It is recommended to import no more than 1000 entries at a time, otherwise the import may be very
slow.

[+

3. Click 2, upleadrie , upload the completed template.

—

4. Click OK to complete the import.

Rename Department

Click # for the department to change its name. After editing, click OK to save it.

Delete Department

Click 7] for the department to delete it.

@ Note: Cannot delete the root department and departments containing sub-departments or person.

Refresh Department

If a department was modified on another client, the department information displayed on this page may not
update automatically. Please click { * next to the root department name to refresh manually.

11.2 Add Person

Add person information to departments one by one or in batches, including the basic information, room
information, face image, vehicle information, card, Custom Attribute, etc.

Note:
Residents added in Resident Management will be automatically synced to the root department.

11.2.1 Add in Batches

Import personnel information and face photos in batches.
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Department

Person D Mame
Please enter keywo
Plate Number
N {I.‘ dept
Department! —+ £ o
Department2 + Add ok, Import T T, Export =
Department3 - . . n N .
~ i erson ID MName ¥ Gender = Import Departments -
Department5
001 Daniel Male
Import Personnel Info
002 Matth... Male
Import Face Photo
003 Susan Female
Import from Child Domain

Import Personnel Information

Import personnel information in batches through templates.

1.

5.

To download the default template, click Import > Download Template.

Import Personnel Information *

1. Download the template and then fill in information following the e
xample.

) download template

2.Please select the file to import.

Ty Upload File

In the template, enter the person information that you want to import. Fields marked with an asterisk (*) are
required.
@ Note:
It is recommended to import no more than 1000 entries at a time, otherwise the import may be very
slow.
In the Batch Import dialog box, click Upload File to select the file.

(Optional) Select Overwrite Duplicate Data. When an employee ID already exists, the corresponding
employee's information will be overwritten and updated.
If not selected, the import will fail if the imported employee ID duplicates an existing employee ID.

Click OK.

Import Face Photos

Batch import face photos using a .ZIP file.

1.

Name the photos as Person ID_No..jpg. Up to 6 photos are allowed per person. And then pack all photos into
a .ZIP file.

Select a target department from the left-side department tree, and then click Import > Import Face Photo.
Click Upload File to upload the ZIP file.
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Batch Import Photos X

Please select the file to import.

|i. Upload File Please import a .zip file no larger than 500ME

4. Click OK.

11.2.2 Add One by One

Select the target department from the left-side department tree, and click Add. Enroll the person's basic
information, room information, face image, vehicle information, card, etc., set access permissions, add persons to
the face library, and then click OK.

Basic Information

Add x

Basic Information
I Basic Information

Room Information

*Person ID
Face Image
*Name
Vehicle Info
Card *Persannel Type Common Personnel @
Permission Group D Card Number | Passport
Face Libi
SR Visit Validity Period | Permanently Valid
Date of Birth =
Gender -:_5_3 Male Female Unknown

Mobile Phone Nu...

Nenartmant dent

“ .:E 1CEI

Parameters Description

Identity Information | Enter the person ID (letters/digits/underscores/hyphens), name and other information
as needed.

Personnel Type e Common Personnel: Access permissions are determined by their permission groups
and verification rules.

e Super Personnel (applies only to access controllers): Can access doors they have
permission for, bypassing restrictions like keep closed, anti-passback, interlocking
(excluding multi-factor authentication); verification will fail for doors that they have
no permission.

¢ Unauthorized Personnel (applies only to access controllers): Cannot access any
door. Verification attempts on a door they have permission for will not unlock the
door but will trigger an unauthorized access alarm; verification will fail for doors
that they have no permission.

ID Card Number Select the ID type from the list, and then input the ID number.
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Parameters Description

Visit Validity Period The visitor can access with card, face recognition, or password only within the set
period.

e Only within the validity period can the credentials (face, card, password, etc.) be
successfully verified on authorized access control devices.

e After the validity period expires, even if the visitor has access permission,
verification will not succeed. If the access control device is also used for recording
attendance, no attendance records will be generated (except pass-thru records).

> Note:
You can choose Permanently Valid, 1 Day, 7 Days, 30 Days or Custom.
When custom validity period, the earliest start time of the visit validity period is
00:00 on the current day, the latest end time must be later than the start time.

Extend Door Opening | (Applies only to access controllers)

Time Upon successful verification on a door with access permission, the door opening time is
three times the door opening time set on the access controller, facilitating the passage
of people with mobility impairments.

Door Opening Door opening passwords can be generated automatically or entered manually.
Password After a door opening password is set, the person can use the password to access
specified doors configured in Access Permission Config.

Others Configure Custom Attribute as needed.

(Optional) Room Information
1. Click Add in Room Information.

2. Then complete the information. Rooms are created in Room Management.

+ Add
*Resident Type Owner

*Move-in Dats 2024-05-11

Note:
Modifying the move-in/expiration date will be automatically synced to the person's Validity Period, while
modifying the person's validity period not affect move-in/expiration date.

(Optional) Face Image

@ Note:

Image verification is enabled by default. To disable it, see Face Image Verification.

Click Add Photo. Choose a way to add photos:

Face Image
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e Upload: Select a photo of the person from the PC and upload it.

¢ Take a photo: Select a camera to view its real-time screen on the PC. Click Take a Photo to capture the current
frame. Click OK to save the photo, or click Retry to take another one.

Take a Photo

Camera HIK 2K Camera

Take 2 Photo

@ Note:

e Please first enable HTTPS and log in via the HTTPS protocol before taking photos.

e The camera device supports USB cameras and the built-in camera of the computer. If you are using a
USB camera, connect it to the PC in advance.

¢ Remote collection: Select a face recognition access control device and click Remote Collection. After
the device completes face collection, you can check the collected photo on the client. Click Re-Collect if
necessary, or click OK to complete the collection.

Remote Collection

Collection Device | 216815180244 -

Remote Collection

@ Note:

Only some access control devices support remote collection.

After the photo is uploaded, the feature extraction status is Not Extracted. Features will be extracted after saving
the information.

(Optional) Vehicle Information
Add the person's vehicle information. Up to 6 vehicles are allowed per person.

1. On the Vehicle Info tab, click Add.
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2. Enter the license plate number and select a validity period.

Note:
Vehicles added/edited/deleted here will be automatically synced to Parking Mgt > Authorized Vehicle. To

sync vehicles to devices, see operations in Vehicle Data Sync. Only vehicles within the validity period can
access the gates at the entrance and exit.
(Optional) Card Information

Supports reading and enrolling cards.

1. Go to the Card tab.

+ Add () Start @ Configure Card E-.

Card Verification Commen Card

2. Click Configure Card Enrollment, and configure parameters as needed. (It only needs to be configured once
and card information can be then read for multiple people.)

Read Description

Mode

Local Connect the card enroller to the PC’s port, and then place the card on the enroller to read/enroll
it.
[ Note:

On the PC, right-click Computer, select Manage> Device Manager > Ports (COM & LPT), and
check for the USB Serial Device (COMX), where X is the serial port number.

Common | Common card supports card reading only.

Card (1) Connect the card enroller to the PC's port.

(2) Select the card enroller model: (O)EC-W1D-EMC or (O)EC-W2D-M.

(3) To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.
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Read Description
Mode

E> Note:
The configuration card is used to send the common card information to the

general access control device/access controller.

MIFARE | MIFARE card supports card reading and enrollment. And you can also encrypt sectors
Card to prevent from data leakage.

Card Enrollment Config

Read Maode @® Local Remote
Card Type MIFARE Card
Serial Port for Car... | Serial Port1

Card Encryption Config

rd [Sync Configuration Card (7)

Please place the card on the collection devic

(1) Connect the card enroller to the PC’s port.

[ Note:
Only (O)EC-W2D-M supports reading the MIFARE card. So you don’t need to
select the card enroller model.
(2) Card encryption configuration: Enter the card’s old key and sector number to
encrypt the specified sector. To change the key, please enter the new key.

(3) To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.

[E> Note:
The configuration card is used to send the encryption card information to the
general access control device/access controller.

Remote | Select an access control device as collection device, and then swipe a card on it to read the card.

[ Note:
This feature is only available to certain access control devices. Please refer to the actual

interface.

3. Click Add to add cards.

Note:
Up to 8 cards can be added. The number of cards supported may vary with device; if the device's capacity

is less than the number of cards an individual has, only a portion of the cards can be synced successfully.

Parameter Description
Card Verification e Common Card: Can open doors with access permissions normally without
Type triggering an alarm.

e Duress Card: Can open doors with access permissions normally while
simultaneously triggering a duress alarm.

Card Number Read or enroll the card.
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Parameter Description

E> Note:
Preparation: (Local)Place the card on the card enroller; (Remote)Swipe the card
on the access control device.

e Read card: Click Start to read the card.

e Enroll card (only when the MIFARE card is read locally): Enter the card number
manually and then click Start; or, click Start to read the physical card number.

Card Password Only cards for general access control devices need to be configured with a card
password. Card Password is hidden by default. You can enable it in Function Switch.

(Optional) Permission Group

Assign access permissions to personnel. Permission groups are created in Access Permission Config.

Click and then select the permission group.

Access Permission | 22

Permission Group

ease enter Ke

Public Door Permission Gro...

@mna @
.

(Optional) Face Library

Selected(1) i Clear

Public Door Permission Gro...

Add face photos to a face library for monitoring. Face libraries are created in Face Library Management.

Select a face library from the drop-down list.
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Face Library11
Face Library10
Face Library9
Face Library8

Face Library7

11.2.3 Get Personnel from Device Side

You can retrieve person information from access control devices to the platform.

[y Note:
e This function is available on certain devices only. Please refer to the actual interface.
e Successfully retrieved person information will be deleted from the device.

e During the import process, the platform compares personnel names. If the device contains information
about a person not listed on the platform, the platform will automatically create a new personnel entry. If
both the device and the platform have information about the same person, the person information from
the device will overwrite the existing information on the platform.

1. Click Get Personnel.

2. In the pop-up window, select the access control device(s) for sync and click OK. The person information will be
synchronized from the device side to the platform.

-+ Add o, Import - T, Export = More ~

Perse 2 = Gender + Depar = C
erson D+ Mame = Gender = Departm... = DC GetPersennel

Get Personnel

*Select Device Select -

“ CEn:E

11.3 Personnel Management

You can search, edit, delete, assign persons, and export person information.

Department Person ID Name 1D Card Num. Feature Extra.. All - Valid Period | All

Plate Number @ Search Criteia Config Search Reset

Visit Validity Period

e Search: Set person ID, name, ID card number, feature extraction status as needed, and then click Search.

Note:
You can also set Custom Attribute as search criteria. Click Search Criteria Config, select up to 10
attributes, and then click OK to add them as search criteria.

e Edit person: Click /# inthe Operation column to edit the person information.
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e Delete person: Select person(s) to be deleted and click Delete, or click [iij in the Operation column.

¢ Change department: Select the department on the left-side department tree, select the person(s) on the
right, and then click Change Department to move the person(s) to another department.

e Export: Select the department on the left-side department tree, click Export and select Export Personnel Info
or Export Personnel Info and Images.

e Re-extract: If the extraction fails, select person(s) and click More >Re-extract.

e View card information: Click the number in the card information column to view the card type and card
number.

Card Information(2card(s)) X

I Card Information

——— Card1 Card2

12121212 111111111

e Batch modify person access validity period: Click More >Access Validity Period to modify the access validity
period for multiple persons in batches.

Modify Access Validity Period X

Mote: No personnel selected. The current configuration applies to all retrieved personnel (total: 2 people).

Visit Validity Period (@) Permanently Valid Custom

¢ If no persons are selected, the validity period of all found persons will be modified by default.

¢ If specific persons are selected, only the validity period of the selected persons will be modified.

11.4 Custom Attribute

You can add custom attributes as supplements to person information. These custom attributes are displayed
when adding, viewing, and modifying person information.

Add Attribute

1. Click More > Custom Attribute above the personnel list.

< Custom Attribute

+ Add Please enter keywords
Attribute Name g Attribute Type D Required B Operation
A Text Box No 2 W
8 List (single-choice) No 2 W
c List (multiple-choice) No 2 W

2. Click Add. Set the parameters by referring to the table, then click Save.

Item Description
Attribute Name Enter the custom attribute name.
Attribute Type Choose one of the following type:

¢ Text Box: When adding person, you need to manually enter the attribute
information.
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Item Description

Add X
Result:
*Attribute N... | A
| custom Attribute
Attribute Ty... | Text Box v ﬁ
A
Required \

¢ List (single-choice): You can add multiple options and set a default option for
the attribute. When adding person, you can choose only one option from the
preset options.

Add X
*Attribute N... | B
Result:
Attribute Ty... | List (single-choice) - \
| Custom Attribute
I Option Config
8
*Qption1 1 [m)
1
*Option2 2 + w \ 2
Default Opt... (8 None Option
Required

“ Cancel

e List (multiple-choice): You can add multiple options and set a default option for
the attribute. When adding person, you can choose multiple options from the
preset options.

Add X
*Attribute N... | C
Attribute Ty... | List (multiple-choice) he Result:
| Option Config | custom Attribute
*Option1 1 [} ﬁ c 1% +1
*Option2 2 + mW v
| v2
Default Opt.. () None (@ Option |1 - \\_ ~
Required
“ Cancel
Required If enabled, the attribute must be completed to submit the person information.

Other Operations
e Edit attribute: Click . for the attribute to modify it. (Note: The attribute type cannot be changed.)

* Delete attribute: Select attribute(s) to be deleted and click Delete, or click [ii] in the Operation column.

12 Visitor Management

Go to Access&Attendance> Visitor Mgt.

Visitors are those who temporarily need access to a restricted area. The platform provides a comprehensive
service for visitors, from pre-registration to sign-out.

e Pre-register the visitor information and assign temporary access permissions to them. Visitors can then enter
the specified area within the validity period using face recognition or card swiping. After passing through an
access control device, a visitor record is automatically generated.
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e When visitors leave, they can be signed out manually by an admin or automatically by the system after their
access end time, generating a sign-out record. Upon sign-out, the visitor’s access permissions are cleared,
ensuring prompt data updates.

e Search visit and sign-out records of visitors to manage visit information.

e Monitors whether visitors enter authorized areas during authorized time. If not, an unauthorized area access
alarm or an unauthorized time access alarm will be reported.

12.1 Registration

Register visitor information and assign access permissions.

Go to Visitor Mgt > Registration.

@ Note:

You can also enroll the visitor information on the UNV Guard app. Please refer to the user manual of the app.

12.1.1 Register Visitor

Click Add to register the visitor information (identity information, card information, image, license plate number,
Custom Attribute, etc) and associate access permission groups and access time, and then click OK.

Basic Information

Basic Info I Basic Info
Face Image sitor Name
Card
Email Addres
Access Time Custom
2025-08-06 00:00:00 - 2025-08-31 23:59:59 =
D Number Passport N
Visitor Type Visit .
Gender ® Male Female Unknown
Permission Grou ease sele

PEEEt “ Cance'

1. Complete the required information (fields marked with an asterisk *) for the visitor.

2. Select the access time (1 Day, 7 Days, 30 Days or Custom) and the permission groups. The permission groups
set which doors the visitor can access and need to be created in advance (see Access Permission Config).

3. (Optional) Select the ID type from the list, and then input the ID number.
4. (Optional) Add the visitor's vehicle information. One visitor can only be associated with one vehicle.

Note:

Vehicles added/edited/deleted here will be automatically synced to Parking Mgt > Authorized Vehicle. To
sync vehicles to devices, see operations in Vehicle Data Sync. Only vehicles within the validity period can
access the gates at the entrance and exit.

5. (Optional) Authorize area(s) for the visitor. An alarm will be triggered if the visitor enters an unauthorized
area.

126



@ Note:
e Select smart NVR's video channels and smart IPCs as the authorized area.

¢ If an authorized area is configured, you must add a visitor photo. This photo will be used by smart
devices to compare with the captured image to determine the visitor's permissions.

e After configuring the authorized area, you need to configure an Area Monitoring task for unauthorized
access monitoring.

6. (Optional) Configure Custom Attribute as needed.

(Optional) Face Image

Note:
Image verification is enabled by default. To disable it, see Face Image Verification.

Click Add Photo. Choose a way to add photos:

Face Image

¢ Upload: Select a photo of the person from the PC and upload it.

¢ Take a photo: Select a camera to view its real-time screen on the PC. Click Take a Photo to capture the current
frame. Click OK to save the photo, or click Retry to take another one.

Take a Photo

Camera HIK 2K Camera

Take 2 Photo

[®p Note:
e Please first enable HTTPS and log in via the HTTPS protocol before taking photos.

e The camera device supports USB cameras and the built-in camera of the computer. If you are using a
USB camera, connect it to the PC in advance.

¢ Remote collection: Select a face recognition access control device and click Remote Collection. After
the device completes face collection, you can check the collected photo on the client. Click Re-Collect if
necessary, or click OK to complete the collection.
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Remote Collection

Collection Device | 21611k 180244

@ Note:

Only some access control devices support remote collection.

After the photo is uploaded, the feature extraction status is Not Extracted. Features will be extracted after saving
the information.

(Optional) Card Information
Supports reading and enrolling cards.

1. Go to the Card tab.

I Card Information

8 Configure Card E...

Read

Card Encryption Type

Note:
Only cards for general access control devices need to be configured with a card password. <Card
Password> is hidden by default. You can enable it in Function Switch.

2. Click Configure Card Enrollment, and configure parameters as needed. (It only needs to be configured once
and card information can be then read for multiple people.)

Read Description

Mode

Local Connect the card enroller to the PC’s port, and then place the card on the enroller to read/enroll
it.
[ Note:

On the PC, right-click Computer, select Manage> Device Manager > Ports (COM & LPT), and
check for the USB Serial Device (COMX), where X is the serial port number.

Common | Common card supports card reading only.

Card (1) Connect the card enroller to the PC's port.

(2) Select the card enroller model: (O)EC-W1D-EMC or (O)EC-W2D-M.

(3) To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.
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Read
Mode

Description

E> Note:
The configuration card is used to send the common card information to the

general access control device/access controller.

MIFARE
Card

MIFARE card supports card reading and enrollment. And you can also encrypt sectors
to prevent from data leakage.

Card Enrollment Config

Read Maode @® Local Remote

Card Type MIFARE Card

rd [Sync Configuration Card (7)

Please place the card on the collection device first

(1) Connect the card enroller to the PC’s port.
[ Note:
Only (O)EC-W2D-M supports reading the MIFARE card. So you don’t need to
select the card enroller model.

(2) Card encryption configuration: Enter the card’s old key and sector number to
encrypt the specified sector. To change the key, please enter the new key.

(3) To swipe a card on the general access control device/access controller, place the
configuration card on the card enroller, click Sync Configuration Card, and then
swipe it on the general access control device/access controller.

[E> Note:
The configuration card is used to send the encryption card information to the

general access control device/access controller.

Remote

Select an access control device as collection device, and then swipe a card on it to read the card.

[ Note:

This feature is only available to certain access control devices. Please refer to the actual
interface.

Read or enroll the card.

Read Mode

Description

Local

Preparation: Place the card on the card enroller.
e Read card: Click Start to read the card.

e Enroll card (only for the MIFARE): Enter the card number manually and then click Start;
or, click Start to read the physical card number.

Remote

Preparation: Swipe the card on the access control device.
Read card: Click Read to read the card.

129




12.1.2 Visitor Management

You can view visitor status, edit, delete, export, search, and sign out visitors.

SigninTime | 2025-11-0500:00:00 ~ 2025-11-0523:59:59 £  Today Last3days Last7 day

Vistor Type | All | ViitorName Email Adchess Feature Exrac..| All | person toVist

+ Add 2, Export & Custom Attribute & Access Time

Visitor Status

e Unauthorized: The visitor has no permission group assigned.
e Registered: The visitor has been assigned a permission group, but has not arrived yet.
e Arrived: The visitor has been verified at the access control devices.

e Qverstay: The visitor has not signed out upon expiration of the access period.
Sign out

Click _'4 in the Operation column to sign out the visitor. When signed out, the visitor will be removed from the
visitor list and the related access permission will also be cleared.

Note:
Visitors who haven't been signed out by the access permission end time will be automatically signed out at
the set auto sign-out time (set in Visitor Settings).

More Operations

Edit: To edit the visitor information and access permissions, click  in the Operation column.

Delete: To delete registered visitors, select the visitors to be deleted and click Delete, or click i] in the
Operation column. The visitor’s access permissions will be revoked after deletion.

Export: Select visitors, click Export.

Search: Set criteria such as sign in time and visitor name as needed, and then click Search.

Note:
You can also set Custom Attribute as search criteria. Click Search Criteria Config, select up to 10
attributes, and then click OK to add them as search criteria.

e Re-extract: If the extraction fails, select visitor(s) and click Re-extract.

Convert Visitor to Personnel: Click ‘=) in the Operation column to directly change a visitor into personnel.

@ Note:

After conversion, the visitor will be automatically signed out.

Batch modify visitor access time: Click Access Time to modify the access time for multiple visitors in batches.

Modify Visitor Access Time b4

Mote: 3 people selected

Access Time 2025-11-07 00:00:00 - 2025-11-07 23:59:59

Today  Next 7 days  MNext 30 days

¢ If no visitors are selected, the validity period of all found visitors will be modified by default.

¢ If specific visitors are selected, only the validity period of the selected visitors will be modified.
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12.1.3 Custom Attribute

You can add custom attributes as supplements to visitor information. These custom attributes are displayed when
adding, viewing, and modifying visitor information.

Add Attribute
1. Click Custom Attribute above the above list.

< Custom Attribute

+ Add Please enter keywords
Attribute Name Attribute Type 3 Required g Operation
A Text Box No 2 W
] List (single-choice) No 2 W
c List (multiple-choice) No 2 W

2. Click Add. Set the parameters by referring to the table, then click Save.

Item Description
Attribute Name Enter the custom attribute name.
Attribute Type Choose one of the following type:
¢ Text Box: When adding visitor, you need to manually enter the attribute
information.
Add X

Result:
“Attribute ... | A \

I Custom Attribute
Attribute Ty... | Text Box - »

Required

N

“ Cance!

e List (single-choice): You can add multiple options and set a default option for
the attribute. When adding visitor, you can choose only one option from the
preset options.

Add X

=Attribute N... | B
Result:

Attribute Ty... | List (single-choice) - \

| Custom Attribute
I Option Config
B
=Option] 1 1w

~Optionz |2 + o 2

Default Opt... @ None Option

Required

¢ List (multiple-choice): You can add multiple options and set a default option for
the attribute. When adding visitor, you can choose multiple options from the
preset options.
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Item Description
Add X
Attribute N C
Attribute Ty... | List (multiple-choice) - Result:
I oo |//i Custom Attribute _\
Option 1 w ﬁ c 1% &1 - |
“Option2 2 4 v1
o | — |
Default Opt. None (@ Option |1 - \\\7 7/
Required If enabled, the attribute must be completed to submit the visitor information.
Other Operations
e Edit attribute: Click * for the attribute to modify it. (Note: The attribute type cannot be changed.)
e Delete attribute: Select attribute(s) to be deleted and click Delete, or click [i] in the Operation column.

12.2 Visitor History

The Visitor History page displays visitor records of those who have signed out.

Search

1. Set search criteria such as sign in time and visitor name as needed. (You can also click Search Criteria Config
to add custom attributes as search criteria.)

2. Click Search to view the visitor information within the specified time period.

SigninTime | 2025-10-3100:00:00 ~ 2025-10-3123:5959 =  Today Last3days Last7days  Current mont
VistorType | All © | Visitor Name Maobie Phone. Person to Visit 1D Card Numb.

Plate No.

More Operations

e View details: Click [Z! in the Operation column to view details about the visitor such as basic information and
sign in/out time.
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View Details X

Basic Info I Bacic Info
Face Image -
Card
Gender Male Female Unknown
Cancel
e Delete records: Select record(s) to be deleted and click Delete, or click [ii] in the Operation column.

e Export records: Select record(s) to be exported, click Export, and then select the storage path to save the
records.

12.3 Visitor Settings

Set the automatic sign-out time for visitors. Visitors who haven't been signed out by the access permission end
time will be automatically signed out at the set time each day.

Auto Sign-Out Time 01:00:00
Registration

Note: Visitors who haven't been signed out by the visit end time will be automatically signed out at the set time.

Visitor History
ave

Visitor Settings

Blocklisted Person

On the day when a visitor's access permission ends:

e [f the auto sign-out time is later than the permission end time, the visitor will be automatically signed out at
the set time on the same day.

e If the auto sign-out time is earlier than the permission end time, the visitor will be automatically signed out at
the set time on the following day.

For example, if visitor A's access time is 8:00-11:00, visitor B's access time is 8:00-13:00, and the auto sign-out
time is 12:00, then visitor A will be automatically signed out at 12:00 on the same day, while visior B will be
automatically signed out at 12:00 on the following day.

12.4 Blocklisted Person

The system supports adding blocklisted persons. Once added, these individuals cannot be registered as visitors.

Note:
The blocklisted person feature is not supported in cloud-edge mode.
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+ Add

Add Blocklisted Person

Click Add, enter the blocklisted person's email address, and optionally provide remarks to explain the reason for
restriction.

Add X

During addition, the system will check whether the blocklisted person already exists in the visitor list based on
their email address.

¢ Not registered as a visitor: After successfully adding the blocklisted person, any subsequent attempt to
register this individual as a visitor will fail.

e Already registered as a visitor: The visitor will be automatically signed out, and the blocklisted person will be
successfully added.

More Operations

e Search: Enter keywords in the upper-right corner to quickly find blocklisted persons.

e Edit: Click the corresponding /* for a blocklisted person to modify his/her information.

e Delete: Select the blocklisted person(s) and click Delete, or click [i] in the Operation column.

12.5 Area Monitoring

Go to Park Application > Area Monitoring.

Monitors whether visitors enter authorized areas during authorized time. If a visitor enters an unauthorized area
or appears during unauthorized hours, an unauthorized area access alarm or an unauthorized time access alarm
will be reported.

e Visitor monitoring is conducted using smart devices with face monitoring capabilities. Both video channels
connected to smart NVRs and smart IPCs are supported.

e After creating a visitor monitoring task, visitor photos will be automatically synced to all smart devices in the
system, and a face match monitoring task will be created on smart devices.

e When a smart device recognizes a visitor, it will verify whether the visitor is in an authorized area and appears
during authorized hours.

¢ If the device is not within the visitor's authorized area, an unauthorized area access alarm will be
reported.

¢ [f the time is not within the visitor's access time, an unauthorized time access alarm will be reported.

@ Note:

e Please configure authorized area and access time for visitor in Registration.

e If the platform is connected to EZCloud, then visitor information cannot be edited on the platform. You
need to configure the authorized area on the visitor review page on the UNV Guard app.
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12.5.1 Monitoring Task

Go to Park Application > Area Monitoring > Area Monitoring.

Create visitor monitoring tasks to monitor unauthorized area or time access.

Area Monitoring

Permission Search

Add Task
1. Click Add.

.
ks
ERE

.
3
=

Add Area Monitoring Task >

* Monitoring Type Unauthorized Area Al... (@ Unauthorized Time Al... (3
Monitoring Target Visitor -
* Monitoring Methad Face Recognition v
- o 80

n ::En:e

Item Description
Task Name Enter a custom task name.
Monitoring Type Select the monitoring type(s).

e Unauthorized Area Alarm: Triggers an alarm when the monitored target
enters an unauthorized area.

e Unauthorized Time Alarm: Triggers an alarm when the monitored target
appears during unauthorized hours.

Monitoring Target

Default is Visitor.

Monitoring Method

Default is Face Recognition.

Match

If the match degree between the captured image and visitor photos meets

or exceeds the set threshold, the system identifies it as the same person. The
system then evaluates whether the access is unauthorized based on the visitor
permissions.

2. Click OK. The system will automatically sync information of visitors who haven’t been signed out to all smart

devices.

@ Note:

You can create up to 10 monitoring tasks.

Task Management Operations

* Edit: Click /# for the task to edit task parameters.

* Delete: Select task(s) to be deleted and click Delete, or click Tiij for the task.

® Enable/Disable: Click ::Ej/-i:il for the task to enable or disable it.
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Subsequent Operations

¢ Search for visitor match events: When a smart device matches a visitor, it reports a visitor match event.
View visitor match events in Comprehensive Search > Face Search .

e Search for unauthorized access alarms: If a visitor enters an unauthorized area or appears during
unauthorized hours, an unauthorized area/time access alarm will be reported (in this case, no match alarm
will be reported). If the visitor is within the authorized area and time, no alarm will be reported.

View unauthorized area/time access alarms in Historical Alarm.

12.5.2 Permission Search

Go to Park Application > Area Monitoring > Permission Search.

Displays authorized visitors on each device.

Area Monitoring

=l sync O Refresh
Permission Search

Device Person List Device Status Organization Sync Status Operation

# Online ® Succeeded

¢ Sync: The system automatically syncs visitors to devices in authorized areas. If the sync fails, you can select
the device and click Sync to re-sync the visitor information.

Note:
Sync Status: Displays Succeeded only when all visitors are successfully synced to the device; displays
Failed if any visitor sync fails.

e View Authorized Visitors: Click Visitor List (in blue) to view authorized visitors on the device (only visitors who
haven’t been signed out are displayed).

< 171-Visitor List

J Refresh
Name s Email Address 2 Card Number 2 Access Time S Picture Status Operation
001 001@3.com 2025-03-24 14:48:24~2025-03-24 23:59:39 ® Succeeded 0
A £

002 002@3.com 2025-04-22 00:00:00~2025-04-23 23:59:59 ® Succeeded

Anna 1M11@163.com 2025-03-25 20:19:34~2025-03-25 23:59:59 ® Succeeded

e If the sync fails for some visitors, select the visitor and click Re-Sync.

e Click = for the visitor to view visitor details.

13 Access Control Management

Access control management offers permission management services for entrances and exits in locations like
campuses, communities, buildings, and schools. With face recognition terminals, general access control devices,
access controllers, etc., personnel can open doors using face recognition or card swiping once permissions are
set. Administrators can view live videos from access control devices, remotely open or close doors, and review
all historical access records. This function automates access verifications, prevents unauthorized entries, ensures
safety, and improves the efficiency of gate management.

Functions

Menu Description

Access Control Permission | Allows users to configure access permissions for personnel as needed, specifying
accessible access control devices and their access times. You can view, search, and
edit personnel access permissions after configuring.
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Menu

Description

Personnel information, such as images, cards, is automatically synced to the linked
access control devices, which can extract image features. When personnel pass
through the access control devices, their information is verified with the stored
data, allowing entry only if the verification succeeds.

Remote Control

Manage access control devices by system's default organization or custom
organization, and batch open/close doors remotely.

Face Recognition Access
Control Configuration

Configure the parameters of the face recognition access control device and sync
the configuration.

Access Control Live

Allows users to view live videos from access control devices and captured access
records. Capturing snapshots, enlarging live view images, remotely opening/closing
doors are supported.

Pass-Thru Records

Allows users to filter personnel access records by date, access control device, etc.

Workflow

1. Add face recognition terminals, general access control devices, access controllers, etc.. See Device
Management > Private Device.

AN S

Add persons. See Personnel Management .
Configure the effective time of access permission. See Access Control > Schedule Template.
Specify access control devices for persons. See Access Control > Access Permission Config.

View live videos of access control devices and people access records. See Smart Live View > Access Control

Live and Data Search > Pass-Thru Records.

13.1 Access Control Permission

Go to Access&Attendance > Access Control.

By configuring schedule templates and access permission groups, you can restrict the access control channels and
access periods for individuals, preventing unauthorized entry and ensuring campus security.

13.1.1 Schedule Template

Go to Access Control > Schedule Template.

The schedule template is used to configure the effective time of access permission in each day. People can
only access the specified door(s) within the set time period in the schedule template. By configuring schedule
templates in advance, you can quickly apply the time settings from the template when configuring permission
groups to set access permissions for personnel in batches effectively.

@ Note:

e There is a default template in the system for all-day access, which cannot be edited or deleted.

* You can customize new schedule templates, which can be edited and deleted.

e There are 2 kinds of schedule template: Weekly Schedule and Holiday Schedule. During regular periods,
access control permissions are executed based on the weekly schedule; while during holidays, the holiday
schedule takes precedence and access control permissions are executed based on the holiday schedule.
For example, if access permissions are not granted during holiday periods, access will still be restricted

even if those periods

Add Schedule Template

are within the access periods of the weekly schedule.

L click -+ to add a schedule template.

2. Configure the weekly schedule.
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T
Template Name: Daytime (1] Copy Template

dule

Holiday Schedule

o £ Edit o i} Clear

© O Ense
O = Access Tim,
No. Description
1 Set the template name.
2 Select Copy Template to choose an existing template and apply its time settings to the current
template. You can then edit the copied time settings based on your needs.
3 Click Edit to set precise access periods for each day of a week. Up to 8 time periods are allowed
per day.
Mon Tue Wed Thu Fr Sat Sun
No. Start Time End Time Schedule Type
08:00:00 : 18:00:00 : Access Time -
2 Access Time =
Access Time -
4 [ [ Access Time =
5 [ [ Access Time =
6 [ [ Access Time =
7 Access Time =
8 Access Time =
Copy To All
ETue Wed Thu Fri Sat Sun Copy
OK Cancel
After completing settings for a day, you can select other day(s) and click Copy to copy settings to
them.
[ Note:
The access periods of general access control devices can be precise to the minute (for
example, if the access time is set to 18:00, then it will be valid until 18:00:59).
The access periods of other access control devices can be precise to the second;.
4 Click Clear to clear all settings of this template.
5 Click Erase to erase the assigned time periods by clicking or dragging the left mouse button in the
time chart.
6 Click Access Time to assign time periods by clicking or dragging the left mouse button in the time
chart.

3. (Optional) Configure the holiday schedule.
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Weekly Schedule Haliday Schedule

A m
Holiday Schedule (1)

SpringFestival () select Holigay o

£ Edit i Clear
2 o
2 4 2 4 18 2 22 24
Spr estr o Q Erase
o Access Time
No. Description
1 Select holiday(s). (Holidays created in System Config > Sercive Config > Holiday Management)

e Up to 16 holidays can be associated with a schedule template.

e Click X in the upper-right corner of the holiday to delete it.

2 Click Edit to set precise access periods for each day of a holiday. Up to 8 time periods are allowed
per day.
SpringFesti... Mid-Autumn Christmas
Holiday Period Start Time End Time Schedule Type

Period1 12:00:00 16:00:00 Assign Time
Period2 Assign Time
Period3 Assign Time
Period4 Assign Time
Period5 Assign Time
Periodb Assign Time
Period7 Assign Time
Period8 Assign Time

Copy To: [ Al

B Mid-Autumn Christmas Copy

() Attention:

12:00-23:59.

settings to them.

Cancel

The access period for general access control devices can only be set as 00:00-11:59 or

After completing settings for a holiday, you can select other holiday(s) and click Copy to copy

3 Click Clear to clear all settings of this template.

time chart.

Click Erase to erase the assigned time periods by clicking or dragging the left mouse button in the
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No. Description

5 Click Access Time to assign time periods by clicking or dragging the left mouse button in the time
chart.

4. Click Save to save the settings.

13.1.2 Access Permission Config

Configure permission groups to associate persons and effective period for access control devices (face
recognition terminals, door stations, zone stations, general access control devices, access controllers, speed gate
& turnstile) and elevator controllers. You can assign access permissions to individuals to restrict their access

to specific access control devices and elevators, allowing categorized permission management and ensuring
security.

[ Note:
e By default, there is a public door permission group in the system that applies to all people at all times.
You need to add access control devices under this group. See Manage Permission Group.

* You can add multiple permission groups to meet your needs.

¢ Do not configure conflicting permission groups for personnel. For example, cannot assign different
schedule templates to the same individual on the same device.

Add Permission Group

1. Click Add.
Add Permission Group X
* Mame
* Schedule Template default \

(1) Enter the permission group name.

(2) Select a Schedule Template so that people can only access the specified access control devices within the
set time period in the schedule template.

Note:
The access period in the holiday schedule for general access control device can only be set as
00:00-11:59 or 12:00-23:59. Please make sure the selected schedule template is configured properly.

(3) Click OK.

2. Add access control device(s) or elevator controller(s).
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Add Permission Group X

The permission group is added.

Add Access Control Device Add Elevator Controller

Cancel

e Add Access Control Device: Click Add Access Control Device, Select access control devices, and then click

> to add them to the right-side list. Click OK.

Access Control Point

X

Door (1) Selected(2) B Clear

) Please

BICRA) [E] 216216.160.2571_1
=] - E 216.216.160.251 m216-215-163-79_1
[E] 216216.160251_1
0@ B 2621616078
[&] 216.216.16078.1

nter k

m
i
Jo

YWOords i

) Please enter keywords

Add Elevator Controller: Click Add Elevator Controller, select the floors bound to the elevator controller,
and then click > to add them to the right-side list. Click OK.
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Configure Elevator Control X

Elevator Controller List Selected(2) Jﬂ] Clear

) Please enter keywords ) Please enter keywords
Om 7Y oo @
0@ W@ reo =
R 1 Sig
Bl
00 @ 100
- <
B
= m 216.216.180.3
B
B
00 @ w20
B
B

3. Add persons.
(1) Click Add Person.

Add Permission Group X

The access control device is added.

Add Person

Cancel

(2) You can select persons By Person/Department or By Building. Select the persons you want to assign
access permission to, and then click > to add them to the right-side list.

@ Note:

When By Person/Department, up to 200 people can be displayed for each department. People not
displayed can be found by search, with up to 200 displayed.
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Access Person X

Select Persans | By Person/Department v All people under the selected department(s) in the left-s...
By Person/Department (1) Selected(3) i Clear
Please enter keywords Please enter keywords
-
ﬂ' dept an tk137
! -
Fradiant an tk138
‘ -
el an tk139
part
>
ptk
th137 €
th138
th130

I NSNS NERNENENE NE NE NE RS

(3) Click OK.

Sync Permission Groups

After adding a permission group, it is necessary to push personnel information to access control devices or
elevator controllers. Personnel who have been synced will have access rights to the selected access control
devices or elevator controllers.

+ Add {3 Refresh | =| Manual Sync Auto Syne () Scheduled Sync (7) | 02:00 @ | View Sync Progress
Permission Group Name Schedule Template Access Permission Elevator Control Permission Access Person Operation
Public Doar Permission Group default All Members [EI]
Auto Sync Enabled by default.

After selecting Auto Sync, the system will automatically sync incremental data for new
or updated permission groups.

Scheduled Sync Select Scheduled Sync and set a time. The system will sync the incremental data that
have not been synced or have failed to be synced at the specified time.

Manual Sync Click Manual Sync, select the sync mode and the access control point range, and click
Sync.
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Manual Sync X

Sync Made (® Incremental () Full (@)
Access Control Point Range All Devices (®) Specified Devices
Speaified Devices --p t--

“ Cance'

¢ Incremental sync: Resync data that have not been synced or have failed to be
synced.

e Full sync: Resync all data, which will clear data synced by other platforms on the
device, while retaining data added on the device.

If there are any failed syncs, the system will automatically retry at regular intervals until the sync succeeds.

View sync progress: Click View Sync Progress to view the sync progress and details by door.

< Back | View Sync Progress
All Channels

Access Centrol Devies Door Syne Pragrass &

Manage Permission Group

Permission Group Name Access Control Baint Rangs Elevatar Control Rangs

—+ Add T Delete (% Refresh =| Manual Sync Auto Sync (7) Scheduled Sync (7) | 02:00 C View Sync Progress
[} Permission Group Name Schedule Template Access Permission Elevator Control Permission Access Person Cperation
Public Door Permission Group default All Members [ M
01 default 19211521211 part O m A 2 w
02 default 192.1152.122_1,192.115.2,123_1 dept o m A 2 W

@ Note: The system’s default permission group can be modified for access control devices but cannot be
deleted.

* Edit access control points: Click []| in the Operation column to reselect the access control devices for the
permission group.

* Edit elevator controllers: Click [ in the Operation column to reselect the elevator controllers for the
permission group.

* Edit access persons: Click 'L in the Operation column to reselect the access persons for the permission
group.

¢ Edit permission group: Click /* in the Operation column to edit the permission group name or change a
schedule template.

e Delete permission group: Click 7ii] in the Operation column or select permission groups and click Delete.

13.1.3 Permission Search

View access permissions of persons. In normal situations, after configuring permission groups, personnel
information will be automatically synced to access control devices and elevator controllers; in case of failed
synchronization of personnel information, manual synchronization is also supported.
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Search Member Access Control Point Range: Elevator Control Range

By Name

Sync Status

=l sync £ Refresh | (D) 17no data s selected,all f

Perso Cause

e Search: Select a search method (by name, by person/department, or by building) and enter keywords, set
criteria including access control point(s), elevator controller(s), sync status (succeeded, failed, not synced) as
needed, and then click Search to retrieve the detailed access permission information, such as valid period,
access device, and sync status.

Note:

The validity period of permissions is determined by either the person's validity period or the resident's
residency period. If someone's identity is both a person and a resident with different periods, the most
recently updated period will take precedence.

® Sync to device: Click . for the person or select persons and click Sync to sync the personnel information to
the device.

13.2 Remote Control

Go to Access&Attendance > Access Control > Remote Control.

Remotely controls access control channels (including face recognition terminals, door stations, zone stations,
channels under access controllers, speed gate & turnstile) to open/close door, keep open/closed, and restore.

e Open: Temporarily opens the door for access. The door will automatically close after the person has passed
through.

¢ Close: Manually closes the door.
e Keep Open: Opens the door and keeps it open until manually restored.

¢ Keep Closed: Closes the door and keeps it closed until manually restored. During this status, persons cannot
open the door with verification.

* Restore: Cancels the Keep Open or Keep Closed status.

In scenarios such as emergencies or when someone lacks access permissions, the admin can, based on the actual
situation (e.g., the access control area, number of channels, or the number of people), choose to: 1. select one or
multiple channels for door control; 2. control all doors with one-click; 3. control doors in custom channel groups

with one-click. Flexible channel group management and batch operations enhance response efficiency, allowing
or denying access quickly.

13.2.1 By Default Organization

Manage access control channels by organization.

Go to Remote Control > Default Org. The upper-right side displays the access control channels in the
organization, allowing you to perform door control operations on them. The lower-right side displays pass-thru
records on access control channels.
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Default Org Custom Group O

Al [ Open

[ KeepOpen [& Keep Closed <A Restore Keep AllOpen |~

>

H

Door_1

Total 1 20/page Goto | 1

Succeeded Failed

Open/Close Door
Door control operations: Open, Close, Keep Open, Keep Closed, and Restore.

You can perform these operations on online access control channels one by one or in batches.

Control Selected Channels | 1. Select access control channel(s).
Onl
y e Select All: Select All to select all online channels on the current page.
e Custom Selection: Select online channels one by one or drag the mouse to
select multiple channels from the right-side list.
2. Click Open/Close/Keep Open/Keep Closed/Restore above the right-side list
to control the selected channels.
Control All Authorized Without selecting any channels, simply click Keep All Open/Keep All
Channels Closed/Restore All above the right-side list to control all authorized online
channels in the system.

Pass-thru Records

Only the latest 20 pass-thru records are displayed. By default, the records are from all channels in the system. If
you've selected any channels, only the records from the selected channels will be displayed.

¢ Filter: Select Succeed or Failed to view the corresponding pass-thru records.

* View Details: Click [5! for a record to redirect to the Pass-Thru Records page to view the person's snapshot
information.

13.2.2 By Custom Group

After adding access control channels into Custom Groups, you can perform door control operations on multiple
channels by group with one-click.

Example: Add channels from multiple areas to an emergency group. In an emergency, you can quickly control all
channels in the emergency group to open doors, allowing rapid access for people across different areas.

Go to Remote Control > Custom Group. The upper-right side displays the access control channels in the group,
allowing you to perform door control operations on them. The lower-right side displays pass-thru records on
access control channels.

Open/Close Door

Choose a method to control online access control channels:
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Default Org Custom Group

@

Keep Open
Keep Closed

Restore

Succeeded

Time

2025/03/26 12:30:03

2025/03/26 12:28:21

Keep All Open

Total 1 20/page Goto | 1

Failed

Channel Name Name 3 Person ID Department Authentica... ¥ Authentica... ¥ Card .. 3 Operation

178_1 Face B Succeeded - T

178_1 Face B Succeeded - &l

Control Channels in Multiple
Groups

Select groups from the left-side list, then click [ (Keep Open)/ [2 (Keep

Closed)/ - (Restore) above the left-side list to control all online channels in the
selected groups.

Control Channels in One
Group

Click for a group, then click Keep Open/Keep Closed/Restore in the pop-up
menu to control all online channels in the group.

Control Selected Channels
Only

1. Select access control channel(s).
¢ Select All: Select All to select all online channels on the current page.

e Custom Selection: Select online channels one by one or drag the mouse to
select multiple channels from the right-side list.

2. Click Open/Close/Keep Open/Keep Closed/Restore above the right-side list
to control the selected channels.

Control All Authorized
Channels

Without selecting any channels, simply click Keep All Open/Keep All
Closed/Restore All above the right-side list to control all authorized online
channels in the system.

Pass-thru Records

Only the latest 20 pass-thru records are displayed. By default, the records are from all channels in the system. If
you've selected any channels, only the records from the selected channels will be displayed.

¢ Filter: Select Succeed or Failed to view the corresponding pass-thru records.

information.

View Details: Click [Z! for a record to redirect to the Pass-Thru Records page to view the person's snapshot

13.2.3 Custom Group Configuration

Go to Remote Control > Custom Group. You can group access control channels, which facilitates performing door

control operations By Group.

Name

-+ Add

Group Name
EmergencyGroup
EmergencyExit

1F

Door Reset

Channel Name Remarks Operation

75.1,173.1,178.1 2

173.1,178.1

R

1781,173 1 1231231

R
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Add Group

1. Click Add.
Add Group X
* Name Please enter keywords Remarks Please enter keywords
Door Selected(3) i Clear
7, Please enter keywords — Please enter keyworc

B La
s

un

3. Select organization(s)/access control channel(s) from the left-side list, then click > to add them to the
selected channel list.

4. Click OK.

2. Enter a custom group name and remarks.

Group Management

e Search: Search groups by group name and access control channel.
e Edit: Click / for a group to edit the group name and channels in it.

e Delete: Click 7] fora group or select group(s) and click Delete.

13.3 Access Control Configuration (Access Controller &
Speed Gate & Turnstile)

Go to Access Control > Access Control > Access Control Config.

Configure the parameters of the access controller/speed gate & turnstile device itself.
Note:

The functions described in this section can also be configured via the device's web interface. The Ul display
may vary with device version. For any discrepancies, please refer to the device's user manual.

13.3.1 Device Parameter Configuration

Select the access control device from the device list to configure how it handles verification records.
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Device List

I Record Upload Settings

N Reporting Type Upload All v

.- Storage Mode Stop Recording ® Overwrite

E 192.117.2.92

i

Card Type B General IC Card MIFARE Card

Save

Reporting Type For access control verification records:
e Upload All: Includes both successful and failed verification records.

e Upload Successful Records

Storage Mode When verification records reach the device's storage limit:
e Stop Recording: Stops receiving new records.

e Overwrite Recording: New records overwrite the earliest records.

Card Type Select the card type supported by the access control device for verification (General IC
Card, MIFARE Card). Single choice.
MIFARE cards allow key configuration to encrypt sectors and prevent card data leakage.

13.3.2 Door Parameter Configuration

In the device list, select the access control device to configure the opening and closing parameters for the door

channel.
Device List
Door Channel | Door Parameter Config
0t D DoorChannel1
@] poorChannel2 Door Name DoorChannel1
5192‘1172‘92 D DoorChannel? Door Opening Duration(s) 5
D DaoorChannel4
Exit Button Type N.O.
Door Opening Timeout(s) 10
Auto Door Lock Upon Closing »
Door Magnet Type N.C.
Exceeding Maximum Authentication Att... |0
Super Password @
Duress Code @
Copy To Select Al
[DoorChannel?2  [JDoorChannel3  [(DaarChannel4
Parameter Description
Enter a custom name. Door names under the same access control device should be
Door Name .
unique.
Door Opening The duration for a single door opening operation. The door will automatically close
Duration after this set time elapses.
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Parameter

Description

Exit Button Type

Select based on the type of the connected button.

¢ N.O. (Recommended): Circuit is open when the door is closed; pressing the button
closes the circuit and triggers opening.

e N.C.: Circuit is closed when the door is closed; pressing the button opens the circuit
and triggers opening.

Door Opening
Timeout

An alarm will be triggered if the door remains open beyond the set time.

Set to 0 to disable this alarm.

Auto Door Lock upon
Closing

The door lock will engage immediately after closing, even if the set lock action time has
not been reached.

Door Magnet Type

Select based on the type of the connected door lock.

¢ N.O.: Connected to an electric strike lock. Circuit is open when the door is closed
and closed when the door is open.

e N.C.: Connected to an electromagnetic lock. Circuit is closed when the door is
closed and open when the door is open.

Exceeding Maximum
Authentication
Attempts

An alarm will be triggered when consecutive failed card swipe attempts reach the set
value.

Set to 0 to disable the alarm.

If Alarm Linkage Configuration is completed, a corresponding alarm action will be
triggered.

Super Password

This password can open the door with any verification method. Do not disclose the
password.

Duress Code

When under coercion, entering this code will open the door and the device will report
a duress event to the platform.

Copy To

Select other door channels to copy the current configuration to the selected door
channels upon saving.

13.3.3 Verification Template Configuration

Verification templates define how the device performs verification during different time periods. Pre-configuring
templates allows you to bind them to multiple door channels separately, enabling quick deployment of

verification methods.

1. Select an access control device from the device list to view the configured verification template.
The system includes a pre-set default verification template that is active 24/7; it can be modified but not

deleted.

Device List

ot

=]

*Template Name default

default
Mon Tue Wed Thu Fri Sat Sun

Time Intervall 00:00:00 - 23:59:59 Card, Password
Time Interval2
Time Interval3
Time Intervald
Time Intervals
Time Intervale
Time Interval?

Time Intervald

Copy To Select Al
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2. Click 4+ to add a template, or select an existing template to modify it.

Time Period Time periods on the same day cannot overlap.
Verification Multiple verification methods can be selected simultaneously.
Method e Card: Verification is successful when the swiped card number matches the number
assigned to the person in the library.
e Password: Verification is successful when the entered password is correct.
e Card+Password: Verification is successful when the card number matches AND the
password is correct.
Copy To After setting the verification method for a specific day, select other dates to copy the
current settings to them upon saving.
3. Click Save.

13.3.4 Door Verification Configuration

Bind card readers to door channels and assign verification templates to the card readers.

Select an access control device from the device list, then select a door channel to view its card readers (by
default, one entry and one exit reader are pre-configured; parameters can be modified as needed).

Device List

Door Channel + Add [ Delete O Refresh
[ Doorchannelt Card Reader Channel Name Direction Check Template Card Reader Operation
[ poorchannel2
ReaderChannel1 Enter default WiegandReader1,485CardReader1 2 W
[ Doorchannel3
[ DoorChannel4 ReaderChannel2 Exit default WiegandReader2,485CardReader2 2 W

Add Card Reader Channel

The card reader must be physically connected to the Wiegand or RS-485 interface on the access control device.

Click Add, configure the settings according to the table below, then click Save.

Door Channel

D DoorChannel1
D DoorChannel2
D DoorChannel3

D DoorChannel4

| Basic Info
Card Reader Cha...
Direction ® Enter Exit
Check Template ... | default -

| Card Reader binding

-+ Bind 1 Delete
Card Reader Protocol Port Mode Format Tamper Detection  Operation
485CardReader2 . - RS485 Card Reader Ascending Order Disable £

Save Cancel

Card Reader
Channel Name

Enter a custom name.

Direction

Enter or exit.

Check Template
Binding

Select a Verification Template.

Card Reader
Binding

Click Bind and select the card reader type (Wiegand or RS-485) based on the actual wiring.
Click the ./ corresponding to the card reader to modify its protocol parameters.
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Modify Reader

Click the /7 corresponding to the card reader channel to modify parameters such as its verification template and

bound devices.

Delete Reader

Click the Ti] corresponding to the card reader channel and confirm the deletion.

13.3.5 External Device Configuration

485 Serial Port Configuration

Device List

485 Serial Port Configuration  Wiegand Interface QR Code
RS485 2 >
o I Rs435
e | Rs485 3 >
I N
B 2162161701 | RS485 External Device Config ~
£ External Device
RS485 Address  External Device Name  Serial Port ID Port Modle Format Tamper Detection  Operation
2 485 Card Reader1 - IC Card Reader  Ascending Order Disable =z
3 485 Card Reader2 - IC Card Reader  Ascending Order Disable 2

Save

¢ Modify the data transmission parameters for RS485_2 and RS485_3; generally, using the system default
values is sufficient.

e Configure the card readers connected to RS485_ 2 and RS485_3.

Parameter Description

Card Reader Name Enter a unique custom name.

e Disable: The port mode is disabled.
Port Mode e IC card reader: Connects an IC card reader.

¢ QR code reader: Connects a QR code reader.

Port Number When the serial port mode is set to QR code reader, this parameter must be
configured and must be unique.

e Ascending order: The card number sequence is the same as the sequence read
by the card reader

Format
e Descending order: The card number sequence is the reverse of the sequence
read by the card reader.
Tamper Detection When enabled, an alarm will be triggered when card reader tampering is detected.
Copy To Used to apply the same settings to other card readers.

Wiegand Interface Configuration

Configure the card reader connected to the Wiegand interface.
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Device List 485 Serial Port Configuration  Wiegand Interface QR Code

IA @t Wiegand Interface
Wiegand Port Card Reader Name Protocol Format Tamper Detection Operation
I
B 216216701 0 Wiegand Card Reader 1 Wiegand 34 Ascending Order Disable d
1 Wiegand Card Reader 2 Wiegand 34 Ascending Order Disable a
Parameter Description
Card Reader Name Enter a unique custom name.
e Wiegand 26: Card numbers are read using the Wiegand 26 protocol (only reads 3-
byte card numbers).
¢ Wiegand 34: Card numbers are read using the Wiegand 34 protocol (only reads 4-
Protocol
byte card numbers).
e Custom Wiegand: Protocols used by Wiegand card readers other than 26 and 34
(configuration rules need to be set in the device interface).
e Ascending order: The card number sequence is the same as the sequence read by
the card reader
Format . .
¢ Descending order: The card number sequence is the reverse of the sequence read
by the card reader.
Tamper Detection When enabled, an alarm will be triggered when card reader tampering is detected.
Copy To Used to apply the same settings to other card readers.
QR Code Configuration

With QR code detection enabled, in the card number verification mode, personnel can scan the card number QR
code on a QR code reader for verification.

Note:
The platform currently does not support generating card number QR codes.

485 Serial Port Configuration  Wiegand Interface QR Code

QR Code Detection .

Mote: Require card authentication

OR Code Protocal (8 Privat Third Party

13.3.6 Event Input Configuration

T
T

After an alarm detector is connected to the access control device, the event input interface status can be
configured according to the detector's operation mode.

e N.O.: In the default state, the circuit between the alarm detector and the access control device is open. When
an abnormal event is detected, the circuit closes and the access control device reports an alarm.

¢ N.C.: In the default state, the circuit between the alarm detector and the access control device is closed.
When an abnormal event is detected, the circuit opens and the access control device reports an alarm.
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Note:
The number of interfaces varies among different models of access control devices. Please refer to the Ul for
accurate information.

I Event Input Configuration

Emergency Port N.O. N
Event Input Port 1 MN.C. N
Event Input Port2 | N.O. N
Event Input Port 3 | N.O. N
Event Input Port4 | N.O. N
Event Input Port5 | N.O. N
Event Input Port & | N.O. N
Event Input Port7 | N.O. N
Event Input Port 8 | N.O. N

Save

13.3.7 Alarm Report Configuration

Configure whether access control devices, door channels, and card readers report alarms to the platform.

Note:
Please subscribe to alarms from the corresponding devices on the User Subscription page on the platform.

Device List
- B8 Access Control Device . When enabled, the corresponding alarm event will be reported to
o . J]DoorChanneH Linkage Type Alarm Type Event Type Enable the platform
~ [E wiegandReader1
Abi | D
[E\ 485CardReader1 Linkage Configuration Door Alarm nofma oo
deot ! + [l DoorChannel2 Opening Alarm
dept 2 [B WiegandReader3 Linksoe Confiaurats Door Al Door Opening Timeout
%mzwwzgz (2485 CordReadier inkage Configuration oor Alarm Alarm
‘WiegandReader4
gwsg dReaderd Linkage Configurati Door Al Hormal Door Magnet
ardReader: inkage Configuration oor Alarm Opening
v J]DoorchanmsB
Normal Door Magnet
[BWiegandReader5 Linkage Configuration Door Alarm 9
[E)485CardReaders Closing
[AwiegandReaders Likone Confioati oo Al Authentication Over
[B)485CardReadert inkage Configuration oor Alarm Limit Alarm
+ [l DoorChannel4
[E wiegandReader7
[E\485CardReader?
[E WiegandReader8
[B485CardReader8
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1. Select an access control device, door channel, or card reader on the left to view its corresponding event
types. The event types for these three are different and should be configured separately.

2. Click to enable alarm reporting; click @[ ) to disable alarm reporting.

13.3.8 Alarm Linkage Configuration

When specific events occur, the linked access control device will perform a series of actions. For example: when
an alarm is triggered, the access control controller will sound a buzzer and open the door.

Device List

Event Type | All Keywords Reset
ot + Add [ Delete
Linkage Type Event Type Event Name Linkage Target Operation
Event Linkage Device Alarm Fire Alarm Access Control Point 2 W
Event Linkage Device Alarm Fire Alarm Cleared Access Control Point 2 W
Total 2 item(s) item(s) 1/1 Page JumpTo |1 Page

Add Linkage Configuration

Up to 30 linkage configurations can be added (including 2 default configurations: fire alarm keeps the door open,
fire alarm cleared closes the door).

1. Click Add to go to the page as shown below. Currently, only Event Linkage is supported as the linkage type.

> Add Alarm Linkage Info

I Event Source

Linkage Type @ Event Linkage
*Event Type Device Alarm M *Alarm Type Device Tamper Alarm M
| Linkage Target
Buzzer Alarm Output Access Control Peint
Access Controll... On off @ k
Card Reader Bu... Linkage Name Linkage Status
. TP Buzzer
WiegandReader1 . Off ® Not Link Duration s
- e () Buzzer
WiegandReader2 on Oft @ Not Link Duration s
H - e = Buzzer
WiegandReader3 . Off ® Not Link Duration s
. TP Buzzer
WiegandReader4 . Off ® Not Link Duration s
- e () Buzzer
WiegandReader5 on Oft @ Not Link Duration s

Cancel

2. Select the event type and the corresponding alarm type.

Event Type Alarm Type Description

Device Alarm The access control device itself triggers alarms.
Device Tamper Alarm The access controller is opened.
Fire Alarm Fire hazards such as smoke or flames are detected.
Device Tamper Alarm Cleared The device tamper alarm stops.
Fire Alarm Cleared The fire alarm stops.

Door Alarm Alarms triggered by doors connected to the access controller.
If this type is selected, please also specify the corresponding door channel. To
configure alarm linkage for multiple door channels, add them one by one.
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Event Type

Alarm Type

Description

Door Magnet Alarm

Alarm triggered by an unconventional door
opening signal.

Door Opening Timeout Alarm

Alarm triggered when the door remains open
beyond the timeout period set in door parameter
configuration.

Normal Door Magnet Opening
Alarm

Door is opened normally via the magnetic sensor.

Normal Door Magnet Closing
Alarm

Door is closed normally via the magnetic sensor.

Authentication Over Limit Alarm

Alarm triggered when the number of consecutive
failed card swipes reaches the set limit.

Card Reader Alarm

Alarms triggered by card readers connected to the access control device.

If this type is selected, please also specify the corresponding card reader and event
input port. To configure alarm linkage for multiple card readers and input ports, add

them one by one.

Card Reader Tamper Alarm

The card reader enclosure is opened.

Duress Alarm

A duress code is used to unlock the door.

Unauthorized List Alarm

An alarm triggered when an unauthorized person
swipes a card.

Card Reader Tamper Alarm
Cleared

The card reader tamper alarm stops.

Event Input Alarm

Only applicable to pedestrian speed gates & turnstiles.
Event alarms triggered by alarm detectors connected to the access control device.

Event Input Alarm

Event detected

Event Input Cleared

Event cleared

3. Set linkage targets.

Buzzer: Can trigger the access controller itself or externally connected card readers to beep. Linkage status

includes On (activate buzzer), Off (deactivate buzzer), Not Link (no linkage).

Buzzer Alarm Qutput

Access Contrall... @ Or

Card Reader Bu... Linkage Name Linkage Status
WiegandReader1 on Off @ Not Lin
WiegandReader2 on Off @ Not Lin
WiegandReader3 on Off @ Not Lin
WiegandReader4 on Off @ Not Lin
WiegandReader5 on Off @ Not Lin

Access Control Point

Cancel

Buzzer
Duration

Buzzer
Duration

Buzzer
Duration

Buzzer
Duration

Buzzer
Duration

e Access controller buzzer: The access controller itself emits a beep. The built-in buzzer sounds 30 times,
and the buzzer duration cannot be configured.

e Reader buzzer: A card reader physically connected to the access controller emits a beep. After
selecting On as the linkage state, the buzzer duration must be set.

Alarm Output: If output devices such as alarm lights are connected, alarm output linkage can be
configured. Linkage status includes On (activate alarm output), Off (deactivate alarm output), Not Link (no

linkage).

After selecting On as the linkage state, the alarm output duration must be set.
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Buzzer Alarm Output Access Control Point

Alarm Output Linkage Name Linkage Status
Alarm Qutput 1 ® On Off Not Link Duration | 1 s
Alarm Output 2 ® on Off Not Link Duration |1 s
Alarm Output 3 @ On Off Not Link Duration | 1 s
Alarm Output 4 ® On Off Not Link Duration |1 s
Alarm Qutput 5 ® oOn Off Not Link Duration | 1 s
Alarm Output 6 ® on Off Not Link Duration |1 s

Cancel “

e Access Control Point: The linkage status includes On (activate), Off (deactivate), N.O. (keep open), N.C.
(keep closed), Restore Keeping Open/Closed (cancel keeping open/closed).

Buzzer Alarm Output Access Control Point

Access Control ... Linkage Name Linkage Status
DoorChannel1 ® On Off N.O N.C Restore Keeping Open/Closed Not Link
DoorChannel2 On Off N.O. N.C Restore Keeping Open/Closed @® Not Link
DoorChannel3 ® on Off N.O N.C Restore Keeping Open/Closed Not Link
DoorChannel4 On Off N.O N.C Res Open/Closed ® Not Link

Cancel “

4. Click Save.

13.4 Advanced Configuration

Go to Access&Attendance > Access Control > Advanced Configuration.

Configure advanced verification rules for access control.

13.4.1 Door Configuration(General Access Control)

Go to Access Control > Advanced Configuration>Door Configuration.

Note:
Only general access control devices support this configuration.

Configure abnormal door opening alarm parameters. When the door is opened abnormally, an alarm will be
reported to the platform.

Select an general access control device in the Door list and configure it.
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Channel Name:

= all Door Opening Timeout{s): 60

j‘ O 188-£.94
|j| 192 W8.4.94 AC 1 Duress Code:
W 19248404 AC 2
m 192.1 4 AC 3 Authentication Owver Limit Threshold: 5
W 102 | AC 4

@ 192,158,487 Abnormal Door Opening Alarm: .

[ s
Item Description

Door Opening Timeout(s)

After being set, if the door open duration has reached the limit, a door opening
timeout alarm will be reported.

Duress Code

Set the duress code (0-8 digits). If an abnormal situation occurs, people can open
the door using the duress code and the access control will trigger a duress alarm.

Authentication Over Limit
Threshold

After being set, if the number of failed attempts to open the door has reached the
threshold, an authentication over limit alarm will be reported.

Abnormal Door Opening
Alarm

When enabled, an alarm will be reported when the door is opened abnormally.

13.4.2 Multi-Factor Authentication (Access Controller & Speed

Gate & Turnstile)

Multi-factor authentication is an access control mechanism that requires multiple individuals to be present
simultaneously and all authenticate successfully before access is granted. This mechanism is commonly used
in high-security locations (e.g., banks, warehouses), leveraging mutual supervision among on-site personnel to
ensure the safety of funds, valuables, important documents, etc., within the premises.

Multi-factor authentication requires the configuration of personnel groups (assign multiple individuals with
the same identity into a group), authentication groups (configure the door channel, personnel groups requiring
simultaneous authentication, and effective time slots).

For example: If an authentication group is configured with two personnel groups: Group A requires at least 2
individuals present simultaneously, and group B requires at least 3 individuals present simultaneously. The door
will only unlock after both groups successfully complete verification in sequence.

13.4.2.1 Personnel Group Configuration

Group individuals with the same identity to facilitate the selection of personnel groups when configuring
authentication groups, enabling rapid configuration of authentication rules.

Personnel Group Config Authentication Group Config

+ Add & Refresh

Group Three

Add Personnel Group
1. Click Add.

5]

R
&}
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Add Personnel Group X

* Personnel Group M

Person/Group (1) Selected(3) £y Clear

J

Flease enter keywords 7 Flease ent

. -
|} ﬁ dep -a
- -

as Emma an James
-
-~

-
as Bob

i

Ll B
aa Daniel
Ll a
an Matthew
-
& Henry
-
aw Grace
Ll .

aa Lily
-

an James
-

aa John

-
aun William

2. Enter the group name, and select personnel.

[®p Note:
Each personnel group allows up to 100 people.

3. Click OK.

Personnel Group Management
* Edit: Click 4 to change the group name and personnel.

* Delete: Click 7iij, or select personnel groups, and then click Delete.

13.4.2.2 Authentication Group Configuration

An authentication group consists of door channels, personnel groups, and validity periods. Multiple personnel
must successfully pass verification simultaneously at the door channel before the door can be opened.

Personnel Group Config ~ Authentication Group Config
+ Add

Doo Access Controller Validity Per € Enable Authenticati.. & Operati

Doy 102117202 « s W B

192.117.282

Add Authentication Group
1. Click Add.
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< Add

I Basic Config

~ Deor Channel DoorChannel3
* Authentication Inte.. | 10 Second(s)
| Authentication Group Config  Note: An authentication group allows up to 8 personnel groups, with a total of no more than 16 concurrent authentications.
Enable Authenticati... c
Schedule Template default Validity Period 2025-09-28 09:44:22 - 2025-09-28 23:59:59
Group Member
+ Add
Personnel Group ¥ Concurrent Authentications w Operation
Group One E m
Group Two 2 )
Cancel
Parameter Description

Door Channel

Select a channel under the access controller/speed gate & turnstile (single selection
only).

E Note:
Each channel can only be assigned to one authentication group. Channels already
assigned to an authentication group will not be displayed in the device list.

Authentication
Interval

All required personnel must complete authentication within a specified time interval
of N seconds. Authentication is considered invalid if this interval is exceeded, and the
process must be restarted.

Enable
Authentication
Group

The authentication group will only take effect after being enabled.
If immediate activation is not required, you may choose not to enable it now and
modify this setting later.

Schedule Template

Select a Schedule Template to set the daily access permission effective time.

Validity Period

Set the active time period for the authentication group.

E> Note:
If the authentication group is outside its validity period, all verification attempts
will fail.

Authentication
Group Members

(1) Click Add to add a personnel group.

(2) Select personnel groups. For each personnel group, specify the number of
individuals required to authenticate simultaneously (this number must be less than
or equal to the total members in the group).

E> Note:
An authentication group can contain up to 8 personnel groups, and the total
number of people that require simultaneous authentication across all groups
cannot exceed 16.

2. After completing the configuration, click Finish.

The system will automatically sync the authentication group information to the door channels.

Authentication Group Management

For successfully synced authentication groups, the following operations are supported:
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* Enable/Disable: Click (7 to enable; click @) to disable. The group will be re-synced after status
modification.

* Edit: Click 4 to modify authentication group information. The updated configuration will be re-synced after
the modification.

* Delete: Click [iij, or select authentication groups and click Delete.

e Copy: Click [Z] to open the door channel list. Select target door channel(s) to copy the current authentication
group configuration. The corresponding authentication group(s) will be created in the list.

OB 102117292
m DoorChannel3
m CoorChanneld

13.4.3 Anti-Passback (Access Controller & Speed Gate &
Turnstile)

Anti-passback includes two types of rules:

e Area anti-passback: Card swipe records must strictly follow an "in-out" or "out-in" sequence.
Example: If a premises has an entrance and an exit, a person who has entered but not yet exited will be
unable to enter again through the entrance (prevents multiple individuals using one card). The same logic
applies to the exit.

I enter—exit—enter
en_'@; _ A R _ enter—enter ©
1 exit—exit Q)

¢ Route anti-passback: Individuals must swipe their cards at readers in a specified sequence.
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Example: If personnel are required to enter a warehouse in the order of Door A - Door B = Door C, they will
be unable to proceed to the next door if they bypass any door (tailgating) or re-authenticate at a door that
has already been passed (proxy authentication).

enter |_ (| |—
A=l -0 -[
Walk along the route. §|

The system supports both single-controller anti-passback (configure rules for door channels under a single
access controller) and cross-controller anti-passback (configure rules for door channels across multiple access
controllers).

13.4.3.1 Single-Controller Anti-Passback

Configure area anti-passback or route anti-passback for door channels under a single access controller.

Add New Rule
1. Click Single-Controller Anti-Passback.

2. Select an access controller/speed gate & turnstile, then click Next.
< Add Single-Controller Anti-Passback

Select Access Control Device Set Anti-Passback Rule

Device List

3. Configure the anti-passback rule.

* Area anti-passback
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Select Access Control Device
* Anti-Passhack Rule

* Time Template

Configure Card Reader

Cancel

nneld

Set Anti-Passback Rule

Area Anti-Passback

default

Back

Parameter Description

Time Template

Select a Schedule Template to define the daily access permission effective time.

Configure Card
Reader

[ Note:

Enable at least one entry card reader and one exit card reader.
If multiple card readers are enabled, personnel may enter through any entry reader
and exit through any exit reader.

The first authentication does not distinguish between entry and exit directions.
After the initial successful authentication, subsequent verifications will perform
anti-passback validation based on the previous entry/exit direction.

Route anti-passback

Select Access Control Device Set Anti-Passback Rule
* Anti-Passback Rule Route Anti-Passback
* Time Template default
* First Card Reader Not Configured
Configure Card Reader
e fer Enable Anti-Passback
192.117.2.92_EntryReadert [ @)
nanneld 192.117.2.92_ExitReaderCl -+ ()
4 2. 192.117.2.92_ExitReaderCt | *=*
nnele e
7 nnel
Parameter Description

Time Template

Select a Schedule Template define the daily access permission effective time.

First Card Reader |
route.

times.

First card reader not set: Card swiping can start from any card reader in the

Non-closed routes (e.g., 1-2-3-4): Each person can pass through only once.

Closed routes (e.g., 1-2-3-4-1): The same person can pass through multiple
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Parameter Description

e First card reader set: Card swiping must start from the first card reader.
Personnel may exit from any reader in the route and restart from the first reader
at any time (e.g., for route 1-2-3-4, sequence 1-2-3-1 is also allowed).

Configure Card (1) Select subsequent card readers (multiple selections allowed) to form the route.

Reader
(2) All readers in the route must have anti-passback enabled; otherwise, subsequent

segments of the route will not function properly.

4. Click Finish to save and automatically sync the rule to the access control device.

13.4.3.2 Cross-Controller Anti-Passback

Configure area anti-passback or route anti-passback for door channels under multiple access control devices.

Add New Rule
1. Click Cross-Controller Anti-Passback.

2. On the Main Controller tab, select an access controller/speed gate & turnstile as the main controller.
On the Sub Controller tab, select one or multiple access controllers/speed gates & turnstiles as the sub
controller.

@ Note:

Some access controllers with lower specifications cannot be used as the main controller.

< Add Crass-Controller Anti-Passback

Select Access Control Device

Device List Main Controller Sub Controller

@ Only one main controller can be selected.

fal . il A e &

Access Co... w Organizati.. +

Cancel m
3. Click Next.
4. Configure the anti-passback rule.

e Area anti-passback
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Select Access Control Device
* Anti-Passhack Rule

* Time Template

Configure Card Reader

Cancel

nneld

Set Anti-Passback Rule

Area Anti-Passback

default

Back

Parameter Description

Time Template

Select a Schedule Template to define the daily access permission effective time.

Configure Card
Reader

[ Note:

Enable at least one entry card reader and one exit card reader.
If multiple card readers are enabled, personnel may enter through any entry reader
and exit through any exit reader.

The first authentication does not distinguish between entry and exit directions.
After the initial successful authentication, subsequent verifications will perform
anti-passback validation based on the previous entry/exit direction.

Route anti-passback

Select Access Control Device Set Anti-Passback Rule
* Anti-Passback Rule Route Anti-Passback
* Time Template default
* First Card Reader Not Configured
Configure Card Reader
e fer Enable Anti-Passback
192.117.2.92_EntryReadert [ @)
nanneld 192.117.2.92_ExitReaderCl -+ ()
4 2. 192.117.2.92_ExitReaderCt | *=*
nnele e
7 nnel
Parameter Description

Time Template

Select a Schedule Template define the daily access permission effective time.

First Card Reader |
route.

times.

First card reader not set: Card swiping can start from any card reader in the

Non-closed routes (e.g., 1-2-3-4): Each person can pass through only once.

Closed routes (e.g., 1-2-3-4-1): The same person can pass through multiple
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Parameter Description

e First card reader set: Card swiping must start from the first card reader.
Personnel may exit from any reader in the route and restart from the first reader
at any time (e.g., for route 1-2-3-4, sequence 1-2-3-1 is also allowed).

Configure Card (1) Select subsequent card readers (multiple selections allowed) to form the route.

Reader
(2) All readers in the route must have anti-passback enabled; otherwise, subsequent

segments of the route will not function properly.

5. Click Finish to save and automatically sync the rule to the access control device.

13.4.3.3 Rule Management

Access Control Name Anti-Passback Type | All Anti-Passback Rule | All Status All

Anti-Passback Type » Anti-Passback Rula 3 Sub Controller 3 Status ¢ Cause Operation

Access Controller Single-Controller Anti-Pa. Ares Anti-Passhack - ® succeeded Vi 0]

e Search: Enter keywords for access controller/speed gate & turnstile names, select an anti-passback type
(single-controller or cross-controller), anti-passback rule (area, route), and status (successful, failed, syncing,
configuration error), then click Search.

® Edit: Click ./ to modify the anti-passback rule. The updated configuration will be re-synced after changes are
made.

* Delete: Click iij, or select anti-passback rules and click Delete.

13.4.4 Multi-Door Interlocking (Access Controller & Speed Gate
& Turnstile)

Multi-door interlocking refers to a configuration where multiple doors form an interlocking combination. Within
this combination, only one door can be open at any given time; all other doors must remain closed.

Depending on the capabilities of the access controller or speed gate & turnstile, common configurations include
2-door interlock, 3-door interlock, and 4-door interlock.

Example: If door channel A and door channel B form a 2-door interlock, when door A is open, door B cannot be
opened using regular credentials by anyone.

This function is typically used in locations requiring high security or where ventilation needs to be controlled,
such as bank vaults or pharmaceutical enterprises.

Device List
+ Multi-Door Interlocking W Delete

E2

Interlocking Combination

DoorChannel1,DoorChannel2

DoorChannel3,DoorChanneld

Add Multi-Door Interlocking
1. Inthe device list, select the access control device and click Multi-Door Interlocking.

2. Select at least 2 access control points for interlocking.
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| Add
Please select at least two access control points for interlocking.
DoorChannell
DoorChannel2
DoorChannel3

DoorChanneld

Delete Multi-Door Interlocking

3. Click OK.

Select the multi-door interlocking configuration, and then click Delete.

Important Notes
¢ Interlocked doors cannot be set to Keep Open.

e Super Users are not restricted by interlocking rules and can open doors directly.

13.4.5 Keep-Open/Closed Schedule

Configure keep-open/closed schedules for access control devices (including face recognition terminals, door
stations, zone stations, access controllers, speed gate & turnstile).

Keep-open During the effective time period, the door opens automatically and keeps open, allowing
periods personnel to pass without verification.

If the door is manually closed during the keep-open period, it will keep closed until manually
opened again and then keep open.

Keep-closed During the effective time period, the door closes automatically and keeps closed, preventing
periods personnel from verifying and opening the door.

If the door is manually opened during the keep-closed period, it will keep open until
manually closed again and then keep closed.

Other periods Personnel must verify to open the door, and the door will close automatically after
personnel pass through.
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Schedule List + o
* Template Name ~ keep_open Remarks

keep_open Linked Access Control Device Note: Deleting offline device will not clear its keep-open/closed schedule.

+ Add

Keep-Open/Closed Period Configuration Note: White-No schedule, verification required: Green-Keep open, verfication not required: Red-Keep dlosed, no access even verified

Normal Keep-Open/Closed Holiday Keep-Open/Closed
2 it £ Clear

s+ 5 8 10 12 6 18 2 2 2 & No Schedule
Keep Open

W Keep Closed

Configure Keep-Open/Closed Schedule

1. Clickthe 4 after the schedule list to add a schedule template; or select an existing schedule template to
modify.

2. Enter the template name and the remarks (optional).

3. Link access control devices.

e Click Add, select the access control devices that need to apply the schedule template, and click OK.

Add Linked Access Control DeviceSelected(1) X

* Click 71 to sync the schedule template to the selected access control devices.

® Click (| = to enable the schedule; only when enabled will the keep-open/closed schedule take effect on
the access control devices.

* Click 1] to delete an access control device; deleting an online access control device will also delete the

device's keep-open/closed schedule, while deleting an offline access control device will not delete the
device's keep-open/closed schedule.

4. Configure keep-on/closed periods.

¢ Normal Keep-Open/Closed: Configure keep-open/closed periods for Monday through Sunday.
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Normal Keep-Open/Closed Holiday Keep-Open/Closed

0 Z Edit

Sun

B5 Clear e

18 20 22 24 & Mo Schedule

(v )0

W Kesp Closed

=]
"

[ [ [ [T [ [
[ [ [T ] [

Save

No.

Description

1

Two methods are available to set keep-open/closed periods:

¢ Click Keep-Open, Keep-Closed, No Schedule, and click or drag to draw keep-open/keep-
closed/no-schedule time periods on the calendar, with each cell representing one hour.

[ Note:
White indicates no schedule and verification is required for door opening, green
indicates keep-open without verification, and red indicates keep-closed where
verification will not open the door.

¢ Click Edit to manually select time periods and the corresponding keep-open/keep-closed
types, with precision to seconds. You can set up to 8 periods per day.
After setting the schedule for a day, you can select other days and then click Copy to
quickly apply the schedule to other days.

Mon Tue Wed Thu Fri Sat Sun

No. Start Time End Time Schedule Type

1 08:00:00 c 18:00:00 ¢ Keep Open .

Fa
r
T

Keep Open -

Keep Open r

L
r
r

4 t e Keep Open -
5 ¢ C Keep Open v
6 c = Keep Open -
7 e C Keep Open v
8 t e Keep Open -

Copy To: Al
BT Ewed METhe M Msst Esun Copy

2

Click Clear will remove all the configured periods from the current template.

(Optional) Holiday Keep-On/Closed: Configure keep-on/closed periods on holidays.
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MNormal Keep-Open/Closed Holiday Keep-Open/Closed

Select Holiday (1/1... ¢ Mew Year >

& Edit By Clear

New Vear [l N & No Schedule

Keep Open

W Keep Closed

No. Description
1 Click Select Holiday, select holidays, and then click OK.
-+ Add Please enter the content
Heliday Mame % Holiday Period % Day(s) = Repeat by Year &
10/01 - 10/08 E] e
2 Two methods are available to set keep-open/closed periods:
¢ Click Keep-Open, Keep-Closed, No Schedule, and click or drag to draw keep-open/keep-
closed/no-schedule time periods on the calendar, with each cell representing one hour.
o Click Edit to manually select time periods and the corresponding keep-open/keep-closed
types, with precision to seconds. You can set up to 8 periods per day.
3 Click Clear will remove all the configured periods from the current template.
5. Click Save.

13.4.6 Door Opening Mode Configuration(Face Recognition
Access Control)

Configure the "all-day authentication + exception period authentication" door opening mode for face recognition
access control devices in batches by group. If not configured, the device's default mode will be used.

Group Name All-Day Authentication Mode Access Control Range
+ Add Note: If not configured, the device's default mode will be used. All-day authentication + exception periods authentication are supported.
Group Name Access Control Range All-Day Authentication Mode % Door Opening Period 1 Door Opening Period 2 Door Opening Period 3 Remarks Operation
Doorl 216.216.160.159 Face Recognition 00:00:00-06:00:00(Re.... - - 4 7_7'

Configure Door Opening Mode
1. Click Add. The Add page appears.

2. Add device groups to facilitate batch configuration of devices by group.
Enter a group name, select the access control devices, and click Add to add them to the selected devices list.
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Add X

N\
1 ]
(1) @

Device Group Configuration Door Opening Mod

5
W
o

* Group Name | Door1 I Remarks
Access Control Device Selected(1) _Iﬁl Clear
r keyv Please enter keywords
216.216.160.159
B 515216160159
>
<
3. Click Next, configure door opening modes.
Add X
N
) o
Device Group Configuration Door Opening Mode Configuration
Default All-Day Configuration (00:00:00~23:59:59)
Door Opening Mode Authentication (®) Face Recognition Remote Door Opening Automatic Door Opening
Exception Period Configuration
—+ Add MNote: Exception periods will use the door opening modes configured below; up to 3 exception periods...
Door Opening Period Door Opening Mode Operation
00:00:00 - 06:00:00 ® Remote Doar Opening - Tl

(1) Select the default door opening mode for all-day:
e Authentication: The door opens only after the person passes the authentication.

* Face Recognition: The door opens immediately when the access control device captures a face,
without verifying permissions.

¢ Remote Door Opening: The access control device reports the person information to the platform, and
the platform remotely controls the door opening based on the authentication result.

e Automatic Door Opening: The system tries remote door opening first. If no authentication is returned
three consecutive times via the remote door opening mode, the system uses the local authentication
mode for judgment.

(2) (Optional) Click Add to add a door opening mode for exception periods.
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¢ Up to three exception periods can be configured.

e During exception periods, the door opening mode configured for exception periods will be used for

door opening.

4. Click OK. The selected devices will use the configured door opening mode during the specified time periods.

More Operations

Edit or delete door opening mode groups as needed.

¢ Edit a door opening mode group: Click the corresponding * in the Operation column to edit the door

opening mode group.

¢ Delete a door opening mode group: Select door opening mode groups and then click Delete on the top to
delete the selected door opening mode groups; or click the corresponding 7| in the Operation column to
delete a door opening mode group.

13.5 Face Recognition Access Control Configuration

Go to Access&Attendance > Access Control > Face Recognition Access Control Configuration.

Configure face recognition access control parameters on the platform and sync them to the devices with one
click. You can also copy the settings from a device to other devices for batch configuration.

13.5.1 Face Library Configuration

Configure parameters such as verification templates for the face library.

1. Select a face recognition access control device from the device list.

Access Control Device

[

Copy To

Staff Library Visitor Library

Verification Template Configure Verification Template

Face 1:N Matching Threshold —————————) 83

Fingerprint 1:N Matching Threshold  e—————) 82

Infrared 1:N Matching Threshold ————————— 86

Linkage Actions on Successful Verification

Open Door Status Indicator Display Audio Message Local Screen Display Wiegand Output Bluetooth Output

Linkage Actions on Failed Verification

Status Indicator Display Audio Message Local Screen Display

Save

2. Refer to the table below to configure the parameters.

Table 13-1: Configuration Description

Parameter

Description

Library Type

e Employee Library: For long-term personnel, such as property owners,
security guards, etc.

e Visitor Library: For temporary personnel.
[ Note:

When configuring verification templates, face & ID card verification cannot
be enabled simultaneously for both the employee library and visitor library.

Verification Template

Configure verification templates for the week (Monday to Sunday).

Click Configure Verification Template to go to the configuration page.
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Parameter

Description

Configure Verification Template X
m Tue Wed Thu Fri Sat Sun

Time Period1 | 00:00:00 C 23:59:59 Face and ID Card Picture Match % CardNo. X ~
Time Period2 C Selact verification mathod
Time Period3 C Selact verification method
Time Period4 C Selact verification method

Time Period5 C Select verification method

Tue Wed Thu F Sat Sun Copy

“ Cancel

e Set verification time periods for each day. The start time of each time period
must not be later than the end time. Up to 8 non-overlapping time periods
can be configured per day.

e Supported verification methods: Face & ID Card Verification, Number
Allowlist, Face Allowlist, Password, Face & ID Card + Number Allowlist,
Number + Face Allowlist, Password + Face Allowlist, Fingerprint Allowlist,
Face Allowlist + Fingerprint.

¢ A maximum of three verification methods can be configured simultaneously
within a single time period.

e After setting the verification schedule for one day, you can select other days
and click Copy to apply the same settings for quick configuration.

[ Note:
After saving the configuration, the system will automatically generate a
verification template name and sync it to the device.

1:N Matching Threshold

For visible light / infrared / fingerprint recognition, the 1:N matching degree
must meet or exceed the set threshold to succeed.

Visible light recognition threshold range: [0-100]. Default: 82.

Infrared recognition threshold range: [0-100]. Default: 86.

Fingerprint recognition threshold range: [0-100]. Default: 82 (only effective
when used with a fingerprint module).

Linkage Actions on
Successful Verification

Actions triggered after successful verification, such as door lock control and
status indicator results.

e Open Door: Sends an unlock signal to open the door.

e Status Indicator Display: Indicator light turns green.

¢ Audio Message: Plays "Verification successful."

e Local Screen Display: Displays "Verification successful."

e Wiegand Output: Sends a signal to the card reader for verification.

e Bluetooth Output: Transmits signal via Bluetooth to bound devices
(supported by some devices; subject to the actual Ul).

[ Note:
The linkage actions on successful verification may vary by device model.
Refer to the actual device.
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Parameter

Description

Linkage Actions on Failed
Verification

Options for actions triggered after verification failure:
e Status Indicator Display: Indicator light turns red.
e Audio Message: Plays "No permission."

e Local Screen Display: Displays "No permission."
[ Note:

The linkage actions on failed verification may vary by device model. Refer to
the actual device.

3. After completing the configuration, click Save to sync the settings to the device.

4. (Optional) After saving the configuration, click Copy To to copy the settings to other access control devices.

13.5.2 Face Detection Configuration

Configure face detection parameters.

1. Select a face recognition access control device from the device list.

Access Control Device

>

Liveness Detection (®) On Off

Liveness Threshold 50
Liveness Detection Leval Medium

Quality Threshold L8] 5
Minimum Recognition Distance Adaptive

Maximum Recognition Distance Adaptive

Face & |D Matching Thresheld O 1

Save

2. Refer to the table below to configure the parameters.

Table 13-2: Configuration Description

Parameter

Description

Liveness Detection

Select Enable to activate the liveness detection function.

[ Note:
Algorithm-based detection determines whether the subject is live,
effectively preventing spoofing using videos, photos, or other non-live
materials.

Liveness Threshold:

This parameter is displayed only when liveness detection is enabled.
Valid range: [1-100]. A higher threshold requires more pronounced liveness
features, improving the detection rate against non-live attempts.

Liveness Detection Level

This parameter is displayed only when liveness detection is enabled.

It indicates the success rate of detecting non-live attempts such as videos or
photos.

Three levels are available: High, Medium, and Low. A higher level imposes
stricter criteria for liveness judgment.
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Parameter

Description

Quality Threshold

The minimum matching threshold for a captured image to be recognized as a
face during face verification. Images below this threshold are classified as "non-
face" and fail the detection.

Valid range: [1-100]. A higher value improves matching accuracy.

Adjust the threshold by dragging the slider or entering a value.

Minimum (Maximum)
Recognition Distance

Within this range, photos will be captured.

[ Note:
If both parameters are set to non-adaptive options, ensure the maximum
recognition distance is greater than the minimum recognition distance.

Face & ID Matching
Threshold

When using ID card verification, this specifies the minimum similarity required
between the face image recognized by the access control device and the ID card
photo. Verification fails if the similarity is below the threshold.

Valid range: [1-100]. A higher value requires greater similarity between the live
person and the ID photo.

Adjust the value by dragging the slider or entering a number.

3. After completing the configuration, click Save to sync the settings to the device.

4. (Optional) After saving the configuration, click Copy To to copy all settings to other access control devices.

13.5.3 Recognition Display Configuration

Configure the content displayed on the screen after successful face verification.

1. Select a face recognition access control device from the device list.

Access Control Device

Copy To
Person Recognition Result (@) Show Hide
Background Image Show Background Image (8 Hide St Snapshot
Mame (® Show Encrypt Custom
Extended Info Show Time Show Person Remark ®) Hide
Message G default Custor

Temperature Measurement Statistics G Show Hide
IP Address (®) Show Hide
Temperature Guide Graphic

Save

2. Refer to the table below to configure the parameters.

Table 13-3: Configuration Description

Parameter

Description

Person Recognition Result

e Show: After successful verification, the access control interface displays the
person information.

e Hide: After successful verification, the access control device screen does not
display the person information.

Background Image

e Show Background Image: After successful verification, the access control
device screen displays the image uploaded to the face library.

e Hide: After successful verification, the access control device screen does not
display personnel image information.

¢ Show Snapshot: After successful verification, the access control device
screen displays the captured image.
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Parameter

Description

Name

Show: After successful verification, the access control device screen displays
the recognized person's name.

Encrypt: After successful verification, the access control device screen
encrypts the person's name, displaying only partial information.

Custom: After successful verification, the access control device screen
displays custom information entered here.

Extended Info

Show Time: Displays the detection time.

Show Person Remark: Displays the remarks of the successfully recognized
person (set in the face library).

Hide: Default mode, no additional extended information is displayed.

Measurement Statistics

Message e Show: After successful face recognition, the access control device screen
displays "Recognition Successful."
e Custom: After successful face recognition, the access control device screen
displays custom information entered here.
Temperature e Show: The access control device screen displays the total number of

temperature screenings and persons with normal body temperature.

Hide: The access control device screen does not display temperature
measurement statistics.

IP Address

Show: The access control device screen displays the device's IP address.

Hide: The access control device screen does not display the device's IP
address.

Temperature Guide
Graphic

Show: When the temperature measurement function is enabled, the access
control device screen displays the temperature measurement guide image
(for wrist temperature measurement devices).

Hide: When the temperature measurement function is disabled, the
access control device screen does not display the guide image (for wrist
temperature measurement devices).

3. After completing the configuration, click Save to sync the settings to the device.

4. (Optional) After saving the configuration, click Copy To to copy all settings to other access control devices.

13.5.4 Port & Peripheral Configuration

Configure port and peripheral parameters.

1. Select the face recognition access control device from the device list.

Access Control Device
Copy To

53

Wiegand Input Port

Wiegand Port Configuration

Wiegand Output Port

Wiegand 34

Forward

®No

2. Refer to the table below to configure the parameters.
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Table 13-4: Configuration Description

Parameter

Description

Wiegand Port
Configuration

The Wiegand port can connect to external IC card readers and CPU card readers.
e Input and output ports can be configured separately.

e Protocol Type: Wiegand 26 and Wiegand 34. Select according to the actual
scenario.

e Wiegand 26: Card numbers are read using the Wiegand 26 protocol
(reads only 3-byte card numbers).

e Wiegand 34: Card numbers are read using the Wiegand 34 protocol
(reads only 4-byte card numbers).

¢ Format Configuration: Specifies that the card number sequence read by our
company's card readers is in positive order.

e Forward: Select this option for input/output when the sequence matches
that read by our company's card readers.

e Reverse: Select this option for input/output when the sequence is the
reverse of that read by our company's card readers.

Volume Configuration

Sets whether the access control audio is muted. If not muted, the audio volume
can be set.

¢ Select No to enable the audio function.
The audio volume can be set.

¢ Select Yes to enable mute on the device.

[ Note:
When mute is enabled, there will be no prompt sounds during access
control verification.

3. After completing the configuration, click Save to sync the settings to the device.

4. (Optional) After saving the configuration, click Copy To> to copy all settings to other access control devices.

13.5.5 Advanced Configuration

Advanced configuration supports features such as QR code configuration, upload configuration, attribute rule
configuration, and IC card encryption configuration.

1. Select the face recognition access control device from the device list.

Access Control Device

E

Copy To

QR Code Configuration

ollection (®) Enable Disable

QR Code Protocol (®) Private Protocao Third-Party Protoco

Upload Configuration

Attribute Rule Configuration

IC Card Encryption Configuration

2. Refer to the instructions below to configure the parameters.

e QR Code Configuration
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QR Code Configuration v

®) Private Protocol Third-Party Protoco

Table 13-5: Configuration Description

Parameter Description

QR Code Collection e Disable: The device camera will not collect QR code data.

* Enable: When the verification template includes a number allowlist, the
device camera will support collecting and verifying QR code data.

QR Code Protocol e Private Protocol: The device will parse the QR code data locally.

e Third-party Protocol: The QR code data will be uploaded to the face
recognition speed gate management platform for parsing.

Upload Configuration

Upload Configuration v

Report Type Report AllRecords
El

Table 13-6: Parameter Description
Parameter Description
Report Type e Report All Records: The terminal will upload access records for all

recognition outcomes (including all scenarios of both successful and failed
recognition).

e Report Successful Records Only: The terminal will only upload access
records for successful recognitions.

Attribute Rule Configuration

Attribute Rule Configuration v

Helmet Enable (@ Dis Y @®N
Mask Enable  (®) Disable ¥ @N
Temperature Measurement Enable (@) Disable Open Door if Verification Failed Yes  @No
Temperature Unit Celsius (°C)

Temperature Pre-Alarm off

Temperature Pre-Alarm Offset 030

Lowest Temperature 35.50

Highest Temperature 42,00

Alarm Threshold 37.30

Save

Table 13-7: Parameter Description

Parameter Description

Helmet When enabled, the recognition terminal will provide both on-screen and
voice prompts (Please wear a helmet) if a person is detected without a safety
helmet.

When helmet detection is enabled, configure whether to unlock upon
verification failure.

¢ Yes: If the recognition terminal detects a person not wearing a helmet, it
does not affect the actual verification (e.g., face, card, face & ID card) and
the door will unlock if verification is successful.
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Parameter

Description

¢ No: If the recognition terminal detects a person not wearing a helmet, the
door will not unlock.

Mask

When enabled, the recognition terminal will provide both on-screen and
voice prompts ("Please wear a mask") if a person is detected without a mask.
When mask detection is enabled, configure whether to unlock upon
verification failure.

* Yes: If the recognition terminal detects a person not wearing a mask, it
does not affect the actual verification (e.g., face, card, face & ID card) and
the door will unlock if verification is successful.

¢ No: If the recognition terminal detects a person not wearing a mask, the
door will not unlock.

Temperature
Measurement

When enabled, the temperature measurement module will provide both
on-screen and voice prompts ("Abnormal Body Temperature") if a person's
temperature exceeds the set alarm threshold.

When temperature measurement is enabled, configure whether to unlock
upon verification failure.

* Yes: If the temperature measurement module detects a person's
temperature exceeding the set alarm threshold, it does not affect the
actual verification (e.g., face, card, face & ID card) and the door will
unlock if verification is successful.

¢ No: If the temperature measurement module detects a person's
temperature exceeding the set alarm threshold, the door will not unlock.

Temperature Unit

Select the temperature unit: Celsius (°C) or Fahrenheit (°F).

Temperature Pre-alarm

* On: When the temperature measurement module detects a person's
temperature within the range [Pre-alarm Threshold ~ Alarm Threshold],
it will provide both on-screen and voice prompts ("High temperature
detected, please retest").

e Off: Alarm prompts will only occur when a person's temperature reaches
the alarm threshold.

Temperature Pre-alarm
Offset

When temperature pre-alarm is enabled, set the pre-alarm offset value.
Pre-alarm Threshold = Alarm Threshold - Pre-alarm Offset.

Lowest/Highest
Temperature

Value range: [30~45]. The default lowest temperature is 35.5, and the default
highest temperature is 42.

Users can configure the temperature measurement range according to the
actual application scenario.

Alarm Threshold

If the temperature measured by the module exceeds the value set here, the
device and voice prompts will indicate "Abnormal Body Temperature".

The value must be within the range of the lowest and highest temperature
settings.

IC Card Encryption Configuration

IC Card Encryption Configuration

Encrypt IC Card Enable
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Table 13-8: Parameter Description

Parameter Description
Encrypt IC Card Enable or disable IC card encryption.
[ Note:

registered on the access control device.

This must be configured based on whether the issued IC cards are
encrypted or standard. For card configuration details, please refer to
Personnel Management > Card Information .
When IC card encryption is enabled, if a non-encrypted card is used for
verification, access will be denied even if the card number has been

Key Type Select Type A or Type B according to the actual scenario.
Card Read Key The password for the MIFARE card. A six-byte password (in hexadecimal).
Read Sector No. The storage space of the MIFARE card is divided into 16 sectors (0-15). Please

select the appropriate sector number based on the actual scenario.

default value: 0.

Sector Offset Enter the sector offset for reading the MIFARE card. Integer range: [0-47],

default value: 4.

Sector Length 4. Enter the sector length for reading the MIFARE card. Integer range: [1-8],

3. After completing the configuration, click Save to sync the settings to the devic

4. (Optional) After saving the configuration, click Copy To to copy all settings to other access control devices.

13.5.6 Personalized Configuration

e.

Configure personalized parameters such as advertising mode, custom keys, and custom audios.

1. Select the face recognition access control device from the device list.

Access Control Device
Copy To

Ad Mode Custom Keys Custom Audio

E»

Ad Mode @®on oft

Scheduled Time 00:00:00 23:59:59

Play Interval (s) 10
Standby Time (s) 10

Import Ad File Select File

Note: 1. Import zip file or image/video files wiith names <20 characters. 2. Max 8 JPG files (<2MB each), max 3 MP4 files (<60MB each). Recommer
480*800 (4" device).

Total Duration

Save.

2. Refer to the table below to configure the parameters.

Table 13-9: Configuration Description

nded resolution: 800*1280

10" dlevica), 500

Parameter Description

Ad Mode Enable or disable the ad mode according to your

needs.
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Parameter

Description

Ad Mode Custom Keys Custom Audio

Ad Mode @on off

Scheduled Time 00:00:00 23:59:59

Standby Time (s) 10

Import Ad File Select File

e Scheduled Time
Set the time period for playing ads. Ads will only play between the start time
and end time.
Requirement: The end time must be later than the start time; otherwise, the
settings will not be saved.

e Play Interval
Set the time interval for playing ads.
Requirement: Integer value in seconds, range [1-3600], default value: 10.

e Standby Time
When no face is detected by the device for the duration set here, it will
enter ad mode.
Requirement: Integer value in seconds, range [10-3600], default value: 10.

e Import Ad File
Users can upload custom ad files. For file requirements, see the "Note" on
the page.
Click Select File to upload an ad file.
¢ Video Play Order
Click 4} to move the video up in the play order.

Click .. to move the video down in the play order.

Custom Keys

Choose to show or hide the following buttons on the device screen: Call User,
Open Door by Password, Call Management Center, and QR Code Scan.

Ad Mode Custom Keys Custom Audio

Call User (®) Shov Hide
Open Door by Password (®) Shov Hide
Call Management Center (®) Shov Hide
QR Code Scan (®) Shov Hide

Custom Audio

Click Select File to choose and upload an audio file from your local device.
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Parameter Description

Copy To
Ad Mode Custom Keys Custom Audio

Import Audio File Select File

Note:
1. Importing the audio file will restart the device.
2. The device will be discannected during the restart process. 3. Restoring factory defaults or clearing SD card data will restore the default audic file.

Save

[ Note:
The device will restart after a successful upload.

3. After completing the configuration, click Save to sync the settings to the device.

4. (Optional) After saving the configuration, click Copy To to copy all settings to other access control devices.

13.6 Access Control Live

Go to Video Application > Smart Live View > Door Access Control.

View live videos of access control devices and pass-thru records. You can take snapshots, zoom in on live video,
open / close door remotely, etc.

View Live Video

To start live video, double-click the target channel or drag it to a window.

Door Access Control

Pass-Thru Records

M
" h\é"W
[l 217.22100 1 oo
Bl 2172236 2
B 21722781
] 217. 1
Note:

The channels of general access control devices and access controllers do not provide live view; only pass-thru
records are displayed.

More Operations

Real-time pass-thru records: Pass-thru records are displayed on the right. The background color will be red if
authentication fails, such as stranger.

Toolbar: See Live View Toolbar Operations for reference. The functions are similar.
View more: Click 5 on the upper-right corner to view history pass-thru records on the Pass-Thru Records
tab.

View pass-thru details: Double-click a pass-thru record or click Details under the record (including snapshot,
personal information, camera, snapshot time, and authentication result).

View live video: Click View Live Video under the passing record to view the live videos of people passing
through.
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Access control: Click next to an access control device in the left-side list, or click in the live view

toolbar, and then select an option (Open Door, Close Door, Keep Open, Keep Closed, Restore (restore door
from keeping open/closed)) in the pop-up list as needed.

[m] 217.2.2.36 1
ﬁ Open Door
o
Close Door
[8]
Keep Open
Keep Closed
Restore

13.7 Pass-Thru Records

Go to Data Search > Pass-Thru Records.

View pass-thru records, and search by start and end time, access control device, etc.

@ Note:

e The pass-thru records on the access control devices will be synced to the platform in real time.

e Conditions for successful verification: correct credentials (face, card, password, etc.), credentials within
their validity period, access permission.

Search Pass-Thru Records

To search records, set the start and end time, channels under access control devices, person range (department/
visitor/stranger), search type (by name/by card number/by person ID), entry/exit direction (in/out/not
configured), authentication (face/ID card/IC card), authentication result (succeeded/failed), then click Search. The
search results will be displayed.

@ Note:

® Click #: to the right of the search criteria to customize the search criteria.

® Click i attop right corner of the table to configure the display fields for the list.

e See Edit Channel Info to configure the entry and exit directions of the access control channels.

*Start and End Time
2025-09-26 00:00:00 ~ 2025-09-26 23:59:59 Today last3days Last7days  Current month

Access Control Device Person Range Search Type Entry/Exit Direction

By Name Al
Authentication Authentication Result
A, Export  SyncPass-Thru Records

Channel Na... = Entry/Exit... + Name e PersonID %+ Departm... PersonTy... + Authentic... & Authentic... & Card Nu...

More Operations
e Export records: Select pass-thru records, and then click Export.

e View details: Click [ in the Operation column.
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e Sync pass-thru records: Sync pass-thru records of an access control device to the platform, and then click
Search to refresh the records.

@ Note:

Only pass-thru records on the online face recognition terminals can be synced manually. General access
control devices and access controllers do not support manual sync.

1. Click Sync Pass-Thru Records. A window appears.
2. Set a time period for the pass-thru records you want to synchronize on the device side.

3. (Optional) If you choose to synchronize image data, images in the pass-thru records will also be
synchronized.

4. Select the desired access control device.
5. Click OK to start synchronizing pass-thru records of the selected device.

6. When sync succeeded, you can click Search to refresh to pass-thru record list.

14 Elevator Control Management

Elevator control management provides elevator permission management services for building scenarios in
industrial parks, residential areas, schools, hotels, etc. Through elevator controllers installed in the elevator
system, building administrators can assign permissions, so people can access specified floors by verifying

their identity at card readers or door stations inside the elevators. People can also call elevators to their

floor by verifying identity at door stations outside the elevators or call indoor stations to open the door. The
administrator can also view real-time video in elevators and search access records. Elevator control management
can automatically verify floor access permissions to prevent unauthorized intruders. It ensures assets security
and personnel safety while enhancing the guard management efficiency.

Functions
Menu Description
Elevator Control Configure floors, linked devices (cameras/door stations), and verification mode
Configuration related parameters.
Elevator Control Configure elevator control permissions (by specifying floors), so elevator users can
Permission only go to the floors they have access to, and call elevators to the floors they are
currently located.
Elevator Live Video View live video from the linked devices (cameras/door stations) to monitor the
elevator’s real-time status.
Elevator Controller Search verification records from elevator card readers to monitor personnel
Verification Records elevator usage records.

]
Elevator Elevator Controller
Live Video Verification Records

Administrator \ ,
Door station Elevator Controller
outside the elevator ‘ . ) Configuration
verify or call indoor station to open the door !
q i call the elevator to the current floor Link floors
\ * Link devices
Door station&Card reader (camera/door station)
inside the elevator
Personnel/Resident/ verify Person
Visitor permission
. go to the allowed floors
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Configuration Procedure
. Add persons. See Personnel Management , Resident Management, Visitor Management.
. Add elevator controllers, cameras/door stations. See Device Management > Private Device.
. Add floors. See Community Room Management and Custom Units.

1

2

3

4. Configure elevator floors. See Floor Configuration.

5. Configure linked cameras/door stations. See Link Devices.
6

. Assign permissions on elevator controllers and door stations. See Schedule Template,Access Permission
Config.

7. View the live video of people entering/exiting elevators and elevator usage records. See Smart Live View >
Elevator Live Video, Data Search > Pass-Thru Records >Elevator Controller Verification Records.

14.1 Elevator Control Configuration

Go to Access&Attendance > Access Control > Elevator Control Management.

Configure the elevator floors managed by the elevator control system and the linked devices (cameras/door
stations), as well as verification parameters of the elevator controller.

14.1.1 Floor Configuration

Configure the elevator floors managed by the elevator control system based on the actual situation of the

building.
Select an organization on the left side, and elevator controllers in the organization will be displayed on the right
side.
Elevator Controller List

Device Status Configuration Method Search Keywords

All Al Device Name

@
3 Refresh | (@

2 torl 2 2 tom U ®0 ® B m
® Oniine ® B o
® Online ® B o
. I

Configure Floors

1. Select elevator controllers (you can select multiple for batch configuration), and click Configure Floors; or click
{83 in the Operation column.

2. Select the configuration method.

e Custom Unit: Select floors for the custom unit.

@ Note:

¢ In the custom unit, you can add floors manually, which is suitable for scenarios where the existing
units do not meet the elevator floor requirements.

® Add units on the Custom Unit page, or click - in the Select Floor Range dialog box to add units.
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Configure Floors X w Select Floor Range X

* Configuration Method () (8 Custom Unit Bind Unit Custom Unit 4 Note: Please select the floor range for the ele
wvator controller.
* Select Floor Range P » o e
- ) - 08 an
Unit 21
1F
Unit 1
2F
3F

“ Cancel

¢ Bind Unit: At the community level, select a unit, and then select the floors under that unit.

@ Note:

e Units are created in Room Management.

e After the elevator controller is bound to a unit, the residents of that unit automatically gain the
elevator control permission for the floors they reside on.

Configure Floors X ] [ Select Floor Range X }

* Configuration Method (7) Custom Unit (®) Bind Unit @ The left shows the room list. To add rooms, go to[Community Management]

= wvator controller.
— 0@

Y

* Select Floor Range

ess Ente Note: Please select the floor range for the ele

& Building 1 LE
Unit 1 LE
Unit 2 LE
Unit 3 8.

& Building 2 LH

& Building 3 B

[k
a:
8
B

“ Cancel

3. Click OK.

View Floors, Modify Floor Control Mode

In the list, you can view the range of floors and the total number of floors bound with the elevator controller.

O Refresh | (D) 216.216.170.1 @ Control Mode

Configuration Met . . Operat
Device Name Device ID 1P Address oy Floor Range Total Flo.  Operation || Floor Name Control Mode (2) .
od ion
160.23 16023 216.216.160.23 Custom Unit -1-6 7 u -2
. . Free Mode
216.216.170.1 170 216.216.170.1 Bind Unit -2-10 12 -1 4
Controlled Mode
tk_20 tk_20 216.216.160.20 Not Configured - - o]
- - emeE & om Forbidden Mode
2 B Fres Mode 2

1. Click the corresponding (i) for the elevator controller to expand the bound floors.

2. Click the corresponding /# for the floor, or select the floor and then click Control Mode to change the floor
control mode.

* Free Mode: All elevator users can light up the elevator buttons for that floor.
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e Controlled Mode: Only the verified elevator users can light up the elevator button for that floor.

¢ Forbidden Mode: No elevator user can light up the elevator button for that floor.
View Elevator Control Configuration

Click the corresponding [=] to view the detailed elevator control configuration.

@ Note:

Elevator control configuration cannot be modified directly. To modify the configuration method, you need to
clear the configuration, and then configure again.

View Details x

*

Canfiguration Methed (7) Custom Unit ® Bind Unit

* Floar Range BL

Cancel

.

Clear Configuration

Select the elevator controller, click Clear Configuration, or click [ in the Operation column, to clear the bound
floors and personnel permissions and restore the unconfigured state.

14.1.2 Custom Units

If the existing units in the community do not meet the elevator floor requirements, you can customize and add
units and floors.

Unit Name Linked Elevator Control

Please enter keywords Please enter ke

ords

+ Add Ti] Delete & Refresh | (D)
Unit Name Floor Range Total Floors Linked Elevator Control Operation
Unit_20 1-5 5 - ® 2 w
Unit-0 e 16023 ® B
216216.170.1 1-10 10 ® 2 W
Unit 21 1.3 5 ® 2 m
Add a Custom Unit
1. Click Add.
Add x
* Unit Name
* Floor Range (7) -1 —| 20 B ricor Unit | Floor

B Skip0

Total 21 floor(s) “ Cancel
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Unit Name Enter a custom name.
Floor Range Enter the range of floors.
Floor Unit e If selected, the floor names will include units (such as "1st Floor"), and you can
input a custom name as needed.
e If cleared, the floor names will not include units.
Skip O If selected, the generated floors will not include the Oth floor.
2. Click OK.

Edit Floor Name

1. Click () for the corresponding unit to expand the floor list.

2. Click /# for the corresponding floor to edit the floor name.

-+ Add
Unit Name
Unit_20
Unit-0
216.216.170.1

Unit 21

(7 Refresh (@

Floor Range

View and Edit Units

Unit _20

Total Floors Linked Elevator Control

: w
2

. 3 3 2
5 ® ¢ 4 . 2
® ¢ @ 2

* If the unit is not bound to any elevator controller, you can click corresponding / to edit the unit

configuration.

Total 5 floor(s)

Unit _20

1 —| 5 Floor Unit

* If the unit is already bound to an elevator controller, you can click the corresponding [Z! to view the unit
configuration (cannot modify).

Delete a Unit

* If the unit is not bound to any elevator controller, you can click the corresponding [ii] to delete the unit.

¢ If the unitis already bound to an elevator controller, you need to clear the binding relation in Floor
Configuration before you can delete the unit.

14.1.3 Link Devices

Link cameras, door stations, and video intercom devices with an elevator controller.

14.1.3.1 Camera

Link camera(s) with an elevator controller to view the live video of people entering/exiting the elevator. See
Elevator Live Video.
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Camera Door Station

+ Add i Refresh Device Name
Device Name IP Address Device ID Device Type Linked Elevator Control Status Operation

63 192.168.0.63 63 C 218elevator_1F ® Online 2 W @

1. On the Camera tab, click Add.

Add X

Camera List Selected(2) Jﬂ] Clear

LA

63_1 oC 219elevator

“ Cance'

2. Select camera(s), and then click > to add the selected camera(s).

@ Note:

An elevator controller can link with multiple cameras; a camera can link with only one elevator controller
location.

3. Choose the location of the linked elevator controller. You can choose an elevator controller or a floor.
4. Click OK.

To a linked camera, you can:

e . :Modify the location of the linked elevator controller.

e 1i] : Remove the link between the camera and the elevator controller.

* (©):Go to Smart Live View to view the live video from the camera.

14.1.3.2 Door Station

For scenarios where the elevator controller is bound to a custom unit.

After linking the elevator controller with a door station, elevator users can verify identity on the door station to
gain access to the specified floors; administrators can view the live video from the door station and its access
records.

e The door station is outside the elevator: After successful verification on the door station, the elevator user
calls the elevator to his/her current floor, and the elevator controller grants access to allowed floor(s).

¢ The door station is inside the elevator: After successful verification on the door station, the elevator controller
grants access to the allowed floor(s).

@ Note:

e Door station permissions and elevator control permissions need to be configured separately for elevator
users.

e After elevator users call the elevator through a door station, Pass-Thru Records will be generated,
Elevator Controller Verification Records will not.
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Camera Door Station

+ Add 3 Refresh |(® Device Name - Please enter keyword
Linked Elevator C .
Device Name IP Address Device ID Device Type Binding Method Syne Status 3 Status Operation
ontrol
216.216.160.16 216.216.160.16 [ Door Station Inside Elevator 160.23 ® Succeeded ® Online S W T ©®
216.216.160.251 216.216.160.251 251 Door Station Outside Elevator Unit 2_13F Syncing ® Online 2 W v ©® B

1. On the Door Station tab, click Add.
Add X

Access Control Device List Selected(2) Jﬂ] Clear

evice Na evice Type Bi g Me!
N 216.216.160.16 Door Station Inside Elevatc ~ 218.216.170.1 | *=*
Elevato < 216.216.160.251 Door Statian Outside Eleva ~ 2F
< VAR

“ Can(EI

2. Select door station(s), and then click > to add the selected door station(s).

Note:
An elevator controller can link with multiple door stations; a door station can link with only one elevator
controller location.

3. Choose the binding mode and the location of the elevator controller.

e |f the door station is outside the elevator, choose the floor of the elevator controller.

@ Note:

Here, only floors of a custom unit can be linked; to bind the door station to a unit, go to Video
Intercom to configure the device location.

¢ |If the door station is inside the elevator, choose the elevator controller.
4. Click OK.
For a linked door station, you can:
e 7 :Modify the location of the linked elevator controller.
e [i] : Delete the link between the door station and the elevator controller.

® (1) After linking with a door station for the first time, the system will automatically sync door station
information to the elevator controller. If the sync failed, you can click this button to resync.

@ Note:

Sync can succeed only when the device is online.

* (&): Go to Elevator Live Video to view the live video from the door station.

El: View the location of the linked elevator controller.
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Sync Details *

Sync Status | All N
P Address Device ID Device Type Linked Elevator Control Sync Status

Coar Station 216.216.170.1_-2 ® Succesded

T
o
T
o
o
=
T
L
T
L

14.1.3.3 Video Intercom

For scenarios where the elevator controller is bound to a community unit.

After linking the elevator controller with a door station at community floor, elevator users can use the door
station to verify identity or call an indoor station for remote door opening so as to gain access to the allowed
floor(s).

¢ After successful verification on the door station, an elevator user can call the elevator to his/her current floor;
and the elevator controller will grant access to the allowed floor(s) (if the elevator user has access to only one
floor, the corresponding floor button automatically lights up; if the elevator user has access to multiple floors,
he/she needs to push the elevator button manually).

¢ The elevator user uses the door station to call an indoor station, or people in the room uses the indoor station
to view the live video from the door station and opens the door remotely. The elevator arrives at the floor
where the door station is located and automatically lights up the button for the floor where the indoor station
is located.

@ Note:

e Door station permissions and elevator control permissions need to be configured separately for elevator
users.

e After elevator users call the elevator through a door station, Pass-Thru Records will be generated,
Elevator Controller Verification Records will not.

Camera Door Station Video Intercom
5 Refresh Device Name
Device Name P Address Device ID Device Type Control ~ Sync Status = Status Operation
216.216.160.251 4113160045 sor Station ® Succeedec ® Cnline T B @

Follow the steps to bind the elevator controller with door stations. And then the Video Intercom tab will be
displayed.

1. Go to Video Intercom > Device Location Config to bind door stations with floors in the unit, and bind rooms
with indoor stations.

2. Go to Elevator Control Permission > Floor Configuration to bind the elevator controller with the unit (which
shall include the floors where the door stations are located).

3. After the operation is completed, the system automatically generates the linking between the door station
and the elevator controller.

For a linked door station, you can:

e 15: After linking with a door station for the first time, the system will automatically sync door station
information to the elevator controller. If the sync failed, you can click this button to resync.

@ Note:

Sync can succeed only when the device is online.

e [5: View the location of the elevator controller linked with the door station (the door station automatically
links with the corresponding floor).
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Sync Details X

Sync Status | All
Linked Elevator Control Sync Status

IP Address Device ID Device Type

216.216.160.251 251 Door Station 218.216.170.1_-2 ® Succeeded

* (3):Go to Elevator Live Video to view the live video from the door station.

14.1.4 Device Parameter Configuration

Select the elevator controller in the device list and configure the device's own parameters.

[®p Note:
You can also configure device parameters in the device's web interface. The Ul display may vary with the

device version. If there are differences, please refer to the user manual of the device.

Device Parameter Configuration -- Record Upload Settings

Device List Device Parameter Config  Elevator Control Parameter Configuration  Expansion Board Configuration

Pleasa enter keywords

ft

I Record Upload Settings

QutdoorStation

Reporting Type Upload All "

Elevat:
L 160.23
J_: 216.216.170.1

W 20
Card Type ® General IC Card MIFARE Card

Storage Mode Stop Recording ® Overwrite Recording

Reporting Type For the elevator controller's verification records:
e Upload All: Upload all person records, including person records of successful and failed
verifications.

e Upload successful records only.

Storage Mode When verification records reach the device's specification limit:
e Stop Recording: Stop receiving new records.

e Overwrite Recording: New records overwrite the oldest records.

Choose the card type that the elevator controller will use for verification (either general IC

card or MIFARE card).
MIFARE cards can be configured with keys to encrypt sectors and prevent data leakage

from the cards.

Card Type
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Elevator Control Parameter Configuration

Device List

Ex

Device Parameter Config Elevator Control Parameter Configuration Expansion Board Configuration
Elevator Control Mode Auto Mode M
Manual Call Response Ti... |5 5
Manual Call Response Ti... | 300 5
Automatic Call Trigger Ti... | 1000 Millisecand(s)
Save

Elevator Control
Mode

e Auto Mode: Upon successful verification, all elevator floors that the elevator user has
access to automatically light up.

¢ Manual Mode: Upon successful verification, the elevator user needs to press the
elevator button manually.

¢ Adaptive Mode: Upon successful verification, if the elevator user has access to only
one floor, the elevator floor automatically lights up; if the elevator user has access to
multiple floors, he/she must press the elevator button manually.

Manual Call
Response Time
(Inside Elevator)

Upon successful verification through the card reader inside the elevator or through
the door station, the elevator user can press the floor button within N seconds; after N
seconds, the access permission becomes invalid.

Manual Call
Response Time
(Outside Elevator)

Upon successful verification through the door station outside the elevator, the elevator
user can press the floor button within N seconds; after N seconds, the access permission
becomes invalid.

Automatic Call
Trigger Time

Once the elevator button lights up, the elevator controller sends a signal to the elevator.

e The elevator will only proceed to the target floor after this signal lasts for a certain
length of time (N milliseconds).

e If the signal disappears before this period (e.g., due to a mistaken press), the
command is ignored.

Expansion Board Configuration

Device List

B

Device Parameter Config Elevator Control Parameter Configuration Expansion Board Configuration

Number of Expan... |3

Expansion Board ... One-Click Upgrade
Expansion Board Address Software Version Latest Version Status Upgrade Status
1 V1.02 Offline
2 Vv1.02 Offline
3 V1.02 Offline

1. Enter the number of expansion boards connected to the elevator controller, and then click Save to
automatically obtain the version information of the expansion boards.

2. Click One-Click Upgrade to upgrade the version of the expansion boards to the latest version.

14.1.5 Verification Template Configuration

Verification templates define different verification methods for different time periods for the device. You can
preconfigure different verification templates and quickly apply them to different card readers of the elevator

controller.
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3.

Note:
You can also configure verification templates in the device's web interface. The Ul display may vary with the
device version. If there are differences, please refer to the user manual of the device.

Select the elevator controller in the device list to view its existing verification templates.
The system has a default verification template that is effective all day, supporting number allowlist or
password comparison; the template can be modified but not deleted.

Device List

= *Template Name Default
Default
at Mon Tue Wed Thu Fri sat sun
Time Interval1 00:00:00 - 23:59:59 Card, Password

Time Interval2

Time Interval3

Time Interval4

Time Intervals

Time Intervalé

Time Interval7

Time Intervald

Copy To Select All

.
Click 4 to add a new template, or select a template to modify it.
Time Interval The verification time periods on the same day cannot overlap.
Verification You can select multiple verification methods at the same time.
Method

e Number allowlist: Verification is successful if the swiped card number matches the
person's card number in the library.

e Password comparison: Verification is successful if the input password is correct.

e Number allowlist + password comparison: Verification is successful if both the card
number and the password are correct.

Copy To After setting the verification method for a day, select other days and then click Save.
The current configuration will be copied to other days.

Click Save.

14.1.6 Verification Configuration

Bind card readers to the elevator controller, and bind verification templates to the card readers.

Note:
You can also configure verification in the device's web interface. The Ul display may vary with the device
version. If there are differences, please refer to the user manual of the device.

In the device list, select the elevator controller to view the card readers under it; an elevator controller supports
up to two card readers.

Device List + Add [ Delete | ¢ Refresh
~ Card Reader Channel Name Check Template Card Reader Operation
& &
EREEE Default SIRE R 2 W
B 128
EkEEE? Default FiRiEFaE2 2 W
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Add Card Reader Channel

The card reader must be physically connected to the Wiegand interface/RS485 interface on the elevator
controller.

Click Add, complete the configuration according to the instructions in the table below, and then click Save.

Device List .
| Basic Info

Card Reader Cha... |i§f§§‘@@] ‘
FAN
fal

Check Template ... | Default M ‘

b 2seecton 1 Card Reader binding

-+ Bind T Delete

Card Reader Protocol Port Mode Format Tamper Detection Operation

EipiE-EE1 - Wiegand 26 - Ascending Order Disable £ T

Save Cancel

Card Reader Enter a custom name.
Channel Name

Verification Choose the verification template.
Template Binding

Card Reader Click Bind, and select the card reader type (Wiegand or RS485) based on the actual wiring.
Binding Click /# to modify the protocol parameters of the corresponding card reader.

Modify Card Reader

Click /# to modify the parameters of the corresponding card reader channel, such as verification template,
bound device.

Delete Card Reader

Click /~ for the card reader channel you want to delete, and then confirm the deletion.

14.1.7 External Device Configuration

Note:
You can also configure external devices in the device's web interface. The Ul display may vary with the device
version. If there are differences, please refer to the user manual of the device.

485 Serial Port Configuration

Device List 485 Serial Port Configuration ~ Wiegand Interface QR Code

RS485 2 >
4 | x

| Rs485 3 >

B 2162161704 | RS485 External Device Config “

£ External Device

RS485 Address  External Device Name  Serial Port ID Port Modle Format Tamper Detection  Operation
2 485 Card Reader1 - IC Card Reader  Ascending Order Disable =z
3 485 Card Reader2 - IC Card Reader  Ascending Order Disable 2

Save
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¢ Modify the data transmission parameters for RS485_2 and RS485_3; generally, using the system default
values is sufficient.

e Configure the card readers connected to RS485_ 2 and RS485_3.

Parameter Description

Card Reader Name Enter a unique custom name.

e Disable: The port mode is disabled.
Port Mode e |IC card reader: Connects an IC card reader.

¢ QR code reader: Connects a QR code reader.

Port Number When the serial port mode is set to QR code reader, this parameter must be
configured and must be unique.

e Ascending order: The card number sequence is the same as the sequence read
by the card reader

Format
e Descending order: The card number sequence is the reverse of the sequence
read by the card reader.
Tamper Detection When enabled, an alarm will be triggered when card reader tampering is detected.
Copy To Used to apply the same settings to other card readers.

Wiegand Interface Configuration

Configure the card reader connected to the Wiegand interface.

Device List 485 Serial Port Configuration ~ Wiegand Interface QR Code

‘fn.‘ @ Wiegand Interface
' Wiegand Port Card Reader Name Protocol Format Tamper Detection Operation
B 16023
B 216216 1701 0 Wiegand Card Reader 1 Wiegand 34 Ascending Order Disable 2
1 Wiegand Card Reader 2 Wiegand 34 Ascending Order Disable a
Parameter Description
Card Reader Name Enter a unique custom name.
¢ Wiegand 26: Card numbers are read using the Wiegand 26 protocol (only reads 3-
byte card numbers).
¢ Wiegand 34: Card numbers are read using the Wiegand 34 protocol (only reads 4-
Protocol
byte card numbers).
e Custom Wiegand: Protocols used by Wiegand card readers other than 26 and 34
(configuration rules need to be set in the device interface).
e Ascending order: The card number sequence is the same as the sequence read by
the card reader
Format . .
e Descending order: The card number sequence is the reverse of the sequence read
by the card reader.
Tamper Detection When enabled, an alarm will be triggered when card reader tampering is detected.
Copy To Used to apply the same settings to other card readers.

QR Code Configuration

With QR code detection enabled, when operating in the number allowlist verification mode, people can scan QR
codes on the connected QR code reader for verification.
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The platform currently does not support generating QR codes for card numbers.

485 Serial Port Configuration  Wiegand Interface QR Code

QR Code Detection .

Station Note: Require card authentication

Save

14.2 Elevator Control Permission

Access&Attendance > Access Control.

Configure floor access permissions and the validity period of access permissions. After completing the
configuration, you can view, search, and modify the permissions as needed.

The configuration steps are as follows:

1. Schedule Template

2. Access Permission Config

3. Permission Search

14.3 Elevator Live Video

Go to Video Application > Smart Live View > Elevator Live Video.

After the elevator controller is linked with cameras or door stations, you can view live video from the linked
devices to monitor the conditions inside and outside the elevator.

1. On the Linked Device page, click (&) for a device to go to the Smart Live View page.
2. Click the Elevator Live Video tab, find the elevator controller on the resource tree.
3. Expand the elevator control device to view the linked cameras or door stations.

4

Drag the device to a window, or right-click the device and then choose Start Live View, to start its live video.

A
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Smart Live View

R

2 28
Ed2172728 1

5. Real-time face snapshots are displayed on the right.

197



14.4 Elevator Controller Verification Records

Go to Data Search > Pass-Thru Records > Elevator Controller Verification Records.

Search verification records from elevator card readers to monitor personnel elevator usage records.

@ Note:
e The elevator controller's verification records will be synced in real time to the platform.

e Conditions for successful verification: the credential is correct, the credential is within its validity period,
and the elevator user has the elevator control permission.

¢ To query the verification records of the linked door stations, go to Pass-Thru Records.

Search Verification Records

Select the start and end times, elevator controller, person range (department/visitor/stranger), and search type
(by name/by card number/by employee ID), and then click Search. The elevator controller verification records
that meet the search criteria are displayed.

*Start and End Time 2025-09-04 00:00:00 ~ 2025-09-04 23:59:59 Today last3days Last7days  Current month

&) PassThru Records

B Elevator Controller Person Range Search Type
Verification Records

By Name
T, Export
Time B Device Name = Name B PersonID Departm... + Authentic... ¥ Authentic... Card Nu... = Snapshot Operation
2025/09/04 17:12:21 128elevator] XzqQ dept Card No. Failed 90443582 & &l
2025/09/04 16:54:41 128elevatorl XzQ dept Card No Succeeded 90443582 & =

128elsvatorl xzQ dept Card No.

More Operations
e Export records: Select verification records and then click Export to export the selected verification records.

e View details: Click [Z in the Operation column to view the details of the corresponding record.
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Pass-Thru Details X

Snapshot Person Info
Name o
Persan ID XZQ
Department dept
& Card Number 50443582
Remarks

Authentication Mode Card Mo.
Authentication Result Succeeded
Channel

Time 2025/09/04 16:54:41

15 Video Intercom

Go to Access&Attendance > Video Intercom.
Video intercom is mainly used in residential scenarios.

Video intercom can be performed between visitors (via door stations installed at the building entrance or zone
stations installed at the community entrance), residents (via indoor stations installed at home), and security
personnel (via client in management center or security room) to provide efficient access control.

Workflow

1. Add zone stations, door stations and indoor stations. See Private Device.

2. Add persons and rooms, and then associate persons with rooms. See Personnel Management or Room
Management.

3. Configure call and answer permissions for client users. See Call Recipient Management.

4. Associate the installation location (building or room) for zone stations, door stations and indoor stations to
correspond with residents and clarify device usage for inbound and outbound persons. See Device Location
Config.

5. Use zone stations, door stations, indoor stations, and the client to perform video intercom. See Incoming Call
and Outgoing Call.

6. View intercom records. See Call Records.

15.1 Call Recipient Management

Assign answering permissions to different video intercom devices for different users. This configuration is used to
manage the permissions of property managers.

Go to Video Intercom > Call Recipient Mgt.
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T Delete

Selected Device(s)
aaaaa

15.1.1 Add Call Receipt

1. Click Add. A page as shown below appears.

2. Select the user(s) from the left-side list and click » to add to the right-side list.
Add

X
o @

Select Call Recipient

Select Video Intercom Devic
Select User

Selected User(s)

£ Clear Al
Q Please enter keyword Q Please enter keywords
Al admin

A

B

pc

yeg

>
&«
3. Click Next.
4. Select the device(s) from the left-side list and click » to add to the right-side list.
Add X
© 3
Select Call Recipient Select Video Intercom Device
Select Device Selected Device(s) {1 Clear Al
. Q Please enter keywords
Q Please enter keywords
iz root Device Name Device Type
=123 192 ¥#i5.53 Indoor Station
sZycg
>
«
< 1 >
Back “ Cancel
5. Click OK.

15.1.2 User Management

Edit: Click ~~ inthe Operation column to view the list of the devices the user can answer. You can add or
delete devices as needed.

Delete call recipient: Click 7] in the Operation column, or select the user(s) to be deleted and click Delete.
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15.2 Device Location Config

Associate the installation location (community entrance/building/room) with the zone station, door station and
indoor station, so as to match devices with residents and to specify devices used by callers and call recipients.
Prerequisite

e Zone stations, door stations and indoor stations have been added to the platform. See Device Management >
Private Device.

¢ Buildings and rooms have been added to the community. See Room Management > Add Room.

Go to Video Intercom > Device Location Config.

+ Add W Deete < Download Tempiate J, mpot 7 Sync Device Name ~ | | Q Please enter keywords
w P o

Device Name 1P Address Serial No. Device Type Linked Location Sync Status Operation

197000553 194 553 210235C 00007 Indoor Station Room 101, unit 1, building 1, p. Succeeded g B

15.2.1 Add Device Location

You can add device locations in batches or one by one.

Add Directly
1. Click Add. A page as shown below appears.

Add X
Select Device Selected Device(s) [y Clear All
- . Door station can be linked to unit or floor. Please enter keywords
- /_;_\ Device Name Device Type Linked Location

192.115.1.105 ndoor Station 801

Door Station

Zone Station

“ Caneel

2. Select device(s) from the left-side list and click » to add them to the right-side list.

3. Select the device location in the Linked Location column. A zone station can be linked with a phase. A door
station can be linked with a unit or floor. An indoor station can be linked with a room.

@ Note:
[ ]

After adding an outdoor station to the selected device list, you need to choose the device type (zone
station or door station).

e A community can be linked with multiple door stations; a room can be linked with multiple indoor
stations.

* To delete the selected devices from the right-side list, click Clear All; or select devices and click « to
delete them from the list.

4. Click OK.

Add in Batches

1. Click Download Template.
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2. Fill in the template with information about the device and its location, and then save.

3. Click Import. A dialogue box appears.

Please select the file to import.

T

—_

Upload File | Only XLSX files allowed

4. Click Upload File and select the completed template.

Note:
The file size cannot exceed 1MB.

5. Click OK.

15.2.2 Sync Location
e Syncin batches: Select the devices in the device list and click Sync to synchronize the location information.

Sync one by one: Click f{" in the Operation column to synchronize the location information.

15.2.3 View Details

Once a zone station is linked with a phase, and the door station is linked with a unit, the zone station and the
door station will be linked to all indoor stations within the respective phase/unit for subsequent call operations.

1. click [ for the device to view the linkage status.

2. Filter the devices by selecting the linkage status (Not Linked/Succeeded/Failed).

Sync Details X
Linkage Status: All -

No. IP Address & Serial No. 2 Device Type 4 Detailed Address Linkage Status %

1 19z 20 Indoor Station Succeeded

Total 1 E 20/jpage + Goto 1
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15.3 Incoming Cali

A call window appears on the client when a call comes in from a zone station, a door station or an indoor station.
If the call is from the zone station or door station, you can also view the live video from the door station or zone
station and open the door on the client.

Call from unit 2, building 2, phase 2,

2073.08-04 180010

Open Door Remotely  Aceept Decline

@ Note:

e Users can only answer incoming calls from the specified devices. See Call Recipient Management.

e You can configure the ringtone duration (40s~60s) for the video intercom. The system will end the call
when it is not connected within the set duration. See System Config > Service Config > Video Intercom.

15.4 Outgoing Call

On the Video Intercom > Contacts page, you can view the residents and the linked indoor station of each room,
and make calls to indoor stations.

Room No. {3 Refresh T, Expont

Enan
[ RERRRERRRRRRRN
En v
B,
At .

Room 101, unit 1, building 1, phase 1,1111 RRRRRERRR I

@ Note:

¢ You cannot call a zone station or a door station from the client.

e Users can only call devices in the organization(s) that they have access to.
1. Select a building/unit/room in the left list to view the rooms and residents.

2. Click for the room in the Operation column to call the indoor station linked with that room. Click Hang

Up to end the call.
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Call room 101, unit 1, building 1, phase 1,

@

Hang Up

15.5 Call Records

View the call records in Video Intercom > Call Records.
Start and E... 2023-10-05 00:00:00 2023-10-07 23:59:59 Today Last 3 days Last 7 days Call Type: Al - Call Status: Al - m Reset

s

A, Export
Device Name & Device Type 4 Device Location & Call Type 2 Call Status & Call Time & Call Duration & Operation
19 553 Indoor Station Room 101, unit 1, building 1, phas.. Outgoing Missed 2023/10/07 16:39:16 ]

iE 5.53 Indoor Station Room 101, unit 1, building 1, phas. Outgoing Answered 2023/10/07 16:38:11 00:00:11 @

19 5.53 Indoor Station Room 101, unit 1, building 1, phas. Incomin, g Missed 2023/10/07 09:43:51 <

e Search: Set the start and end time, call type, and call status as needed, and click Search.
[ ]

Call Back: Click " in the Operation column to call an indoor station.

e Export: Click Export above the list to export the search results to a .xIsx file.

16 Attendance Management

Go to Access&Attendance> Attendance Mgt.

Attendance management provides an automated and comprehensive solution for tracking employee attendance.
Companies can install access control devices at entrances and exits and configure attendance schedules
according to their policies. When employees sign in and out using face recognition or card swiping, the
attendance records are generated automatically. Administrators can view attendance data, handle leaves, and re-
sign in/out for abnormal attendance records, ensuring efficient and accurate attendance management.

Functions
e Attendance Regulations: Set automatic calculation time of attendance.
¢ Staff Schedule: Configure workdays and daily attendance periods for personnel.

e Attendance Management: Administrators can handle leaves and re-sign in/out for abnormal attendance
records.

e Attendance Statistic: View original data, attendance details, and attendance summary of check-in records.

Configuration Workflow

1. Add access control devices (face recognition terminal, general access control device, access controller). See
Private Device.

2. Add personnel information. See Personnel Management .
3. Assign access control permissions to individuals. See Access Permission Config.

4. Set attendance schedule for personnel. See Staff Schedule.
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5. People sign in/out on access control devices.

6. View attendance records. See Attendance Statistic.

[ Note:
Conditions for successful attendance recording: correct credentials (face, card, password, etc.), credentials
within their validity period, access permission, and sign in within the specified period.

16.1 Attendance Regulations

Set automatic calculation time of attendance. The system will calculate the attendance data of the previous day
at the set time every day. You can see attendance data in Attendance Details. If the automatic calculation of

attendance data fails, please refer to Attendance Details for manual calculation.

Attendance Rules

* Auto Calculation Time: 05:00

16.2 Staff Schedule

Configure workdays and daily attendance periods for personnel.
Configuration workflow: Configure daily attendance periods - Configure shift (workdays) - Schedule shifts for

personnel (specify shifts)

16.2.1 Set Time Period

Set daily attendance period. There are two types of attendance periods: Normal period and flexible period.
[ ]

Normal Period: For normal attendance, employees must sign in&out during the specified valid sign in&out

time range.
Flexible Period: For flexible attendance, employees can go to work at any time, and daily attendance duration
can be calculated by the selected flexible duration calculation method.

Normal Period

+ 0] = Period Name: Default Period

* Period Type: Normal Period -

@ al ) Default Period
® Daily Period Settings

= Work Hours Start: 09:00 * Valid Sign In Time: 08:30 ~ 09:30 & MustSignin

= Work Hours End: 18:00 * Valid Sign Out Time: 17:30 ~ 1830 B Must Sign Out

Absence Settings

Signed In,Late Than 0 min(s),Mark As Late
Signed Out,Leave Early Than 0 min(s),Mark As Leave Early
Not Signed In,Mark As Absent

Not Signed Out,Mark As Absent

L. click +-.

2. Enter a name for the period.
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. Select Normal Period.

. Set when the work hours start and end. One day will be added automatically (+1) if the Work Hours End time
is earlier than the Work Hours Start time. The Work Hours Start time and Work Hours End time must be
within the range of Valid Sign In Time and Valid Sign Out Time.

. Set whether sign-in and sign-out are mandatory. If selected:

(1) Set Valid Sign In Time and Valid Sign Out Time: Specify a valid time range for sign-in and out. The time
range includes the boundary values. For example, if the Valid Sign Out Time is 17:30-18:30, then sign-out
is allowed during 17:30-18:30.

(2) Configure absence settings.

¢ Signed In, Late than x min(s), Mark As Late: If a person signs in within x min(s) after the Work Hours
Start time, the attendance status is normal. x is no more than 999.

¢ Signed Out, Leave Early Than x min(s), Mark As Leave Early: If a person signs out within x min(s) before
the Work Hours End time, the attendance status is Normal. x is no more than 999.

Click Save.
. To edit a time period, click the period name on the right window.

@ Note:

e When +1 appears in the field, the time will be extended to the next day. All the related times must be
earlier than the auto calculation time of the next day.

¢ The valid sign-in time range must not overlap with the valid sign-out time range.

Flexible Period

+ )
Period Name Default
Period Type Flexible Period -
Default
Daily * Flexible Duration Calculation: Calculate Duration by First Sig «

Period Settings
* Daily Attendance Duration: 540 min(s)

* Switch to the Mext Attendance Day At 00:00

Click .

Enter a period name.

. Select Flexible Period.

. Select a method of flexible duration calculation.

¢ Calculate Duration by First Sign-in and Last Sign-out: Take the earliest sign-in time and the latest sign-
out time during an attendance day to calculate the attendance duration. Taking the following figure as an
example, the attendance duration is D.

Switch to the next attendance day at

@ Sign infout time D
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e Cumulate Duration by Multiple Sign Ins&Outs: The attendance duration is cumulated by the duration of
every two sign in&out during an attendance day. As shown in the figure below, the attendance duration
is the total time period of the A+B+C. If the number of sign-ins&outs on one day is odd, the administrator
can resign-in&out according to the actual situation and then calculate the attendance duration, otherwise
all the sign ins&outs of the day would be invalid.

Switch to the next attendance day at

@ Sizn in/out time

A B C

5. (For Cumulate Duration by Multiple Sign Ins&Outs) Set a valid sign in&out interval. The sign in&out is valid
only if the interval between the two sign in&out is greater than or equal to the set interval.

6. Set a daily attendance duration. Absence will be recorded if the daily working time is less than the set daily
attendance duration.

7. Set the time when the attendance day switches to the next attendance day. For example, if 01:00 is set, the
attendance day is from today’s 01:00 to the next day’s 00:59. Signing in&out before 00:59 or at 00:59 in
the next day is considered as today’s attendance. Signing in&out after 01:00 or at 01:00 in the next day is
considered as the next day’s attendance.

8. Click Save.

Other Operations
You can edit and delete periods as needed.

e Edit: Click a period name to edit the corresponding information on the right window.

e Delete: Select a period to be deleted, click [ii] , and confirm the deletion.

16.2.2 Shifts Management

Add shifts to set workdays for attendance and associate attendance periods to workdays.

Add Shifts
1 click —|—, enter the shift name, shift cycle (default is Week, repeat by week).

2. Click Select Period.
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Select Period X

Sun Men Tue Wed Thu Fri Sat

[ Default Period ~

daily - T

copyTo: All

Sun M Mon M Tue M wed M Thu M Fr Sat

3. Select a workday on which the shift starts.

4. Select a time period (set in Set Time Period), and add it into a shift.

@ Note:

Up to 8 periods are allowed for each shift.

5. Select workday(s) to apply the same settings to other days. You can also select All to apply the same settings
to every day (Monday through Sunday).

6. Click OK.

More Operations

You can edit or delete shifts.
¢ Edit: Click the shift name and edit the shift information in the right window.

e Delete: Select the shift to be deleted, click 7i] , and confirm the deletion.

16.2.3 Schedule Management

Specify shifts for departments or staff.

1. Click Schedule.
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Schedule X

*Validity Period: 2024/04/23 - 202412131

*Select Shift: ‘ Default Shift -

Department and Staff Selected(2) [ Empty
2 Please input keywords and press Enter. ) Please enter keywords
dept New

[a]

New] o 9652500
9652500
9652501
9652502

»
9652503

(o]

i

-

i

-~

i

(o]

el

(o]

- 9652504 «
-

- 9652505
(o]

5 9652506
(o]

& 9652507
-

o 9652508
-~

el

9652509

2. Select the department or people for which you want to set schedule (up to 5000 people are allowed for each
shift).

3. Select a shift and set a validity period.

@ Note:

People may have multiple shifts with different dates, but each person can have only one shift every day.
If the validity period of the new shift and the old shift overlap, the overlapping part of the validity periods
belong to the new shift.

If you initially set shift 1 to be executed from 1/1 to 1/31, and later you set shift 2 to be executed on 1/5,
then you will have shift 1 being executed from 1/1 to 1/5 and 1/6 to 1/31, and shift 2 being executed on
1/5.

4. Click OK.

After scheduling shifts, select a department/person on the left side of the Schedule Management to view the
corresponding schedule. To cancel a shift for a person, select the shift and then click Cancel Schedule on the top.

Department and Staff ~+ Schedule Tl Cancel Schedule
Please input keywords and press Enter | [ Shift Name Name Validity Period
_ Default Shift 01 2024-04-24 - 2024-12-31
Default Shift 02 2024-04-24 - 2024-12-31

16.2.4 Holiday Adjustment

During holiday periods, you can set holiday dates, during which attendance will not be recorded; you can also set
make-up workdays, on which normal attendance is required.

For example: If New Year's Day (Jan 1 to Jan 3) is set as a holiday, so attendance is not required from January 1st
to January 3rd; if a make-up workday is required on the following Saturday (Jan 6), set January 6th as a workday.

—+ Add
Holiday Name Holiday Date Holiday Days Work Date
Holidays 2026 2026/02/24 a 2026/02/14~2026/02/14
Holiday3 2025/10/01~2025/10/08 a 2025/10/11~2025/10/11

209



Add Holiday Adjustment

1.

Click Add. The Add dialog box appears.
Add X

*Holiday Name Select b
Haliday Date Start Time ~ End Time

Waork Date

+ add

Work Datel Start Time ~

m

Attendance Pericd Select o

Click the selection box after the holiday name to select the holiday (holidays can be created in advance in
Service Configuration >Holiday Management). The system will automatically get the holiday start and end
dates.

Select Holiday X

—+ add QPlease enter keywords
Holiday Name < Holiday Date Holiday Days Repeat by Year
1 2025/09/16 - 2025/08/17 2 No

22 2025/09/15 - 2025/09/18 4 No

heliday1 10/01 - 10/10 10 Yes

holiday2 2025/09/10 - 2025/09/17 8 No

Holiday3 2025/10/01 - 2025/10/08 8 No

Holiday5 2026/02/17 - 2026/02/24 8 No

“ Cancel

If no holiday exists, click Add to add a holiday manually.
Add Holiday x

*Holiday Name

Dat - End Dat =i | Holiday < 30 Days

LA
S
1]
7]
[ii]
m

*Start Date

Repeat by Year

"]

. (Optional) Add work dates and attendance periods. During work dates, check-in and check-out must follow

the attendance periods; otherwise, abnormal attendance will be recorded.
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@ Note:

e Work dates and holiday dates cannot overlap.
e If a work date is added, attendance periods must be selected.
e Up to 5 work dates can be added.

4. Click OK.

More Operations

Edit or delete holiday adjustments as needed.

e Edit a holiday adjustment: Click the corresponding . in the Operation column to edit the holiday
adjustment.

¢ Delete a holiday adjustment: Select holiday adjustments and then click Delete on the top to delete the
selected holiday adjustments; or click the corresponding 1] in the Operation column to delete a holiday
adjustment.

16.3 Attendance Management

Administrators can handle leaves and re-sign in&out for personnel.

16.3.1 Leave Management

Add leave/business time period records for the staff. The recorded durations will not be seen as abnormal
attendance. After a new leave/business record is added, you need to click Calculate in Attendance Details to
update its attendance status and duration.

Add Leave/Business
1. Select the target person on the organization list.

2. Click Leave/Business.

*Person:

*Main Leave Type: Ask for Leave -
Sub Type: Casual Leave .
| eave Start Time: 2022/08/02 09:00

«Leave End Time: 2022/08/02 18:00

Duration (min):
Remarks:

g
Note: Leave and re-sign are not automatically counted in attendance data. Ple

ase manually calculate them in Attendance Details

3. Select the main leave type. When the main leave type is set as Ask for Leave, you need to select its sub type
(specific reason for leave).

4. Set the leave start time and leave end time.

5. Click OK.
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More Operations

You can edit or delete leave/business records.

e Edit: Click /# for the record in the Operation column to edit the information such as leave type and leave
start and end time.

e Delete: Click ] forthe record in the Operation column to delete the record.

16.3.2 Re-Sign In&0Out Management

For abnormal attendance records such as absence, late arrival, you can modify the attendance records by re-sign
in and out operations. After making a re-sign in or out, you can click Calculate in Attendance Details to update
the attendance status and absent hours of this day.

Start and End Time 2022-1103 - 2022-11-03 Yesterday Last7days Last30days Cumentmonth

root

Sign Out Tim  Attendance S )
Absent (min) Operation

Workday Department Person ID Name Shift Name  WorkHours  Sign In Time
001 e tatus

2022/11/03 root 001 E= Default Shift 09:00-18:00 ~) (=) Absent 540 S

1. Select the department or person on the left-side organization list.

2. Set atime range. All the abnormal attendance records of the specified department or person within this
period are displayed.

Click (re-sign in) or @ (re-sign out) in the Operation column for the absence record you want to
handle.
4. Modify the sign-in time or sign-out time as needed.

5. Click OK.

@ Note:

e The re-sign in or out time must be within the effective range, otherwise, the re-sign in or out operation is
not effective.

e A person can be re-signed in or out up to 100 times a day. Before more re-sign operations can be
performed for this person, you need to clean up re-sign in&out records for this person manually.

e If there are multiple re-sign records in one day, the earliest and the latest re-sign time within the valid
time period will be considered as the re-sign time.

16.3.3 Re-Sign In&Out Records

A record is generated each time a sign-in or sign-out time is modified manually. You can search, edit or delete re-
sign in&out records on this page.

1. Select the department or person from the organization list.

2. Specify a time range and type, click Search. Search records are displayed.

Start and End Time 2022-11-03 - 2022-11-03 Yesterday Last7days Last30days Cument month

Person ID Name Department Type Time of Handling Operation
001 001 root Re-Sign In 2022/11/04 17:38 Y
More Operations
Edit: Click ~* inthe Operation column to modify a re-signed time.
Delete: Click [i] to in the Operation column delete a re-sign in&out record. After the record is deleted, the

person's attendance statistics will use the original attendance data during the corresponding time period.

16.4 Attendance Statistic

Attendance statistics only include people in the system and do not include strangers. Entry/exit records of
strangers are included in pass-thru records.
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Original Data: View all records of people entering or leaving by face recognition or swiping cards during the
specified period.

Attendance Details: View attendance details including attendance status and absence duration during the

specified time period. One record is generated for each person every day.

Attendance Summary: View the total length of absence during a specified period and the details.

Note:
The attendance calculation is precise to the minute. The attendance statistics and sign-in/sign-out time are
based on minute counts. For example, a sign-in at 08:00:59 would be recorded as 08:00.

16.4.1 Original Data

View all the records of people entering or leaving by face recognition or swiping cards during a time period. For
example, if there are five entries or exits, then five access records are displayed.

Search and view the access records of a specific department or a person, including person ID, name, department,
access control device, access time.

Department and Staff Start and End Time 2025-05-2200:00 - 2025-05-23 23:59 esterday Last7days Last30days Current month m Reset

Export Sync Criginal Data
Al jept
S dep

Person ID Name Department

1. Select the department or person from the organization list.
2. Setatime range.
3. Click Search.

Search results are displayed. You can click Export to export the data.

If the access control device failed to report access records automatically due to factors such as poor network, you
can click Sync Original Data to sync manually.

16.4.2 Attendance Details

View attendance details including attendance status and absence duration during a specified period. One record
is generated for each person every day.

All the original data of a day will be generated at the automatic calculation time on the next day. If automatic
calculation fails, or if any shifts have changed, you can select the department or person on the left-side
organization list, set the start and end time, and then click Calculate to re-calculate attendance and generate
attendance details.

Note:

When you calculate attendance for a certain day, if abnormal shifts are detected for this day, or if any shifts in
this day are not yet started or ended, then attendance data of the relevant persons in this day will be deleted
and will not be calculated.

You can search attendance statistics of a department or a person by setting search criteria including person ID,
name, department, date, time, sign-in/out time.

Start and End Time 2022-03-15 - 2022-03-15 Yesterday Last7days Last30days Current month

dept
» 001

Export Calculate

Attendance Duration (min)  Atiendance S
Workday Department  Person ID Neme  ShitName  Work Hours Sign In Time Sign Out Time Absent (min)  Remi
Actual Valid tatus

2022-03-15 dept 001 001 Default Shift 09:00-18:00 ~) ~) 0 0 Absent 540

The search results appear in the list. Click Export to export personnel attendance details.
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16.4.3 Attendance Summary

Summarize attendance data by personnel or department.

Personnel Attendance Summary

View the cumulative absence duration and attendance details of personnel within a specified time range. For
example, calculate the total monthly duration of late arrivals, early departures, absences, leave, etc., for each
person.

Select a department or person on the left, set the start and end time, then proceed to summarize attendance
data.

Personnel Attendance Summary Department Attendance Summary
Departr 1t and Staff Start and End Time 2025-09-12 N 2025-09-18 £5]| VYesterday Last7days Last30days Current month

Export

Attendance Duration

Department Person ID Name Late (min) Leave Early (min) (min) Absent (min sk for Leave (min) Attendance Details

1 0
1 0
- 1 0
s
1 0
1 0
1 0

g @ g @ W

@ Note:

e For flexible time periods, attendance duration will not deduct leave time taken within that period. That is:

e When attendance is calculated based on the first and last sign-in/sign-out times, attendance duration
is the length of period A.

e When attendance is calculated by accumulating durations between consecutive sign-ins/sign-outs,
attendance duration is the total length of periods B + C + D.

e Absence duration is calculated as daily working hours minus attendance duration.

@ Sign in&out time A
| ] L e ||
L2 ® O e O o
08:00 11:30 12:30 14:30 16:30 18:30 19:30 20:30

B C D

e Click Export to export all the retrieved attendance data.

e Click [ in the Attendance Details column to view the attendance details of that person.

View Details X

Attendance Duration Atten Absen

jork Ho Sign In Tim

Sign Qut Ti

=
=}

i

o

%

]

i

2]
-
ES

[}

(min) t(mi

tment niD - Name urs e me

Actual Valid

202... 999 999 Def... 09:00-1.. 2025/09/.. 2025/09/.. 540 540

Department Attendance Summary

View the number of employees and the number of employees with abnormal attendance by department,
including the number of employees scheduled to work, those with normal attendance, those who were late (but
did not leave early), those who left early (but were not late), those who were both late and left early, those who
were absent, and those on leave.

After selecting the department and start/end dates, you can view the summarized attendance information for
personnel within the selected department (including sub-departments).
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Personnel Attendance Summary Department Attendance Summary

Select Department

Start and End Time

2025-09-18 - 2025-09-18 | Yesterday Last7da

Export

Actual Attendance Late Leave Eariy Late & Leave Earl Absent Leave Operation

¢ Click Export to export all the retrieved attendance data.

e Click [ in the Department Attendance Details column to view the summary of absence duration and
attendance details for each person in that department.

¢ Back  Department Attendance Details

Export

Department Person ID Name Late (min) Leave Early (min) ) Absent (min)

e Click [ in the Personnel Attendance Details column to view the attendance details for that person.

17 Face Monitoring

Go to Park Application > Face Recognition.

Face recognition is to compare the face snapshots with the images in the face libraries and determine whether it
is the same person by the face match degree. When the match degree reaches the set threshold, it is recognized
as a successful match, otherwise, it is a failed match. You can view the match/not match alarm and important
person alarm records, as well as recognize the important person or abnormal guests.

Note:
Please add smart IPC/NVR in Device Management > Private Device on the platform for face recognition first.

The processes of face monitoring service are as follows:

s Enroll Face Info bt EEES Z;/SyncMnnitoringTas>------------------> El ViewAlarm

‘ Face Library ‘ .—. Face
l ibrary l Snapshots

‘ Enroll Face ‘

Smart Live View -
Face Recognition

Yes No ‘ Data Search - Face Search ‘

N,

‘ Match;\.l.arm ‘ | Notl.\alatch ‘
Alarm

\ Sync to IPC/NVR \

17.1 Face Library Management

Face library includes face related information. By adding face libraries, you can manage faces in different
categories to meet different monitoring needs.

Go to Face Recognition > Face Library Management.
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B Neme 1D No. @A nknown Male Female

(&)  Face Library Mgt

-+ Upload a Local File |+ A Import | 1, Export &> Download Template B3 Batch Import Photos. = Sync to Device

Gender % Date of Birth + Nationality & Province %

17.1.1 Manage Face Library

You can add, edit, or delete face libraries.

[ Note: Up to 128 face libraries are allowed.

Add Face Library

Click + inthe face library list on the left to add a new face library (default name: Face Library+ID).

Face Library —+ 0

© Face Library2 soo
@ Face Library1 oo
Face Library5 soo
Face Library3 @) eeo
Face Library4 @) ooo

Set as Important Library
By default, newly added face libraries are Common Libraries, but can be designated as Important Library.
Use the icon next to the library name to switch: i refers to a common library; refers to an important library.

e Important Library: When monitoring the important library, both a face match alarm and an important person
alarm will be triggered if a person's face matches an entry in the library. This helps distinguish important and
common persons. For example, after adding VIP customers to the important library, staff will be notified when
these customers appear, allowing for prioritized service.

e Common Library: When monitoring the common library, a face match/not match alarm will be reported
based on whether a person matches an entry in the face library. For example, by adding staff to common
library, the system can distinguish between internal staff and external visitors based on the alarm type.

Edit Face Library

Click for the face library and select Edit to rename it.

Delete Face Library

® Delete one by one: Click for the face library and select Delete to delete it.

® Batch delete: Click /7 in the upper-right corner of the list to delete all face libraries.

@ Note: Deleting face libraries will also delete the related face data.

17.1.2 Add Face Data

Add face information to face library. Choose a way to add face data as needed.
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Face Library -+ hame ID No. -:_5_3 All Unknown Male Female

Q0 Please enter keywords

© Face Library11 @ oo All|| 4+ Upload a Local File t o, Face Import T, Export
@ Face Library10 @ ooe Add from Persen Library

*Face Library3 @ oo Upload a Local File

@ Face Library8 ) ooo

© Face Library? &) ooo

Upload from Local
1. Select a target face library on the left, and then click Upload a Local File.
2. Click Add and select a face photo from local.

Note:
The photo must be JPG files. Size: 10KB to 512KB. Max. resolution: 1080px*1920px.

Image verification is enabled by default. To disable it, see Face Image Verification.

Upload a Local File X

All -+ Add | T0J Delete

@ JPG or JPEG image only, 10KB-512KB, max 1080px*1920px.

e
<Name:> 2 Ty <Name:> 2 Ty
<ID No.> <ID No.>

3. Click /# for the uploaded face images. A page as shown below appears. Enter the person name, ID number
and other information as needed. And then click OK.

Person Info
-
Gender ":é:" Unknown Male Female
*Name Mationality
‘- . 1D Type ID Card - Province
1D MNa. City
Date of Bi... f Address

’

4. After completing all the person information, click OK on the Upload a Local File window.

Add from Person Library

1. Select a target face library on the left, and then click Add from Person Library.
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Add from Person Library X

Department (D Only persons with a photo can be selected. O Please enter keywords
Q Please enter keywo Person D + Name  + Face Im... = Gender Depart.. IDNo. + CardN.. + Mobile ... +
~
Lo dept 01 Anna e No Male dept
02 Lisi ® Ves Male dept
03 Bob ® Yes Male dept

“ encel

2. Select person(s) from the person library and click OK to add the selected persons to the face library.

@ Note: Only persons with face images can be added to the face library.

Batch Import

1. Select a target face library on the left, and then click Face Import.

Face Import X

I Face Info Import

Please first download template , and then fill in the face information according to the
required format.

1. Up to 1000 items can be imported at a time.

2. Only xlsx files are allowed.

T, Upload xlsx File

I Face Image Import

1. Image naming format: Name,Jpg/Name Jpeg. One and only one image per person.
2. Each range from 10KB to SMB.
3. Please import a .zip file no larger than S00MB.

T, Upload zip File

2. Face Info Import: Click download template to download the template to local, fill in the person information in
the template, then click Upload .xIsx File.

3. Face Image Import: Name the face photos as Name.jpg/.jpeg. Only 1 photo is allowed per person. Pack all
photos into a .ZIP file, then click Upload .zip File.

4. Click OK.

17.1.3 Manage Face Data

You can search, edit or delete the face data.

Switch View

Click =2 = to switch the view mode into Image or List.

Name 2 Gender 2 Date of Birth % Nationality 2 Province 2 City 2 ID Type 2 IDNo. 2 Status 2 Operation
1 Male ID Card Not Synced 2 W B
22 Femnale ID Card Not Synced 2 W G
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Search Face Data

Set name, ID number, gender as needed, and click Search.

Edit Face Information

Click / forthe face information to edit it.

Delete Face Data
e Delete one by one: Click [ii] for the face data to delete it.

e Batch delete: Select multiple face data and then click Delete above the list.

17.1.4 Sync Face Data

Sync the face data to the smart devices to create monitoring tasks.

Sync to Device
1. Select a face library and click Sync to Device.

@ Note: Only the entire face library can be synchronized.

Face Library + B Neme 1D No. @Al Unknown Male Female

Please enter keywords

+ Upload a Local File |~ & = i 5 ===E
O Face Libraryl ploaci a Local Fil o, Import 1, Export Download Template B3 Batch Import Photos, = Sync to Device [ SyncResuit | Hi

Face Library5 @ Name Gender Date... Nationality Province City ID Type ID No. Status Operation

Face Library3 1 Unknown D Card o Falled

Face Library4 @

- 22 Unknown D Card o Failed
Face Library2 @
Face Libraryé @®

2. Select the target IPC/NVR device(s) and click OK.

Sync to Device X

B o 32
Yo 19 5.91

3. View the sync results of different devices in the pop-up window. Click = to view the sync result for each
people. For people that fail to synchronize, click

L., to resynchronize.
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Sync Result(Face-01) x Details(192.168.4.155)

Succeeded Failed = ame 2 Result & Operation

192 132 1 0 1 Thox W Failed /7

o
I}
o
o

Total 2 20/page - Goto 1 Total 1 20/page

Goto 1

View Sync Result

The synchronization status can be viewed by the arrow icon in front of the face library: gray(unsynced);
red(some failed); green(succeeded).

Select a face library and click [5] or Sync Result to view the synchronization status of devices and people. If
the synchronization fails, it can be resynchronized.

Click [, for the face data to view the sync status of that face in each device. If the synchronization fails, it can
be resynchronized.

@ Note: For successfully synchronized face libraries, if the face information in the library is updated, it will be
automatically synchronized to the device.

17.2 Monitoring Task

Create face libraries for face recognition. IPC/NVR will monitor the faces in the detection area, compare the face
snapshots with the face images in the libraries, and report a match or not match alarm.

Go to Face Recognition > Monitoring Task.

(&)  Face Library Mgt

NS
)

Monitoring Task Monitoring fask § ¥2 ® InUse

.
)

.
Y

17.2.1 Create Monitoring Task

[®p Note: Up to 32 monitoring tasks are allowed.

1. Click Add. A page as shown below appears.
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Add Monitoring Task X

(1) @

Configure Monitoring Parameters Select Faces Select Cameras

*Task Name

*Alarm Type (8 Match Alarm Not Match Alarm

*Match (%) 9] 80

Remarks
s
2. Set the parameters.

Item Description
Task Name Set the monitoring task name.
Alarm Type e Match Alarm: The system reports a match alarm when the similarity between

a captured face and a face in the monitored face library reaches the similarity
threshold; for example, when the system detects a VIP guest.

e Not Match Alarm: The camera reports a not match alarm when the similarity
between a captured face and a face in the monitored face library fails to reach
the similarity threshold; for example, when the system detects a stranger.

Match Set the face similarity threshold.

3. Click Next and select face libraries (only face libraries that have been synced to the device can be selected) to
be monitored.
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Add Monitoring Task 4

© 2] ®

Configure Monitoring Parameters Select Faces Select Cameras

(® [ Face Libraryl
[ Face Librarys

Back Next Cancel

4. Click Next and select cameras to be used for monitoring.

Add Monitoring Task X

© © ©

Configure Monitering Parameters Select Faces Select Cameras

Device List Selected(2) i Clear

) Please enter keywords

® 192.115.1.220_1
® 192.115.1.220_1 ® 192.115.1.221._1
® 192.115.1.221._1
® 192.115.1.222 1
B~ 192.115.1.98_1 ¢

5. Click OK.

17.2.2 Manage Task

You can view, edit, delete or enable/disable the monitoring task.

View Monitoring Task

Select a monitoring task to view the monitoring status of each channel.

222



+ Ada Monitoring Task2

Task Name g Face Library Name Remarks Status g Operation Channel Name 8 Status 5
Monitoring Task3 Face Library ® InUse 2 WO R nvr_1 ® Succeeded

Monitoring Task2 Face Library1 ® InUse WO e R nvr_2 ® Succeeded

Monitoring Task1 Face Library2 ® InUse 2 WO e R

Re-Monitor

—
o

If there some channels failed to receive monitoring tasks, click (=) to assign the monitoring task again.

Edit Monitoring Task

Click /# to edit the monitoring task, including the task name and match value.

Modify Monitoring Task X

*Task Name Monitoring Task2 * Match (%) 9] 80
*Alarm Type  Match Alarm Remarks
s
Face Library ) Please enter keywords
E Face Library1 Selected Camera(s)
!_,,': nvr_1
B nvr_2

Enable Monitoring Task

For the stopped monitoring tasks, click () to enable the tasks.

Disable Monitoring Task

For the ongoing monitoring tasks, click (—) to disable the tasks. After disabling, the face comparison will stop.

Search Alarm

Click [, to navigate to the Face Search page and view the face alarms generated by this task.

18 Comprehensive Search

Search face/pedestrian/motor vehicle/non-motor vehicle records by attributes, alarms, images, and other
conditions based on video and image data.
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18.1 SeekFree

Go to Data Search > Comprehensive Search > SeekFree.

SeekFree is a comprehensive search method based on video and image data, providing a unified search entry for
motor vehicles, non-motor vehicles, and pedestrian targets. It supports searching for specific targets in massive
video and image data using text and images, improving the efficiency of information retrieval. It can provide
valuable clues for finding objects or people.

When users lack specific target information, they can search using text descriptions or relevant images, quickly
finding the first image of the target. Based on that image, they can then perform progressive searches to obtain
accurate target results.

Combined with a visual map, SeekFree can restore the target's movement trajectory, helping users gain a
comprehensive understanding of the target's activity information, and thus assess the target's appearance
locations, enabling precise people searching and quick object retrieval.

Note:
The SeekFree feature relies on intelligent computing power: the platform needs to add smart NVR devices.

@

@) SeekFree
&
Pedestrian
@ Human/Vehicle Deep Search 2]
- .
Motor Vehi...
2025-10-27 00:00:00 ~ 2025-10-27 23:59:59
3

Non-Motor...

18.1.1 Search by Text

For scenarios where the search target is not clearly defined, users can directly enter a text query in the input box.
The system, based on natural language processing technology, understands the semantics of the user's query and
performs a search for relevant content.

1. Enter a text description (in either Chinese or English): target features + target type(motor vehicle/non-motor
vehicle/pedestrian), such as "people wearing black clothes."

2. Enable/disable Human/Vehicle Deep Search.

e Selected: The system searches for targets in the closeup image of humans or vehicles. The search results
display closeup images of the targets for better viewing of details.

* Not selected: The system searches for targets in the original images. The search results display the scene
where the targets appear for better viewing of the scene.

Note:

Search results of the same target: In the original image, similarity values may be lower due to
interference of other objects in the image. In the closeup image, the similarity values will be higher
due to less interferences.

3. Choose a time range.

@) SeekFree

| [ 6]
| @ Humanyienceoeepseer [ 2

2025-10-27 00:00:00 ~ 2025-10-27 23:5%:59 b

4. Click Q to start the search. The default search parameters are: any location, similarity of 80%.
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5. |If the results from the default settings do not meet expectations, change the search criteria, then click Q to

search again.

Figure 18-1: Enable Human/Vehicle Deep Search

@ 2025-08-2800:0000 ~ 2025-08-28 235959 = AL T Mateh () e 70

Q Paople wearing black clothes Q

ﬁ& @ Human/Vehicle Deep Search (%]

3 Time & Match & E ©

Pictures Video

Details

< >
6 © 25 > | 20/page - | Goto | 1

Figure 18-2: Disable Human/Vehicle Deep Search

Total 500

@ 2025-08-2800:00:00 ~ 2025-08-28 235959 = ALL Mt () ) 70

Q People wearing black clothes Q

4 Human/Vehicle Deep Search =
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18.1.2 Search by Image

For scenarios with existing search images, you can directly import images for searching.

1. click [2A (or Upload) to upload the target image.

For scenes with large images, after uploading the image, the system automatically identifies and extracts
all target images from the large image. You can select the specific target images you want to search. When
queried, the system will search for multiple selected targets.

[ Note:
¢ Images must be in JPG format and less than 4MB.
¢ You can upload up to 1 image; uploading again will overwrite the previously uploaded image.
2. Enable/disable Human/Vehicle Deep Search.

e Selected: The system searches for targets in the closeup image of humans or vehicles. The search results
display closeup images of the targets for better viewing of details.

* Not selected: The system searches for targets in the original images. The search results display the scene
where the targets appear for better viewing of the scene.
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Note:

Search results of the same target: In the original image, similarity values may be lower due to
interference of other objects in the image. In the closeup image, the similarity values will be higher
due to less interferences.

3. Choose the time range, snapshot location, and similarity, then click Search.
[®> Note:
If searching multiple targets simultaneously, the search results will display snapshots mixed for multiple
targets.

Figure 18-3: Enable Human/Vehicle Deep Search
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Figure 18-4: Disable Human/Vehicle Deep Search
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18.1.3 Search Results

Attention:
Switching pages will reset the existing search results, and a new search will need to be performed when re-

entering the page.

The search results support the following actions:

Sorting

You can choose the sorting method from the top-right corner of the page.
Timem Ma‘.-:hl?‘
e By Time: Click the up arrow to sort from earliest to latest; click the down arrow to sort from latest to earliest.
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e By Similarity: Click the up arrow to sort from low to high similarity; click the down arrow to sort from high to
low similarity (default).

View Details

Select a search result to display the corresponding snapshot, the video before and after the snapshot, and the
snapshot details on the right.

Click |[mj on the toolbar to download the image or recording to your local computer.

Click on the toolbar to search for targets within the image or video frame.

Drag to select the person or vehicle you want to search for

4

AcuSearch
AcuTrack

1. Select the target to search for:
¢ Hold down the mouse and drag the area within the green box to move its position.

e Hover the mouse over the edges or corners of the green box, when the cursor changes to an arrow, hold
and drag to resize the green box.

e To exit the search, click X.
2. Choose a search mode. Two modes are available:

¢ Click the AcuSearch button at the top right corner of the green box to go to the SeekFree page, where the
system will automatically search for all capture records of the target within the green box (see Search by
Image).

¢ Click the AcuTrack button at the top right corner of the green box to go to the AcuTrack page, where you
can search for recordings containing the target in the green box.

View Trajectory

Click the © at the top-right corner of the page to view the target's trajectory on the map. The locations where
the target appeared will be connected in chronological order to generate the trajectory.

(D 2025/05/29 00:57:28 Snapshot Details X 47 18924 View
=1 18924

1.89_24 .
- Name Display Method Tracking @

18924 View

(@ 2025/05/28 00:45:25
18924 View
£ 18924 - X
7 e 09 18924
- | 189 24

2025/05/29 02:38:34 34 18924

® 2025/05/29 00:26:13 - v
3 18924 / .
2025/05/29 00:44:38 - -
© 2 . . ——

=1 18924

Total 500 2 3 4 5 6 v 25 > |20page - Goto | 1
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Click to play the trajectory, with adjustable play speed. Enable snapshot preview to view the person’s

snapshot at the device locations.

[®> Note:
e Prerequisite: Please complete the Map Configuration first by uploading the map and marking the camera
positions.

e The trajectory will be drawn for only the top 20 snapshots in the search results.

e Try to set more precise search criteria to ensure the system retrieves snapshots of the same target and
generates the movement trajectory for that target.

18.2 Face Search

Go to Data Search > Comprehensive Search >Face.

You can search persons by attribute, event, or face image in passing records from cameras or face libraries.

For example, in the event of a security incident or an urgent need to locate specific individuals, you can search
information by attributes (location, snapshot time), event (match/not match alarm), or face images. This allows
you to quickly retrieve the relevant person's passing records or his/her information in face library, providing
additional details for investigation.

18.2.1 Search by Attribute/Alarm

Search pass-thru records by face attributes or alarms.

1. Select a search type.

e By attribute: Set the snapshot location (through precise search by selecting the device on resource tree or
fuzzy search by entering keywords of the device name) and snapshot time. Click Custom to set the gender,
age, glass type, mask status, and body temperature range as needed.

@ Search Type | By Attribute - Snapshot L. | Precise Search - | Please select
€] Snapshot Ti.. | 2025-06-14 000000 ~ 2025-06-16 23:5%:59 = Today Last3 days  Last7 days R m
=
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) 1pcos
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20256716 23:1158
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male
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NoLens
No Mask

Unknown

% female

£3 No Lens

& No Mask @ Unknown

& unknown & unknown

Total 46082 2 3 4 5 & v 2305 > | 20/page - Goto | 1

¢ By alarm: Set the monitoring type (match alarm/not match alarm/important person alarm), face library,
snapshot location (through precise search by selecting the device on resource tree or fuzzy search by
entering keywords of the device name), snapshot time and similarity range (0%~100%). Click Custom to
set the name, gender, card type, mask status and body temperature range as needed.

Note:
Match alarm sources: Face Monitoring and visitor Monitoring Task. Not match/important person

alarm sources: Face Monitoring.
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2. Click Search to find pass-thru records.

Search Results
Search results are displayed on the bottom side of the page.

e Click on a result to view the snapshot, recording (5s before and after the snapshot time), and face attributes
on the right. To save the snapshot/recording, click & under the tab.

e Add to face library:
1. Add a stranger to a face library by hovering over the search result and clicking G-

2. Select the target face library, complete the person information, and click OK.

Add to Face Library X

*Select Fac... | Face Library3 -

Gender  (®) Unknown Male Female
*Narme Nationality
ID Type 1D Card - Province

ID Mo, City
Date of Bi... = Adldre:

“ CE TCEI

e Search by image: Hover the mouse over the result and click [8] to Search by Image.

e Export: Click Export to export the search results to a .xlsx file.

® Trajectory: Click © to view Face Trajectory.

Related Operation

You can customize the attributes displayed on the snapshot record and alarm record cards as needed. See Card
Attribute.

18.2.2 Search by Image

Search similar face images in the face libraries or pass-thru records.

Note:
You need to add smart NVR on the platform for face comparisons first.

1. Select the search type as Search by Image.
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2. Select a search library type.

e Pass-thru records: The system compares the uploaded image with the snapshots of pass-thru records in
NVR.

e Face library: The system compares the uploaded image with the face library images in NVR.
3. Upload an image to search (only 1 image is allowed).

e Upload library image: Click Upload Library Image, select a face library and search the face image by
entering the person name, ID number, and gender. Select the face image and click OK.

Select Library Image X

i Card . ! Gender () A Unknown Ma
Face Library Name 1D Card Number der (@) All nknown Male Female

2 Please enter keywo Reset
2 ] Face Library! | () o o

@ B
@ B

Total 2 20/page - Goto | 1
¢ Upload local image: Click Upload Local File, and select the face image from local.

4. Set the search criteria.

Search in Snapshot Set the start and end time.

pass-thru time

records - -
Snapshot Select NVR(s) or the video channels under NVR(s), and the uploaded image
location will be compared with the pass-thru records in NVR(s).

Search in face | Face library | Select NVR(s), and the uploaded image will be compared with the face library
library images in NVR(s).

Match Set the face similarity, and the system will display the face images that are
greater than or equal to the set similarity.

5. Click Search to view the similar images.

Figure 18-5: Search Pass-Thru Records

Search Type | Search by Image - Searchin | Pass-Thru Records - n
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Upload Library Image
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= =t 2 ) =i 24 = =i 24
® 202505727 Q© 2025/05/2 ® 202505727 1.

Total500 < 1 2 3 4 5 & 25 > |20/page - Goto | 2

®

Details
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Figure 18-6: Search Face Library

SesrcnType  Search by Image Searchin  Face Library

More Operations

When you select the search type as Pass-Thru Records, from the search results, you can view snapshots,
recordings, trajectories, add entries to the face library, export data, etc. For details, please refer to Search by
Criteria > Search Results.

Related Operation

You can customize the attributes displayed on the face cards as needed. See Card Attribute.

18.2.3 Search by Frequency

People frequency refers to the number of times the same individual appears in the camera area over a specified
period. This function allows specifying face libraries as the search range and customizing frequency parameters
to identify high/low persons. It helps administrators track abnormal activities and manage targeted persons
effectively.

e High frequency persons: Individuals who appear more frequently than a set threshold (e.g., repeat customers
or line sitters).

e Low frequency persons: Individuals who appear less frequently than a set threshold (e.g., elders or students
who have not been seen for a long time. Administrators need to stay updated on their safety status).

Prerequisites
Face Monitoring tasks have been created.

Data source: Matching records between persons in face libraries and captured persons.

Search Criteria

Select the search type as Search by Frequency, set search criteria as needed, and then click Search.

Search Criteria Description

Frequency Choose to search for high/low frequency persons.
e High frequency: Search data 2 input value;

e Low frequency: Search data < input value.

Library Select one or multiple face libraries (including common and important libraries);
default is all libraries.

Snapshot Location Specify a camera or channel through precise search (by selecting the device on the
resource tree) or fuzzy search (by entering keywords of the device name), default is
all devices.

Snapshot Time Set the snapshot time period (up to 7 days), or click Today, Last 3 Days, or Last 7 Days.

Match Configure the similarity range (0%~100%) to filter and retrieve matching persons.
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Search Results

Figure 18-7: High Frequency Person
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Figure 18-8: Low Frequency Person
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1. View the matching results with the face library in the left-side column.

e For high frequency searches, results are sorted in descending order of frequency. For low frequency
searches, results are sorted in ascending order of frequency. Up to 100 people can be displayed in the
result list. If results exceed 100, the top 100 are shown based on the sorting rules.

e Each face library photo card displays frequency, person information, and library name.

2. Select a search result to view the matching snapshot records in the center. The number of records equals to
the frequency.

¢ The snapshot and library face photo are displayed in pairs, showing the match degree, snapshot
information, etc.

e Records are sorted in descending order of snapshot time, with the latest records displayed first.
3. Select a record to view alarm details on the right, including alarm snapshot, recording, and face information.
4. Export data.

¢ Click Export Person to export only the person information in the face library (data on the left side).

¢ Click Export All to export both the person information in the face library and the snapshot information.
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18.2.4 Face Trajectory

For face search records, you can view the location where the person is present on the map and the movement
trajectory of the person plotted in chronological order. The trajectory provides valuable information, such as the
person's activity range and residence place.

Operation Description

After the face that meets the search criteria is retrieved on the Face Search page, you can click @ in the upper-

right corner of the result list to view the person's movement trajectory on the map. To play it, click .The

speed is adjustable. If Snapshot Preview is enabled, a face image with snapshot information will be displayed
when passes by the camera.

@ Note:

e Make sure that Map Configuration is completed (the map has been uploaded and cameras have been
added to the map).

The system only plots the trajectory based on the most recent 20 snapshot records.

Please set the search criteria as precisely as possible to help the system retrieve snapshots of the same
person and plot a more accurate trajectory.

@ SearchType By Attribute - SnapshotL.. | Precise Search

| &} SnapshotTi.,  2025-05-29 000000 ~ 2025-05-29 235959 Today last3days Lest7days m Reset Custom

2, Export
. .

Total 52245 2| 3| 2][5] ¢

18.3 Pedestrian Search

Go to Data Search > Comprehensive Search > Pedestrian.

18.3.1 Search by Attribute

Search pedestrian snapshot records by snapshot location (through precise search by selecting the device on
resource tree or fuzzy search by entering keywords of the device name) , snapshot time, and age, garment style,
etc. Click Custom to set more search criteria.

Search results are displayed below. Click a record view the alarm image and person attributes on the right.
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More Operations

& o
> ERIS

e Search by image: Hover the mouse over the result and click [8] to search by image.
e Export: Click Export to export the search results to a .xlIsx file.

e Download image/recording: Click [f@ under thelmage/Recording tab to download the image/recording.

Related Operation

You can customize the attributes displayed on the snapshot record card as needed. See Card Attribute.

18.3.2 Search by Image

The system supports searching for similar individuals in pedestrian pass-thru records using pedestrian images.

@ Note:

Please first add the smart NVR on the platform for human body comparison via the smart NVR.
1. Select the search type as Search by Image.
2. Click Upload Local File to upload the image of the individual you want to search for (up to 1 image).

3. Set the search criteria.

Snapshot Time | Choose the start and end times for the records to search.

Snapshot Select the NVR or video channels under the NVR (multiple NVRs can be selected
Location simultaneously). The search image will be compared against the pedestrian pass-thru
records on the NVR.

Match Set the image similarity threshold. The search results will only display human body images
with similarity greater than or equal to the threshold to the uploaded image.

4. Click Search to search the images that meet the criteria.
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Search Result Operations

You can perform actions such as viewing images, watching video recordings, viewing trajectories, etc.

18.3.3 Pedestrian Trajectory

For pedestrian image search records, the system supports marking the locations where a pedestrian appeared on
the map and generating his/her movement trajectory in chronological order. The trajectory provides information
such as the pedestrian’s activity range and stop points.

Operation Description

After finding the matching pedestrian on the Pedestrian Search page, click © in the top-right corner of the

result list to view the pedestrian's movement trajectory on the map. Click to play the trajectory, with
adjustable playback speed. Enabling snapshot preview will allow you to view the pedestrian's snapshot images at
the device locations.

@ Note:

* Please complete Map Configuration first: Upload the map and mark the camera locations.

¢ The system will only generate the trajectory for the most recent 20 snapshot records from the search
results.

e Try to set more precise search conditions (such as a higher similarity threshold) to help the system
retrieve snapshots of the same pedestrian, enabling the generation of the pedestrian's movement

trajectory.
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18.4 Motor Vehicle Search

Go to Data Search > Comprehensive Search > Motor Vehicle.

18.4.1 Search by Attribute/Alarm/Violation

You can search target vehicles by vehicle attribute, alarm event, or violation in vehicle pass-thru records captured
by cameras.

1. Select a search type.

By Attribute: Set the snapshot location (through precise search by selecting the device on resource tree or
fuzzy search by entering keywords of the device name) and snapshot time. Click Custom to set the plate
number, vehicle type, plate color, plate type, driving direction, speed type, vehicle colors, vehicle attribute
(authorized/forbidden/temporary vehicle) as needed.

@ Search Type | By Attribute - SnapshotL.  Precise Search
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Note:

The card also displays the vehicle's attribute (authorized/forbidden/temporary vehicle) in Parking Lot.
For authorized vehicles, the owner's name and telephone number will also be shown in the detailed
attributes on the right side.

By Alarm: Set the vehicle monitoring type (match alarm/not match alarm), snapshot location (through
precise search by selecting the device on resource tree or fuzzy search by entering keywords of the device
name), and snapshot time. Click Custom to set the plate number, plate color and vehicle color as needed.

Note:
Vehicle alarm types are configured in Main Parking Lot.

Search Type | By Alarm - Monitorin... Not Match Alarm = Snapshot L. | Precise Search
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Others.
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3
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e By Violation: Set the violation type (all/speeding), snapshot time. Click Custom to set the plate number,
vehicle type, plate color, plate type, driving direction, speed type, vehicle color, vehicle attribute
(authorized/forbidden/temporary vehicle) as needed.

@ Note:
* Please add radar vision cameras and configure speeding alarm rules first.

e The record also displays the vehicle's attribute (authorized/forbidden/temporary vehicle) in
Parking Lot. For authorized vehicles, the owner's name will also be shown.

e Clickthe 7 inthe table header to sort vehicles on the current page; click the Sgezd = above the
table to sort all vehicles by speed.

SearchType By Violation - Violation Ty.. | All - Vehicle Ov

SnapshotTi..  2025-07-1400:00:00 ~ 2025-07-16 23:59:59 Today Last3days Last7 day

51128 whT Anna Other = Unknown 2025/7/14 00, Okm/h

] i: o
| 3 #: :
| a b C

2. Click Search to find motor vehicle records.

More Operations

Search results are displayed at the bottom of the page.

¢ For results searched by attribute/event: You can click a record to view picture, video (5s before and 5s after
the snapshot time), and motor vehicle attributes on the right. And also click [f&] under the tab to save the
picture/video.

e Search by image: Hover the mouse over the result and click [8] to search by image.

¢ Click Export to export the search results to a .xlsx file.

* Click © to view Motor Vehicle Trajectory.

Related Operation

You can customize the attributes displayed on the snapshot record and alarm record cards as needed. See Card
Attribute.

18.4.2 Search by Image

The system supports searching for similar vehicles in vehicle pass-thru records using vehicle images.

Note:
Please first add the smart NVR on the platform for vehicle comparison via the smart NVR.

1. Select the search type as Search by Image.
2. Click Upload Local File to upload the image of the vehicle you want to search for (up to 1 image).

3. Set the search criteria.

Snapshot Time Choose the start and end times for the records to search.

Snapshot Location Select NVR(s) or the video channels under NVR(s), and the uploaded image
will be compared with the vehicle pass-thru records in NVR(s).
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Match Set the image similarity threshold. The search results will only display vehicle
images with similarity greater than or equal to the threshold to the uploaded
image.

4. Click Search to search for vehicle pass-thru records that meet the criteria.

Figure 18-9: Search Vehicle Pass-Thru Records

@ SearchType | Search by Image - Snapshot L. | 1.89_1,1.89_10,1.89_11,1*+*
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Search Results
The search results are displayed at the bottom of the page.

¢ Click on a specific result to show the original snapshot, recording (5 seconds before and after the snapshot),
and snapshot details on the right side. Click [i& to save the image/recording.

* Click © to view Motor Vehicle Trajectory.

18.4.3 Motor Vehicle Trajectory

For motor vehicle search records, the system supports marking the locations where a motor vehicle appeared on
the map and generating its movement trajectory in chronological order. The trajectory provides information such
as the motor vehicle’s activity range and stop points.

Operation Description

After finding the matching pedestrian on the Motor Vehicle Search page, click © in the top-right corner of the

result list to view the motor vehicle's movement trajectory on the map. Click to play the trajectory, with

adjustable playback speed. Enabling snapshot preview will allow you to view the motor vehicle's snapshot images
at the device locations.

[ Note:
* Please complete Map Configuration first: Upload the map and mark the camera locations.

e The system will only generate the trajectory for the most recent 20 snapshot records from the search
results.

e Try to set more precise search conditions (e.g. a specific license plate number) to help the system
retrieve snapshots of the same motor vehicle, enabling the generation of the motor vehicle's movement
trajectory.
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18.5 Non-Motor Vehicle Search

Go to Data Search > Comprehensive Search > Non-Motor Vehicle.

18.5.1 Search by Attribute

Search non-motor vehicle snapshot records by snapshot location (through precise search by selecting the device
on resource tree or fuzzy search by entering keywords of the device name), snapshot time, vehicle type, driving
direction and speed type.

Search results are displayed below. Click a record to view the alarm image and non-motor vehicle attributes on
the right.

@ Search Type | By Attribute - Snapshot L. | Precise Search - | Please select
Q Snapshot Ti. 2025-05-29 00:00:00 ~ 2025-05-29 23:59:59 [=]| Today Last Last 7 days
& Vehicle Type | All - Driving Dire.. | Al - Specd Type | Al - Reset
T, Export
‘ % male % Unknown % Unknown Pictures  Video
8 Youth § Teenager & Teenager
© Blue  Long @ Black  Long .. & Brown Long
n nknown D Unknown
2] n @ up
-Wheel Vehicle g5 2 heel Vehicle db 3-Wheel Vehicle

male male % male
& vouth Youth & Youth
® Gray Llong .. @ Black Long .. N
D unknown
@ up

Non-Motor Vehicle

2-Wheel Vehicle 6 2-Wheel Vehicle

2025/5/28 12:11:58

male % male @ male = s
8 Youth - & Youth & Youth .
an = = T
? Gray Short R @ Blue Short ... @ Green Short -

& Youth

Blue Long Sleeves

Total 4588 E 2 3 4 5 6 2300 > 20/page - Goto

Black Unknown

More Operations
Perform the following operations as needed.

e Search by image: Hover the mouse over the result and click [#] to search by image.
e Export: Click Export to export the search results to a .xlIsx file.

* Download image/recording: Click [f§] under thelmage/Recording tab to download the image/recording.

Related Operation

You can customize the attributes displayed on the snapshot record card as needed. See Card Attribute.
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18.5.2 Search by Image
The system supports searching for similar non-motor vehicles in pass-thru records using images of non-motor
vehicles.

Note:
Please first add the smart NVR on the platform for non-motor vehicles comparison via the smart NVR.

1. Select the search type as Search by Image.
2. Click Upload Local File to upload the image of the non-motor vehicle you want to search for (up to 1 image).

3. Set the search criteria.

Snapshot Time Set the start and end times of the records.

Snapshot Location Select NVR(s) or the video channels under NVR(s), and the uploaded image
will be compared with the non-motor vehicle pass-thru records in NVR(s).

Match Set the image similarity threshold. The search results will only display non-
motor vehicle images with similarity greater than or equal to the threshold
to the uploaded image.

4. Click Search to search non-motor vehicle pass-thru records that meet the criteria.

Figure 18-10: Search Non-motor Vehicle Pass-thru Records

@ searchType | Search by Image - SnapshotL.. | 192.115.189_1192.115. *=*
Q Match (%) ] 80 o e allowe:
&t SnapshotTi.. | 2025-05-27 00:0000 ~ 2025-05-2923:59:59 (=] Today Last3days Last7days Upload Local File Reset

Search Results
The search results are displayed at the bottom of the page.

Click a specific result to show the original snapshot image, recording (5 seconds before and after the snapshot),
and snapshot details on the right side. Click [fg] to save the image/recording.

18.5.3 Non-Motor Vehicle Trajectory

For non-motor vehicle image search records, the system supports marking the location where a non-motor
vehicle appeared on the map and generating its movement trajectory in chronological order. The trajectory
provides information such as the non-motor vehicle's activity range and stop points.

Operation Description

After finding the matching non-motor vehicle on the Non-Motor Vehicle Search page, click © in the top-right

corner of the result list to view the non-motor vehicle's movement trajectory on the map. Click to play the

trajectory, with adjustable playback speed. Enabling snapshot preview will allow you to view the non-motor
vehicle's snapshot images at the device locations.
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@ Note:

e Please complete Map Configuration first: Upload the map and mark the camera locations.

¢ The system will only generate the trajectory for the most recent 20 snapshot records from the search
results.

e Try to set more precise search conditions (such as a higher similarity threshold) to help the system
retrieve snapshots of the same non-motor vehicle, enabling the generation of the non-motor vehicle's
movement trajectory.

R (O 202505728 12:1920
) 1921151892

=
B (© 2025/05/28 17:02:17
R (=7 192.115.1.89 2

ISR (© 2025/05/28 193551
(=7 192.115.1.89.2

18920

. mzozsfos,/zs 193551
o ARE] ;

ER © 2025/05/28 19:4249
£ 192.115.1.89.2

2025/05/28 19:35:51

19 AcuTrack

Data Search > AcuTrack

AcuTrack can search for motor vehicle/non-motor vehicle/pedestrian targets in recorded videos by a target
image. It can retrieve the video segments containing the target and mark the corresponding time periods on the
playback progress bar. AcuTrack allows users to continuously view the video segments containing the targets,
review the events, greatly reducing the workload of video investigation.

Note:
The AcuTrack function relies on intelligent computing power: you need to add smart NVRs to the platform.

Target Search

1. Click Upload in the top left corner and upload an image of the target.
For a large scene image, after the image is uploaded, the system automatically recognizes and extracts
thumbnail images of all targets in it, and you must select one image that will be used for target search.

@ Note:

e The uploaded image must be in JPG format and less than 4MB.
¢ Only one image is supported. Uploading again will overwrite the previously uploaded image.

2. Set atime range (up to 24 hours), capture device, similarity, and click Search.
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| Motor Vehicle/Non-Mator Vehicle/Pedestrian Snapshots (8)  + Upload () Time(cannot exceed 1 day) Snapshot Location Match (%)

2025-07-1500:00:00 ~ 2025-07-1523:59:59 =

© 2025-07-15 14:21:58
192.115.1.69-D2

Search Results

Attention:
Switching page will reset the existing search results, and you will need to perform a new search when going
back next time.

e The left side shows the video segments containing the target, sorted from early to late by time. The recording
start time and camera name are shown above the video. The video duration is displayed in the lower right
corner.

¢ Select a video segment to play it. On the timeline, red indicates video segments with target, and blue
indicates regular video segments.

* Click on the playback toolbar to search for targets on the current video image.

Drag to select the person or vehicle you want to search for

X

AcuSearch
AcuTrack

1. Search the target to search:
¢ Drag the mouse within the green box to move its position.

e Hover over the edge or vertex of the green box. When the cursor turns into an arrow shape, drag to
resize the green box.

¢ To exit the search, click X.
2. Choose a search mode. Two modes are available:

¢ Click the AcuSearch button at the top right corner of the green box to go to the SeekFree page, where
the system will automatically search for all capture records of the target within the green box (see
Search by Image).
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¢ Click the AcuTrack button at the top right corner of the green box to go to the AcuTrack page, where
you can search for recordings containing the target in the green box.

20 People Flow Counting

This function is applicable to people flow control scenarios such as campus areas, train stations, etc. The smart
IPCs, NVRs or radar devices count the number of people entering and leaving an area and the number of people
present in an area to track the dynamics of people flow, helping formulate evacuation or security measures in a
timely manner to ensure safety.

Functions

Menu Description

Real-Time People Allows users to view live video from devices and real-time data reported from

Counting devices, including people counting data and crowd density data, and will trigger an
alarm when the number of people in an area exceeds the preset threshold.

Data Statistics Allows users to view the people flow dynamics within an area by time period and
view the details.

20.1 Real-Time People Counting

Go to Video Application > Smart Live View > People Counting.

View the live videos of the video channels under the smart IPC/NVR/radar and the people flow and crowd
density data.

@ Note: Among radar devices, only visual intelligent alarm detectors support live view.

Prerequisite

¢ Smart IPC/NVR/radar devices have been added to the platform. See Device Management > Private Device.

e People flow counting and crowd density monitoring functions have been enabled on the device.

On the Smart Live View page, click ~ and select People Counting.

20.1.1 People Flow Counting

Configure people flow counting tasks on the device, detect the number of people entered/exited and calculate
their difference to get the number of people present in the monitoring area.

Add People Flow Counting Area

1. Click 4 for the people flow counting. A dialogue box appears.

@ )——————— 0

Basic Information Basic Information Select Device

. Counting Avea 1 Device List Selected(2) £ Clear

. f i
“push Interval () 60 e s Note: People flow counting must be

=
B o<
2. Configure the area information.
Item Description
Name Set the counting area name.
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Item Description

Push Interval(s) Set the alarm push interval.

Alarm Threshold Set the critical, major and minor alarm threshold. An alarm is reported when the
number of people present exceeds the threshold.

[E> Note: Threshold level: Critical (required) > Major > Minor.

Select Device Select devices (maximum 20) for the people flow counting.

3. Click OK.

View People Flow Counting

e The counting area list is on the left and the critical alarm threshold are displayed next to the counting area
name.

e On the people flow counting area, double-click on a device in the channel list to view its live video in a
window.

@ Note:

®* Upto 4 live videos can be displayed at the same time. You can click - in the lower left corner to
switch to 1/3/4 windows.

¢ To perform operations on the live view, see Live View Toolbar.

People Counting

P LI frd A
I T s 2 g
B iy 77 g

L T

i

NO VIDEO

e Click === for the people flow counting area and select Search. The real-time data of people entered/exited/
present/allowed (critical alarm threshold - people present) are displayed on the right side.
If the number of people present is less than the critical alarm threshold, the status is Entry Allowed;
otherwise, the status is Entry Prohibited.

* Click [E in the right corner to view Data Statistics.

Edit Area

Click === for the people flow counting area and select Edit to edit the area information, including the area name,
push interval, alarm threshold and camera.

Delete Area

Click === for the people flow counting area and select Delete to delete the area.

20.1.2 Crowd Density Monitoring

Configure the crowd density monitoring tasks on the device and detect the number of people present (crowd
density) in the monitoring area.
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Add Crowd Density Monitoring Area

1. click + for the crowd density monitoring. A dialogue box appears.

Crowd Density Monitoring Area Info X Crowd Density Monitoring Area Info x

Basic Information Basic Information Select Device

*Name Detection Area 1
*Push Interval (s 60

| Crowd Density Ala...
Click to select

*Critical Alarm Threshold

2. Configure the area information.
Item Description
Name Set the counting area name.
Push Interval(s) Set the alarm push interval.
Alarm Threshold Set the critical, major and minor alarm threshold. An alarm is reported when the

number of people present exceeds the threshold.

[E> Note: Threshold level: Critical (required) > Major > Minor.

Select Device Select one device for the crowd density monitoring.

3. Click OK.

View Crowd Density
e The counting area list is on the left. The critical alarm threshold are displayed next to the counting area name.

e On the crowd density monitoring area, double-click on a device in the channel list to view its live video in a
window.

@ Note:

®* Upto 4 live videos can be displayed at the same time. You can click - in the lower left corner to
switch to 1/3/4 windows.

e To perform operations on the live view, see Live View Toolbar.

People Counting

e Click === for the crowd density monitoring area and select Search. The real-time data of people present and
allowed (critical alarm threshold - people present) are displayed on the right side.
If the number of people present is less than the minor alarm threshold, the status is Normal; otherwise, the
status is Minor Alarm/Major Alarm/Critical Alarm.
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Edit Area

Click === for the crowd density monitoring area and select Edit to edit the area information, including the area
name, push interval, alarm threshold and camera.

Delete Area

Click === for the crowd density monitoring area and select Delete to delete the area.

20.2 Data Statistics

Go to Data Search > People Counting.

Users can view the people flow dynamics within an area by time period and view the details.

@ Note: You need to add a People Flow Counting area first.

1. Select a counting area in the people flow counting area list on the left.

2. Select the counting type, set the counting period, and then click Search.
Type: By Hour v 2023-09-26 00 2023-09-27 00 m Today Las

eoteFow o I A

? Counting Area 1.

Current monih

350

? Counting Area 2 ...

€2 Counting Area 3 ...

" T0100 | 0200 ' 0300 ' 0400 | 05:00 ' 0600 0700 0800 ' 0900 ' 10:00 ' 11:00 ' 1200 ' 1300 | 1400 ' 1500 1600 1700 1800 19:00 ' 20:00 ' 21:00 | 22:00 ' 23:00 ' 00:00
Entered Bited -O- Present

2, Export Show Details

Channel Name 2 Counting Period 4 Entered + Exited & Search Result &

1P Camera 02 2023/09/26 01:00 0 0 Succeeded

1P Camera 02 2023/09/26 02:00 0 0 Succeeded

1P Camera 02 2023/09/26 0300 0 0 Succeeded

IP Camera 02 2023/09/26 04:00 0 0 Succeeded

1P Camera 02 2023/09/26 05:00 0 0 Succeeded

1P Camera 02 2023/09/26 06:00 o 0 Succeeded

® Statistical chart: Click E L. in the upper-right corner to switch the view to line chart or bar chart.

¢ The line chart shows the trend of the number of people entered/exited/present at each point of time.
Click -0~ entered edted -O- Present tO filter the statistics.

¢ The bar chart shows the number of people entered/exited/present. Click mm ent=rec Exited () Present 1O
filter the statistics.

(Uit: Person) b u

09:00 10:00 11:00 12:00 12:00 14:00 15:00 16:00

Entered Exited () Present

e Data list: Shows the number of people entered/exited/present at each point of time.
¢ Select Show channel details to show the channel name in the list.

e Click Export to export data.

21 Radar Control

Go to Park Application > Radar Control.

Radars support human presence detection, fall detection, people counting detection, and vital sign detection.
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Once radars are connected to the platform via the private protocol and monitoring tasks have been assigned to
them, radar detection alarms can be reported to the platform.

Prerequisite

Radars have been added in Device Management > Frontend Device > Private Device.

21.1 People Counting Monitoring

Triggers an alarm when the number of people in the monitoring area exceeds the set threshold.

Add Monitoring
1. Click Add.

2. Enter the task name, and then specify monitoring area, alarm threshold(maximum allowed people number),
monitoring period, and monitoring cycle.

e By day: Set up to 8 monitoring periods for a day. The task will be repeated daily.

¢ By week: Set monitoring periods for each day of the week. The task will be repeated weekly.

Add X
“Task Mame: Please enter ':::.
*Monitoring Area: Radar X

*Alarm Threshold:  Greater thar{ 100 :.people \:

*Monitoring Period: | 2025-06-24 2025-08-30 =

*Monitoring Cycle: (@) By Day By Week

No. Start Time End Time Operation

3. Click OK.

+ Add < Refresh Sorted by task creation time

5@ People Counting Monitoring

. Task Name Task Creation Ti.. Monitoring Area Alarm Th... Monitoring Period Monitori.. Alarm C... Latest Alarm Time Task Status. Operation
4%) People Pr

PecpleCounting  2025-06-24 19:4134 Radar 100 2025-06-24+2025-06-30 By Day 0

W 2 1m

%) Fail Monitoring

w

Other Operations

¢ Filter tasks: You can search monitoring tasks by task name, latest alarm time, and task status. You can also
click % to collapse the search criteria.

View details: Click |;EI in the Operation column to view monitoring task details and alarm records.

247



Current Location: Monitoring List»People Counting Monitoring Details

PeopleCounting Edit

Task Creation Time: 2025-06-24 19:41:24 Monitoring Area: Radar Alarm Threshold: 100 Monitoring Period: 2025-06-24~2025-06-30

Monitaring Cycle: By Day v View Detal Alarm Court: 0 Latest Alarm Time: -

Total 0 alarm record(s) 2025-06-24 00:00:00 2025-06-30 23:59:59 Refresh

Alarm Device Alarm Type Alarm Time Status Operation

Click View Details to view the alarm location and handle alarms. (Note: Currently, radars do not support
camera connections, so live view and playback functions are unavailable now.)

Stop task: Click in the Operation column to stop the monitoring task. Once stopped, alarms will not be
triggered.
e Edit task: Click /# inthe Operation column to edit the monitoring task.

e Delete task: Click [ii] inthe Operation column or select task(s), and then click Delete above the list.

21.2 People Presence Monitoring

Detects the presence of individuals in the monitoring area.

* Presence alarm: Triggers an alarm when someone remains in the monitoring area for a long time, such as
lingering in a hazardous zone.

e Absence alarm: Triggers an alarm when no one is present in the monitoring area for a long time, such as
employees being away from their duties or absent for a long time.

Note:
Time thresholds can be configured on the radar's management page.

Add Monitoring
1. Click Add.

2. Enter the task name, and then specify monitoring areas, monitoring period, monitoring type and monitoring

cycle.
e By day: Set up to 8 monitoring periods for a day. The task will be repeated daily.

e By week: Set monitoring periods for each day of the week. The task will be repeated weekly.
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Add

“Task Mame:

*Monitoring Area:

*Monitoring Period:

*Manitoring Type:

*Manitoring Cycle:

Mo.

3. Click OK.

eople Counting Monitoring

) ol Monitoring

Other Operations

PresenceMonitoring
Radar X

2025/06/24

(®) Prolonged Presence

® By Day By Week
Start Time
09:00:00
+ Add O Refresh

Task Name Task Creation Time

Presenceblont 2025-06-24 10:47:54
aring

click % to collapse search criteria.

2025,/06/30

Prolonged Absence

End Time

17:00:00

Cancel

Wonitoring Area Moritoring Period

Radar 2025-06-24-2025-06-30 By Day

Monitoring...

Operation

Sorted by task creation time v Please enter the task name Y

Alarm Count  LatestAlarm .. Task Stat Operation

0

o
N
=]

Filter tasks: You can search monitoring tasks by task name, latest alarm time, and task status. You can also

View details: Click E‘ in the Operation column to view monitoring task details and alarm records.

(5) Current Location: Monitoring List >People Presence Monitaring Details

PresenceMonitoring

Task Creation Time: 2025-06-24 19:47:54

Manitoring Cycle: By Day v View More

Total 0 alarm data

Alarm Device

2025-06-24 00:00:00

Edit

2025-06-20 23:59:39

Alarm Type

Monitoring Area: Radar

Alarm Count: 0

Latest Alarm Time:

Refresh

Alarm Time

Status

Menitoring Period: 2025-06-24~2025-06-30

Operation

Click View Details to view the alarm location and handle alarms. (Note: Currently, radars do not support
camera connections, so live view and playback functions are unavailable now.)

triggered.

Edit task: Click / inthe Operation column to edit the monitoring task.
Delete task: Click 7]
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21.3 Fall Monitoring

Triggers an alarm when someone falls in the monitoring area.

Add Monitoring

1. Click Add.

2. Enter the task name, and then specify monitoring areas, monitoring period, and monitoring cycle.
e By day: Set up to 8 monitoring periods for a day. The task will be repeated daily.

e By week: Set monitoring periods for each day of the week. The task will be repeated weekly.

Add pid
*Task Name: Please enter ’
*Monitoring Area: Radar X ™
*Monitoring Period: 2025/06/24 2025/06/30

“Monitoring Cycle: By Day By Week
No. Start Time End Time Operation

1 09:00:00 21:00:00

3. Click OK.

+ Add O Refresh Soted by task crestion time

Task Name Task Creation Time Monitoring Area Monitoring Period Monitoring...  Alarm Count  LatestAlarm .. Task Stat Operation

FallMonitoring 2025-06-24 19:56:30 Radar 2025-06-24-2025-06-30 By Day. o - Enabled [ERONV-an)

Other Operations

e Filter tasks: You can search monitoring tasks by task name, latest alarm time, and task status. You can also
click %/ to collapse the search criteria.

View details: Click E‘ in the Operation column to view monitoring task details and alarm records.
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(5) Current Location: Monitaring List> Fall Menitaring Details

FallMonitoring Edit

Task Creation Time: 2025-06-24 19:56:30 Monitoring Area: Radar Monitoring Period: 2025-06-24~2025-06-30
Monitoring Cycle: By Day v View More Alarm Count: 0 Latest Alarm Time:
Total O alarm data | 2025-06-24 0000:00 2025-06-30 23:50:50 Refresh

Alarm Device Alarm Type Alarm Time Status Operation

Click View Details to view the alarm location and handle alarms. (Note: Currently, radars do not support
camera connections, so live view and playback functions are unavailable now.)

Stop task: Click i“: in the Operation column to stop the monitoring task. Once stopped, alarms will not be
triggered.

e Edit task: Click /# inthe Operation column to edit the monitoring task.

e Delete task: Click 7ii] in the Operation column or select task(s), and then click Delete above the list.

21.4 Vital Sign Monitoring

Triggers an alarm when the vital sign (heart rate/respiration) does not meet the set threshold, allowing timely
health conditions for personnel.

Add Monitoring

1. Click Add. Configure parameters as described below.
Add

X
*Task Mame: Please enter @)
*Manitoring Area: Radar X
“Alarm Threshold: Heart rate - Greater than ™ 20 times per minute
Breathe \’ Greater than \’ 20 times per minute [-]
Heart rate Greater than 20 Times per minute or Breathe Greater than 20 times per minute Switch
*Monitoring Period: | 2025-06-24 2025-06-30

*Manitaring Cycle: (@) By Day By Week

Mo. Start Time End Time Operation

“ Cance'

Item Description
Task Name Customize the rule name as needed.
Monitoring area Select the radar(s) for monitoring.
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Item Description

Alarm threshold e Triggers an alarm when the respiration is greater than/less than N times per
minute.

e Triggers an alarm when the heart rate is greater than/less than N times per

minutes.
Monitoring period Set a start and end date for monitoring.
Monitoring Cycle e By day: Set up to 8 monitoring periods for a day. The task will be repeated daily.

e By week: Set monitoring periods for each day of the week. The task will be
repeated weekly.

2. Click OK.

+ Add

Q
P

Sorted by task creation time

eople Counting Meritoring

Task Name Task Creation Ti.. Monitoring Area Alarm Threshold Monitoring Period Monitori Marm C... Latest Alarm Ti Task Stat.. Operation

%) raii Monitoring VialSign 2025-06-24 2007:23 Radar 2025-06-24~2025-06-30 8y Day 0
‘fﬂ Vital Sign Monitoring
Other Operations
e Filter tasks: You can search monitoring tasks by task name, latest alarm time, and task status. You can also
click to collapse the search criteria.
View details: Click in the Operation column to view monitoring task details and alarm records.

Current Location: Monitoring List>Vital Sign Monitoring Details

VitalSign Bt

Task Creation Time: 2025-06-.

Monitoring Area: Radar Alarm Breathe Greater than 20 Times per minute a..  Monitoring Period: 2025-06-24~2025-06-30
Threshold:

Monitoring Cycle: ByDay v View Details Alarm Count: 0 Latest Alarm Time: -

Total 0 alarm record(s) 2025-06-24 00:00:00 2025-06-30 23:5%:59 Refresh

Alarm Device Alarm Type Alarm Time Status Operation

Click View Details to view the alarm location and handle alarms. (Note: Currently, radars do not support
camera connections, so live view and playback functions are unavailable now.)

Stop task: Click in the Operation column to stop the monitoring task. Once stopped, alarms will not be
triggered.
e Edit task: Click / inthe Operation column to edit the monitoring task.

e Delete task: Click [ii] inthe Operation column or select task(s), and then click Delete above the list.

22 Parking Management

Go to Park Application > Parking Mgt.

The basic parking management services cater to parking scenarios without parking fees, such as corporate
campuses, industrial sites, communities, and schools. It is designed for parking lot managers and staff, providing
vehicle access management, as well as the search and analysis of vehicle flow and violation data, offering an
intelligent parking management system and visual data management platform.

Key Functions:

e Parking lot management: Manage parking lots and associated LPR cameras (for entrance/exit) + gates and
radar cameras + LED displays, providing online configuration and remote control of parking lot devices.
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Note:

Gates and LED displays do not need to be manually added to the platform.

e Gates are physically connected to LPR cameras (for entrance/exit), allowing for gate control through
vehicle recognition. They are generally deployed at parking lot entrances and exits.

e LED displays are physically connected to radar cameras and display vehicle information when speeding

is detected. They are generally deployed on campus roads with speed limits.

e Vehicle management: Add and manage information for authorized and forbidden vehicles. The system also
allows for configuring validity periods and adding speeding vehicles to the forbidden vehicle list, ensuring
effective vehicle permission management.

e Data search, analysis, and statistics: Provides vehicle flow statistics, pass-thru violation vehicle data, and
violation alarms, offering insights into vehicle trends and supporting parking lot management.

@ Note:

Violation vehicle data can be viewed on related pages such as in Smart Live View > Vehicle Application,

Comprehensive Search > Motor Vehicle Search, and Alarm Center.

Parking Mgt

Lane Device

Rule Rule

ParkingLot  Entrance & Exit

Let Through Speeding

Speeding Event

Radar Camera +
LED Display

Vehicle Mgt
Authorized vehicle
Forbidden vehicle

Wehicle Sync

vehicle Vehicle Pass-
Flow thru Record

Violation violation Data
Alarm  Record Statistics

Data Search

Device Mgt

22.1 Parking Lot Management

Before using this function, you must first add parking lots to the system. You can also add sub-parking lots (e.g., a
main parking lot is divided to surface and underground sub-lots). When adding a parking lot, you need to provide
detailed information about the parking spaces in both the main and sub-lots. If vehicles are already parked during

-

LPR Camera + Gate

setup, the number of available parking spaces should reflect the actual situation.

Once a parking lot is added, you can add entrances & exits and lanes, as well as bind cameras.

Up to 8 parking lots (1 main lot, 7 sub lots) and 16 entrances & exits are allowed. Each entrance & exit can have 2

lanes.

Note:

The number of parking spaces and let through rules for the main and sub-lots are independent.

22.1.1 Add Parking Lot

Prerequisites

Entrance & exit devices have been added in Device Management > Frontend Device > Private Device.

e For LPR cameras, select LPR as the device type.

e For radar cameras, select Radar Vision as the device type.
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Add Parking Lot
1. Go to Parking Mgt > Parking Lot Management.

Parking Lot + 2 Default_Parking Total Space: 1000  Total parking spaces for Pre-registered Vehicles: 100
~ (P Default_Parking _
& NIE Entrance & Exit + £ W Lane Info Linking Devices
~ & Default_Entran... “Lane Name Lanel
Lanel TiJ
Lane? *Lane Type Entrance -

Save

2. Click -+ in the parking lot list.

3. Fill in the basic information for the parking lot.

Add Parking Lot Wizard X

Basic Parking Lot Info

e & Exit Config Lane
I Parking Lot Info

*Parking Lot Name Please enter

*Parking Space Total Parking Space

Parking Space for Pre-... | Parking Space for Pre-registered V

I Let Through Rule

Let Through Rule Allow Pre-registered Vehicles C ~
Cancel

Item Description
Parking Lot Name Required. Enter a custom name.
Parking Space Required. Enter the actual number of parking spaces.
Parking Space Count for Enter the actual number of parking spaces for authorized vehicles.
Authorized Vehicles
Let Through Rule e Rule 1: Only authorized vehicles are allowed entry; forbidden vehicles

and unlisted vehicles are denied entry.

* Rule 2: Forbidden vehicles are denied entry; authorized vehicles and
unlisted vehicles are allowed entry.

4. Add entrance & exit.
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Add Entrance & FExit b4

*Entrance & ...

Number of ... | 2

Item Description
Entrance & Exit Required. Enter a custom name.
Name

Number of Lanes Choose 1 or 2, based on the actual number of lanes.

5. Configure the lane information.

Add Parking Lot Wizard X

© © ©

Basic Parking Lot Info Add Entrance & Exit Config Lane

Entrance & Exit Lane Info Linking Devices

- *Lane Name Lanel

Lanel
Lane? *Lane Type Entrance -
-
Lanel
Lane2
[ Back l [ Mext l Cancel
Item Description
Lane Name Enter a custom lane name.
Lane Type Choose Entrance or Exit as needed.

6. Link devices to the lane.
On the Linking Devices tab, click Linking Devices, and then select device(s) to link.
[®p Note:

Only LPR cameras can be selected. Cameras are added in Device Management > Frontend Device >
Private Device.
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Add Parking Lot Wizard X

© e
\\,// \\,//

Basic Parking Lot Info Add Entrance & Exit Config Lane

Entrance & Exit Lane Info Linking Devices

-1 -+ Linking Devices

Lanel
Device Name © Device Type © IP Address  © Device Status © Operation
Lane2
2
Lane1 Add Linking Device %
Lane2
<Please enter device name ke)
Device Na... & Channel ID & IP Address © Access Pr... & Device Ty... © Status ’ Operation
1961 5257692644... 172.20.86.196 Private Capture Cam... e Online El

7. Click Save.

Manage Parking Lot

Click ( /# or 117 ) to edit or delete parking lots, entrances & exits, lanes, and linked devices.

Parking Lot Default_Parking Total Space: 1000  Total parking spaces for Pre-registered Vehicles: 100
~ (P Default_Parking =
. Entrance 8 Exit + £ W| tLaneinfo Linking Devices
@®NIF i —
~ @ Default Entran... — Linking Devices | = (3 Refresh
& Lane1
B ne2 @ Device Name ¢ Device Type > IP Address ¢ Device Status ¢ Operation
1961 Camera 172.20196.196  Online

22.1.2 Configure Alarm Rules

¢ Speeding Alarm: Based on the speed detection capabilities of radar cameras, you can configure speeding
alarm rules to receive speeding alarms and deny access to speeding vehicles.

e Match/Not Match Alarm: The system supports setting match and not match alarms for authorized and
forbidden vehicles. It performs a license plate comparison between the vehicles captured by the camera and
the registered vehicles. If the license plates match, it reports a match alarm; otherwise, it reports a not match
alarm.

Note:

Alarm rules should be configured for the main parking lot and will apply to all LPR cameras and radar vision
cameras added to the platform.

Steps

1. Select the main parking lot and click /.
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Edit Parking Lot Info X

I Parking Lot Info

*Parking Lot Name

*Parking Space

Parking Space for Pre-...

I Let Through Rule

et Through Rule

Default_Parking_Lot

1000

Allow Pre-registered Vehicles C ~

I Speeding Alarm

Speeding Alarm

Add Speeding Vehicle...

(:) Speedin... | 10 Km/h

I Alarm Type
Authorized Vehicle Naot Match Alarm v
Forbidden Vehicle Match Alarm v
2. Configure speeding alarm rules.
Item Description
Speeding Alarm When enabled, set the threshold for speeding alarms (default is 10 km/h, range is
1-300 km/h).

An alarm is triggered if a vehicle's speed exceeds the set threshold.

to Forbidden Vehicle

Add Speeding Vehicles [E> Note: This function can be enabled after the speeding alarm is enabled.

List When enabled, set the frequency threshold, so that when a vehicle exceeds the
speed limit M times within N days, it is automatically added to the forbidden
vehicle list.

3. Configure match alarms for authorized vehicles, and configure not match alarms for forbidden vehicles.
Take authorized vehicle as an example:

¢ |f set to Match Alarm, when the captured vehicle's license plate matches that of an authorized vehicle, a
match alarm is reported. This can be used to alert the appearance of authorized vehicles.

¢ If set to Not Match Alarm, when the captured vehicle is not in the list of authorized vehicles, a not match
alarm is reported. This can be used to alert the arrival of unfamiliar vehicles.

e If set to Disable, then the license plate comparison will not be performed, and no alarms will be

generated.

4. Click Save.

Related Operation

To search vehicle alarms, see Motor Vehicle Search.
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22.2 Vehicle Management

Manage vebhicle access permissions for parking lots using the authorized and forbidden vehicle lists.

Vehicle Types

e Authorized Vehicle: Vehicles added to the authorized vehicle list are granted access to the parking lot during

the specified validity period.

e Forbidden Vehicle: Vehicles added to the forbidden vehicle list are denied access to the parking lot during the
specified validity period.

e Temporary Vehicle: A vehicle is considered temporary if it is unlisted on either the authorized or forbidden
list, or if is listed but outside the validity period. Access permissions for temporary vehicles are determined by
the parking lot's let through rule.

Priority Determination

If a vehicle's license plate is on both the authorized and forbidden lists, and is within the validity period for both

lists, the vehicle will be prioritized as a forbidden vehicle.

Effective Scope

Vehicle lists are applied uniformly across all parking lots.

22.2.1 Authorized Vehicle

Add authorized vehicle information, including vehicle information, owner information, authorized validity period,

etc.
+ Add 1] Delete oy Import
A22222
umber A22222
A9999
A00002
AA0000
A00009
A00008
A00007
#HiA00006
Note:

~

T, Export

1o

o)
o)

Bob

Basic Information

2/16-2024/12/26

[ 2024/12/16-2100/12/31

6-2024/12/31

-2024/12/31

6-2024/12/31

8-2024/12/31

Total 14 \:\ 20/page

Plate Num

Status - Operation

® Norr 2 W
1231451
@ Inactive 2
® Norr Z
@ Norr 2 W
@ [nactive Zamm|
@ Long-Term 2
@ Norma 2 W
® Long-Term 2 1

Goto | 1

The authorized vehicle list synchronously displays vehicles associated with Person/Visitor.

Add Authorized Vehicle

You can add authorized vehicles one by one or in batches.

Add one by one
1. Click Add.
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Vehicle Info Authorization Info
*Plate Num... Start Time SetDateand Tme B
Plate Type Small Vehicle Plate - End Time Set Date and Time =

Leaving start time and end time blank means pe...

Plate Color | Blue
Vehicle Type | Small Vehicle -
Vehicle Col.. | White N

Vehicle Owner Info

Vehicle Ow...

CardType | ID Card .

Telephone

2. Complete the vehicle information.

Vehicle Info Plate number is required.
Vehicle Owner You can enter the information manually or click Bind Person to select a person from
Info department to bind.
Department Pleace enter keyword
ST Person... & Name % Gender % Depart... ID Car... % CardN... & Mobile... Featur.. & Operation
£} dept
003 Wang Male dept 110 No Image =)
zhangsan zhang Male dept 120 No Image )
001 Anna Male dept No Image =)
002 Lisa Male dept No Image =)
Total 4 20/page - | Goto | 1
Cancel
[E> Note:
After binding here, the vehicle will be accordingly added to the Person's vehicle list.
Authorization Vehicles will only have access during the authorized validity period. Leaving the start
Info time and end time blank means permanently valid.

3. Click Complete to save.
Batch import
1. Click Import.
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Import X
Save File To b

Download

2. Prepare a template.

(1) Click Download to download the import template.
(2) Fill in the template with vehicle information.
3. Import the template.
(1) In the Import window, click the text box, and select the modified template from local.
(2) Click OK.

Other Operations
e Search: Select a search criteria in the upper-right corner and enter keywords to search for vehicles.
* Edit: Click 4 for the vehicle to edit the vehicle information, see Add Authorized Vehicle.

Note:
If the vehicle is already associated with a person/resident/visitor:

* You cannot modify the vehicle's plate number, owner name, or authorized validity period.

¢ You click Reset to unbind the person-vehicle association. The vehicle will also be removed from the
Person's/Resident's/Visitor's vehicle list.

e After resetting, you can also rebind the vehicle to another person.
* Delete: Click 7ii; for the vehicle, or select vehicle(s) to delete and click Delete.

Note:
If the deleted vehicle is already associated with a person/resident/visitor, it will also be removed from the
Person's/Visitor's vehicle list.

e Export: Select vehicle(s) and click Export to export the vehicle information into a file.

22.2.2 Forbidden Vehicle

Add forbidden vehicle information, including plate number, owner information, prohibited entry time periods,
etc.

+ Add | T Delete Please enter keywords

Vehicle Owner < Plate Number Mobile Phone No. Start Time End Time Remarks Operation
A12345 PR}
A12456 2 W
AA45678 2024,/08/22 00:00:00 2 W

AB A456788 ThaSe a2 2024,/08/08 00:00:00 2024/08/09 16:19:25 4

Add Forbidden Vehicle
1. Click Add.

2. Enter the required license plate information and other details as needed.
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Add X

*Plate Number

Vehicle Qwner

Phone No.

Start Time

End Time

Remarks

“ Cance'

Note:
Vehicles will be denied access during the specified time period. Leaving start time and time blank means
permanently prohibited.

3. Click OK.

Other Operations
e Search: Enter the license plate keywords in the upper-right corner to search for a specific vehicle.

* Edit: Click /# for the vehicle to edit the vehicle information.

* Delete: Click 7iij for the vehicle, or select vehicle(s) to delete and click Delete.

22.2.3 Vehicle Data Sync

You can sync authorized and forbidden vehicle information to parking lot devices.

The list displays the matching relationship between all vehicles and parking lot lanes. You can search for vehicles
using criteria such as parking lot name, entrance & exit, lane name, plate number, vehicle attribute, and sync
status.

* Syncone by one: Click =] for the vehicle to sync its information to the corresponding lane’s device.

e Batch sync: Select vehicle(s) and click Batch Sync to sync the information of the selected vehicles to the
devices. If you click Batch Sync without selecting any vehicles, all vehicles meeting the search criteria will be

synced.

Parking Lo, Entrance.. | Lane Neme | © Plate Num..

Vehicle Att.. N Sync Status Al

Batch Sync

Plate Number Vehicle Attrib... Parking Lot N... Entrance & Exit Lane Name Sync Time Sync Status Failure Cause Operation

A00022 Pre-registered Ve.. 2024/08/10 09:36... To be synced )
A00023 Pre-registered Ve... 2024/08/10 09:36... To be synced )
A00D024 Pre-registered Ve... 2024/08/10 09:36... To be synced )
A00025 Pre-registered Ve... 2024/08/10 09:36... To be synced )
A00026 Pre-registered Ve... 2024/08/10 09:36... To be synced 1
A00027 Pre-registered Ve.. 2024/08/10 09:36... To be synced |
A00028 Pre-registered Ve.. 2024/08/10 09:36... To be synced ]

22.3 Vehicle Volume

You can search for parking lot vehicle flow statistics on the Vehicle Flow page.

Search criteria:
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e Statistical unit: By Day/Month/Year (default is the current day/month/year; you can specify a different day/
month/year)

e Parking Lot

e Entrance & Exit

Calculate By By Day 2024/08/09 00:00:00 ~

Parking Lot

Total Parking Volume Average Traffic Volume/Hour T, Export

8 1

Search Results:

Total Parking Volume | The total number of vehicles that meet the search criteria, including both vehicles
entered and exited.

Average Traffic ¢ By Day: Average vehicle flow per hour = (Total daily vehicles entered + Total daily
Volume vehicles exited) / 24 hours.

¢ By Month: Average vehicle flow per day = (Total monthly vehicles entered + Total
monthly vehicles exited) / 30 days.

e By Year: Average vehicle flow per month = (Total yearly vehicles entered + Total
yearly vehicles exited) / 12 months.

Click to display the data as a line chart.

il Click to display the data as a bar chart.

Click to save the current chart as an image file.

Export Click Export to download the detailed record search data as a vehicleFlowList.csv file
locally.

23 Electronic Patrol

This function is mainly used for campus area scenes where security guards patrol the premise according to the
patrol schedule.

You can configure patrol schedules on the platform, specify personnel to conduct patrols according to the
schedule and designated routes. After patrollers check in at patrol points through face recognition terminals/
general access control devices/access controllers, the system generates patrol records accordingly to keep track
of patrol tasks.
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; Configure Patrol Schedule .‘2. Execute Patrol Task

Patrollers checkin ondevices at the designated
Patroller1/2 | Shift1 | Route 1 E . E—. E — E timesand routes

Patroller3 | Shift2 | Route2 E—. El—- El_..q @
(z)
Patroller4/5 | Shift3 | Route3 [i{— Elﬁ = El
1 ®
Patroller N Shift N | Route N «ev et % @

The general patrol process is as shown below:

Person Patrol Point prey—
Library
= Patrol Route N Patrol - Patrol Records

Permission l
Schedule

Config

Face recognition terminal

| Access Controller

|
| .
|

General access control device

Prerequisite

¢ Patrollers have been added in the person library. See Personnel Management .
¢ Device permissions have been assigned to patrollers. See the descriptions below.

1. Add face recognition terminals, general access control devices, and access controllers. See Device
Management > Frontend Device > Private Device.

2. Configure device permissions for persons in the personnel library. See Access&Attendance > Access
Control Permission.

23.1 Patrol Configuration

23.1.1 Patrol Point

Add face recognition terminals, general access control devices, and access controllers as patrol points. Patrollers
need to check in on the specified devices to complete the patrol schedule.

Add Patrol Point
1. Click Add to add a patrol point.

2. Enter a name for the patrol point, choose a device type, and then select a device from the list.
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Add Patrol Point X

*Patrol Point Name:

*Device Type:  (®) Face Recognition Terminal
General Access Control Device

Access Controller

A

+ F‘jlclc:ucl
& 2oe1m1103

M 2c 181183 AC 1

QK Cancel

3. Click OK. The patrol point is added.
4. Repeat the above steps to add all the needed patrol points.

Patrol Point Name: Device Type: Device Name: Reset
Add Refresh
Patrol Point Name Device Type Device Name Operation
Point2 Face Recognition Terminal 21741173
Point1 Access Controller 217.2.2.100

Manage Patrol Point
You can search, edit, or delete patrol points.
e Edit: Click /~ torename a patrol point (cannot change the patrol device).

* Delete: Click 7iij to delete a patrol point; or select multiple patrol points and then click Delete on the top to
delete the selected patrol points.

e Search: Set search criteria such as patrol point name, device type, device name, and then click Search.

23.1.2 Patrol Route

A patrol route includes patrol points arranged in certain order at certain time interval for patrollers to follow
when conducting patrols.

e A patrol route can include face recognition terminals, general access control devices, and access controllers.

¢ In a patrol route, one device can be added only once that is to say, one device cannot be patrolled multiple
times in a patrol route.

e The following patrol methods are available:
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Patrol Method

Description

All Random

Patrollers are allowed to patrol in random order, so long as all the patrol points are
covered.

First Point Fixed

Except for the first patrol point, other points allow check-in in any order.

First and Last Points
Fixed

Except for the first and last patrol points, other points allow check-in in any order.

All Points Ordered
(Random Interval)

The patrol must be conducted in the order specified by the patrol list, with no
specific time interval required between adjacent patrol points.

All Points Ordered
(Fixed Interval)

The patrol must be conducted in the order specified by the patrol list, with the
same time interval between adjacent patrol points.

All Points Ordered
(Custom Interval)

The patrol must be conducted in the order specified by the patrol list, with the user-
set time interval between adjacent patrol points.

Figure 23-1: Patrol Route

Route Name Total Patrol Duration: Patrol Method: Patrol Point: Reset
Add Refresh Export v
Route Name Total Patrol Duration Patrol Method Number of Patrol Poi... Description Operation
Rout: 2minute(s) First Point Fixed 2
Route 2 Tminute(s) All Points Random 2 1212132123123123
Rout: Tminute(s) 4
Add Patrol Route
1. Click Add. A page as shown below appears.
Figure 23-2: Patrol Route
Current Location: Patrol Route> Add Route
“Route Patrol b Ardered (Fix val)
Name: Method: All Points Ordered (Fixed Interval)
AInterval *Check-in
n e\.va minute(s) Time minute(s)
duration:

Description:

Discrepancy:

* Selected Patrol Point(s)(3) :

Patrol Point Operation
013140E3
DOOR22

3232

Total Patrol Duration:40minute(s)

2. Set the patrol route. The parameters are described below.

Parameter

Description

Route Name

Enter a name for the route.

Patrol Method

Choose a patrol method. See patrol methods.

Total Patrol Duration

Required for the following patrol methods: All Random, First Point Fixed, First and

Last Points Fixed, and All Points Ordered (Random Interval)
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Parameter

Description

Set the total duration of the patrol (maximum duration is 300 minutes).

Time Interval

Required for All Points Ordered (Fixed Interval).
Set the time interval between two patrol points.

Time Discrepancy
Range

Set the allowable range of patrol time deviation, within which it is considered
normal patrol; otherwise, it is considered unscheduled patrol.

Patrol Point

Click - in the upper-right corner of the patrol list to add patrol points.

Patrol Point X

All
3232
013140E3

DOOR22

You can perform the following actions to a patrol list:

* Click 7ii] in the upper-right corner to clear all the patrol points.
* Click Tiij for a patrol point to delete it.

e Drag a patrol point to change its sequence in the list (only available to certain
patrol methods).

¢ First point fixed: You must set the first point. Click the corresponding Set as First
Point. The patrol point appears on the top of the list.

DOOR22 =]

e First and Last Points Fixed: You must set the first point and the last point
separately. Click the corresponding Set as First Point. The patrol point appears
on the top of the list. Click the corresponding Set as Last Point. The patrol point
appears on the bottom of the list.

Patrol Point O

01314083 L w E
DOOR22 €D (]

e All Points Ordered (Custom Interval): You need to set the time interval between
each patrol point and the previous patrol point.
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Parameter Description
Patrol Point Check-in Interval Operation
3232 minute(s) ]
013140F3 20 minute(s) (]
DOOR22 15 minute(s) w
Description Input a description of the patrol route.

3. Click OK.

Manage Patrol Routes

You can search, edit, delete, or export patrol routes.

Search: Set search criteria such as route name, total patrol duration, patrol method, and then click Search.

¢ Edit: Click /& to edit a patrol route.

Delete: Click 7 to delete a patrol route; or select multiple patrol routes and then click Delete on the top to
delete the selected routes.

Export: Select multiple patrol routes, and then click Export > Export Selected or Export All to export the
routes to a form.

23.1.3 Patrol Team

Assign patrollers to different teams so you can assign shifts when making a patrol schedule.

Create Patrol Team

1. Click in the team list to create a team.

Enter the team name, select patrollers, and then click :j:/—>.\:: to add them to the team.

Team List } Add Team

*Team Mame:
A Add Tear
an Add Team _
Person List

All People Selected Person(s)

E]

L] dept Name Gender Department Operation

1 Male 1

IS
W he

/- N, 2 Male 1

)

™ Bl -
3. Click Save.

Manage Patrol Team
View team members, edit teams, or delete unneeded teams.

Click in the upper-right corner to toggle between list or card mode.
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Figure 23-3: Patrol Team-List Mode

Team List { Teamt

Person List Edit oo

Name Gender Department
Male dept
2 Male dept

Figure 23-4: Patrol Team-Card Mode

Team List }

Team1
q
Person List Edit
-~ s
-—n '€EM
Patroller(s): 2
B
d.dn 1. An
. jr
£ o
1 (Male) 2 (Male)
dept dept

e View: Select a team in the team list to view the team members on the right.
e Edit: Click Edit on the right side to rename the team, add or remove team members.

e Delete: Hover over the team name and then click Delete to delete the team.

23.1.4 Patrol Schedule

Configure patrol schedules so patrollers can patrol the specified routes according to the set shifts.

Figure 23-5: Patrol Schedule

Schedule Patrol Route: SFhedu\e Effective 20240611 -~ 20240618 “ -

Name: Time:

Found query results 9 Add
Schedule Name Schedule Effective Time Patrol Route Patroller Operation
Schedule2 2024-06-18~2024-06-20 Route 1 i B W
Schedulel 2024-06-18~2024-06-30 Route 2 1 Em

Add Patrol Schedule
1. Click Add. A page as shown below appears.
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Figure 23-6: Add

o Schedule Details

*Schedule Name:

Holiday configuration(optiona Patrolle

By Week

Estimated Patrol Duration Start Time End Time Operation

T(minute(s)) 18:05:00

m canee

2. Configure the patrol schedule. See parameter descriptions below.

Parameter Description

Schedule Name Enter a name for the patrol schedule.

Schedule Effective Configure the time during which the schedule is effective. The schedule needs to be

Time carried out only during the effective time.

Patrol Cycle e By Day: Set a patrol schedule for a day, and the schedule will be repeated every

subsequent day.
e By Week: Set a patrol schedule for a week, and the schedule will be repeated
every subsequent week.

Daily Patrol Schedule | When setting a daily patrol schedule, you need to complete the following in
sequence: patrol route, patrol start time (patrol end time will be calculated
automatically).

3. (Optional) Configure holiday dates. Set days on which patrol schedules will not be performed. Multiple
exception dates are allowed. Click Add, and then select a holiday
‘::\:/:‘ Schedule Details e Holiday configuration(optional) Patrolle
X Holiday Duration .
No. Holiday Name Date Range Operation

(day)

4. Click Next, select patrollers from the team or from a person library.
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l:\\//:l Schedule Details "\\//'\ Holiday configuration(optional) — e Patroller

Please select patroller. Selected?person

Person eam Selected Parsoni(s) [
-
- 1
- m Jeg N
- 2
-~
M o
-
-
" o —
— TN
(=)
N

5. Click Create to complete patrol schedule.

@ Note:
All patrols in the patrol schedule are required to patrol all patrol routes.

Manage Patrol Schedule

Search, edit, or delete patrol schedules.

e Search: Set search criteria including schedule name, patrol route, schedule effective time, patrol cycle (by day
or by week), and then click Search.

* Edit: Click to edit a schedule.

Delete: Click [ii] to delete a patrol schedule; or select multiple patrol schedules and then click Delete on the
top to delete the selected schedules.

23.2 Patrol Search
23.2.1 Schedule Search

View patrol schedules and their status.

Schedule Records
You can filter schedules by patrol route and patroller.
Schedule records can be displayed in two styles: card and list.

e When displayed as cards, each card represents a patrol shift and displays information about this shift,
including patrol route, patrol time, patroller, scheduled check-in time at each patrol point, current patrol
status of each patrol point (completed/not patrolled).

By default, the calendar on the right side shows schedules of the current month. The dates with shifts are
marked with a blue dot. The currently selected date is marked with a red dot.
Click the left or right arrow to view more shifts.
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Schedule List List

Patrol Route : All v Patroller : All v < 4 72 >
slmin  Today
Teaml Abnormal Patrol Teamz Abnormal Patrol Team3 Abnormal Patrol
. 2024-06-18
Routel Route2 Route3
D 04:17:27~04:18:27 D 12:46:45~12:47:45 D 15:15:49~15:17:49
& < 2024-06 »
o =1 Q12
Su Mo Tu We Th Fr Sa
2 First and Last Points Fixed £ All Points Random £, First Point Fixed o
ET-B31H-M-B-172-20-156-22 (I} sfsf ET-B31H-M-B-172-20-156-22 () 02 05 04 05 0807 02
Patrol Time:- Patrol Time:- Patrol Time:- > 09 10 11 12 13 14 15
6 17 19 2 21 22
sfsf dd ET-B31H-M-A-172-20-84-204 23 24 25 26 27 28 29
Patrol Time:- Patrol Time:- Patrol Time:- 30
ET-B31H-M-A-172-20-84-204
Patrol Time:-
N Last
Patrol Time:-
¢ The following shows shifts displayed as a list.
Schedule List Card List
Patrol Route : All v Patroller : All v Patrol Time : 2024-06-18~2024-06-18 v
Patrol Route Patrol Method Patrol Time Patroller Shift Status Operation
Rovtel First and Last Points Fixed 2024-06-18 04:17:27~2024-06-18 04:18:27 1 ‘Abnormal Patrol =
Routez All Points Random 2024-06-18 12:46:45~2024-06-18 12:47:45 1 ‘Abnormal Patrol =
Route2 First Point Fixed 2024-06-18 15:15:49~2024-06-18 15:17:49 I ‘Abnormal Patrol =R
Routed First Point Fixed 2024-06-18 1:52:48~2024-06-18 10:53:49 1 Abnormal Patrol o

Shift Details

Click View Details in list mode or double-click a card in card mode to view detailed information about a schedule,
including shifts, patrol points, and patrol time.

Shift Info
Patrol Time: 2024-06-18 (12:46:45~12:47:45) Patrol Route: 123 Patrol Method: All Points Random Patrol Schedule: %8
Actual Start and Last Points Time Error: (+5minute(s)) Patroller: 1 Shift Status: Abnormal Patrol

Total patrol point(s): 2

Patrol Point Patrol Time Actual Patrol Time Patrol Status

Pontl Missed Patrol
Fontd Missed Patrol

23.2.2 Records Search

Search patrol records to view the details of a patrol schedule.

Patrol Records
You can search patrol records by criteria such as schedule effective time, patrol route, and patroller.

In the list of patrol records, you can view the patrol status of each patroller on each patrol route in the patrol
plan. Patrol results are divided into Normal and Abnormal.

Note:
For a patrol route, if any point is abnormal (early patrol / late patrol / missing patrol), the route is abnormal;
if every point completes the patrol according to the plan, the route is normal.
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Schedule Effective Time: = 2024-06-11 00:00:00 ~ 2024-06-18 23:59:59 Patrol Route: Patroller: Reset

Found query results 23 Export v Refresh
Patrol Route Patrol Time Actual Start Time Actual End Time Patroller Patrol Schedule Patrol Status Operation
Route1 2024-06-18 16:52:49~2024-06-18 16:53:49 ~ 2024-06-18 16:47:49  2024-06-18 16:58:50 1 scneduel
Route2 2024-06-18 15:15:149~2024-06-15 15:17:49  2024-06-18 15:14:49  2024-06-18 15:18:50 12
Route3 2024-06-18 12:46:45~2024-06-18 12:47:45  2024-06-18 12:41:45  2024-06-18 1252:46 1 5o

Patrol Details

Click [ to view the details of a patrol route, including shift information, and patrol status of each patrol point.

Shift Info
Patrol Time: 2024-06-18 (12:46:45~12:47:45) Patrol Route: 123 Patrol Method: All Points Random Patrol Schedule: iH3
Actual Start and Last Points Time Error: +5minute(s) Patroller: 1 Shift Status: Abnormal Patrol

Total patrel point(s): 2

Patrol Point Patrol Time Actual Patrol Time Patrol Status
Pointl - - Missed Patrol
Pont2 Missed Patrol

Export Patrol Records
e Export selected: Select patrol records to export, and then choose Export Selected. The selected patrol records
are exported.

e Export all: Choose Export All to export all patrol records.

23.2.3 Patrol Statistics

You can collect patrol statistics from different dimensions, including patrol route, patroller, and patrol point, and
set search criteria such as time range and patrol route.

After setting search criteria, click Search to view the statistical results.

Patroller Patrol Point Statistics Time: = 2024-06-11 00:00:00 ~ 2024-06-18 23:59:59 Reset

Report by:
Found query results 5 Export v Note: Missed » Unordered » Unscheduled. Missed shifts will not be counted as "unordered” or “unscheduled
Shift Abnormal Shift Patrol Paint On-time Early Patrol Late Patrol Missed Patral Make-up Patrol Not Patrolled .
Patrol Route Operation
Count Count/Rate Count Count/Rate Count/Rate Count/Rate Count/Rate Count/Rate Count/Rate
Routei 4 4/100.0% 8 0/0% 0/0% 0/0% 4/50% 0/0% 4/50% &
Route2 2 2/100.0% 8 0/0% 0/0% 0/0% 4/50% 0/0% 4/50% T
Route3 5 5/100.0% 20 1/5% 0/0% 0/0% 12/60% 3/15% 4/20% 0

The statistical items include: shift count, on-time patrol count/rate, early patrol count/rate, late patrol count/rate,
missed patrol count/rate, make-up patrol count/rate, not patrol count/rate.

Patrol Result Description of Judgment Rules

Normal Complete the patrol within the route [start time, end time].

Missed patrol Not patrol within the route [start time, end time].

Early patrol In an all points ordered (fixed interval) or all points ordered (custom interval) route,

patrol earlier than the point within the route [start time, end time].

Late patrol In an all points ordered (fixed interval) or all points ordered (custom interval) route,
patrol later than the point within the route [start time, end time].

Make-up patrol In an all points ordered route, within the route [start time, end time], the latter
location has been patrolled and then the former location is patched.
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Patrol Result Description of Judgment Rules

Not patrol Patrol time has not started and patroller are not on patrol.

View Details

Click = to view patrol details and statistics of early patrol, late patrol, missed patrol, and make-up patrol.

[ Routel

Statistics Time: 2024-06-11 00:00:00~2024-06-18 23:59:59 Shift Count: 5 On-time Count/Rate: 1/5%

Early Patrol Count/Rate: 0/0% Late Patrol Count/Rate: 0/0% IMissed Patrol Count/Rate: 12/60% Make-up Patrol Count/Rate: 3/15%
Early Patrol Statistics Late Patrol Statistics Missed Patrol Statistics Make-up Patrol Statistics

Patrol Time Patroller Patrol Schedule
2024-06-17(22:27:01~22:28:01) 1 Schedulel
Patrol Point Patrol Time Actual Patrol Time Patrol Status
ET-B31H-M-A-172-20-84-204 - - Missed Patrol
sfsf - - Missed Patrol
ET-B31H-M-B-172-20-156-22 - - Missed Patrol
dd - - Missed Patrol
Total 3 ‘ 1 | 10/ page

Export Patrol Statistics

e Export selected: Select patrol data to export, and then click Export > Export Selected. The selected data are
exported.

e Export all: Click Export > Export All to export all patrol data.

24 Map Configuration

Go to Basic Config > Map Configuration.

E-map is applicable in various scenarios such as campus areas, enterprises, and residential areas. Maps, including
flat maps, model maps, and GIS maps, can be bound to areas to display the location of multiple resources and
alarm events reported by devices. You can also perform operations on devices and manage resources on the map
visually, which provides you with an immerse operating experience.

Functions

e Map Engine Management: GIS maps and scene maps carry longitude and latitude information and need to be
managed through the map engine service. On the map engine management page, users can upload GIS maps
and configure scene maps.

e Edit Map: Users can bind maps (including flat map, model map, GIS map, and scene map) with an area, add
devices to the map, and draw hot zones.

e Map Application: With the map background, users can view device locations, alarm locations, and trajectories
of a person more intuitively.

Configuration

Prepare the maps that you will use. See the table for detailed descriptions.

Flat map Flat maps are maps in JPEG, JPG, PNG, and BMP format, such as the floor plan of an
area or a room, applicable to small campus areas, shopping malls, etc.
Upload the flat map. See Edit Map-Bind Map.
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Figure 24-1: An example of flat map

uildings List

= Single-Fl... £ Real-time Alarm Name Display Method € Locate Point | /2 Dra

A

> [y root

~ + Add Floor
@3 30Map
2 cis

B4 Flat

GIS map GIS maps are generally map resources released by map manufacturers, such as
Google Maps and Baidu Maps, which can present the real ground environment,
including administrative regions, buildings, roads, etc., and are suitable for
management scenarios in wide regions.

Follow the steps to upload a GIS map:
1. Upload a GIS map file in gmdb format. See Map Engine Management -Add Map.
2. Bind a GIS map with an area. See Edit Map-Bind Map.
Figure 24-2: An example of GIS map
- [l root & *
he.
) ®
Model map A model map is a 3D map model in 3dtiles or gltf format. It is usually the internal

space of a floor, which can reflect the 3d space layout of buildings. Model maps are
suitable for the internal scenes of office buildings and residential buildings.
Upload model map. See Edit Map-Bind Map.

Figure 24-3: An example of model map

Buildings List

= Single-Fl.. Name Display Method | Show Road Network | © Locate Point. > Draw Heat Zone | £

N £\ Real-time Alarm [l Hold and drag the right mouse butt:

~ [l root

2 + Add Floor
@a 3omap
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Scene map

A scene map is a model in unw format. A model is one or more complete buildings,
including multiple floors. Scene maps usually carry latitude and longitude
information and can be overlaid on GIS maps to both represent location information
through the GIS map and visualize the internal structure of a building through the
model. For model maps, scene maps are more professional and applicable to the
general scenarios of office buildings, residential buildings, etc.

1. Upload the scene map files in unw format. See Edit Map-Bind Map.

2. For instructions on modifying scene map parameters (longitude and latitude, sky
styles, GIS map), see Map Engine Management- Scene Management.

Figure 24-4: An example of scene map

Buildings List

Name Display Method

24.1 Map Engine Management

Go to Basic Config > Map Config > Map Engine Management.

Configure the map service, including adding maps and configure scene maps.

@ Note:

For instructions on uploading flat maps, 3D model maps, or scene maps, see Edit Map-Bind Map.

24.1.1 Map Management

24.1.1.1 Add Map

You may upload GIS maps (offline maps), access third-party maps (online maps).

(& Map Server

v Upload Map

|

Baidu 2D Map

Baidu Satellite Map

Google 2D Map
Google Satelite Map
Third-party Map

Single Image Map

Upload POI Data

Upload Urban Road Network

Q

©

Center Latitude: 3016362062

Reset Return to Default Location
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Upload GIS Map
The system will analyze the GIS map type (including 2D maps, satellite maps) after you upload a map.

1. Go to Upload Map, click Add Map.
2. Click the Upload Map tab.

Add Map

Upload Map Access Third-party Map

*Map Mame:
=City:

*Map Unload: [

Upload Cancel

3. Enterthe map name, city, and then click [ and select the map file (.gmdb format, max. 512MB) to upload.
4. Click Upload.

v  Upload Map

1, Add Map
(@ Baidu 2D Map [ @]
I-_1
— 12%
(>) Baidu Satellite Map \d
@ Note:

Do not close the page or browse to other pages before the map is uploaded.

Access Third-party Map (online maps)
The system supports third-party maps (which released on website by map-makers).

1. Go to Upload Map, click Add Map.
2. Click the Access Third-party Map tab.
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*Image MName:
* Map Name:

* Map Tile URL:

* Resolution:

* Level Range:
Coordinate System:
* Map Tile Start point: | 00
* Map Tile Center Point:

* Map Tile Conversion Fun

WGSa4

000

Upload Map Access Third-party Map
* Image Type: Default
* Tile Size: | 236
Copyright Info:
18 Level Unit: @ Meter Angle

3. Configure the parameters (obtain parameter values, you can either download the map service information file

from the third-party map service publishing website or contact the third party for assistance).

Parameter Description

Image Name Name of the map source, used for internal differentiation, and can be
customized. It consists of letters, such as "Google".

Image Type You may choose Default, 2D, and Satellite, or click Customize to add a custom
type.

Map Name Enter a map name as needed. The name will be displayed in the map list.

Tile Size Size of map tile. The default unit is pixel (px). You can check it in the map service
information file.

Map Tile URL Third-party map address. You can check it in the map service information file.

Resolution Resolution of each level of map, separated by commas, refers to the actual

distance represented by one pixel on the screen. You can check it in the map
service information file.

Copyright Info

Copyright information of the map.

Level Range The supported range of levels for the map, from 1 to 18. You can check it in the
map service information file.
Unit Unit of the map, which can be Meter or Angle. You can check it in the map

service information file.

Coordinate System

Coordinate systems used in the map. You may choose Default (Mercator),
WGS84, and Mars. You can check the map service information file for the
available options.

Map Tile Start Point

Longitude and latitude of the starting point for map tiles. You can check it in the
map service information file.

Map Tile Center Point

The level, longitude, and latitude of the center point of a map tile can be found
in the map service information file.
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Parameter Description

Map Tile Conversion Manipulates the map tile sequence number, such as adding prefixes or
Function converting to hexadecimal, and thereby concatenate the complete address to
retrieve the map tile.

Add Correct Point Used to compare and align the coordinates of the third-party map with the base
map. If they are not consistent, at least three correction points should be added
on both sides at the corresponding positions.

4. Click Next to preview the map.

5. Click OK to save the map.

Map Management Operations

e Enable map: Only enabled maps will be displayed. Only one map can be enabled at a time.
Click to enable a map. Blue means the enabled status.

e Set the center position of the map, which is the default position displayed when you open the map page.
In the floating window above the map, you can view the current status, including the map level and the
longitude and latitude of the center position.

Current Level: 14
Center Longitude: 119.99999963

Center Latitude: 30.00000022

Reset Return to Default Location

1. To change the center position, click Reset.
2. A"+" symbol will be displayed on the map. Drag the map to align the center with the "+".
3. Click Set as Default Position to set the marked position as the center position.

e Return to the default location: Click Return to Default Location to quickly return to the default position.

24.1.1.2 Upload Urban Road Network
Road network refers to the actual distribution of roads on a map. When a road network is added to a map,

the route (or trajectory) will be drawn based on the road network, otherwise, it will be a straight line segment
between the starting point and the destination.

Upload Road Network
1. Expand the Upload Urban Road Network tab, click Upload Road Network.
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(g» Map Server > Upload Map

> Upload POI Data
Map Managemenit

w Upload Urban Road Metwork
Scene Management

1, Upload Road Network

rJa
Ln
n
Ln

111

Delete Road Metwork Diata

2. Enter the road network name, and upload the road network file.

Upload Urban Road Network

“Road Network Mame:

*Upload File: O

Note:
The road network file must be in .kml or .shp format.

3. Click Upload.

Road Network Management Operations

* Show or hide road network: Click [*1/ ] in the bottom right corner of the map to show or hide the road
network.

e View details: Click : and then choose View Details to view the detailed information about the uploaded road
network file.

e Delete road network: Click Delete Road Network Data, and then confirm. All road network data will be
deleted.

24.1.2 Scene Management

A scene map is a model in unw format. A model is one or more complete buildings, including multiple floors.
Scene maps usually carry latitude and longitude information and can be overlaid on GIS maps to both represent
location information through the GIS map and visualize the internal structure of a building through the model.

You can add scene image models and configure model parameters as needed.

e The scene maps added on this page will not be automatically synchronized to e-map (Edit Map). However,
after completing configuration, you can export the map model and upload it in e-map.

e The scene maps added in e-map will be synchronized to this page. You can modify the model parameters
here, and the changes will be automatically synchronized to the scene maps in e-map.

24.1.2.1 Add Scene Map

A scene map (.unw format) includes models of multiple layers.
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Add Scene

1. Go to Scene Management, click Add Scene.

(g Map Server Current model total 3 Al
Unpublished

5 = | g

Birnuntrai ﬁ mall | L

2. Inthe Add scene dialog box, enter the scene name, and upload a map (.unw format) for the scene.

Note:
The models of each layer will be analyzed after you upload a scene map here.
You may also add layers (see Add Layer) and upload models in the Edit scene dialog box.

Mzp Management

¥ Scens name:

Upload File: O

Cancel

3. Click OK.

Add Layer

1. On the Scene Management page, hover over a card, click View Details.
Current model total 7

e View Details

Unpublish

Add scene
Delete

2. Inthe layer list, click -, choose Add Layer.

(> Map Server < 1
Map Management Layer List Video Fusion Resource
Scene Management —+
5 Test Add Layer
Add Model
> LayerTest

3. Enter the layer name, and then click OK. The layer is created.
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Add Layer X

* Layer Name:

4. Inthe layer list, click -+, choose Add Model.
5. Select the layer, and then upload the model file (.zip format).

Upload Model

Layer.| LayerTest

*Upload Model: |

Cancel

6. Click OK. The model is created.

LayerList  Video Fusion Resource Building Properties 4

Scene Properties. >

> Default Layer

24.1.2.2 Configure Model Properties
Configure model properties and scene properties after the model is uploaded.

1. Go to Scene Management > Layer List, and then select a model.
2. Configure properties on the right side.

e Model properties: Configure the latitude and longitude coordinates of the model, road network, and
optimal view.
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Madel Properties bt

Longitude: 116.391272539128
Latitude: 39.80700467372793

Height: 2.7596544594739634

Show Road Metwork
Upload Road Network
Optimal View:
Set Current View as Optimal View
Floor:

Building1 1Floor_3
Additional Configuration Info

Add Key Point

¢ Scene properties: Configure the scene models to be displayed on the earth scene to enhance the visual
appeal of the model map.

e SkyBox: The display style for the sky.
¢ Show Earth: Place the scene model on the earth sphere.

e Custom Map Image: Select an uploaded GIS map source to display the scene model on the GIS map
according to the latitude and longitude.

¢ Show Road Network: Displays road networks on the scene model.

e Water/Wall: Click Add and use mouse to draw lines as water surfaces or walls.

Scene Properties

Scene Name: | 1

Show SlkyBox

@) Blue Sky Nightfall Night
Custom

Show Earth

Custom Map Image

N— - Please Baidu 20 Map [l Baidu Sateli...
3 select:
! 2 T
[ Show Road Network

i
L
L

O T

Optimal View: Set

Position to Opt... ‘ ‘ Reset

Additional Configuration Info

Add Key Point

Water Add

3. Click Save in the upper-right corner when you complete the configuration.

24.1.2.3 Export Model

After completing the configuration of the scene model, click on Export in the upper-right corner to export the
scene map (.unw format).

More Operations

You can upload a scene map in Bind Map.
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24.2 Edit Map

Go to Basic Config > Map Configuration > Edit Map.
Users can bind maps to different areas, add devices to the maps, and draw hot zones on the maps.
@ Note: Flat maps, model maps, GIS maps, and scene maps are supported.

Figure 24-5: An example of a flat map

Buildings List

= Single-Fl... (") Real-time Alarm Name Display Method €)' Locate Point | {7’ Draw Heat Zone £ Layel 751 More Configurations ¥ = Setas Defau...

A

- [y root

” -+ Add Floor
22 3pmap

B cis

B Flat

Figure 24-6: An example of a scene map

Buildings List 9] =
£ Real-time Alarm

v A root

& scene

Name Display Method 7. Evacuation Route 7. Roam C...

Hold and drag the

24.2.1 Bind Map

Create areas and floors and bind them to a map according to the actual building.

Prerequisite

To use the GIS map and city road network, please make sure you have uploaded them in System Configuration >
Map Engine Management.

@ Note:

For images, model maps (including road networks), and scene maps, you can upload them directly in E-map
page.
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1. Bind Map

For the first-time use, please add a default map first. It is recommended that the default map provides an
overview of the area. You can then add submaps as needed. For example, Area Map > Building Map > Floor Map.

1. On the MapEdit page, click Create your own map.

You haven't bound any map. Flease bind a map first

Create your own map

2. Select the map type and upload the corresponding file. Then click Binding.

Bind Map X
Map Type: (@) Flat Map Model Map GIS Map
Scene Maj
Upload Map:

@ Note:

e Flat map: @ Must be JPEG, JPG, PNG, or BMP images, max size 100MB. Both the height and width
cannot exceed 8190px. @ Cannot be paused or canceled after the file is uploaded.

¢ Model map: @ Supports single gltf model; 3dtiles models/gltf models compressed into a ZIP file can also
be uploaded. Please make sure there is a tileset.json file/index.gltf in the root directory after unzipping
and the size of the model must be within 100MB.® Road networks allow Shapefile data in a zip file.
Road network data must include point data and route data.

* GIS map: After uploading a GIS map in Resource Management > Map Engine Management, you can bind
the map on this page.

e Scene map: Must be .unw format scene maps (no size limit). After uploading, the scene map will be
overlaid on the enabled GIS map according to the latitude and longitude.

2. Add Submap
In the building list, the first uploaded map is designated as the root layer.

1. Choose the parent map, click -, and click Add Submap to add a submap.
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Buildings List

v B ais
s 1 Add submap
= Move
B 12 Renzme
B 122 Delete

@ Note:

¢ Up to 4 levels of maps are allowed.
e The root map can be renamed but cannot be deleted.
e You can click Move > Up/Down to change the map sequence on the list.

2. For newly added submaps, please bind the map by referring to 1. Bind Map.

3. Add Floor

For flat maps, model maps, and GIS maps, there is a default floor in the floor list, you can also add multiple floors
to the area map. (Scene maps already have multiple floors included by default, so you don't need to add floors)

1. Click Add Floor to add a floor.

~+ Add Floor

2. To bind a map for newly added floors, see operations in 1. Bind Map.

@ Note:
[ ]

Click : for the floor to set it as the default floor, rename or delete it, or move it up or down in the floor
list.

e The default floor can be renamed but cannot be deleted.

e The default floor is displayed each time you access the map. You can also change the default floor.

4. Change Map

Click More Configurations > Change Map in the upper-right corner to upload a new map.
24.2.2 Device Point Management
Mark devices on the map to visualize device locations.

Mark Device Point on the Map

1. Click Locate Point above the map. All devices in the local domain are listed.
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(2% Mere Configuration. Set as Defau...

[ 4
B 172.20.155.139

=8 172.20.155.199

& © 17220155911

n-.--1 ! Locate

° 17 Remave from Map

. indicates devices that are already marked on the map.
e Click : for the device to locate it on the map or remove the device from the map.
e If the device name is not fully displayed, drag the left edge to resize the panel.

2. Select a device and drag it to the desired position on the map.

3. Change the device icon in the pop-up window as needed.

Point Setting X
Point Mame: 172.200485.51_10
E lcon:
. -
Change |} B8

BN cae B

Cancel m
e v B

4. Click OK.

Manage Device Points on the Map

For devices marked on the map, you can edit the device information, move the device position, or remove them
from the map.

R

6666 £ b ]

* Click / to edit the point name and icon.
* Click <~ to move the point position.

* Click |7 to delete the point.

Aggregate Points

If device points on the map are very close together, they will be aggregated and a number will be displayed to
indicate the total number of aggregated devices.
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24.2.3 View Map

After binding a map and marking device points to the area, you can view device points visually.

1. By default, the page shows the default floor of the root area.

2. Select an area map from the map list on the left and the default map for that area will be displayed on the
right.

3. Click on the floor list in the map's upper-left corner to switch to the map of the desired floor.
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®
@ Note:

* You can use the scroll wheel to zoom in or out on the map.

° HEHL 04
°

gL 05

* You can hold and drag the left mouse button to move the map.

e For model map and scene map, you can hold and drag the right mouse button to move the map
perspective.

Click @ in the map's lower-right corner to restore the default perspective.

24.2.4 Heat Zone

Draw heat zones on the map. A heat zone is to jump from the current area to another linked area. For example, if
an alarm occurs at location A and you also need to check the situation at location B, you can set A as a heat zone
linked to B.

Draw Heat Zone

1. Click Draw Heat Zone above the map.

2. Use the left button to draw a closed area on the map, and double-click to complete the drawing.

3. Select a map to link to in the pop-up window and click OK.
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Heat Zone Setting *®

Please select the linked building

v ?.,H root

wa

#a cis
R ==
Ba 12
Ba 122
» {y DTTLT
Rl =
» g 1
@ 10
» By 102

Default

Description:

“ Cance'

Heat Zone Management

Hover the mouse over a heat zone to display operation icons.
e Click = to jump to the linked area from the current area.

e Click /7 to editthe linked area.

e Click [i] to delete the heat zone.

24.2.5 Map Display Management
Mange the display of on-map device resources, road networks, and map perspectives.

Show/Hide Device Name

Click Name Display Method above the map to choose whether to display device names on the map.

| © Locate Poin
A an

@ Hide by default, and show as mouse approaches

© Always Display

Show/Hide Road Network

After uploading a road network to a model map or a GIS map, you can set whether to display the road network.

Select Show Road Network. The road network is shown as blue paths in the figure below.
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213.208.220.125 [

- I —

Set Default Perspective
You can set a default perspective in flat maps, model maps, or GIS maps.

e Click Set as Default Perspective in the upper-right corner to set the current map view as the default
perspective. After adjusting the map view, you can click -@- in the bottom right corner to restore the default
perspective.

* Click . in the upper-right corner, and select map(s) of the same type as the current map to sync the current
default perspective setting to the selected map(s).

Manage Layer Display
Configure the types of device resources to be displayed on the map for a clearer view.

Click Layer in the upper-right corner and select the types of devices to be displayed on the current map.
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{57 More Configurations

All

Encoding Device

Other De... & IPC

Decoder

ADU

Access Control Device

Access C... [ AccessC...

Smart Device

AIBOX

Video Intercom Device

Entrance ... & Indoor unit

Radar Device

Radar

Channel
Encoding ... & Alarm In... [ Alarm Ou...
Voice Inte... ¥ Door ¥ Decoding...

Video Int...

Clear Data

Click More Configurations > Clear Data in the upper-right corner to clear all devices and heat zones on the map.

24.2.6 Evacuation Route

Draw evacuation routes on the map so when an emergency occurs, people can follow the route to safely
evacuate.

@ Note:

Evacuation routes can be drawn on scene maps only.

Draw Evacuation Route
1. Click Evacuation Route in the top toolbar to display the evacuation route list.

2. Click Add Path in the list to start drawing a route.
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3. Click to draw anchor points. The system will connect the anchor points in sequential order to form line
segments. Click [Jlfl] to enter preview mode.

4. Click . again, and then enter a name for the route.

Cancel

5. Click OK to save the route.

Edit Evacuation Route

1. Click Evacuation Route in the top toolbar to display the evacuation route list.

Add path

2. Click [ for the route you want to edit.
3. Modify the route by referring to the descriptions in the table below.

Table 24-1: Icon Description

Icon Description

Add an anchor point.

Click anywhere on the map to add an anchor point.
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Icon Description

. Insert an anchor point.

Click anywhere between two anchor points on the route to insert a new anchor point.

. Delete an anchor point.

You can delete any anchor point on the route, and after deletion, the two adjacent anchor
points will automatically connect to form a line segment.

. Move an anchor point.

You can drag and move any anchor point.

. Undo the previous action.

4. Click il to save the changes and enter preview mode.

[ Note: To exit the editing mode, click [ and then confirm the prompt message.

5. Click [l

6. Setthe route name, and then click OK to save the changes.

Delete Evacuation Route

In the evacuation route list, click Efor the route you want to delete, and then confirm the action.

24.2.7 Roam Config

Draw roam paths on the map to enable automatic movement of the map perspective along the roam path.

Note:
Roam paths can only be drawn on scene maps.
Draw Roam Path
1. Click Roam Config in the top toolbar to show the roam path list.

2. Click Create Path in the list to start drawing the path.

Figure 24-7: Draw Roam Path

|} 1 (‘\“ H 1] m lr/mrii_ii-iw‘lw"f:"':“JJ;JID{-M:“.‘V-‘j’.’.

3. Click to draw anchor points. The system will connect the anchor points in sequence to form line segments.

292



4. Click [ to enter preview mode.

I
()

5. Click [l again, and then enter a name for the roam path.

Figure 24-8: Create Roam Path

Cancel

6. Click OK to save the settings.

Preview Roam Path
You can adjust the video speed and viewing angle in preview mode.

Progress bar

The progress bar at the bottom shows the preview progress.

* Click to play the preview video; click to pause the video.

e Drag the progress indicator to adjust the progress; or click on the progress bar to navigate to the desired time
point.

e The progress bar shows the positions of the various anchor points. Click a marker to navigate to the
corresponding time point of the anchor point.

Adjust view

Adjust the view upward or downward.
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* : Adjust the view upward.

* : Adjust the view downward.

Adjust speed

Adjust the video playing speed in preview.

¢ : Increase the video playing speed in preview.
o ) . . . .
-. Decrease the video playing speed in previews.

¢ Drag the slider up or down to increase or decrease the video playing speed.

Edit Roam Path

1. Click Roam Config in the top toolbar to show the roam path list.

Add path

2. Click [ for the path you want to edit.
3. Edit the path by referring to the descriptions in the table below.

Table 24-2: Icon Description

Icon Description
Add an anchor point.

Click anywhere on the map to add an anchor point.

Insert an anchor point.

Click anywhere between two anchor points on the path to insert a new anchor point.

Delete an anchor point.
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Icon Description

You can delete any anchor point on the path, and after deletion, the two adjacent anchor
points will automatically connect to form a line segment.

Move an anchor point.

You can drag and move any anchor point.

- Undo the previous action.

4. Click [ to save the changes and enter preview mode.

[ Note: To exit the editing mode, click [ and then confirm the prompt message.

5. Click [H-

6. Set the path name, and then click OK to save the changes.

Delete Roam Path

In the roam path list, click for the path you want to delete, and then confirm the prompt message.

24.2.8 Panoramic Config

Customize look around view parameters to achieve panoramic viewing of the scene model (where the model
rotates around a central axis, allowing you to view all sides of the model).

Configure Panoramic View

1. Click Panoramic Config on the top toolbar to enter editing mode.

Panoramic Center

Height| 1

Panoramic Distance:

[ ] ‘ 115 meter

Panoramic speed:

Panoramic angle:

2. Configure look around view parameters by referring to the descriptions in the table below. After the
configuration is completed, the left side of the page will display the look around view effects.

Table 24-3: Panoramic View Parameters

Parameter Description

Panoramic | Longitude,

. (1) Click E to enter the top-down view mode.
Center latitude

(2) Click to select a point. A dialog box as shown below appears. Check the
longitude and latitude and then click Confirm Selection.
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Parameter Description

Longitude: 120. 1 Wil 2995543

Latitude: 30U 8==80829450903

Confirm Select Cancel

Height Enter the height (meters) of the center of the panoramic view.

[ Note: The height must be an integer in the range of 1 to 500.

Panoramic Distance Set the distance (meters) for the panoramic view. The value must be an integer
in the range of 1 to 500. You may also drag the slider to adjust the value.

Panoramic speed Set the speed (°/s) for the panoramic view. The value must be an integer in the
range of -180 to 180. You may also drag the slider to adjust the value.

Panoramic angle Set the angle (°) for the panoramic view. The value must be an integer in the
range of 0 to 90. You may also drag the slider to adjust the value.

3. Click OK to save the settings.

24.3 Map Display Configuration

Go to Basic Config > Map Configuration > Parameter Configuration.

You can customize the map display style as needed.

Map Applications Screen Display Name Configuration
You can customize the e-map title displayed in full-screen mode.

1. Enter the title name as needed.
2. Click Save.
Figure 24-9: Set Title

Map Applications Screen Display Name Configuration

Restore Defaults Reset

Points Display Method

For scene maps, to meet different needs for point icon clarity and loading speed, we provide 2 display modes:
Fluency Mode (fast loading but low clarity) or High-definition Mode (high clarity but slow loading).

1. Choose a point display mode as needed (Fluency Mode/High-definition Mode).
2. Click OK.

Figure 24-10: Points Display Method
Points Display Method

Optional Methods: (@ Fluency Mode High-definition Mode
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Figure 24-11: Points Display Effect

High-definition Fluency

mct_cam_ 0002
s

24.4 Map Application

With the map background, users can view device locations, alarm locations, and trajectories of a person more

intuitively.

¢ Real-time Alarm: Allows users to view various types of devices and device alarms on the map and control the
devices intuitively.

=i .Tﬁn 3
[ Real-time Alarm

u

o 192 121118

2717

Alarm Count

B /. 05
D 2024-01-22 20:18:45

jor |ObjectisRec...

w05
-01-22 20:18:45

I &

e Face Trajectory: The system can retrieve the snapshots of a person of interest based on specified features
or face image, and then marks his/he geolocation on the map based on time and geographical coordinates
to display his/her trajectory on the map. The trajectory provides useful information, including the range of
activity and specific locations where the target person has been present.

@), sencrripe  ryAnroune - SpanL. |Precis searcn

&
=
S

Total 52245 il 2 3 4 5 6 - 213 > | 20/page - Goto 1

e Motor Vehicle Trajectory: The system can retrieve the snapshots of a motor vehicle of interest based
on specified features/event/violation, and then marks it's geolocation on the map based on time and
geographical coordinates to display it's trajectory on the map. The trajectory provides useful information,
including the range of activity and specific locations where the target vehicle has been present.
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25 AR Live Map

Go to Video Application > AR Live Map.

AR live map upgrades the traditional 2D map command system, which lacks a sense of presence, into a three-
dimensional command system based on augmented reality.

Using the live video from an high-position camera as a real-world map, it supports the overlay of additional
resource labels (such as surveillance points, buildings, roads, etc.), while integrating with a 2D map to construct
a comprehensive, multi-angle video surveillance network, providing multi-dimensional information support for
command and dispatch.

Multi-type labels can ._AR Live Map Command System v HIEIE Search labels quickly
tag various resources, \ and_jymp_to their high-
enabling global position view.
oversight and detailed
focus in a view.

Overlay resources such
as camera locations,
roads, and buildings as
labels on the high-
position camera’s live
viewfor easy reference.

Openthe associated
low-position camera
live in the high-position
camera’s live view to
monitor key scenes.

Note:
By default, one high-position camera is supported. For multiple AR cameras, additional licenses are required.

Go to the AR live map page:
¢ If no high-position camera is available, please first configure high-position cameras.

¢ If a high-position camera already exists, the live video from the first camera in the high-position camera list
will automatically play.

Table 25-1: Icons

Icon Function Description
A \ Expand or collapse the toolbar below.
m View AR live map in full screen.

E/E Show or hide all label names.

Enable or disable 3D positioning.
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Icon Function Description

E> Note:
VSS cross-domain cameras do not support 3D positioning.

9

o

Show or hide the PTZ control panel.

o,

g/g Show or hide the map.

. After displaying the map, switch between the map and the live view.

./. After displaying the map, zoom in or out on the map.

25.1 Configuration

Click the Configure button in the toolbar at the bottom to go to the Configuration page.

Perform high-position camera configuration, personalization, high-position camera image rotation, and more.

25.1.1 Configure High-Position Camera

AR live maps can only be accessed after a camera has been configured as a high-position camera.

Add High-Position Camera
1. Click Configure at the bottom of the AR Live Map page, go to Configuration > High-Position Camera Setup.
Figure 25-1: High-Position Camera Setup

em > Setup

©  High-position Cam...

1 High-position Camera List

Add

Camera Name. Latitude and Longitude Optical Center Ca...

1921173120 2 (30.246927963974866,120.14137317366652)

2. Click Add, go to the Add page and configure the high-position camera information.

Note:
Ensure that the high-position camera has been added to the map in advance in Edit Map.
Currently, 2D maps and GIS maps are supported.

Figure 25-2: Add High-Position Camera

Add

@ Camera point is a required field, please add it to the map in advance

SelectCa.. | 192.117.3.120_1

Camera IP: ‘ 192.117.3.120 ‘Device Chann...| 2

camers .. | R o~ v [Fo0omecomen
Camera Pass.._ Device Manuf..{

Camera Purt..l 80 ‘ Camera Hewgh.“ m

(1) Click the Select Camera input field and select a camera from the organizational tree.

(2) When the device type is selected as a PTZ camera, fill in the camera IP and other information for login
authentication to enable full functionality such as PTZ control and 3D positioning.
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3. Click OK to add the high-position camera.

Note:

The first high-position camera in the list will be displayed by default when entering the AR live map
interface.

The order of high-position cameras can be adjusted by dragging them in the list.

4. Calibrate the high-position camera: Return to the AR live map page, press F10 to enter calibration mode,
adjust the screen to position the camera's optical center and label angles, and press F9 to exit calibration
mode after completion.

AR Live Map Command System
7

7fu—T_

To ensure greater accuracy, it is recommended to first adjust the optical center and then

adjust the label.

Optical ...

Modify High-Position Camera Information
1. In the high-position camera list, click the corresponding ,/* for the camera to go to the page as shown below.

Figure 25-3: Modify Camera Point Marking

Edit

@ Camera point is a required field, please add it to the map in advance

Select Ca...

Camera IP: | 192.117.3.120 | Device Chann...| 2
Camera Usern‘..| admin | Device Type: | HD Dome Camera
Camera Pasm..l = | Device Manuf..| Uniview

Camera Port: | 80 | Camera Heigh.! 2m

Cancel

2. Adjust the camera parameter settings and click OK to save the changes.

Note:
Modifying the camera position is not supported.

Delete High-Position Camera
1. In the high-position camera list, click the corresponding Tii] for the camera.

2. Click OK to confirm the deletion.

A Are you sure you want to delete the high-position

camera?
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25.1.2 Personalization

Customize the AR live view title name and label aggregation.
Go to Setup > Personalization.

Figure 25-4: Personalization

System Customization

Personalization
AR Systern Name] AR Live Map Command Systs

Save Reset

Whether to enable tag aggregation: .

* AR system name: The title name displayed at the top of the AR page. The default name is "AR Live Map
Command System," and it supports up to 12 characters.

¢ Enable label aggregation: When enabled, multiple nearby labels will be aggregated into a single point (the
number indicates the label count). Click the aggregation point to expand the label list. It is recommended to
enable this when there are many labels to prevent them from overlapping.

Figure 25-5: Display Effect
AR Live Map Command System AR Live Map Command System
Label List “Lxl“ |
B 1api26.1 7m“‘, ‘
B

25.1.3 Other Configuration

Figure 25-6: Other Configuration

Image Rotation Configuration

High-positio...

High-Position Camera Image Rotation

If the camera's image is reversed compared to the real-world scene perspective, the image can be flipped
through rotation.
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High-position Camera Image Rotation

Please enter the hig... Q

High-position Camera Name Image Rotation Operation

192.117.3.120 2 Normal Z

a

Select Rotation Type:) Normal

Normal
Flip Vertical
Flip Horizontal

180°

25.2 High-Position Camera Switching

Switch between high-position cameras to view their respective live video.

The system only supports displaying the AR live video from one high-position camera at a time. To view other
high-position cameras, perform the following switching operation:

L. Click the to expand the list of high-position cameras.

2. Inthe camera list, select the desired camera to switch to its AR live view.

Figure 25-7: Swtich High-Position Camera

High-positio... High-po

omain(Online)
& 1921173.120.2

# 102.117.1.100.1
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25.3 High-Position Camera Patrol
Add high-position patrol tasks to view live video from multiple high-position cameras in sequence.
Add a High-Position Patrol Task
L Click , select High-Position Patrol Task.

2. Click §& to add a high-position patrol task.
Figure 25-8: Add High-Position Patrol Task

P

Selected Cameras (2)

v @102

| o8 19211711001 @ 10211731202

#£ 192117.1.1001

(1) Enter a task name and set the patrol interval (i.e., the time duration between switching high-position
cameras).

(2) In the camera list, select a high-position camera and click ‘;‘ to add it to the patrol group. (Drag = to

adjust the order; click ijjj to remove a camera.)

(3) Click OK to complete the task creation.

Start High-Position Patrol

In the high-position patrol task list, click (3] corresponding to the task to initiate the patrol. The high-position
cameras in the patrol group will switch and play live video sequentially according to the set time interval. The
currently playing camera information is displayed above the live video.

Click [{D] to pause the patrol task, remaining on the current camera's live video.

Click to exit the patrol task.
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Figure 25-9: High-Position Patrol

2 Patrolling... 26Switch to the next high... [5 | |

Modify Patrol Task

In the high-position patrol task list, click the corresponding [ for the task, select Edit to modify task parameters.
Refer to Add High-Position Patrol Task for specific operations.

Figure 25-10: Task Operation

Delete Patrol Task

In the high-position patrol task list, click the corresponding [ for the task, select Delete, and then confirm the
deletion.

25.4 High-Low Position Camera Linkage

When abnormal situations are detected in the panoramic view of a high-position camera, you can click the low-
position camera labels on the screen to view their live videos for detailed monitoring.

On the high-position camera's live view image, click a low-position camera label to open its live video.

@ Note:

A maximum of 5 labeled live videos can be displayed simultaneously on the high-position camera's live video
image.
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Figure 25-11: High-Low Position Camera Linkage

5 &£ 192117.1.90_1

192.117.1.90.1 [ police_ |

A low-position camera's live view window supports the following operations:
e Dragthe window border to move its position.
e Top-right toolbar: Zoom in/restore the window, close the window.

e Bottom-left toolbar: View the list of cameras associated with this low-position label, switch to 4-split window,
switch to single window.

25.5 Add Label

Supports overlaying various types of information - such as monitoring points, roads, and buildings—onto the
high-position camera's live video in the form of labels on the AR live map screen, serving as monitoring aids.

25.5.1 Add Label

Add fixed labels, vector labels, area labels, and personalized labels to the AR live map.
Click the Add Label button at the bottom of the page to display the label list on the left.
Figure 25-12: Label List

| Label List

Building

i [u [u

Road Patrol Route |  Direction

o]

Custom Ar...
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Fixed Label

Fixed labels include low-position cameras, high-position cameras, buildings, and custom labels. The addition
method is similar for all. Here, adding a high-position camera label is used as an example:

1. Select High-Position Camera from the label list.

2. Move the cursor to the map and click the location to be marked. The Add High-position Camera page pops

up.

Figure 25-13: Add High-Position Camera Label

Label Name

Label Attribute Police

Label Direction | Upper Right

Label Size medium

Label Shape Circle

High-position...

Add as Key Label 7.7

3. Enter the label name and configure relevant parameters, then click Save to complete the addition.

Table 25-2: Fixed Label Parameters

Parameter Description

Label Name The name of the camera label. If left blank, it will be automatically populated with the
camera's name.

High-Position Click to open the camera resource list. Select the camera and click OK to bind the

Camera corresponding camera to this label.

Label Attribute

¢ Click [ to expand the options and select a label attribute (e.g., Public Security
Network / Police / Industry / Key Personnel / Surveillance Equipment / Public
Area / Road Facility / Duty Post / Other).

® Click . to go to Label Attribute Management and add new label attributes.

Label Direction

The direction of the label, including: UpperRight / LowerRight / UpperLeft /
LowerLeft.

Label Size

The size of the label in the AR live map (Large, Medium, Small).

Label Shape

The shape of the label in the AR live map (Diamond, Circle, Hexagon, Rectangle).

Add as Key Label

Click . to add this label to the key labels list.
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Vector Label

Vector labels include roads, security routes, directions, and custom labels. The addition methods are similar.
Here, adding a road label is used as an example:

1. Select Road from the label list.

2. Move the cursor to the map. Click the location to be marked for the first time to set the starting point, then
click again to set the endpoint. The Add Road page pops up.

Note:
When adding a security route label, you can repeatedly click the left mouse button to plot the route, and
click the right mouse button to end the plotting.

Figure 25-14: Add Road Label

Add Road

Label Mame

Label Color

Route Color -

Label Attribute | Public Place
Label Direction | Upper Right

Label Size medium

Label Shape Circle

Remarks

Add as Key Label 7.7

3. Enter the label name and configure relevant parameters, then click Save to complete the addition.

Table 25-3: Vector Label Parameters

Parameter Description

Label Name Name of the label.
Label Color Color of the label.
Route Color Color of the label route.
Label Attribute Attribute of the label.

 Click | to expand the options and select a label attribute (e.g., Public Security
Network / Police / Industry / Key Personnel / Surveillance Equipment / Public
Area / Road Facility / Duty Post / Other).

* Click . to go to Label Attribute Management and add new label attributes.

Label Direction The direction of the label, including: UpperRight / LowerRight / UpperLeft /
LowerLeft.
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Parameter Description
(o)
o l @ LowerRight
Label Size The size of the label in the AR live map (Large, Medium, Small).
Label Shape The shape of the label in the AR live map (Diamond, Circle, Hexagon, Rectangle).
Remarks Remarks related to the label.
Add as Key Label Add the label to the key label management list.

Area Label

Area labels include custom areas and other custom labels. The addition methods are similar. Here, adding a
custom area is used as an example:

1. Select Custom Area from the label list.

2. Move the cursor to the map. Left-click to select points for the area to define the shape, then right-click to
finish drawing. The Add Custom Area page pops up.

Figure 25-15: Custom Area

Add Custom Area

Label Name
Label Color
Label Attribute | Police
Label Direction | Upper Right
Label Size medium

Label Shape Circle

Fill -
. S———
||

Opadity 25%

Stroke w | |Solid Li... »

Remarks

Add as Key Label 7.7

3. Enter the label name and configure relevant parameters, then click Save to complete the addition.

Table 25-4: Custom Label Parameters

Parameter Description
Label Name Name of the label.
Label Color Label colors include blue, red, pink, purple, green, orange, and gray.
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Parameter Description

Label Attribute Attribute of the label.

 Click | to expand the options and select a label attribute (e.g., Public Security
Network / Police / Industry / Key Personnel / Surveillance Equipment / Public
Area / Road Facility / Duty Post / Other).

* Click . to go to Label Attribute Management and add new label attributes.

Label Direction The direction of the label, including: UpperRight / LowerRight / UpperLeft /
LowerLeft.

‘| @ uUpperieft 7 : l r 4 UpperRigiﬂ

3 | e Lowerl eft
Label Size The size of the label in the AR live map (Large, Medium, Small).
Label Shape The shape of the label in the AR live map (Diamond, Circle, Hexagon, Rectangle).
Fill Fill color of the area.
Opacity Transparency level of the area display.
Stroke Line style of the area border, which can be set to solid or dashed, with configurable

line thickness.

Remarks Remarks related to the label.

Add as Key Label Add the label to the key label management list.

Custom Label

Custom label types include third-party webpages and custom labels, which have similar addition methods. Here,
using a third-party webpage as an example:

1. Select Third-Party Webpage from the label list.

2. Move the cursor to the map and click the location to be marked. The Add Third-Party Webpage page pops
up.
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Figure 25-16: Add Third-Party Webpage

Label Name

Label Color

Label Attribute

Label Direction | Upper Right

Label Size medium

Label Shape Circle

Fill -
Opacity S 25%

Stroke [ ] ~ | |Solid Li... w

Remarks

Add as Key Label 7.7

3. Enter the label name and configure relevant parameters.

Table 25-5: Custom Label Parameters

Parameter

Description

Label Name

Name of the label.

Label Direction

The direction of the label, including: UpperRight / LowerRight / UpperLeft / LowerlLeft.

-

Label Attribute

Attribute of the label.

¢ Click [ to expand the options and select a label attribute (e.g., Public Security
Network / Police / Industry / Key Personnel / Surveillance Equipment / Public
Area / Road Facility / Duty Post / Other).

* Click . to go to Label Attribute Management and add new label attributes.

URL

Third-party webpage URL link.

Bind Camera

Click to open the camera resource list, select the camera, and click OK to bind the
corresponding camera to this label.

Add as Key Label

Add the label to the key label management list.

4. Click Save and Configure to set the label size and choose whether to display video within the label area.

5. Click OK to save the settings.
Clicking a web label in the AR live map will open the web address (the example shown in the diagram is the
management platform) and overlay the camera's live video on the webpage.
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Figure 25-17: Third-Party Webpage Configuration and Display Effect

Please configure the content area and window size

Window Size: Width(pd | 600 Height{p) | 600

Management Platfo... | Police ‘

Aanagement PI...

&

25.5.2 Label Operations

Supports modifying, deleting, hiding, and other operations on labels.

Search Labels

Enter keywords in the upper-right corner of the page to search for labels under the current high-position camera
or all high-position cameras. Clicking a label will jump to the camera view where the label is located and highlight
it on the image.

Figure 25-18: Keyword Search
AR Live Map Command System

Manage Labels

Click Add Label to enter label editing mode, where the following operations can be performed:

¢ Move label: Vector labels and area labels cannot be moved after being added. Other labels can be dragged to
change their position.

* Modify label: Click E corresponding to a label to modify its parameters.

® Delete label: Click E corresponding to a label to delete it.

View Labels

Exit label editing mode. Click the label name to view label details or the camera's live video.
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¢ For low-position camera labels, clicking the label name will open the live video of that camera.

Figure 25-19: Low-Position Camera Label Details

@ Note:

A maximum of 5 label live videos can be displayed simultaneously in the high-position camera view.

e For high-position camera labels, clicking the label name will switch to the AR live view of that high-position
camera.

¢ For building labels, clicking the label name will display label details and open the live video of the associated
camera.

Figure 25-20: Building Label Details
Meeting Room |Puh.|'n: P|

Detailed Info

Building Name:None

Organization:None

Height:None Total Foors:None

Total Building Area:None Accommeodation Capacity:N...

Linked Camera

e For third-party webpage labels, clicking the label name will open the third-party webpage and play the live
video of the associated camera.

e For other types of labels, clicking the label name will display label details, etc. Specific behaviors are subject to
the screen display.

Hide Label Names

Exit label editing mode, supports showing or hiding label names for a clearer view of label information.

e Click (@) of a label to hide its name. Click again to restore the display.
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* Click g in the upper-right corner to hide all label names. Click again to restore the display.

25.6 Label Management

Centrally manage labels, supporting operations such as editing and deleting.

Click Label Management at the bottom of the page. The Label Management list will appear on the left side,
allowing you to view and manage all labels.

Figure 25-21: Label Management

Label Management

____

Current ... v

position Camera (1)

e Click a label to go to the high-position camera view where the label is located.

e Search: Select either the current high-position camera or all high-position cameras, then enter keywords to
search for labels.

* Edit: Click [ next to a label and select Edit to modify its content.

e Delete: Click ﬂ next to a label and select Delete to delete the label.

25.7 Key Label

Manage key labels of focus. Clicking a label quickly navigates to its location.

Add Key Label
Three methods are supported for adding labels to key labels:

* Inthe AR live map, click the E on a label to add it to the key label list under the corresponding label category.
Figure 25-22: Mark as Key Label

Mark as Key Label

-

e In the upper-right corner of the AR live map page, enter keywords to search for a label, then click the
corresponding E to add the label to the key label list under the corresponding label category.
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Figure 25-23: Add to Key Label

Current ... v

e When adding a new label, set it as a key label. For details, see Add Label.

Key Label List

Click Key Label at the bottom of the page to display the Key Label list on the left side of the page, showing all key
labels in the system.

Figure 25-24: Key Label List

Key Label

Current ... v

Low-position Camera (1)
@ L1 |Skynet|
High-position Camera (1)

Building (1)

Third-party Webpage (1)

e Filter key labels: Supports filtering key labels of all high-position cameras or key labels in the current high-
position camera; supports keyword search.

¢ Inthe key label list, select a label. If the label is not in the current field of view, the camera will automatically
move to the label's position.

e Delete key label: Click [& after a label to remove it from the key label list.

25.8 Filter Labels

Filter labels by type or attribute for convenient viewing of desired labels.
1. Click Filter Labels at the bottom of the page to display the Filter Labels list on the left side.

2. Select the desired label types or attributes, and only the selected labels will be shown in the live view.
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Figure 25-25: Filter Labels

Filter Labels v Select All X |

Label Type Label Attrib...

Filter Labels » Select All »

Label Type Label Attrib...

[vw] Low-position Camera [w] Police

[w] High-position Camera [v] Skynet
[v] Building [v] Industry
[w] Road

[v] Key Person

[w] Patrol Route

[v] Device

[w] Direction [v] Public Place

[w] Custom Area

[v] Road Facilities

Cerurite Bnnth

[i#] Third-_nartv Wehnane

25.9 Map Display

View the current high-position camera's location on the map.
Click g in the lower-right corner of the page to open the 2D map.

Figure 25-26: Map Display

a ¥

e The point indicated by the blue icon represents the current high-position camera. Double-click other high-
position cameras on the map to switch to the AR live view of the corresponding camera.

Switch map / live view: Click . to toggle between the map view and the live view.
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Figure 25-27: Map View

ey

92.117.3...

N

Figure 25-28: Live View

Zoom in/out on the floating panel in the lower right: Click + to zoom in; click - to zoom out.
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Figure 25-29: Zoom In on Live View Floating Panel

* Place the mouse over the map, hold down the left mouse button to drag and view the map, and scroll the
mouse wheel to zoom the map in or out.

25.10 PTZ Control

If the high-position camera is a PTZ camera, PTZ control is supported.

[®p Note:
VSS cross-domain cameras do not support the PTZ control function.
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®  Click the in the lower right corner of the page to open the PTZ control panel (click again to hide it).

Direction arrows such as u and n can be used to adjust the PTZ orientation, while g and g can adjust the
camera's focal length to zoom the picture in or out.

Figure 25-31: PTZ Control Panel

Click the direction arrows , ’, , ’ around the AR live view to adjust the PTZ orientation.
¢ Inthe live view, scroll the mouse wheel to zoom the picture in or out.
Click the in the upper left corner of the page to enable the 3D positioning function (click again to disable
it).
¢ Click to locate: Click any point in the picture, and the PTZ camera will rotate to center on that location.

¢ Drag to Zoom: Hold down the left mouse button and drag a box in the picture. Drag from top-left to
bottom-right to zoom in; drag from bottom-right to top-left to zoom out.

Note:

If 3D positioning is not activated, you can also hold down Ctrl + left mouse button to drag a box for
zooming.

26 Alarm Center

You can manage all types of alarms in the system. Real-time alarm and alarm linkage are available for you to

detect abnormalities promptly. You can also search and analyze historical alarms to understand alarm trends and
review events.

Function Description

Function Menu Description

Alarm Configuration e Allows users to configure alarm recipients, aggregation rules, and sounds to

push targeted notifications to users based on their needs.

e Allows users to configure alarm linkage methods so that when an alarm occurs,
it can automatically trigger associated actions (play live view, display a pop-

up alarm window, etc.), ensuring users can promptly perceive and view alarm
details.

Real-time Alarm Allows users to view various device resources and alarms on a map and control
devices in a visualized way, providing an immersive operational experience.

Historical Alarm Allows users to search and handle various kinds of alarms received by the system.

26.1 Alarm Configuration

Configure alarm recipients, aggregation rules, sounds, and alarm linkage.
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26.1.1 User Subscription

Configure subscription information for users so that they can receive and view alarms on the Web interface when
specified alarms occur on certain devices.

Note:
By default, the admin and loadmin users can receive all alarms without manual alarm subscription.

¢ You can manage subscription information by user or by subscription group.

¢ Subscription information can be manually entered or auto-filled by template.

Configure Subscription Template

You can create a subscription template for specific alarm types and apply it when configuring subscription
information for users or groups, reducing the workload of repeat configuration.

1. Go to Alarm Config > User Subscription.
2. On the Subscription Template tab, click - .

3. Complete the subscription information on the right-side.

Figure 26-1: Create Subscription Template

Subscription Template

Create Subscription Template

=Subscription Template Name!

*Subscription Template Description:

Alarm Subscription Information
«Alarm Level Select All Critical Mino: Waming Alert Others

<Alarm Type: Add

Alarm Type Alarm ID Operation

Device Name Device Code Operation

EC_PAG_MOBILE ECPAGMOBILE

(1) Customize the template name and description.
(2) Select alarm level(s) to subscribe.
(3) Click Add next to Alarm Type to select alarm type(s) to subscribe.
(4) Click Add next to Device List to select device(s) to subscribe.
4. Click Save.

The successfully saved templates will be displayed in the left-side list. You can enter keywords in the search bar to
search for the template or hover the mouse over a template name and click to delete it.

Subscribe by User
Configure alarm subscription information one by one.

1. On the User tab, select a user from the left-side user list.

2. Click Add in the right-side and complete the subscription information.

319



Figure 26-2: Configure User Subscription Information

User

"loadmin"Information

Administrator emplate

A Critical Majo Mine Warning [ Alert Qthers

admin

&n loadmin

Alarm Type Alarm ID Operation
Device Online 216
Device Offline 217

List
Device Name Device Code Operation
EC_PAG_MOBILE ECPAGMOBILE

e By Template: Select an existing subscription template, and the subscription information in the template
will be automatically filled in.

e Manual Enter: Select alarm level(s), alarm type(s) and alarm device(s) to subscribe manually.
3. Click Save.
After saving, you can click on the user in the left-side list to view the subscription information.

Other Operations:

e Edit Subscription Information: Click Edit to edit the subscription information.
e Cancel Subscription: Click Cancel Subscription to cancel the user's subscription.

e Save as a Template: Click Save As a Template, enter the template name and description to save the current
configuration as a template.

e Copy Subscription Information: Click Copy To, select user(s) to replicate the current configuration.

By Subscription Group

Add users to groups and configure subscription information by group.

1. On the Subscription Group tab, click - .

2. On the right-side, customize the subscription group name and description, and then select users for the
group.

Figure 26-3: Configure Subscription Information for Subscription Group

Subscription Group
Create Subscription Group

Groupl Subscription Gr User:
Subscription Group User:

Alarm Subscription Information
Select Template:  Template2 Template Description: 1
«Alarm Level Select All Critical Major WMino Warning Alert Others
xAlarm Type Add
Alarm Type Alarm ID Operation

Online

Device Name Device Code Operation

EC_PAG_MOBILE ECPAGMOBILE

3. Configure subscription information for subscription group.
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¢ By Template: Select an existing subscription template, and the subscription information in the template
will be automatically filled in.
¢ Manual Enter: Select alarm level(s), alarm type(s) and alarm device(s) to subscribe manually.
4. Click Save.

After saving, you can click on the group name in the left-side list to view the subscription information. You can

click Edit to edit the subscription information or hover the mouse over the template name and click fjj to delete
it.

26.1.2 Alarm Aggregation

Set alarm aggregation rules to group same types of alarms from the same source within a specified time period.
This function automatically filters repeated alarms in a short period of time, improving alarm handling efficiency
and ensuring that important alarms are not missed.

Configure Alarm Aggregation Rule
1. Click Add.

2. Select alarm source and alarm type, and set the aggregation time (0s-1800s; repeated alarms within this
period are automatically aggregated and the total alarm count will be recorded).

Figure 26-4: Add Rule

Add Rule X

Alarm Source: Select Device

Alarm Type:

Rule: seconds to alarm once
3. Click OK.

You can search, edit (alarm type/time), or delete configured rules.
Figure 26-5: Rule List
+ Add ) Refresh
All loaded. Total 1 items

Alarm Source Alarm Type Time (s)

Operation
EC_PAG_MOBILE Device Online,Device Offline lllegal Access,Network Disconnected,Netw... 10 Edit Z E Delete :
26.1.3 Alarm Sound
Configure alarm sounds for alarms to remind users to promptly check alarms.
Alarm Type Reset
—+ Add 1i] Delete Number of broadcasts 1
Sound Name Sound Files Associated Alarm Types Operation
Default Tones ) /is/alarm/resourcefvoice/Default...  All 4 -
11 ) /isfalarm{resource/voice/5649d46... Device Online, Device Offline, Fan Failure, Cold Start, Scheduled Re.. T

Add Alarm Sound
1. Click Add.
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Add X

@ Users can upload the required alarm sound and customize the scund prompts for related

alarms,
*Sound Name
*Sound attachment T, Upload File

*Associated Alarm Types

2. Click Upload File, select a sound to upload. Click ) to listen, click Reupload if you need change the sound.

Note:
The file supports .mp3 and .wav formats, with a maximum allowed size of 30 MB.

3. Click , select alarm types.

Note:
Each alarm type can only be associated with one alarm sound.

4. Click OK

Configure play times

In the upper-right corner of the page, modify the number of times the alarm sound plays. After making the
changes, click anywhere in the blank area of the interface to save the settings.

[®p Note:
The play times setting applies uniformly to all alarm types.

Search alarm sounds

Select the alarm type and click on Search to query the alarm sound associated with that particular alarm type.

26.1.4 Alarm Linkage Configuration

Configure alarm linkage to automatically trigger actions on linked devices (e.g., display live video on a video wall,
access control) when an alarm is generated. This allows users to promptly perceive and review alarm events.
The system also supports the use of time templates to define the active periods for alarm linkage, preventing
activations during designated "Do Not Disturb" hours.

26.1.4.1 Alarm Linkage Configuration

Configure linkage actions based on different alarm types from the alarm source.

Configure Alarm Linkage
1. Click Add. A page as shown below appears.

2. Select the alarm source type, alarm source, and alarm type. (Only supported alarm types for the selected
source type will be displayed.)
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Alarm Source Type

General

System

Storage

Camera

VICA

Alarm Input

Water Level Detection

Access Control

People Flow Counting

Alarm Source

Alarm Source (selected1)

-9z

@) 192121

® 192121
192,121

- 9z

ws 192121

@) 192.121.1.222_10

@ 192121.1.222 10
@ 192.121.1.222_1001
@ 192121122211

Alarm Type (selected1)

W Selact All

Device Online

Device Offline
Abnermal Parking
Congestion
Speeding

Low Speed

llegal Lane Change
Cross Line
Wrong-Way Driving
Queue Overflow

Fan Failura

3. Click Next to configure alarm linkage. When an alarm occurs, the corresponding linkage actions are triggered.

| User Info

Linked Object Non linked users

| Linkage Time
Select Linkage Time
Schedule Template

| Linkage Action

Pop up live Alert: Displays a pop-up

Pop up playback Alert: Displays a pop-

Live View on Videa... Alert: Pla

( .\/ )

Alarm Source

(®) All users

Specify users

Alarm Linkage

© If not configured, always effective by default.

Backup Recording Alert: Backs up recordings before/afier an ala

Store Recording Alert

Device On/Off Swit... Alert

Equipment Linkage
| Pop up live

Pop up playback
Live View on Video Wall
Backup Recording
Store Recording
Device On/Off Switch
Access Control

Other Linkage
Play Audio
Send E-mail
Send Text

source reports an alarm.

Cancel Back “
Item Description
User Info Linked Object | Trigger action for the selected user(s) or all users when the selected alarm

¢ Non linked users: No users are linked. Only Live View on Video Wall,
Backup Recording, Store Recording, Device On/Off Switch, Access
Control, and Send E-mail are available for linkage.

e All users: Link all users logged into the same server.

o Specify users: Link selected users only (up to 32 users).
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Item Description
Linkage Time | Select Select an alarm linkage Time Template. The alarm linkage will only be active
Linkage Time | during the periods defined in the template. Alarms generated outside these
Schedule scheduled times will not trigger the linked actions
Template If no template is configured, the linkage is always active by default.
Linkage Pop up live Displays a pop-up live view window for specified users.
Action Pop up live (D alert: Displa plive nd
Linked Object All users
Duration (@ Permanent Existence Custom Close 10 second(s)
Playing Mode Play in“pop-up window
Mode Selection @ Main stream priority Secondary stream priority
Window Layout Auto
Associated Mode Associated Alarm Source (@) Manually adding a camera
Camera List O]
No Name Window ID Preset Operation
201_1 1 The presetis
/1
e Duration: Set the window to display permanently or close after the
specified duration.
¢ Playing Mode: The pop-up live view window will overlay on any client
interface.
¢ Mode Selection: Select a stream (main/sub stream) for live view.
e Window Layout: Auto (based on the number of cameras), or specified
(1/4/9/13).
e Associated Mode: Select which camera(s) to play live view.
e Associated Alarm Source: Play the live view of the alarm source.
e Manually adding a camera: Select camera(s) and specify each
camera's live view window and preset.
¢ Text Overlay: Custom text information that can be overlaid on the live
view.
Pop-up Displays a pop-up playback window for specified users.
Playback
Pop up playback
Linked Object
Playback time 10 second(s)
Assodiated Mode (®) Manually adding a camera Associated Alarm Source
Specified Camera Camera List D =

No. Name Window ID ‘Operation
192.117.3.120_1 1
192.117.3.120 2 2

e Playback time: Set the duration of the playback window. Recordings of N
seconds before an alarm will be played.

¢ Associated Mode: Select which cameras for playback.

e Manually adding a camera: Add multiple cameras and specify the
playback window for each.

e Associated alarm source: Play back the recording from the camera
that triggered the alarm itself.
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Item

Description

Live View on
Video Wall

Plays live videos of specified camera on a specified video wall.

Live View on Video...

Video Wall ~ Overlay Red Alarm Box
Duration ®) Permanent Existence Custom Close 10 second(s)
Pane Select Policy Fixed First pane ~
Live distribution Strategy = Sequential Allocation v
Associated Mode (®) Manually adding a camera Associated Alarm Source
Camera List D o
No. Name Operation
1 192.115.2.142 3 X

e Video Wall: Select a video wall for live videos.

e Overlay Red Alarm Box: When selected, a red border will be displayed
around the alarm triggered live view windows.

e Duration: The duration for which the live videos is displayed on the wall.
After the time limit, the linked live videos will be closed and the original
videos in the windows will be restored.

¢ Pane Select Policy (window selection strategy): Configure windows/split
screen for live view display.

¢ Fixed First pane (fixed first window): All cameras’ live videos are
played in the first opened window (window ID is 1).

e Associated alarm linkage pane (Associate alarm linkage window):
After specifying alarm linkage windows on the video wall, camera's
live videos will be played in these windows.

e Custom pane List (custom window list): Add window(s) and specify
the layout (one window can be split into multiple windows).

e Live Distribution Strategy: Select the camera assignment sequence for

specified windows/split screens (windows/split screens are specified in
Window Selection Strategy)

e Sequential Allocation: Cameras will be assigned sequentially to
specified windows or split screens, overwriting existing content in
windows. If camera count exceeds the window count, newly added
cameras will overwrite the earliest displayed cameras.

EN | BN 5 BN 2 |
=
EN | EN EN | Em

e First Pane First (first split window priority): The newest camera video
will be assigned to the first split screen of the specified window,
pushing the original first video to the second split screen, and so on.
If camera count exceeds the window count, the earliest displayed
camera will be removed.

[ Note:
This strategy cannot be selected when using the Custom Pane List
configuration.

EN KN
EN | EN
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Item

Description

¢ Free Pane Priority (idle split screen priority): Cameras' live videos are
assigned to idle split screens in sequence. If no idle split screens, they
will preempt other windows. If the camera count exceeds the window
count, newly added cameras will overwrite the earliest displayed
cameras.

¢ Associated Mode: Select which camera(s) to play live view.
e Associated Alarm Source: Play the live view of the alarm source.

e Manually adding a camera: Select camera(s).

Backup Back up recordings before/after an alarm of specified cameras. You need to
Recording configure backup resources first.
Backup Recording
Before backup alarm 10 s recarding
After backup alarm 10 s recording
Associzted Mode (®) Manually adding a camera Associated Alarm Source
specified Camera Camera List ] 4'__
No. Name Operation
192.117.3.120_1
2 192.117.3.120_2
1 /1
e Back up recordings from N seconds before the alarm to N seconds after
the alarm.
e Associated Mode: Select which cameras for recording backup.
e Manually adding a camera: Add multiple cameras.
e Associated alarm source: Back up the recording from the camera that
triggered the alarm itself.
Store Store recordings after an alarm from specified cameras. You need to
Recording configure storage resources first.
Store Recording
After storage alarm 10 s recording
Associsted Mode (®) Manually adding a camera Associated Alarm Source
Specified Camera Camera List o m
No. Name ‘Operation
192117312001
2 192.117.3.1202
1 /1
e Store N seconds of recordings after the alarm.
¢ Associated Mode: Select which cameras for recording storage.
e Manually adding a camera: Add multiple cameras to store their
recordings.
e Associated alarm source: Store the recording from the camera that
triggered the alarm itself.
Device On/ When an alarm occurs, turn on the alarm output of the camera.
Off Switch
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Item

Description

Device On/Off Swit... (1) Al

Select On/Off Switch Alarm Input List

No Name Operation

1 NVR_OTS_11 X

Access When an alarm occurs, the specified access control devices can be controlled
Control to open or close door.
Access Control (D) Alert: Controls specified devices
Access Control Access Control Device List Selected List (2)
T m Local Domain Device Name Device Action Operation
%15 1 192, 1.37 Open Door o)
B 201
192.834.1.37_1 Close Door iy
i 1o 37
Dw; 371
e Access control device: Select face recognition terminal(s), general access
control device(s), and access controller(s) from the left-side list and add
them to the selected list.
¢ Device action: Open Door, Close Door, Keep Open, Keep Closed, Restore
(restore door from keeping open/closed).

Play Audio Broadcasts alarm information to specified users. For broadcast contents, you
can choose from the provided expressions (which will be replaced with the
specific alarm information) or enter custom descriptions.

Play Audio (D Alert: Broadcasts alarm information to specified users
Linked Object All users
Content Templat ${Alarm Time) = S{Alarm Device} = S{Alarm Type) = Expression
Please handle it General Alarm
${Alarm Type}
${Alarm Level}
${Alarm Devica}
${Alarm Time}
Supported expression types:
e General Alarm: Alarm Type, Alarm Level, Alarm Device, and Alarm Type.
¢ Vehicle Event (only applicable to vehicle event alarms): Plate Number,
Vehicle Owner Name, and Vehicle Speed.
Send E-mail | Sends an email to specified users.

Send E-mail (1) Alert: Sends an email to specified users, up to 32 email addresses are allowed

Email Address

Content Templat ${Plate Number} x ${Vehicle Owner Name} x  ${Vehicle Speed} x Expression

Vehicle Event

${Plate Number}

${Vehicle Owner Name}

S{Vehicle Speed}

Image Attachment Send I
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Item Description

[ Note:
Before using this function, you need to configure the email server and
contacts first. See System Config > Service Config > Email.

e Email Address: Select email addresses (up to 32 email addresses).

e Content Template: you can choose from the provided expressions (which
will be replaced with the specific alarm information) or enter custom
descriptions.

Supported expression types:

e General Alarm: Alarm Type, Alarm Level, Alarm Device, and Alarm
Type.

¢ Vehicle Event (only applicable to vehicle event alarms): Plate Number,
Vehicle Owner Name, and Vehicle Speed.

¢ (The configuration is displayed only for vehicle event alarms)If want to
attach vehicle alarm snapshot in the email body, you can select Send
Image.

Send Text Sends a custom text message (displayed in a pop-up window) to specified
users.

Send Text

Linked Object

Text Contents

Manage Alarm Linkage

You can edit, delete, enable, disable alarm linkages. Linkages must be enabled to take effect.
Alam Source Aam Type Setus Al v Reset

e Edit: Click /7 in the Operation column to modify alarm linkage configuration.

e Delete: Click [ in the Operation column or select linkage(s) and click Delete above the list, and then
confirm the deletion.

Enable alarm linkage: Click in the Operation column or select linkage(s) and click Enable above the list to
enable the linkage.

¢ Disable alarm linkage: Click & in the Operation column or select linkage(s) and click Disable above the list to
disable the linkage.

26.1.4.2 Time Template

A time template defines the active periods for alarm linkage configurations. Linkage actions will only be executed
for alarms that occur within the scheduled time defined in the template. Pre-configuring time templates allows
for quick selection when setting up alarm linkage, improving configuration efficiency.

@ Note:

A time template consists of two parts: a weekly schedule and a holiday schedule. The weekly schedule
governs alarm linkage during regular days, while the holiday schedule takes priority during holidays. For
example, if a holiday is configured as Do Not Execute Linkage Actions, linkage will not be triggered during
that period, even if it falls within an active time slot in the weekly schedule.

Add a New Time Template

1. Click 4 to add a new time template.
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Configure the weekly schedule.

senedute Lt e Template Name A2 Copy Template
Please enter keywords to
Please enter
oA femare 0/128
Weekly Schedule Holiday Schedule
2 Edit 3 Reset
0 2 4 6 8 10 12 14 16 18 20 22 24
wo HEEEEEEEEEEEEEEEEEEN -
vrser [ L
Tuesday .-
o Bl
Thursday ..
Friday ..
eea
No. Description
1 Enter a template name.
2 Select Copy Template to select an existing template. Its time configuration will be copied to the

new template for further editing.

3 Configure effective time periods using one of two methods.

¢ Click Effective Time or No Schedule. On the time chart, click or click-and-drag to define
periods. Each block represents one hour.

[ Note:

White blocks (No Schedule) indicate periods where linkage is inactive. Green blocks
(Effective Time) indicate periods where linkage is active.

e Click Edit to manually add up to 12 precise time periods (to the minute) per day.
After configuring one day, you can select other days and click Copy To to apply the same
schedule for quick setup.

Edit X
Sunday Monday Tuesday ‘Wednesday Thursday Friday Saturday
Period Start Time End Time Operation
1 00:00 0100 imj
2 02:00 03:00 Tu]
3 035:00 05:00 imj

-+ Add Time Period

Copy To: All check
Sunday Monday Tuesday Wednes... Thursday Friday Saturday
4 Click Reset to clear all configured time periods for the current template. |
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3. (Optional) Configure the holiday schedule.

Weekly Schedule

Holiday Schedule

© Select Holiday (2/32) f Clear = {7 Refresh

£ Edit

0 2 4

e [ L]
- [ ]

Save

8]

Cancel

Reset

6 8 10 12 14 18 18 20 22 2

i

No Schedule

I

No. Description
1 Select Holidays. (Holidays are created in System Configuration > Service Configuration > Holiday
Management)
e A maximum of 32 holidays can be selected per template.
* Click 3 next to a selected holiday to remove it.
2 Click Edit to set precise active time ranges (up to 12 per day) for each selected holiday.
Edit X
New Year's Day  Thanksgiving
Period Start Time End Time Operation
1 00:00 04:00 [}
2 028:00 18:00 Ty
3 20000 0000 Ty
+  Add Time Period
Copy To: All check
Mew Yea..  Thanksg..
Sl o |
After configuring one holiday, select other holidays and click Copy To to apply the same schedule.
3 Click Clear to remove all selected holidays from the current template.
4 Click Reset to clear all configured time periods for holidays in the current template.
5 Click No Schedule, click or click-and-drag on the time chart to erase periods (set as inactive).
6 Click Effective Time, click or click-and-drag on the time chart to draw periods (set as active).
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4. Click Save to complete the configuration.

26.2 Real-time Alarm

View device resource points and device alarms on the map. You can also perform operations on devices and
manage resources on the map visually, which provides you with an immerse operating experience.

Operation entry: Click the Q in the upper-right corner of the main interface

Prerequisite

By default, the system marks all devices on the background image.

To display devices on the actual map, bind the area map and mark device locations on the Edit Map page.

Map Overview

By default, the page shows the default floor of the root area.

Click the map list in the upper-left corner of the map to select the map of an area.

Click on the floor list in the map's upper-left corner to switch to the map of the desired floor.

Device points and alarm information are displayed on the map.

root

4-01-22 20:18:45

Major [ObjectisRec...
05
© 2024-01-22 20:1845

Major | ObjectlsRec...
2 - 05
© 2024-01-22 20:18:45

By Device
LS .JI"-'-ﬁn
,

[ Today’s Alarm Statistics ]

2717

Alarm Count

@ Note:

¢ You can use the scroll wheel to zoom in or out on the map, or hold and drag the left mouse button to
move the map.

Click -@- in the map’s lower-right corner to restore the default perspective.

Click . in the map’s upper-right corner to enlarge to the full screen. The screen name support

customization, see Map Display Configuration.

Table 26-1: GUI Introduction

Tab

Description

Realtime Alarm

The left-side realtime alarm pane shows the latest 20 alarms. Alarms are sorted by time,
with the latest alarm at the top.

e You can clickEgto filter alarm types to be displayed.
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Tab Description

Filter Alarm
Alarm Level
Critical | Major | Minor | Warning
Alert Others
Alarm Type

[¥] General

[] system

[¥] storage

.
g
3
£
3

5

=
g
El
3
3
g

| Water Level Detection

| Access Control

¢ Click More Alarm Records to go to the Alarm Records page.

Alarm Details e Click an alarm card to switch to the map where the device is located, locate the device
on the map, and show alarm handling operation panel.

e Double-click an alarm card to view alarm details.

Today's Alarm Display the total number of alarms reported today, and the number of alarms that are

Statistics classified by alarm level/alarm type.

E> Note: The number of alarms reported today is counted in real time; the data is cleared
in the early morning of the next day.

Alarm handling
In the realtime alarm list, you can click an alarm card to locate the alarm on the map and display the alarm
handling panel.
Level 2
MaskimageAlarmOn

=) Alarm Dewvice 147-IP Camera 01
Y Alarm Time 2024-01-29 19:10:06

( Alarm Details )

Table 26-2: Alarm Handling Operations

Operation Description

View alarm details Click Alarm Details to view alarm details and perform the following operations.
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Operation

Description

Live View Playback

() Alarm info

147-IP Camera 01

level2

(0.00bps, 0x0)

¢ View the device on the map, its live and recorded video and images, and alarm
information.

e Verify to acknowledge or discard the alarm, and give a comment.
e Choose a user and forward the alarm to the user.

e Upload alarm images for archiving.

Acknowledge alarm

If the alarm is valid, select Acknowledge Alarm and then click OK to set it as a valid
alarm.

Discard alarm

If the alarm is false, click False Alarm and then click OK to discard it.

On-map device operations

Click the device to view the operations allowed. For example:

video wall.

) P

Live View = Playback Live View ... Playback ... Gnd Track...

Camera: View live or recorded video, play video on the

Face recognition terminal/General access control
device/Access controller: Open door, close door,

keep door open, keep door closed, restore door from
keeping open/closed.

Face recognition terminal: You can clear the alarm-
triggered action on the device if the alarm is false.
Additionally, you can click i in the left-side alarm list
to clear alarms on all access control devices in batches.

Open Door Close Door Keep Open Keep Clos...

B B B

Restore  (One-cli

Two-way audio: Make two-way audio calls. Temperature/humidity sensors: View historical data.
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8 0ffline

Host call extension Host broad casting Host call host

T, -

Note: If device points on the map are very close together, they will be aggregated and a number will be
displayed to indicate the total number of aggregated devices.

Grid Tracking

Grid tracking lets you view live or recorded videos of neighboring cameras of a certain device.

1. Click Grid Tracking, the cursor changes to@.

2. Click the marked location on the map, the system will searches cameras around the specified location
according to the straight line distance from near to far and plays video of the discovered cameras in the
windows until all the windows are populated.

@ Note: You can click the video image of a camera to start grid tracking again with that camera as the
center.

S 06201 11:45: 16 AR
| 1

i ’
213. 208. 220. 125
(R

® v w

Heat Zone

Click on a heat zone to jump from the current area to another linked area.

Show/Hide Device Name

Click Device Name above the map to choose whether to display device names on the map.

@ Hide by default, and sho...
Q Always Display
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Measurement
You can measure line distances and closed areas in the scene map.

e Measure distance: Marking points on the map to get the route distance from each point to the start point (the
length of the whole route is displayed at the last point).

1. Click Measure > Measure Distance.

2. Hover the mouse over the map and left-click once to determine the start point. Then, draw the route by
using the left button several times. Finally, right-click on the map to complete the drawing.

Start Paint

Currently 355 m
Click to continue, Right-click to cancel.

e Measure area: Marking points on the map to get the area of a closed figure.
1. Click Measure > Measure Area.

2. Hover the mouse over the map and use the left button to draw a closed figure on the map. Finally, right-
click on the map to complete the drawing.

I 102221722353 | J r
- =g

10.222.172235 1

2 €

Configure the types of device resources to be displayed on the map for a clearer view.

Layer

Click Layer in the upper-right corner and select the types of devices to be displayed on the current map.

Access Control Device

Access Contr... || Access Contr...

Video Intercom Device

Entrance Ma... || Indoor unit

Roaming Route

Note:
Only scene maps support roam path, see Roam Config.

1. Click Roam Route in the top toolbar to show the roam path list.
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2. Click [ to view roam path, you can play a video of the roaming route in the map screen from the first
viewpoint.

Panoramic View

@ Note:

Only scene maps support panoramic view, see Panoramic Config.

Click Enable Panoramic View in the top toolbar to start panoramic view, the model rotates around a central axis,
allowing you to view all sides of the model.

26.3 Alarm Notification

When an alarm occurs, users can be notified by alarm pop-up window and alarm sound.

Prerequisite

Click 63 in the upper-right corner and select Client Config. You can choose whether to enable alarm sound and
pop-up alarm window as needed.

Client Config X

I Alarm Notification

Pop-up Alarm Window (:)
Alarm Sound c

Alarm Pop-up Window

If enabled, when an alarm occurs, a pop-up window will appear in the lower-right corner of the page displaying
alarm information and accompanies by an alarm sound.

Alarm Push b4

Alarm Level Alarm Time Alarm Type  Alarm Device Operat..

-

® Major 2025-07-08 10:31:18  Motion D... 172.2081.1.. [

® Major 2025-07-08 10:31:18  Ultra Mot... 172.2081.1.. [

Do not show again (7)

26.4 Historical Alarm

Go to Alarm Center > Historical Alarm.

Search and handle historical alarms received by the system.

26.4.1 Alarm Records

View historical alarm records and handle alarms.
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Search Alarm

You can search alarms by alarm time, alarm device (default: all; or click +++ to select devices within permissions),
alarm type, alarm level (critical/major/minor/warning/alert/others), handling result (unhandled/acknowledged/
false alarm/ignored), and user who handled the alarm.

After setting the search criteria, click Search to display the alarm records that match the set search criteria.

Figure 26-6: Historical Alarm Records

Alarm Time: 2025/01/07 0 ~ 2025/01/07 2 Alarm Device: Selected devices:0 | L.-*" Alarm Type: Alarm Level: All
History Alarm
Result: | Al Handled By Reset
Found results 264619items Export v Manual Alarm
Alarm Level  Alarm Time Alarm Type Alarm Device Result Operation

ave Area Unhandl.. &
ntrusion Detection Unhan. =
B

o
g
:
c
m

x
:

c
m

Motion Detection Started NVR1_2 Unhandl..,

m

Intrusion Detection NVR1_2 Unhandl

N
m | m

o

m

9 13231 > 20/page v Goto Page

Handle Alarm

Table 26-3: Alarm Handling Operations

Operation Description

View alarm details | Click [Z] for the alarm record to view alarm details.

Alarm Details

5 Live View Playback Image
Alarm Info R —

Alarm Device: NVR1_2

Alarm Level: m Warning

Alarm Type: Intrusion Detection
Alarm Time: 2025-03-26 0%:41:30

Qrganization Level Path: >> NVR1_2

[ Alarm Handling

03-26 09:41:09,
Alarm Plan: Mone

*Result: Acknowledged False Alarm Ignored

Comments:

Push To:
Alarm Snapshot: +
Max. 3 photos
Format: jpg.
bmp, png, gif
Save

Next

The following operations are supported:

e View the channel's location on e-map, live videos, recordings, snapshots, and alarm
information.
For important person, face match, face not match, unauthorized area access,
and unauthorized time access alarms, you can view the face snapshot and library
information. For unauthorized alarms, you can also click Track Trajectory to redirect to
the Face Search page to view the face trajectory.
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Operation

Description

e Acknowledge alarm, mark the alarm as a false alarm, or ignore the alarm, and add
handling comments.

e Select user(s) to push the alarm.

¢ Upload alarm snapshots.

Acknowledge alarm

Click Acknowledge/False Alarm/Ignored next to Result on the Alarm Details page or
select alarm(s) in the alarm list and click Acknowledge to handle alarm.

*Result: Acknowledged False Alarm gnored

wance
|

Push alarm

For example, when the administrators receive an alarm, they can push the alarm to other
unauthorized users for alarm handling.

Click the selectbox next to Push To in the Alarm Details page or select alarm(s) in the
alarm list and click Push Alarm, and then select the alarm recipient(s).

cush Tof1 /1)

- Administartor
"~ -
1x admin

~ .
1p l0Edmin

Canc
ﬂ Mcr‘-e

When succeeded, the recipient will receive the corresponding pop-up alarm window.
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Operation Description

Alarm Push X
Alarm ) Alarm )
Alarm Time Introducer Operati
Level Type
B Minar 2024-07-04 12:23:32  Face Detec... loadmin L?\
B Minar 2024-07-04 12:23:28 Face Detec... locadmin L?\
Alert 2024-07-04 12:19:55 Motion Det... loadmin L?\

Do not show again

Export alarm Select alarm(s) in the alarm list and click Export to export the selected alarm record(s) to
local.
Manual alarm Click Manual alarm above the alarm list and complete the alarm information.
Manual Alarm X
=Alarm Device: NVR1_4 =Alarm Type: Enter Area
=Alarm Time: =Alarm Level: Major

Linked Image: .

After configuration, a manual alarm record will be added to the alarm list.

26.4.2 Pushed from Others

View alarms pushed from others and handle alarms.

Note:
For push operations, please refer to Push alarm.
Search Alarm

You can search alarms by alarm time, alarm device (default: all; or click -+ to select devices within permissions),
alarm type, alarm level (critical/major/minor/warning/alert/others), handling result (unhandled/acknowledged/
false alarm/ignored), and user who handled the alarm.

After setting the search criteria, click Search to display the alarm records that match the set search criteria.

Figure 26-7: Alarm Records Pushed from Others

Alarm Time:  2025/01/07 O - 2025/01/07 23 Alarm Device: Selected devices0 | 1. Alarm Type: Aarm Level: Al
Result: Al Pushed By: Reset
Pushed from Others
Alarm Statistics Found results 3items Export v
Alarm Level Alarm Time Alarm Type Alarm Device Result Pushed By Pushed On Operation
Warning Match Unhandl loadmin =
m Majo Cross Line NVR1_2 Unhandl. loadmin =
2025-01-07 14:08 Leave Area NVR1_2 Unhandl loadmin 2025-01-07 14:24:36 =

Note: On the Pushed form Others page, you can re-handle alarms that previously handled by others and
update the handling result.

339



Handle Alarm

Table 26-4: Alarm Handling Operations

Operation

Description

View alarm details

Click [Z! for the alarm record to view alarm details.

Alarm Details

Live View Playback Image
El Alarm Info JE—

172.20. I‘S 91_3 (0.00Mbps)

Alarm Device: NVRI_2 "
Alarm Level: m Warning ]
Alarm Type: Intrusion Detection '
Alarm Time: 2025-03-26 09:41:30
Qrganization Level Path: >> NVRI_2 '

L

!
D Alarm Handling

03-26 09:41:0¢

Alarm Plan: Mone

*Result: Acknowledged False Alarm Ignored s
Comments:
Push To:

Alarm Snapshot: + |
Max. 3 photos
Format: jpg.
bmp, png, gif

:

The following operations are supported:

Next

e View the channel's location on e-map, live videos, recordings, snapshots, and alarm
information.
For important person, face match, face not match, unauthorized area access,
and unauthorized time access alarms, you can view the face snapshot and library
information. For unauthorized alarms, you can also click Track Trajectory to redirect to
the Face Search page to view the face trajectory.

e Acknowledge alarm, mark the alarm as a false alarm, or ignore the alarm, and add
handling comments.

e Select user(s) to push the alarm.

e Upload alarm snapshots.

Acknowledge alarm

Click Acknowledge/False Alarm/Ignored next to Result on the Alarm Details page or
select alarm(s) in the alarm list and click Acknowledge to handle alarm.

*Result: Acknowledged Falze Alarm Ignared

[
1]

=)
(]
[14]

Push alarm

For example, when the administrators receive an alarm, they can push the alarm to other
unauthorized users for alarm handling.

340




Operation

Description

Click the selectbox next to Push To in the Alarm Details page or select alarm(s) in the
alarm list and click Push Alarm, and then select the alarm recipient(s).

Push To(1/1)

- Administartor
:_,admin

ﬁl A
PLED Ty

When succeeded, the recipient will receive the corresponding pop-up alarm window.

Alarm Push X
Alarm ) Alarm )
Alarm Time Introducer Operati
Level Type
B Minor  2024-07-04 12:23:32 Face Detec... loadmin =
B Minor  2024-07-04 12:23:28 Face Detec... loadmin =
Alert 2024-07-04 12:19:55 Motion Det... loadmin E\

Do not show again

Export alarm

Select alarm(s) in the alarm list and click Export to export the selected alarm record(s) to
local.

Manual alarm

Click Manual alarm above the alarm list and complete the alarm information.

=Alarm Device: NVR1_4 =Alarm Type: Enter Area

=Alarm Time: xAlarm Level: Major

Linked Image: -
Please add image
(ipg. bmp, png. gif)

After configuration, a manual alarm record will be added to the alarm list.
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26.4.3 Alarm Statistics

View alarm trends and the count of each alarm type by time and device.

e Statistical criteria: Supports statistics by time (by day/week/month) and device (default: all; or click -+ to
select devices within permissions).

e Statistical charts: Includes a trend chart by time and a bar chart of alarm counts by alarm type. Hover the
mouse over the chart to display the alarm count within that time period.

¢ Detailed data: Displays the detailed number of alarms reported.
Figure 26-8: Alarm Statistics-Trend Chart
: Statistics Time: ‘Z Week Month 2025-01-07 ~ 2025-01-07 Devica: Selacted devices:0 Reset

Time Alarm Type

History Alarm

. 1 Trend Chart
Alarm Statistics

25,000

20.000 =

15,000 \\/

10,000 \

\,
5,000 \
0

00:00-00:59 02:00-02:59 04:00-04:59 05:00-06:59 08:00-08:59 10:00-10:59 12:00-12:59 14:00-14:59

| Detailed Data T, Export
No. Time Reported Alarm Count
1 16487
i’
5 857, -
Figure 26-9: Alarm Statistics-By Alarm Type
Statistics Time: Day Week Month ‘ 2025/01 2025/01 Device Selacted devices:0 Statistics Resat
History Alarm
Time Alarm Type
I an
AAlarm Statistics
VCA 4
amera | 21371
Intelligent Analysis 6891
Crowd Density | 4
Radar Monitoring | 4
eneral
Water Level Detection
Alarm Input | 10
System O
Storage |0
Access Control | 0
Host Docking | 0
Vehicle Event |0
Alarm(s)
| Detailed Data T, Export
No. Alarm Type Reported Alarm Count
1 VCA 7319
2 1
s Device
4 410
Radar Monitoring 204 .

For the bar chart, click on the bar to view the specific alarms under that type. For example, the following displays
the subtype statistics for service-related alarms.
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Figure 26-10: Alarm Subtype Statistics
Statistics Time: Day Week 2025/01 ~ 2025/01 Device Selected devices:0 Reset

Time Alarm Type

1 All> vea

Alarm Statistics

Face Match |IEEG_—— 2631 No Work Clothes Detection | <07
Face Not Match [l 25344 No Mask Detection | INEEG_—_—— 207
Intrusion Detection | 11124 No Helmet Detection NN 207

Enter Area | 11091 Elevator Entrance Detection NS 206
Leave Area [ 10195

Smoking Detection | 03
s e o ¥ o9 Fall Detection |EEEG— <04
Quick Moving | 9329 Fume Detection | 203
No Chef Hat Detection | 413 No Reflective Clothing Detecti 401
il b o Refecive Cloting Derection I — 4
Fire Deteton Therman | 413 ong Stay Detection NS
dguesrl il pis Scene Change [N 269
Climbing Detection | 410 Abnormal Audio | 6
Calling Detection | 410 Audio Detection Started |2
Using Mobile Phone Detection | 408 Audio Detection Ended | 2
Absence Detection | 403 Object Left Behind | 1
Alarm(s) Alsrm(s)
| Detailed Data T, Export
No. Alarm Type Reported Alarm Count
1 Face Match 263115
2 Face Not Match 25344
ntrusion Detection 1124
] Emtmr Arms 11na1 v
Go to Page ‘ 1 ‘ 2 || 20/page v | Gota Page

27 System Configuration

27.1 Third-Party Application

You can add third-party applications (webpage or program) to the platform so you can open them on the
platform as a function menu directly.

-+ Add Q Pleas

App Name Type Group Address Remarks Operation

Smart Client Embedded Local App oam {"AbsExeName":"http://en.s= .. £ W

1. Click Add.

Add App X Add App X

*Type (®) Embedded Local App Embedded Webpage

* Type Embedded Local App (8 Embedded Webpage
* App Name Please enter the app name * App Name e
* Group v * Group v
* Program Address enter the program address * Open by 'é' Current Window New Window

Program Parameter Please enter the program parametel *Webpage URL ?

Remarks Pleaze enter the remarks

Remarks e re|
App Icon e e E BB Q taf R App leon +8 8 @B g < || E
B L ma e S H A E D ] maE SR AN
@& 6 sl % @m 2 9 Q& &8 QB ® = 2 Q
o o = B % E 2 Qe = o3& a

2. Choose to add a program or a webpage. For detailed operation descriptions, please refer to the on-screen
instructions.

e Embedded program: Enter the program address and startup parameters. The program (e.g. a client) must
be installed on the local PC.

e Embedded webpage: Enter the URL (e.g. http://www.google.com/). The webpage must be can accessed in
Google Chrome.

3. Click OK. When added, you can view the application in Function Navigation on the homepage.

343



27.2 Platform Cascading

Build a multi-domain networking environment to enable lower-level platforms to share resources with upper-
level platforms.

27.2.1 Private Cascading

Go to Platform Cascading> Private Cascading.

Forward platform data to a certain address via the private protocol (OpenAPlI).

Add Forwarding

1. Click New.
Basic Info Select Device
* Forwarding ...
* Select Time: Valid Permanently
Forwarding Ty... Structured Data Forwarding M... URL
*|P Address: * Port Numbe...
2. Enter the basic information.
Item Parameter
Forwarding name Customize a name as needed.

Forwarding type e Structured data: You need to select a forwarding mode (image/URL).

¢ Device: You need to enter the parent organization ID.

e Alarm

IP address/Port Enter the IP address and port number of the destination side.
number

3. Click Next, and then select device(s) for forwarding.

Add Forwarding x
) (2 )
Basic Info Select Device
* Forwarding ... 1

Unselected Resource
Selected Resource

E Delete
Q
Resource ID Resource Name Operation
192.115.1.162 ~
B 192.115.1.164 B
&R 192.115.1.177 1921151164 192.115.1.164 T
By 192.115.1.179 N
B 192.115.1.245 1921151177 192,115,177 i

® 192.115.1.100_1
W 192.115.1.162_1

“ “ Cance‘
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4. Click OK.

27.2.2 Platform Configuration

Configure the parameters of the local platform for use in platform cascading.

Platform interconnection communication protocol configuration

Log in separately to the local platform, the higher-level platform, and the lower-level platform to configure the
interconnection communication protocol.

Platform interconnection communication protocol configuration

V55

| * Intarconnection ID:
¥ Interconnection User [D:

Confirm

Stop updating shared resource names

Stop updating the name of a shared resource on a lower-level platform

parameters

Description

Platform
interconnection
communication
protocol

VSS

Interconnection ID

The VSS-compliant inter-platform interconnection ID is a 20-digit code, where digits 11
to 13 are "200".

[ Note:

e Inter-platform interconnection IDs using the same inter-platform
communication protocol must not be duplicated.

e After adding an higher- or lower-level platform, if you modify the inter-
platform interconnection ID, the system will prompt you to restart the service.
Please proceed with caution as instructed on the screen.

Interconnection User
ID

It will be automatically generated based on the Interconnection ID.
[ Note:

¢ Interconnection User ID must not be duplicated and must not be the same as
their corresponding platform Interconnection ID.

¢ After adding an external domain, if you modify the Interconnection User ID,
the system will prompt you to restart the service. Please proceed with caution
as instructed on the screen.

Stop updating shared resource names

Click to enable the function. When a lower-level platform modifies a resource name, the change will not be

automatically synchronized to the local platform.
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27.3 Protocol&Interconnection

Configure various protocols to achieve data interconnection between different platforms.

27.3.1 Cloud Service

In WAN scenarios, you can add the platform to EZCloud to manage persons, visitors, access permissions, etc. on
the EZCloud's Web interface.

@ Note:
After successful connection with EZCloud:

* You can add, edit, and delete organizations/devices/channels/rooms linked to video intercom devices on
the platform only.

e You can add, edit, and delete rooms/persons/visitors/access permissions/schedule templates/holidays on
EZCloud only, and you can only view such information on the platform.

Register to Cloud

1. Select Enable to enable EZCloud, and then click Save.

EZCloud (®) Enable Disable
Server Address en.ezcloud.uniview.com
Register Code UGGVC i SNROCX [

Device Status

Device Name

Cloud Account

Team Name

Service Agreement http://en.ezcloud.uniview.com/doc/termsofservice.html
Scan QR Code -
[=] P [m]
r]
-

[=]

2. Log in to EZCloud website: https://en.ezcloud.uniview.com.

Team Mode

mmm'’s Te.

Team Settings

Alarm Parameters >

Team : mmm's Team
Notification >
* Device Name : Please enter keywords
Edge Service Confi... >
* Device Register Code : Please enter keywords

(1) Click Team Mode in the upper-right corner and select UNV Guard Team to enter team mode.

(2) Go to Team Management > Team Settings > Edge Service Config. Enter the platform’s device name and
register code, and then click Save to connect the platform to EZCloud.

[®p Note:
The register code can be found on the EZCloud page on the platform.

(3) After successful connection (device status is online), click Sync Data and select From Device to synchronize
data from the platform.
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Attention:

After successful connection, if you disable EZCloud on the platform, the client will exit and unbind the
platform from EZCloud, and the data will no longer be synced.

27.3.2 OpenAPI

When third-party platforms invoke the OpenAPI interface of the platform, they need AppKey information of the
platform for authentication.

@ Note:

Supported interface authentication methods:
e Access Token + Username/Password

e Access Token + ApplID/SecretKey

e Interface Signature + Username/Password

e Interface Signature + ApplD/SecretKey

nvoke the CpenAPl interface of this platform, they must use the following

AppKey {(®) Enable Close
ApplD 1443079168824111
SecretKey 1747959719591813730058617475997198
Access Token ® 01567854396575072572
Walid Until 2025-05-25 18:46:35

Rese

AppKey ¢ Enable: Requires authentication via key. When enabled, the following information will

be generated automatically.
e ApplD: Remains permanently valid if not updated.
e SecretKey: Remains permanently valid if not updated.

e Access Token: Used to verify interface access or invocation permissions, valid only
for 48 hours.

¢ Disable: Does not require key authentication.

Copy Info Click the corresponding [C| to copy the AppID, SecertKey, and Access Token for third-party
platform use.

Reset Info Click Reset to geneate new ApplD, SecretKey, and Access Token.

[ Note:

When you reset or disable the AppKey:

¢ If the previous Token is still valid, this operation will only invalidate the old AppID and SecretKey. The old
Token is still valid.

¢ If the previous Token has expired, this operation will invalidate all.

27.4 Service Configuration

Configure services globally.
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27.4.1 Holiday Management

Set public holidays or specified days as holiday. Holiday has higher priority than weekly schedule and attendance
rules.

¢ Scene 1: During holidays, access control permissions are executed based on the holiday schedule.

@ Note:
After adding holidays on this page, you need to configure the holiday Schedule Template and associate it
with access control devices in Access Permission Config.

e Scene 2: Absence in holidays does not record as attendance exceptions.
For example, attendance rules require attendance during 9:00-17:00 from Monday to Friday. If New Year’s
Day is set as holiday, then holiday attendance rules are applied on New Year’s Day.

Note:
After adding holidays on this page, you also need to configure the Holiday Adjustment rules.

Add Holiday
1. Click Add.

Add ot

*Holiday Mame:
= Start Date: Start Date - End Date

Repeat by Year

2. Enter the holiday name and set the holiday period. The holiday name must be unique.
3. (Optional) If Repeat By Year is selected, the holiday will repeat every year.
4. Click OK.

More Operations

You can edit and delete holidays.
+ Ada [ Delete

Holiday Name § Holiday Period Days Repeat by Vear 3

New Year's Day 01/01 - 01/03 3 Yes & W
® Edit: Click /~ in the Operation column.

* Delete: Select the holidays to be deleted and click Delete, or click [iij in the Operation column.

27.4.2 Email

Configure SMPT server settings, sender email information, etc. When configured, you can use the email sending
function in functions such as alarm linkage.

27.4.2.1 Email Server

Configure the mail server, sender email address, and other related information.
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“Server Authentication l Enable D

*Username

*Paszword

*SMTP Server

* Encryption Type (@)

*SMTP Port

*Sender Address

" Recipient Address 1

Recipient Address 2

Recipient Address 3

Save

o
%)
o
i

Off S5l STARTTLS

Parameter

Description

Server Authentication

e Enable SMTP server authentication: Requires verification of the sender's username
and password to prevent unauthorized use.

e Disable SMTP server authentication: No need to fill in the sender's username and
password; any service can send messages through this server.

[ Note:
Authentication must be enabled if sending emails via public networks, cloud
services, or third-party email providers.

Username/Password

After enabling SMTP server authentication, you need to enter the username and
password of the sender's email account.

[ Note:
The password entered here is the authorization code provided by the SMTP
service, not the email account's login password.

SMTP Server

Enter the address of the SMTP server.

Encryption Type

When SSL/STARTTLS is enabled, the data between the platform and the SMTP server is
encrypted, protecting email content from interception.

SMTP Port

Enter the port number of the SMTP server.

[ Note:
The SMTP port corresponds to the encryption type.

e No Encryption: Port 25 or Port 587(Note: Port 25 is typically used for server-to-
server communication and may be restricted for client use on some networks).

e SSL Encryption: Port 465.
e STARTTLS Encryption: Port 587.

Sender Address

Enter the sender's email address. The system emails will be sent from this address.

Recipient Address

Enter the recipient's email address. Click < to test if emails can be sent successfully.
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27.4.2.2 Contacts

Configure email address information.

Name Email Address Remarks
+ Add

Name + Email Address 5 Remarks 5 Operation

Andrew

2 W
pavid 2 W
Michael 2 W
Add Contact
1. Click Add, then enter the contact's name and email address.
Add X

*Mame Please enter

*Email Address | Flease enter

Remarks Dleaca o

2. (Optional) Click =] to send a test email to the corresponding address and verify if the email sending function
is working properly.

Note:
The Email Server must be configured before sending test emails.

3. Click OK to save the configuration.

Send Test Email
Supports sending test emails one by one or in batches.
* Send one by one: Click [=] in the Operation column to send a test email to the corresponding address.

¢ Send in batches: Select multiple contacts and click the Send Test Email button above to send test emails to
the selected addresses in batches.

More Operations
e Search: Quickly search address book information by contact name, email address, or remarks.
* Edit: Click /# in the Operation column to modify contact information.

e Delete: Select the contact(s) and click the Delete button above, or click ] in the Operation column.

27.4.3 Temperature

Choose a temperature unit as needed. The temperature unit on pages such as Face Search will use the one
specified here.
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*Temperaturs Unit  (®) Celsius (°C) Fahrenheit (°F)

27.4.4 Data Sync Configuration

System Config > Security > Data Sync Configuration

You may synchronize personnel authentication records from the platform to a third-party database for direct use

in a third-party attendance system.

1. Enable Data Sync.
Data Sync: ° ® Enable Disable
Access Control Device (Required)

evice Name % Channel Name 2 Device Type 2 Organization % Operation

gnition Terminal oot

21 2.11 #T13111_AC1
2

245 245 AC_I gnition Terminal oot m

Total 2 20/page Goto | 1
Sync Authentication Failure Records:

, ©

Retry If Sync Fails:

2. Select access control device(s) and synchronize personnel authentication records to the third-party platform.

Click Add, select access control device(s), and click OK.

3. Configure handling measures for the abnormal data.

¢ Sync Authentication Failure Records: When enabled, authentication failure records will also be synced to

the third-party platform; otherwise, they will not be synced.

e Retry If Sync Fails: When enabled, if data synchronization fails, the system will automatically synchronizes

the failed data again every hour; otherwise, the data will not be synchronized again.

4. Configure the third-party server and database information, including the database type (PostgreSQL, MySQL,

SQL Server), data encoding format, server IP/domain name, database name, and database username/
password.

Once completed, click Test Connection to test if the connection with the database is successful.

Database Info

Database Type: MySQL

Data Encoding Format utf-3
*Server [P/Domain Mame 217.2.2.706
*Server Port: S5
*Database Name: K

*Username: root o

*Dassword: sassanss Test Connection| @ The database is connected

5. Enter the name of the third-party database table where the data will be synchronized to.
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Table Field

*Third-party Database Table Name: person o

6. Enter the third-party database field name that corresponds to the platform data type and select the field
format.
Please complete the information according to the third-party database table.
For example: If the third-party database field for “Access Data&Time” is “ac_data_time” with the format
“yyyy-MM-DDTHH:mm:ss”, the platform’s access data&time data will be synced to this field in the set format.

*Person ID id o
*Access Date&Time: ac_date_time yyyy-MM-ddTHH:mm:ss
* Access Date: ac_date yyyy-Mi-dd
*Access Time: ac_time HH:mm:ss
Authentication Result Succeeded:
Failed
Authentication Type: 1A
Device Name:

Device Serial No.:
Channel Name:
Person Nare:
Department Name:

Card Number. k

0
7. Click Save.

27.4.5 Video Intercom

Configure the ringtone duration (40s~60s) for the video intercom. The system will end the call when it is not
connected within the set duration.

*Ringtone Duration: 40  Second(s)
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27.4.6 Face Sync

l Face Sync

*Sync Type  (®) Sync Features Only Sync Images&Features

I Face Enrollment
* Face Image Verification ()

Face Sync Type

When using the access control verification function, face images and features should be synced to access control
devices for verifying the matching degree between the captured person and people in the library.

Set the sync type for face information to be synced to face recognition terminals when configuring Permission
Group.

¢ Sync Features Only: It will not sync face images to the access control device. Even if verification succeeded,
there won’t be any face image on the access control device.

¢ Sync Images&Features: It will sync face images to the access control device so that the corresponding face
image will be displayed on it when the verification succeeded.

@ Note:

Some access control devices do not support direct sync of face features from the platform. So you need to
manually sync face images to these devices, and they will then extract the face features themselves.

Face Image Verification
Set whether to verify image quality when adding face images to personnel/visitor/resident info and face libraries.

e On: Only face images meeting the requirements can be added.

e Off: The system does not verify image quality, allowing low-quality images and images partially obscured.

27.4.7 Time Configuration

Configure time information for the platform, including time zone, date and time format, and system time.

Time Zone (UTC+08:00) China, Singapore, Malaysia -
System Time 2025-08-15 18:35:26 = Sync with Computer Time
Date Format YYYY-MM-DD -
Time Format 24-hour v

Auto Update Enable {®) Disable
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¢ Sync with Computer Time: When selected, the platform's system time syncs with the PC time.

e Auto Update: When enabled, an NTP server needs to be configured. Once configured, the platform's system
time syncs with the NTP server time.

27.4.8 Auto Time Sync

Use the current time of the computer as a reference to adjust the time on the device and keep it synchronized
with the computer time.

Enable Auto Time Sync and set the synchronization interval. The system automatically synchronizes the time once
when the function is enabled, and then continues to synchronize the time regularly at the set time interval.

Auto Time Sync: ®) Enable Disable

Interval: 8hour(s) -

27.4.9 Alarm Input/Output Config

Configure alarm input and output types for the server.
@ Note: For example, the server is connected to an external warning light:
e If the alarm type is N.O., when an alarm occurs, the state is closed, and the warning light lights up.

e Ifthe alarm type is N.C., when an alarm occurs, the state is open, and the warning light goes off.

1. Go to Alarm Input/Output Config.

< Alarm Input/Output Config

&8 Batch Config All - Please enter the content
Channel Name % Device B Device ID 3 Organization Channel Type % Status 3 Marm Type % Operation
[ N@... 3-IN 1 -IN Alarm Input Channel ® Online N.O. 2
5-IN@... 3-IN 10 -IN Alarm Input Channel ® Online N.O. 2
IN@... -IN 11 -IN Alarm Input Channel ® Online N.O. 2
B-IN@... -IN 12 [ -IN Alarm Input Channel ® Online N.O. 2
-IN@... GA80-H15-IN 13 3-IN Alarm Input Channel ® Online N.O. 2
-IN@... -IN 14 -IN Alarm Input Channel ® Online N.O. 2

2. 2. Click the corresponding // for the alarm channel, or click Batch Configure, modify the alarm type. After
the modification, you need to select Enable Alarm Input Channel for the changes to take effect.

Figure 27-1: Configure One by One

Edit Alarm Input Channel *

*Channel Name - E N@R_I_1

Alarm Type MN.O. v

Enable Alarm Input Channel
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Figure 27-2: Configure in Batches

Edit Alarm Input Channel X

* Alarm Channel T
pe Alarm Input Channel v
Alarm Type N.O, M Enable Alarm Input Channel

Select Alarm Input Channel

% @R_I_10
T @R_I_11
T @R__12
T @R__13
@R7

@R8

@R_1_14

@R_1_15

L A B B ¢

@R_I_16

27.4.10 Card Attribute

This function supports the customization of snapshot information and structured attributes displayed on
pedestrian/face/motor vehicle/non-motor vehicle snapshots on the Smart Live View page and Comprehensive
Search page.

¢ By default, all card attributes are displayed on the card.

e Only the selected attributes will be displayed on the card. To conceal an attribute, deselect it. A preview of
the card can be viewed on the right side.

| Pedestrian Pedestrian Related
Pedestrian
Face Related
Attribute Config Card Preview Face
Face Recognition
Snapsh... Snapsh... Gender J Age Upper J % Gender A
§ nge Motor Vehicle Related
€ Upper Go.. Motor Vehicle
[0 LowerGar..

& Shoes Vehicle Application
Non-Motor Vehicle Related

Non-Mator Vehicle

| face
Attribute Config Card Preview
Snapsh... Snapsh.. ‘ Age J ‘ Gender‘J ‘ Glassss.‘.‘J 8 Age
9 Gender
=D Mask
-
Body Temperature
I Face Recaanition
Item Description
Pedestrian Attributes displayed on cards in Smart Live View > Pedestrian Snapshot, Multi-
Target Detection > Pedestrian Snapshot, and Pedestrian Search > By Attribute.
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Item

Description

Face

Attributes displayed on cards in Smart Live View > Face Snapshot, Multi-Target
Detection > Face Snapshot, and Face Search >By Attribute.

Face Recognition

Face match/not match attributes displayed on cards in Smart Live View > Face
Comparison, Face Recognition, and Face Search > By Alarm.

Search by Image

Face library and people pass-thru record attributes displayed on cards in Face
Search > Search by Image.

Motor Vehicle

Attributes displayed on cards in Smart Live View > Motor Vehicle Snapshot,
Multi-Target Detection > Motor Vehicle Snapshot, and Motor Vehicle Search > By
Attribute.

Vehicle Application

Vehicle match/not match and violation attributes displayed on cards in Smart Live
View > Vehicle Comparison and Vehicle Application.

Non-Motor Vehicle

Attributes displayed on cards in Smart Live View > Non-Motor Vehicle Snapshot,
Multi-Target Detection > Non-Motor Vehicle Snapshot, and Non-Motor Vehicle
Search > By Attribute.

27.5 Network Management

27.5.1 Network Configuration

27.5.1.1 TCP/IP

Set TCP/IP parameters in different working modes, including IP obtainment (static or DHCP), IP address, subnet
mask, default gateway, MTU, preferred and alternate DNS server, and default route.

Working Mode
Select NIC
DHCP

*IPw4 Address

*IPw4 Subnet Mask

*IPv4 Default Gateway
MAC Address

MU
Cannection Status
Ratz
Preferrad DNS Server
Alternate DNS Server

Default Route

@ Note:

Multi-address

NIC1

88:26:3f:26:df:24
1500
100M Full-Duplex
114 114 114 114
8 . 8 . 8 . 8

NIC1

e The configured IPv4 addresses of the NICs must belong to different network segments.

e After the Working Mode/NIC/DHCP/IP address is modified: (1) The system will refresh its configuration
and return to the login page. It will be ready to log in within 5-10 minutes. Do not restart or power off the
device during this time. (2) Custom routes will be cleared.

Working Mode

Multi-address: Default mode. The Network Interface Cards (NICs) work
independently with different IP addresses.

Load Balance: NICs that make up a virtual NIC use the same IP and work together to
share the network load.
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¢ Net Fault-tolerance: NICs that make up a virtual NIC use the same IP and work as a
backup to each other. If either NIC becomes faulty, the other takes over.

DHCP

Use a DHCP server to automatically assign an IP address.

IPv4 Address

Server' IP address. Users access the system at this address from a Web or software
client.

Connection Status

The connection status of the selected NIC. The status is "Online" when the network port
has a cable connected and the connection is active.

DNS Server

Domain Name Server, which resolves a domain name into an IP address.

Default Route

Specifies the default NIC that the server uses to send data. The default route may be
different from the NIC set in the Select NIC drop-down list.

27.5.1.2 Port

Configure HTTP, HTTPS, RTSP and alarm ports.

HTTP Port

HTTPS Port

RTSP Port

Alarm Port

20

443

27.5.1.3 Custom Route

Add static routes to interconnect the platform with destination networks. Up to 100 custom routes are allowed.

You need to choose the NIC and set the subnet ID, subnet mask and gateway. A custom route is enabled by
default and can be disabled.

Add

Status:

MIC:

“Subnet ID:
*Subnet Mask:

*Gateway:

@ Note:

o On Off
NIC1

192.168.2.33
255.0.0.0

192.168.2.1

Changing the NIC's working mode will clear all the existing custom routes.
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27.5.2 Security Configuration
27.5.2.1 HTTPS

Go to Network Management > Security Config > HTTPS.

HTTPS is a secure communication method that enhances the data transmission security via mechanisms such as
data encryption and identity verification.

HTTPS only allows encrypted communication using the more secure TLS 1.2 or higher protocol versions. Modern
browsers enable support for the latest TLS versions by default, eliminating the need for manual configuration by
the user, automatically ensuring the best security and compatibility.

When enabled, you can log in to the platform or integrate with third-party systems securely via the HTTPS
protocol.

To enable HTTPS, you must first activate a digital certificate, which is generally issued by a Certificate Authority
(CA) to verify the identity of an entity, such as a website, server, or user. When a user tries to access a webpage
secured by HTTPS, the server presents its digital certificate to the user's browser. The browser verifies the
certificate's validity and authenticity. If normal, an encrypted communication channel is established between
them.

Certificate Management

Choose a method to import and activate the certificate.

Method Description
Import Certificate If you already have a certificate (either official or private), you can import it
directly.
Note: Please import a certificate and activate it before enabling HTTPS.

HTTPS

I Certificate Management

Certificate Management (® Import Certificate Certificate Request Private Certificate (2)

Import Certificate

ote: Please upload a .pem file or both a key and a .crt file

& example.crt (]
& serverke 0]
Certificate Info
example.crt
Issued To IP=127.0.0.1.C=CN
Issued By IP=127.0.0.1.C=CN
Valid Period 2024-11-22T10:08:35Z~2034-11-22T10:08:352

1. Select Import Certificate for Certificate Management.
2. Click Upload Certificate File to upload the certificate file from local.

[E> Note:
Two types of certificate formats are supported:

o key file + .crt file: The .key file is the private key generated by the
certificate holder, and the .crt file is the certificate generated by the
CA.

e .pem file: Packages the .key file and the .crt file into one.
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Method

Description

3. Click Activate Certificate.

Certificate Request

If you do not have a certificate, you can submit a request file to request an
official certificate from the CA.

Note: Please import a certificate and activate it before enabling HTTPS,
HTTPS

I Certificate Management

Certificate Management mport Certificate t Certificate Request Private Certificate @

Create Certificate Request

[¢
E

Certificate Request Info

SETVEr.csr
Property IP=127.0.0.1,C=CN
'Q Please download the certificate request file first Once being

authenticated by the certificate authority, you will get the certificate file.

Impeort Certificate Upload Certificate File

Certificate Info
Please upload the certificate file first

1. Select Certificate Request for Certificate Management.

2. Create a certificate request file.
Click Create Request File. Enter the device information, organization
information, and the email address to receive the certificate. After
confirmation, the system will generate a certificate request file (server.csr),

which can be downloaded locally.
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Method

Description

Create Certificate Request X

Country Example

i)
i1}
i)

Hostname/IP Pleas

M
i
o

Password Pleas

i)
i1}
i)

Province/State Pleas

i)
i1}
i)

Region Pleas

i)
i1}
i)

Crganization Pleas

Company Please ente

E-mai Please ente

(]
o
“
i)

3. Submit the certificate request file to the CA to request a certificate.
4. Click Upload Certificate File to upload the certificate file from local.
[E> Note:

e Only the certificate (.crt format) generated from the above request
can be uploaded. Inconsistent data will fail the upload.

e When creating a certificate request, a .key file is generated in the
background, which will be automatically verified by the system.
Therefore, you don't need to upload a .key file.

5. Click Activate Certificate.

Private Certificate

A private certificate is created by the software developer for testing purposes or
internal network use and is not trusted on the Internet.
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Method Description

Note: Please import a certificate and activate it before enabling HTTPS.
HTTPS

I Certificate Management

Certificate Management mpert Certificate Certificate Request C Private Certificate @

Create Certificate

=]

P
& server.crt

Certificate Info
server.crt

Issued To IP=127.0.0.1,C=CN
Issued By IP=127.0.0.1,C=CN
Valid Period 2025-04-21T06:39:06Z ~2035-04-21T06:39:067

1. Select Private Certificate for Certificate Management.

2. Create a private protocol.
Click Create Private Certificate. Enter the device information, organization
information, and the validity period. After confirmation, the system will
generate a private certificate file (server.crt).

3. Click Activate Certificate.

Once the certificate is activated, you can:

¢ Download Certificate: Click Download Certificate to download the certificate file (server.pem) locally. The
downloaded certificate can be imported directly.

* Delete Certificate: Click 7ii for an imported certificate file to delete the certificate.

Note:
Once deleted, the webpage will return to a status without a certificate, and the HTTPS function will be
automatically disabled.

Enable HTTPS

Once the certificate is activated, please enable HTTPS manually. Then, the system will return to the login page.

Please log in again using the HTTPS protocol.
e For B/S client: Visit https://server IP address using a browser.

e For C/S client: Select HTTPS as the protocol on login page.

27.5.3 Network Security
27.5.3.1 SSH

After enabling SSH, you can login to the platform via SSH on port 23333.
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*55H Enable (@) Disable

@ Note:

e SSHis disabled by default.
e SSH will automatically disable after remaining enabled for 30 minutes.

e Service restarts will cause SSH to shut down automatically.

27.5.3.2 802.1x

Enable 802.1x to control access to the device with username and password set in the network switch.
[ Note:
802.1x must also be properly configured on the authenticator (such as Ethernet switch).
Select MIC MNICT -

802.1x (®) Enable Disable

Protocol Type

EAPOL Version 1 v

Username admin

Password aEssmsssssamsEEE

Select NIC You may select an NIC to enable 802.1x;
Authentication is independent among NICs.
Binding 1 and Binding 2 are displayed if the working mode of the selected NIC is
Load Balance or Net Fault-tolerance.

Protocol Type Currently only EAP-MD5.

EAPOL Version 1 for 802.1x-2001, and 2 for 802.1x-2004.

Username and password Used for authentication. Authentication succeeds when the entered username and
password match that on the authenticator (such as Ethernet switch).

27.5.3.3 ARP Protection

By binding the platform's gateway IP address to the gateway's MAC address, it prevents network interruptions,
data leaks, and other hazards caused by malicious tampering with the gateway's MAC address.

Select Obtain Automatically to obtain an MAC address automatically, or fill in an MAC address manually.
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Select NIC NICT v

ARP Protection (® Enable Dizable
Gateway
Gateway MAC Address 00:00:00:00:00:00 Obtain Automatically

Warning: Using the automatically obtained MAC address may pose a security risk.

Note:
ARP protection is effective only when it is enabled and configured before an ARP attack occurs. Protection
may fail if you edit the gateway MAC address during an attack.

27.5.3.4 IP Address Filtering

Use blocklist/allowlist to forbid or allow login from certain IP addresses only.

IP Address Filtering |/ Close (@) Blocklist Allowist
Blocklist Filtering Note: P addresses within the configured ranges will be filtered.
—+ Add T Delete
Start IP End IP Operation
192,168, 1 . 15 192, 168, 1 . 20 ]

e Blocklist: When enabled, login from the specified IP addresses is forbidden.

¢ Allowlist: When enabled, login only from the specified IP addresses are allowed.

@ Note:

¢ Blocklist and Allowlist cannot be enabled at the same time.
e Blocklist/allowlist is effective to IP-based logins.

¢ You can click a field in the list to edit an IP address.

27.6 Cluster Management
27.6.1 Primary/Replica Management

When a single server cannot meet the required storage bandwidth, forwarding bandwidth, or access capacity,
adding replica servers can expand system management, storage, and forwarding capabilities.

In primary/replica mode, one server acts as the primary server, provides user management, storage, and
forwarding functions, while the other servers act as the replica servers, providing only storage and forwarding
capabilities. The primary and replica servers must be deployed within the same LAN.

Attention:
In primary/replica mode, the primary server’s performance is halved. If more than 3 replica servers are
configured, the primary server is used only for management purposes.
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— Media Data Stream (Live View & Playback)

—  Data Forwarding Stream ~
wa —_—
[ ]

”
Management Client
Replica Server

Primary Server Vidoo Wal
®

Management Client

Replica Server

Video Wall
Video Wall Controller

27.6.1.1 Configure Primary/Replica

Go to the Cluster Config page to configure the primary/replica mode.

Configure Primary Server

Log in to the primary server, select Primary and enter the primary server name. Click Save.

*Current Role {(®) Primary Replica

*Mame

Note:
The device name can be customized, but if hot standby is to be enabled, it must match the actual host name.

Configure Replica Server

@ Note:

¢ Please login to the replica server (input the IP address of the primary server after switching to the replica
server).

e The hardware, version, and model of the primary and replica servers need to be the same.

¢ When switching between primary and replica servers, the service will restart, all data will be cleared, and
the password will be restored to the default.

e There is a maximum number of replica servers that can be supported. Once the limit is reached, no more
replica servers are allowed.

e After the configuration is completed, clients will not be able to log in to the replica server, and users
cannot recover the server on the web page.

1. Login to the replica server, select Replica and enter the primary server's IP address.
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*Current Role Primary (®) Replica

*MName

*Primary IP

*Replica Ser... Device connection, alarm receiving, media forwarding, image and recording storage.

2. Click Save. After switching, the replica server's status is Online.

27.6.1.2 Primary/Replica Status

View replica server's information and status.

@, Cluster Config

Name P Address Type Status
Primary/Replica Status primary 127.00.1 Primary o Online

replica 10.185.21.32 Replica ® Offline

27.6.2 Dual-Server Hot Standby

Dual-server hot standby is to configure a secondary server for the primary server to back up its working

data, ensuring high system availability. The primary server regularly sends heartbeat detection packets to the
secondary server. If the primary server fails, the secondary server automatically switches to operational mode to
ensure uninterrupted user services.

During video playback, the system will simultaneously query recordings from both the primary and secondary
servers.

The primary and secondary servers must be deployed within the same LAN and connected via NIC 2 to transmit
system configuration data. The actual application descriptions are as follows:

1. When the primary server is functioning normally, the secondary server monitors the heartbeat of the primary
server.

<

Servicesy
E

»

Heartbeat Detection

Primary Server Secondary Server

2. If the primary server fails and the secondary server does not detect a heartbeat within 10 seconds, the
secondary server automatically switches to operational mode.
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~-

N\, Services

3

Primary Server Secondary Server

3. When the primary server comes back online, it will be use as the secondary server.

27.6.2.1 Hot Standby Configuration

Go to the Cluster Configuration page and configure the hot standby mode.

Prerequisites

The primary and standby servers must have identical hardware, software version, model, and network
interface cards (NICs).

The primary and standby servers must be on the same network segment. If they are deployed across different
segments, the switch must be configured with NQA (Network Quality Analysis).

The primary and standby servers must have identical root passwords, subnet masks, and gateways.
The names of the primary and standby servers must be different from each other and cannot be "localhost".

The primary and standby servers must be running normally, with no power or network interruptions during
configuration.

Configure Hot Standby

@ Note:

e Perform hot standby configuration on the primary server.

¢ When the primary server has replicas attached and hot standby is enabled, to ensure normal primary-
replica connectivity, you must change the primary server's IP to the virtual IP in the replica’s backend.
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* Current Role

*Mame

*Enable Hot ...

*Secondary ...

*Primary 1P

*Secondary ...

*Virtual IP

*root Passwo...

* Subnet Mask

* Gateway

(®) Primary Replica
ZhC208
(®) Enable Disable
w5209
172 . 20 . 135 . 208
172 . 20 . 135 . 209
172 . 20 ., 135 . 28
255 . 255 |, 255 0
172 . 20 . 135 | 1

Log in to the primary server page, select Primary, and select Enable for hot standby.
Configure the settings as described below.

Name

The actual hostname of the primary
server. You can log in to the local
server backend and run the hostname
command to check it.

Secondary Name

The actual hostname of the standby
server. You can log in to the standby
server backend and run the hostname
command to check it.

(D Attention:

¢ The hostnames of the primary
and standby servers must be
different from each other and
cannot be "localhost".

¢ To change the hostnames of the
primary and standby servers, log
in to the server backend and run
the command: hostnamectl set-
hostname <new hostname>.

Primary IP

IPv4 address of the primary server (see TCP/IP).

Secondary IP

IPv4 address of the standby server (see TCP/IP).

Virtual IP

Select an unused IP address in the network. After completing the primary-standby
configuration, you can use this virtual IP address to log in to the client.

root Password

root password for the primary/standby servers (must be identical in a dual-server).

Subnet Mask

Subnet mask for the primary/standby servers (must be identical in a dual-server).

Gateway

Gateway for the primary/standby servers (must be identical in a dual-server).

Business Network

eth0:0.

Business network interface for the primary/standby servers (must be the same in a
dual-server setup), formatted as "interface:0" , "0" is a fixed suffix— for example,
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After completing the configuration, click Save. The system will sync the settings, and the services on both the
primary and standby servers will restart, making the web interface temporarily unavailable.

Access http://standby server IP:9820, log in to the High Availability software interface (default username/
password: admin/admin), and view the dual-server information.

¢ The primary/standby server names, IP addresses, and virtual IP cannot be modified;

e The root password, business network interface, subnet mask, and gateway IP can be modified.

€3 High Availa High Availability Service Version:
! Ftw ty N
[ Senvice Status % Software type:
b Software patches: No patches available
- Confirm the dual-machine setup. Installation will start after verification -
* Primary Name: 17203 * Standby Name: 209
* Primary MachinelP:  172.20.135.208 *Standby MachinelP:  17220.135.209
* VirtuallP 1722013528 *VirtuallP: 1722013528
* RootPassword uniview_123 * RootPassword: uniview_123
* Business Network:  eth0:0 * Business Network:  ath0:0
* Subnet Mask: 255.255.255.0 * Subnet Mask: 255.255.255.0
* GatewaylP: 172201351 * GatewaylP 172201351
Information Correct,Confirm Installation

After confirming that all information is correct, click Information Correct, Confirm Installation to start
installing the dual-server software on the primary and standby servers.
@] High Availabili... High Availability Service Version:

[ED  Service Status.

After installation is complete, click Cluster Running at the top of the interface to start the cluster service.
The hot standby environment is now ready, and you can access the system by navigating to http://virtual IP

address to log in and manage services.
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@3 High Availabili...

[ED  Service Status

High Availability Service Version:

Service type:
4 Software type:

=
- Software patches

Refresh | Cluster Running

-

Primary Name: 208

Primary MachinelP: 172.20.135.208

Virtual P:

Network status Normal

High Availability ... :

Platform softwar.

No patches available

Unload

Standby MachinelP: 172.20.135.209

VirtuallP:

Network status: ~ Normal

High Availability .. :

Platform softwar... :

Switch 1o single-node mode Switch to single-node mode

Note:

In the high-availability software interface, the primary/standby relationship is determined by the roles
assigned during configuration. Even if services fail over to the standby server, their roles will not be
swapped. You can view the currently active server from the Platform Software Running Status.

Hot Standby Service Management
In the High Availability software interface, you can click the buttons to perform the following operations:

¢ Cluster Running/Cluster Stopping: Starts or stops the cluster service. Once stopped, the hot standby
environment becomes unavailable.

¢ Cluster Restart : Restarts the cluster service.
¢ Refresh: Refresh the cluster status.
* Primary Server-Stop Running : Stops the primary server service, triggering a failover to the standby server.

¢ Standby Server-Stop Running: Stops the standby server service. This does not affect the primary server's
operation, but if the primary server fails, services cannot fail over to the standby server.

e Primary Server(Standby Server)-Switch to Single-node Mode: The primary server is unlinked from the
standby server, and the standby service is stopped. This does not affect the primary server's operation. The
primary server remains accessible via either its physical IP or the virtual IP (since device registration is bound
to the virtual IP). However, if the primary server fails, services cannot fail over to the standby server.

[ Note:
e This operation can not be performed on both the primary and standby servers simultaneously.

¢ Switching to standalone mode does not uninstall the High Availability software; you can later click
Cluster Running to restore the dual-server hot standby configuration.

e After switching, storage must be reconfigured, and historical stored data will be lost!

¢ Unload the high-availability software will result in data loss. Please contact technical support—do not
perform this operation on your own!

27.7 Disk Configuration

The server can utilize either local disk or network disk for resource storage.

e Local disk: The hard disks of the server, used for image storage, recording storage, recording backup and hot
spare.

e Network disk: External Uniview IPSAN, used solely for recording storage and recording backup.

After configuring the hard disk, please refer to Video Storage Configuration to configure video storage services.
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27.7.1 Local Disk

View the installed hard disks, configure disk usage and create RAIDs.

Once the configuration is done, the system will automatically create corresponding storage space for the
specified use.

@ Note:

¢ To ensure normal storage, it is strongly recommended to install hard disks in slots 1/2/3 of the server,
and the system automatically configures the hard disk usage: Slot 1 — Image storage, Slot 2 — Recording
storage, Slot 3 —Backup recording storage.

e The hard disks are hot-swappable, so you can continue using the existing storage after replacing a hard
disk.

¢ If a new hard disk replaces the old one, data on the old disk becomes inaccessible. If the hard disk is
removed and reinserted, its data remains accessible.

27.7.1.1 Disk Resource

On the Disk Resource page, the left side lists the hard disks of the server, including the disk status, total capacity,
and usage of each disk slot, and you can click the column header to sort the contents; on the right side, the hard
disks and RAID resources are displayed separately by their respective usages.

Server
Local Disk

Storage Resource () Usage Configuration (7)

] Network Disk

Disk Resource(16) RAID Resource(0)

M General(7452G) + M Recording Storage(3726G) n -
% Configure Usage ~+ Create RAID [ Refresh Locsl DiskeSIon Local DiskeSiots
. . . - . - =0 7526 &9 37266

Disk Name = Status 2 otal (G.. & Operation

Local Disk-Slot1 ® Normal

Local Disk-Slot5 ® Normal

Local Disk-Sloté ® Normal 931

Local Disk-SlotT ® Normal 931

Local Disk-Slot9 ® Normal 14902

Local Disk-Slot1C @ Normal 931

Local Disk-Slot2. ® Offline 1] .

Local Disk-Slot3 ® Offline 0 - D

Local Disk-Slotd. ® Offline ] - X

Local Disk-Slots @ Offiine Re—m:‘mg Sreep®® + ¥ Hot Spare(0G) -

Local Disk-Slot11 @ Offline

Local Disk-Slot12 @ Offline
Disk Status
Disk Status Description
Normal A hard disk is inserted in the slot and functioning properly.
Abnormal A hard disk is inserted in the slot but has read/write errors.
Offline No hard disk is inserted in the slot.

Partition does not meet
config requirements

After deleting an RAID including an offline disk, when the offline disk comes
back online, it still retains the old RAID and partition information, and this status
will be displayed.

To resolve this issue, click i}y in the Operation column to clear the RAID and
partition information (this will also erase all data on the disk). The disk can then
be used normally.

Set Disk Usage

Disk Usage

Description

General

Used to store images.

Recording Storage

Used to store recordings.
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Disk Usage Description

Recording Backup Used to store backup recordings.

Hot Spare Once a disk is set as a hot spare, the RAID will automatically select the hot spare
disk to replace any damaged disk during automatic rebuilding to ensure normal
operation.

Failover Backup When the primary server goes down, its video recording storage service will
migrate to the Failover Backup resource on the standby server.

[®> Note:
This usage is supported only in the standby server in a primary-standby
mode.

Two methods for configuring hard disk usages:

[®p Note:
e Only hard disks with capacity greater than or equal to 512GB and in normal status can be configured with
usage.

e Each hard disk can only be configured with one usage.

e The system automatically initializes the usage for slots 1/2/3 (slot 1-image storage, slot 2-recoding
storage, slot 3-recording backup storage). The usage for slot 1 is unmodifiable; the usage for slot 2 and 3

is modifiable.
Method 1 1. Inthe disk list, select a disk in normal status but without usage configured, click
Configure Usage.
2. Select the usage in the pop-up window, and then click OK.
Disk Resource(16) RAID Resource(0)
Configure Usage Create RAID (™ Refresh
q g
[ Disk Name = tus = Total (G.. ¥ Usage = Op
Local Disk-5lotl o MNoMlal 7452 M Ceneral
Local Disk- Slg)tns i)
Local Disk-£
:. The disk in slot1 can only be set to genaral usage
Local Disk-£
*Selected Storage Res... | Local Disk-Slot5 X v
Estimated Capacity 3726 GB
*|Usage General -
Method 2 1. Click -+ on the right side
2. Select the disk in the pop-up window, and then click OK.
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B Recording Backup(0G)

Normal

Disk Resource(4) RAID Resource(0)
[ Disk Name = Status = Total (GB) =
Local Disk-Slots e MNormal 931
Local Disk-5lot7 ® Normal 931
Local Disk-5lot9 & Normal 14902
Local Disk-5lot10 ® Normal 931

Clear Disk Usage

To modify disk usage, you must clear the disks/RAIDs of that usage and reconfigure.

@ Attention:
After clearing a usage, all disks/RAIDs configured with this usage will be reset to "no usage," and all data on
the resources will be erased -- affecting the existing storage services.
Note: The default usage of slot 1 cannot be modified (it remains General), but its data will still be cleared.

B General(7452G)

Normal

+ | £

Local Disk-5lot1
7452G

Clearing the usage will reset the usage of all

A associated resources, erase all data within them, and

affect the existing storage services. Continue?

27.7.1.2 RAID Resource

A RAID refers to combining multiple hard disks to work together to achieve higher performance, larger storage
capacity, or enhanced data redundancy and fault tolerance.

Type Requirement Description
RAIDO Number of hard disks: | e Feature: Striping Data is split into blocks and distributed across
2-8 multiple disks.

¢ Advantage: Delivers the highest read/write performance. Total
storage capacity = N x (capacity of the smallest disk).
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Type Requirement Description

¢ Disadvantage: No redundancy. A single disk failure will cause
complete data loss across the array.

RAID1 Number of hard disks: 2 | ¢ Feature: Mirroring - Data is duplicated across two hard disks.

¢ Advantage: Provides data redundancy - one failed disk won’t
compromise data integrity.

¢ Disadvantage: Low storage efficiency, requires 2x disk space. Total
capacity = capacity of the smallest disk.

RAIDS Number of hard disks: | e Feature: Striping with distributed parity - Data and parity
3-8 information are spread across multiple disks.

e Advantage: Provides data redundancy - one failed disk won't
compromise data integrity.

¢ Disadvantage: Requires minimum 3 disks. Capacity = (N-1) x
capacity of smallest disk. Reduced write performance.

RAID6 Number of hard disks: | ¢ Feature: Striping with dual parity - Stores redundancy equivalent
4-8 to two disks' capacity.

e Advantage: Higher fault tolerance — two failed disks won’t
compromise data integrity.

¢ Disadvantage: Requires minimum 4 disks. Capacity = (N-2) x
capacity of smallest disk. Further reduced write performance.

Create RAID

@ Attention:
e Itis recommended to choose unused and normal hard disks to create RAID.
e Slot 1 disk and hot spare disks cannot be used to create RAID.

e When creating RAID, it is advisable to choose hard disks with the same capacity. If the capacities of the
hard disks in the RAID are different, the effective capacity of the RAID will be calculated based on the
capacity of the smallest hard disk, leading to wasted capacity on larger disks.

e The capacity of the RAID should be greater than or equal to 512GB. Please select hard disks that meet the
capacity requirements according to the effective capacity calculation rules for different RAIDs.

1. Select the number of hard disks according to the RAID type. You may also select hard disks on the Create
RAID page.

Disk Resource(16) RAID Resource(0)
Lt Configure Usage - Create RAID i Refrash
[] Disk Name Status = Total (G.. = Usage = C

Local Disk-5lot1 @ MNormal 7452 B Genera

Local Disk-5lot5 ® MNormal 3726 B Recording Sto
Local Disk-Slote ® MNormal 931 --
Local Disk-Slot7 ® MNormal 931 --

2. Click Create RAID.
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Create RAID

The slot 1 and hot spare disks cannot be used for RAID creaticn.

n RAID, disks with larger capacity may have some of their capa...

Name

Type RAIDD - 2~8 data disks -
Selected Local Disk Local Disk-Sloté %+ 1 -
Estimated Capacity 1862 GB

Usags General -

Cancel

3. Enter the RAID name, select the RAID type, choose hard disks for the RAID, and specify the RAID usage

(general/recording storage/recording backup).

@ Note:

In a primary-standby mode, the standby server does not support Video Recording storage. You must
configure Failover Backup to take over the video recording storage service when the primary server goes

down.

4. Click OK.

Hard disks that have been added to the RAID are marked with = after their names.

View RAID

After creating a RAID, you can view the RAID information in RAID Resource page.

Server

Local Disk

Storage Resource (3) Usage Configuration ()

Network Disk
Disk Resource(16)

RAID Resource(1) W General(9314G)

Configure Usage O Refresh
= 9 o RAIDO-RAIDO

18626
Raid Na... ¥ Status ¥ Total (.. ¥ Usage + Operation

AIDO-RAIDD @ Normal 1862 W General Local Disk-Slot1
o RAIDD-R - N
! ‘ =0 1526
Disk Name Status Total(GB)

Local Disk-Sloté ® Normal 931

Local Disk-Slot7 ® Normal 931

¥ Recording Backup(0G)

+

e Expand the RAID to view the included hard disks.
e RAID status includes:

e Normal.

B Recording Storage(3726G)

Local Disk-Slot5
=9 37266

[

M Hot Spare(0G) —+

¢ Degraded: The number of abnormal hard disks in the RAID is within the allowed range (different RAID

types have different allowed ranges). Degraded RAID can be rebuilt.

e Unusable: The number of abnormal hard disks in the RAID exceeds the allowed range, storage fails, and

rebuild is impossible.
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Rebuild RAID

e Automatic rebuild: 10 minutes after the RAID degrades, if a hot spare disk is detected (the capacity of the hot
spare disk must be > the damaged disk), the system will automatically start the rebuild process and replace
the damaged hard disk with the hot spare disk.

* Manual rebuild: Click L5 for the degraded RAID, select a hot spare disk or a hard disk with no usage
configured (its capacity must be > the damaged disk), then click OK to start the rebuild process.

+ CreateRAID [ Delete (3 Refresh

Storage Configuration g Status g Total (GB) g Usage g Operation

~  111-RAD1 Degraded 931 " | General @ [s]

Storage Configuration Status
Rebuild RAID X

Lacal Disk-Slot6 @ Abnormal

Local Disk-Slot? ® Normal *Name

Type RAIDT - 2 data disks
Selected Local Disk LocalDiskslots +1
rmal Disk

g= Disk Local Diskslots X

“ Cancel

The rebuild process status progresses from "Initializing" to "Rebuilding," providing progress updates and
estimated time remaining.

During the RAID rebuilding process, you can click (7)) in the Operation to view and adjust the rebuild speed
(ranging from 1MB/s to 200MB/s). A faster rebuild speed reduces the rebuild time, but it increases the read/
write load on the hard disks, causing longer video search times.

=
=

> RAIDT Rebuilding 931 B Recording Sto

(
bS

Set RAID Rebuild Speed

*RAID Rehuild Speed 20 ME/S

A faster rebuild speed reduces the rebuild time but increases the disk readiwnis load,

causing longer recording search tims.
Note:

If the number of new disks is less than the number of damaged disks, the RAID will remain degraded after
the rebuild. Once all damaged disks are replaced with new ones, the RAID status will return to normal after
the rebuild.

Configure RAID Usage

e If usage configuration fails during the RAID adding process, or if the RAID usage is cleared, you can reconfigure
RAID usage using the following methods:

¢ Method 1: Select the RAID, click Configure Usage, and choose the usage.

Method 2: In the usage area on the right side, click -+, select the RAID to add to the usage.

¢ If you need to modify the RAD usage, you will need to clear the hard disks/RAIDs associated with that usage
and reconfigure.
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B General(9314G)

RAIDO-RAIDO
1862G

Local Disk-5lot1

&9 74526

Delete RAID

Clearing the usage will reset the usage of all
associated resources, erase all data within them, and

affect the existing storage services. Continue?

Select the RAID without usage configured, click Delete, and then confirm to delete the RAID.

Attention:
After the RAID is delet
loss. The original stora

ed, the hard disks in the RAID will become independent, resulting in irreversible data
ge services will be unavailable.

27.7.1.3 Cluster Environment

Primary/Replica Environment

Configuration
description

¢ View and configure the hard disks/RAIDs of replica servers on the primary server's
interface: Select Server in the upper left corner to view the resources under the
corresponding servers.

e For the same storage usage, a single server will create only one storage resource;
the primary and replica servers will create different storage resources.

Video storage

On Storage > Backup, by default, the system allocates the largest available recording
storage/recording backup resources to the cameras.

¢ |If a camera is allocated the primary server's storage resource, its recordings will
be stored on the primary server.

e If a camera is allocated the replica server's storage resource, its recordings will be
stored on the replica server.

Image storage

There is no need to manually allocate storage resources.

e Business images from the primary server are stored in the primary server's
general resources.

¢ Business images from the replica server are primarily stored in the replica server's
general resources; if the replica server lacks general resources, its images will be
stored on the primary server.

Primary/Secondary Envir

onment

Configuration

Log in to the primary server via the virtual IP, then select Server in the upper-

left corner of the page to configure the disks for the primary and standby servers
separately.

Caution: The standby server must be configured with a Failover Backup resource to
take over the video recording storage service when the primary server goes down.

Storage

Storage of the primary server and secondary server are independent.

¢ Images/recordings of the primary server are stored in the storage resource of the

primary server.
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Primary/Secondary Environment

After the secondary server takes over the operations, images/recordings are
stored in the storage resource of the secondary server.

27.7.2 Network Di

sk

Add an Uniview IPSAN (support VX-U series and CX series, and the compatible VX-U component needs to be
installed on the IPSAN) as a network disk for the server. You can also create a resource group consisting of
multiple CX series IPSAN devices to expand the storage capacity.

After adding an IPSAN device, you need to configure its usage (Recording Storage/Recording Backup). The system
will automatically create a storage resource for the usage.

Note:
Network disks do not su

pport image storage.

After configuring the hard disk, please refer to Video Storage Configuration to configure video storage services.

27.7.2.1 Single Resource

Add Uniview IPSAN and configure its storage usage.

Storage Resource (7)

Single Resource(2) Resource Group(0)

-+ Add Resource % Configure Usage

Name Type
192.115.1.12 Uniview IPS...
192.115.2.29 Uniview IPS...

Add Resource
1. Click Add Resource.

Add Resource *

= Refresh
P Address Status s Total (G.. * Usage s
192.115.1.12 ® Normal 551 M Recording Stor
192.115.2.29 Config co... 200

Operation

ra
o

[ES]

Usage Configuration (7)

¢ B Recording Storage M Recording 5

+ Add [ Clear

192.115.1.12(551GB)

Normal

m; 192115112
&= ssiGe

*MName

*Type

*|P Address

Usage Selec -
Item Description
Name Enter a custom resource name.
Type Uniview IPSAN.
IP Address Enter the IP address of the IPSAN device.
Usage Select Recording Storage or Recording Backup as needed.
2. Click OK.
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Configure Storage Usage

If the usage configuration fails during IPSAN adding or if the IPSAN usage is cleared, you can reconfigure its usage.
Method 1 1.

In the device list, select normal IPSAN(s) with no usage, and then click Configure
Usage.

2. Configure the storage usage in the pop-up window, and then click OK.

Single Resource(2) Resource Group(1)

-+ Add Resource D¢ Configure Usage 7 Refresh

Configure Usage

*Selected Storage Res.. | 192115229 X v

Estimated Capacity 200 GB
*Usage Recording Storage -
OK Cancel

Method 2 1. Click -- in the corresponding usage tab on the right.

2. Select IPSAN(s) in the pop-up window, and then click OK.

¢ rding Storage M Recording Backup 3
-+ Add
Add Usage X
Single Resource(1) Resource Group(0)
Name Type IP Address Total (GB) =
192.115.2.29 Uniview IPSAN 192.115.2.29 200

“ Cancel

Clear Storage Usage

If you want to edit the IPSAN usage, you need to clear its current usage and reconfigure it.
Attention:
Clearing the usage will erase all data within the IPSAN resource and affect the existing storage services.

e Clear usage for all resources: Click Clear to reset all resources of that usage to no usage.

* Clear usage for a single IPSAN: Click 7 in the upper-right corner of an IPSAN. The IPSAN usage will be reset to
no usage.
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< - Recording Storage . Recording)

-+ Add 0 Clear

L The Usage of resources in an abnormal state cannot

be cleared. Clearing the usage will reset the usage

192.115.1.12(551GB) n A of all associated resources, erase all data within
Normal o them, and affect the existing storage services.

@ 192.115.1.12 Continue?
551GB

Delete Resource

* Delete one by one: Click ] for an IPSAN and confirm the deletion.

e Batch delete: Select IPSANs with no usage, click Delete, and then confirm the deletion.
@ Attention:

e After deletion, the storage data will be lost and cannot be recovered, and the existing storage services will
be unavailable.

e If the IPSAN is part of a resource group, you must unbind the resource group before deletion.

27.7.2.2 Resource Group

Create resource group consisting of multiple Uniview IPSANs to expand the storage capacity and enhance the
reliability.

[®p Note:
The CX series storage device supports resource group creation, while the VX-U series does not.

Add Resource Group
Only normal IPSANs with usage configured can be expanded to a resource group.

1. On the Single Resource tab, click .~ for an IPSAN.

Single Resource(1) Resource Group(0)
+ Add Resource @3 Configure Usage = Refresh
Mame Type P Address Status = Total (G.. ¥ Usage = Operation
192.115.1.12 Uniview IPS... 192.115.1.12 @ Normal 551 M Recording Stor G
Expand X
*Mame 192.115.1.12
Current Capacity(GB)
*Type
Usage
Expansion Source Existing IPSAN (® New IPSAN
*|P Address l l
This field is required
*Mew IPSAN Name l
o This field is reguired

“ CEI]CE'
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Item Description
Name Enter a custom resource group name.
Usage The resource group inherits the usage configuration of the IPSAN before expansion.

This field is non-editable.

Expansion Source

e Existing IPSAN: Select existing IPSAN with no usage configured.
e New IPSAN: Enter the IP address and name of the new IPSAN.

[ Note:

e The new IPSAN's capacity must be greater than or equal to the minimum
capacity of the IPSAN in the current group.

e The new IPSAN must be a Uniview IPSAN.

2. Click OK.
* A = icon will appear next to the name of the IPSAN that has been added to a resource group.

Single Resource(2

Resource Group(1)

- Add Resource &2 Configure Usage 3 Refresh

MName Type Stal e Total (G.. ¥ Usage > Operati
192.115.2.29 = Uniview IPS.. ® MNormal 20 B Recording Stor
Uniview IPS.. & MNormal 551 W Recording Sto

e Asingle IPSAN can only be expanded once. Subsequently, you can continue to expand the normal resource
group with usage configured: Click . 7 for a resource group to add more IPSANs. See operations in Add
Resource Group.

View Resource Group

After creating a resource group, you can view it in the Resource Group tab.

Storage Resource (3) Usage Configuration (7)

Single Resource(2) Resource Group(1 M Recording Storage Recording
& Configure Usage 3 Refresh + Add £y Clear
Amount a3 = Total (G.. ¥

Operation 192.115.2.29(400GB)

2 e Normal 400

Stotus m, 1215229
&= 200G8

G

e Normal

@m, 192115112
St

551GB

2 192.115.1.12 ® Normal

e Unfold a resource group to view the IPSAN devices in it.
e Total group capacity = Number of IPSANs in the group * Smallest capacity of IPSAN in the group.
e Resource group statuses:

e Normal: All devices in the resource group are online.

e Partially Online: Some of the devices in the resource group are offline.

e Offline: All devices in the resource group are offline.

Configure Resource Group Usage
e If the usage of a resource group is cleared, you can reconfigure its usage.

e Method 1: Select resource group(s), click Configure Usage, and then select a usage.
®* Method 2: Click - in the corresponding usage tab on the right, and then select resource group(s).

¢ If you want to edit the resource group usage, you need to clear its current usage and reconfigure it.
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Attention:

Clearing the usage will erase all data within the resource group and affect the existing storage services.

Clear usage for all resources: Click Clear to reset all resources of that usage to no usage.

Clear usage for a single resource group: Click (5 in the upper-right corner of a resource group. The
resource group usage will be reset to no usage.

< B Recording Storage M Recording 5

(B oo |
-+ Add By Clear || T o

192.115.2.29(400GB)

Mormal

The Usage of resources in an abnormal state cannot

be clearad. Clearing the usage will reset the usage

of all associated resources, erase all data within
% 192.115.2.29 them, and affect the existing storage services.
= 20068 Continue?
@ 192.115.1.12

Unbind

e Unbind one by one: Click 4 for a resource group and confirm the operation.
e Batch unbind: Select resource groups with no usage, click Unbind, and then confirm the operation.

Attention:

After unbinding, the resource group will no longer exist, the IPSAN devices under it will be independent with

their usage cleared, the stored data will be lost and cannot be recovered, and the existing storage services
will be unavailable.

27.8 Advanced Configuration

Press the shortcut key Ctrl+Shift+Alt+Y on the homepage to enter the Advanced Config page and configure some
system parameters.

27.8.1 Function Switch
Use toggle buttons to enable/disable functions.

Auto Log Out/Lock 30 min O]

Show/Hide Card Password

Save

27.8.2 Alarm Customization

You can add alarms types of third-party devices on the platform to receive alarms reported by them. After adding

alarm types here, you can view the added alarm types under the General category in Alarm Configuration and
Alarm Linkage Configuration.
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-+ Add T Delete QPlease enter keywords

Alarm Name Alarm ID Alarm Type Operation
CustomAlarm 74121 20001 2
FireAlarm 1000 20000 & W
1. Click Add.
Add X

= Alarm Mame
= Alarm 1D

*Protocel Type

2. Enter the alarm name and ID (must match the one in the third-party device).
3. Click OK.

27.8.3 Style Personalization

Customize the system logo, and background image of the login page.

LoGO: Nv
LI
Mote: For a custom logo, please upload a 64*64px image: up to 4 custom logos can be uploaded

Login Page:

for a custom image is 1920%1080px. It must be a png image, with 2 maximum size limit of 5MB

Theme Color: ° '
Default Red Green Orange Purple m

Apply Reset

1. Customize the settings as needed.

LOGO The logo is displayed on the login page and the system's upper-left corner.
(1) click -+ to upload a logo image (.png format; resolution: 60px*64px).

(2) Select the target logo image. A "V" will appear at the lower-right corner of the
selected image.

Login Page Set the background image for the login page.
Hover the mouse over the image, and then click ' to upload a new image (.png format,

resolution: 1920px*1080px). After uploading, the new image will replace the existing
background image.

Theme Color Change the color of the interface elements (menu bar, buttons, highlighted texts, etc.).
The default is blue. You can choose other colors as needed.
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[ Note:

The theme color configuration is permanently valid to all users and all clients (B/S
client and C/S client).

2. Click Apply to activate the settings.

27.8.4 Restore Defaults

You can restore the server to factory defaults. This operation will clear all data and configuration. Please handle
with caution.

Default The current network and admin/loadmin user configuration will be kept.

Factory Defaultf Restore all settings to factory defaults.

o Default: Restore all factory default settings except network and admin/loadmin user configuration.

e Factory Default: All settings will be restored to factory defaults.

[®p Note:
After clicking Default or Factory Default, in the pop-up prompt window:

If Initialize Disk is checked, the hard disk's storage configuration will be cleared and all data on the disk
will be deleted. The data cannot be recovered using database backup files.

¢ If Initialize Disk is not checked, the hard disk's storage configuration and existing data will be preserved.

| Restoring factory defaults will restart the device. Continu
4 L e?

nitialize Disk “ Cancel

27.9 License Management

License is used to authorize the system’s supported functions and capacity.
@ Note:
Only the administrator can manage licenses.

27.9.1 License Activation

The system provides a free version with limited functions by default. To access full functions, please import a
license file.

Import License
1. Click 83 in the upper-right corner and select License Management.

2. Follow the on-screen wizard to import a license file: @ Click Apply for Host File and then enter the user
information to apply for a host file; @ Use the host file to activate the license on our company’s official

website (https://global.uniview.com/Support/Product_Licensing/ ); @ Click Import License to import the
license file.
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https://global.uniview.com/Support/Product_Licensing/

License File: (7) rial Version Activated

Application, import, and deactivation of license file.

© Apply for Host File: Apply for a host file using the user information obtained when you purchased the product.

Apply for Host File

Apply for License Activation: Use the host file to activate the license at the URLihttps://alobal.uniview.com/Support/Product Licensing/

Wizard

Import License: Import the license file on this page to complete registration.

Import License

Deactivate License: Click the button to generate a corresponding deactivation file. Then, upload the generated file to Device Unbinding Mgt > Device Unbinding Application on the platform.
URLhttps://Imp.uniview.com,

Deactivate License

3. When imported, the system will restart and return to the login page. Please log in again.

View License

After successfully importing the license, you can view the license's expiration date and the authorization details.

Validity Period

Creation Date Valid Days Remaining Days Expiration Date
2024-08-31 00:16:11 30 5 2024-09-30 00:16:11
License Code Service Info
Authorization Code List Service Type Number of Supported Se...  Used Remaining
M TH MRS 1 NATFOW2 Time Attendance Module 1 1 0
7QH B ExTh L AL INY76 Visitor Service Module 1 1 0
COR i Frad TR PR EGNT Video Intercom Qutdoor A... 256 0 256
ANSZRNIH LOrMUTITIEVEAWM People Management Mod... 1 1 0
SYAZAL LY T A FAOPRHER 2 ANPR Module 1 1 0

¢ [fthe license has 5 or fewer days remaining, the remaining days will be displayed at the top of the interface

(or in the login page). Please import a new license as soon as possible to avoid any disruption to your normal
use.

e The authorization details include the available subsystems and the number of devices allowed for connection.

27.9.2 License Deactivation

License deactivation restores the system to its original status before a license was imported.

Scenario Example: When changing servers, if Server A has a license applied using its host.id and an authorization
code, you need to deactivate the license and unbind the authorization code from Server A's host.id first. Then,
use Server B's host.id and the authorization code to apply for a new license for Server B.

Note:
Once the license is deactivated, the Server will no longer be able to use the original license.

License deactivation process: @ Generate the deactivation file > @ Submit the unbinding application.

Generate Deactivation File

1. Click £53 in the upper-right corner of the page and select License Management.

License File rial Version Activates

Application, import, and deactivation of license file.

Apply for Host File: Apply for a host file using the user information obtained when you purchased the product.

Apply for Host File

Apply for License Activation: Use the host file to activate the license at the URL:nttps //global uniview.com/Support/Product Licensing

Wizard

Import License: Import the license file on this page to complete registration.

Import License

Deactivate License: Click the button to generate & corresponding deactivation file. Then, upload the generated file to Device Unbinding Mgt > Device Unbinding Application on the platform.
URLhttps://Imp.uniview.com,

Deactivate License

2. Click Deactivate License.

3. The system will prompt “The system license will be immediately unavailable after deactivation”. Acknowledge
the risks and click OK. Then, the system will automatically generate and download the license deactivation file
(deactive.id).

4. Re-login to the system, and check that the authorization code is no longer listed on the License Management
page.
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Submit Unbinding Application

Access to the license unbinding website requires permissions. Please contact our technical support to obtain
access.

To proceed:

1. Login to the website at https://Imp.uniview.com/ and go to the Device Unbinding Application page.
2. Select the product category.

3. Upload the device's host.id and the deactivation file separately, and complete the required fields.

4

Click Submit to unbind the authorization code from the host.id.

28 O&M

28.1 Operation Logs

View the operations performed by the user in system's functional modules.
e Set criteria and click Search to search the operation logs that match the criteria.

e Select operation log(s) and click Export to export them.

28.2 Database Backup

O&M > Database Backup

By using scheduled backup and manual backup functions to back up database data, you can restore the database
to a specific point in time from backup files in case of data loss or configuration errors.

Note:
Backup and restoration operations will consume certain system resources, so it is recommended to perform
these tasks during idle periods.

Backup Configuration

&) Backup Configuration
Save Backup To E\Config_DB

E)  Backup Records

Max. Backups -7
| Backup Back Up

| Auto Backup Configuration

Scheduled Backup (® Enable Disable

Backup Frequency All

Monday Tuesday Wednesday Thursday Friday Saturday Sunday

Backup Start Time 01:00

Message Previous Backup -

Next Backup 01:00 07-05-2025

1. Choose the backup path where the backup files will be stored. By default, the backup files are saved in the
disk with the largest remaining space on the PC where the service is located, and it is advisable to select a
non-system disk.

2. Set the maximum number of backups (manual + automatic) that can be retained, up to a maximum of 7. If
there is not enough space, the actual number of backups supported will be performed.
Once the maximum number is reached, new backups will overwrite the oldest backup.
When you reduce the maximum number, the system will delete historical backups in the current path that
exceed the limit.

3. Click Save.
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Manual Backup Click Manual Backup to generate a backup file.

Scheduled Backup 1. Enable scheduled backup.

2. Set the backup date and time, and the system will automatically perform backup at
the specified date and time on a weekly cycle.

3. Click Save.

Backup Records

You can view completed backup tasks in the Backup Records page.

ps’, When the quantity reaches the limit or space is insufficient, new backups will ovenwrite the earliest ones,

&) Backup Configuration

Filename 2 Start Time = Backup Type s Operation

5 Backup Records

1.3.6_20250627172826_2 tar.gz 2025/06/27 17:28:27 Back Up

Oy
&£

w0

1.3.6_20250627183638_2.tar.gz 2025/06/27 18:36:38 Back Up

Restore 1. Click <. A message appears, indicating that restoring the database will restart the
device. Click OK to start restoring.

Restaring database will restart the device. Continue?

2. The restoration process may take some time, so please be patient and do not
disconnect the power.

3. After the device restarts, it will automatically return to the login page. And you need
to log in again.

Download Click <> to download the backup file to your local computer.

= Note:
¢ To avoid overwriting the backup file, please download it timely.

¢ To restore using a local file, copy the file to the backup path. The Backup
Records page will detect and load the local file, after which you can perform the
restoration.

28.3 Restart & Upgrade

Go to O&M > Restart&Upgrade.

Upgrade the system software version, restart the device.

Mote: Do not disconnect power during the upgrade, as it may result in upgrade failure and ser...

Local Upgrade Browse... Upgrade
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Restart Device

Attention:
Restarting the device will interrupt the service. Proceed with caution.

1. Click Restart.

2. The system will return to the login page. Please wait for the restart to complete and then log in again.

Local Upgrade
@ Attention:

Before upgrading, ensure that the system services are normal, and the network connection is stable.

Do not power off the device during the upgrade process, as it may result in upgrade failure and service
abnormality.

The system will restart during the upgrade process, causing service interruption. Proceed with caution.

The previous system configuration and data will be retained after the upgrade.

1. Click Browse, select and upload the new version package from your computer (.tar.gz / .patch).
2. Click Upgrade. The upgrade progress will be displayed.

3. Wait for the restart to complete and then log in again.

28.4 System Diagnosis
28.4.1 Device Status Statistics

Provides statistics on the online/offline status and online/offline duration of devices connected to the system.

Device Status | All Device Type Al Device Name

Reset

Current month

Startand En.. =~ 2025-02-27 00:00:00 ~ 2025-02-27 23:59:59 Today last3days Last7 days

T, Export
on 3 Operation

Online

L]

Online

]

Online

]

Offline

Offline

L]

]

Offline

Offline 1 OdayZhour34min16s

L]

Search device status: Choose device status (online/offline), device (Camera/NVR/Smart Box/ EIA/Radar/Radar
vision/Indoor station/Door station/Face recognition terminal/General access control device/Access control/
LPC/LPR/Xware), start and end time (up to 31 days), and then click Search.

Search results include the current online status, last offline time, total offline count and duration within the
specified time period.

Note:

Last offline time: The actual time when the device went offline, regardless of the specified time period. If
the device has never been online or has been continuously online, the time when the device was added is
displayed.

e Click 2> to open the device's Web interface.

28.4.2 Device Diagnostic Info

Export diagnostic information of IPC/NVR/face recognition access control terminal devices that directly
connected to the platform via the private protocol.

Real-time Diagnostic Information

Real-time diagnostic information can only be exported when the device is online.
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cj;) ® Succeeded Device Name:192.1#%.1.54  Filename: 192464 1.54_20250227115114.tgz

T, Export Diagnostic Info 3 Refresh  Only supports IPC/NYR/face recognition access control terminal devices connected via the private protocal. Please enter keywords
Device Name s Organization = Model s Status 5 Operation
192,455.1.54 001 HIC EuT e Online 1
192.#51.1.100 001 NVR- 2 & @ Online T

192.%".30.25 001 & Offline
19216V 3011 001 o Offline
192.1&TL110 001 o Offline

1. Click T, in the Operation column or select multiple devices and click Export Diagnostic Info.

2. In the pop-up Export Status window, you can view export status and choose Download in Background or
Cancel Export for ongoing export tasks as needed.

Device Name = Organization = Model = Status =
192 14 001 HICE = ® Exporting
192 100 001 NVR- ] ® Exporting

<1 /12

Download in Background Cancel Export

3. The latest export status is displayed at the top of the page. You can click the prompt to view all export
records.

Export Status X

Filename:192.169.1.54_20250227115114.tgz

192.16f.1.54

Filename:192.169.1.54_20250227115045.tgz

Historical Diagnostic Information

After exporting real-time diagnostic information for NVRs, you can view previously packaged diagnostic
information in Historical Diagnostic Info. You can export diagnostic information from the past 15 days at most.

Historical diagnostic information can only be exported when the NVR is online.
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cp No completed tasks in the background.

3 Refresh | Only NVR devices connected via the private protocal ars supported. CPlea

Device Name S Organization S Model S Status : Operation
192,951.0.100 001 NVR- L ® Online T
192 0.25 001 o Offline

19216723011 001 ® Offline

1921672110 001 o Offline

1. Click T, in the Operation column.

2. In the Export window, you can view the diagnostic information files available for export for that device.

[] Filename = File Size b= Time Modified =
1.65MB 2025/02/27 00:00:00
1.51MB 2025/02/26 00:00:00

1.56MB 2025/02/25 00:00:00
1.45MB 2025/02/24 00:00:00
1.32MB 2025/02/23 00:00:00
1.16MB 2025/02/22 00:00:00
1.03MB 2025/02/21 00:00:00
T77.36KB 2025/02/20 00:00:00
cgi_20250227112032log.tgz 175.87KB 2025/02/27 11:20:32
core_20250227104504lcg.tgz 111.07KB 2025/02/27 10:45:04

Total 135 2 3 4 5 6 7 > 20/page - | Goto | 1

3. Select diagnostic information file(s) and click Export.

4. In the pop-up Export Status window, you can view export status and choose Download in Background or
Cancel Export for ongoing export tasks as needed.

28.4.3 Server Diagnostic Info

Export diagnostic information of the server for troubleshooting.
Diagnostic information includes service logs, installation logs, configuration information, etc.

1. Select the server, which can be the primary or replica server.

2. Specify a server time period and click Generate to create a compressed package of the diagnostic information
within that period. During the generation process, you may click Cancel Generation to cancel the task.

@ Note:

During the generation process, if the disk space is insufficient (less than 4GB), the task will automatically
stop, and the status will show "failed"

3. Click <> to download the compressed package to local.

Note:
The system can keep the latest 2 compressed packages. Please download in time to avoid being
overwritten by new files.
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I Diagnostic Info

Server

Server Time 2025-07-04 ~ 2025-07-04
Cancel Generation

Server-Log 2025-07-04 12-46-48.zip

Server-Log 2025-07-04 12-40-25.zip

28.4.4 Server Packet Capture

Perform network packet capture on the server to collect interaction messages between the server and network
devices, thereby understanding network data exchange details and locating network issues.

[ Note:
Network devices can be any devices added to the server, PCs accessing the server, or other devices.

Two packet capture modes are available:

e Common packet capture: Short-duration packet capture for reproducible issues, generating smaller capture
files that can be exported from the web interface.

e Background packet capture: Long-duration packet capture for intermittent issues, generating larger capture
files that require backend export. (Since issue recurrence timing is unpredictable, the task runs in the
background.)

@ Note:

By default, only Common Packet Capture is displayed. To display Background Packet Capture, press Ctrl+Alt
+Shift+B.

| Common Packet Capture

-+ Add Task T Delete (&) start Packet Capture ©) Stap Packet Capture &> Download (3 Refresh

[] Task Start Time Status = Operation
120_ALL_SPECIFY_IP_SPECIFY_PORT - Waiting G B

T19_ALL_ALL IP_ALL_PORT 23 13:51:38 ® Completed L R

I Background Packet Capturs

35 Refresh

Task Start Time Save To Available Space (ME)

S_ALL_ALL IP_ALL P... 2025/05/23 13:45:04 D: Guard\Serve.. 331813 0.08 ® Completed w &

Common Packet Capture

Perform packet capture as tasks, with a maximum of 5 capture tasks allowed, each capturing one packet.

@ Note:

e When capturing packets on a specified NIC, each task retains up to 5 pcap files, with each file limited to
20MB. If exceeding 5 files, the newest pcap file overwrites the oldest one.

e When capturing packets on all NICs, each NIC retains up to 2 pcap files, with each file limited to 20MB. If
exceeding 2 files, the newest pcap file overwrites the oldest one.
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1. Click Add Task to set capture conditions: IP address/port of the network device, and the server's NIC.

Add Common Packet Capture b4

Port Specify -
* Manua Flease =nte o 5 ports, Separate
P Address Specify -

*|P Address] , , , =

Select NIC Loopback Pseudo-Interface 1 -
*NIC IP Addre
Cancel || Add & Continue | IR
Device Parameter Description
Peer Network | Port Port numbers of network devices interacting with this server.
Device

e All: Capture all port numbers.

¢ Specify: Capture only specified port numbers (up to 5 ports, separated

by commas).
¢ Filter: Exclude specified port numbers (up to 5 ports, separated by
commas).
IP Address IP addresses of network devices interacting with this server.

e All: Capture all IP addresses.
e Specify: Capture only specified IP addresses (up to 5 IPs).
¢ Filter: Exclude specified IP addresses (up to 5 IPs).

This Server Select NIC « Al NICs: Capture interaction packets between all server NICs and
specified network devices.

e Specified NIC: Capture interaction packets between a specified server
NIC and specified network devices.

2. Click Add to create a task and exit; click Add and Continue to save the current task and create next one.

Note:
Task name format: Task ID_NIC Name_IP Type_Port Type.

3. The new capture task is in waiting status; click to start capture, and the status changes to "Ongoing".

4. Click (=) to stop capture, and the status changes to "Packaging" and then "Completed".

[ Note:
If no packets are captured, the task status shows "Failed" after stopping.

5. After the task is completed, click <> to download the capture file to your local computer.
Other Operations
L[]

View task parameters: Click [=! to view capture parameters (same as the Add page).

* Delete task: Click 7ii] to delete a task. (Attention: This will also delete all capture files of this task).
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e Batch operations: Select tasks, then click the buttons above the task list to perform batch "Start Capture/Stop
Capture/Download/Delete".

Background Packet Capture

Perform packet capture as tasks, with a maximum of 1 capture task allowed. Depending on traffic volume, the
capture results may contain multiple pcap files. Each pcap file has a maximum size of 200MB.

1. Click Add Task to configure capture conditions: Background packet capture requires setting capture duration,
other parameters are the same as Common Packet Capture.

Add Background Packet Capture X

(5]
T
c
r
o
i
[a]
f

L

L

f

Port Filter -
*Filtering Port | Please ente to 5 ports, Separate e
P Address Specify v
* 1P Address1 ) ) . 4
Select NIC All -
Packet Captu..  5mins v
Cance Add

2. The new capture task is in "Waiting" status; click to start capture, and the status changes to "Ongoing".

3. For unfinished capture, you can click (=) to stop capture manually; after reaching the duration, the capture
stops automatically; the status changes to "Packaging" and then "Completed".

@ Note:

During capture, if the disk space runs low or the service restarts, the task will stop and package file
automatically.
If no packets are captured, the task status shows "Failed" after stopping.

4. After the task is completed, go to the file path indicated on the screen to view the capture files.
Other Operations

® View task parameters: Click [= to view capture parameters (same as the Add page).

* Delete task: Click 7ii] to delete a task. (Attention: This will also delete all capture files of this task).

28.4.5 Network Test

Test network connectivity between the platform and other devices by sending data packets to a specified
address. The test evaluates network latency and packet loss rate based on the responses received.

1. Set the test parameters.
e Test Address: The domain name or IP address of the target device.

e Test Duration: The duration for which the platform pings the target address. The test stops after this
duration.

e Time Interval: The interval at which ping results are obtained. The interval is calculated automatically by
the system based on the set test duration.
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e Packet Size: The size of the data packets to be sent. Larger packets can simulate high-load conditions to
test network latency and packet loss, while smaller packets are suitable for quick connectivity tests.

2. Click Test to start the test. Once completed, you can view the dynamic changes in packet loss rate and
network latency in the chart.

*Test Address 192.117.1.200

* Test Duration 10 Second(s)

Time Interval 2 Second(s)

*Packet Size 54 Bytes
Test Export
Test Result MNermal network connection.

Network Packet Loss Rate @ Network Latency

Latency(ps)

800
600
400

200

3. Click Export to export the current test records to a table. The number of records equals to the floor value of
the test duration divided by the time interval.

28.5 Server Statistics

Go to O&M > Server Statistics.

View statistics on server storage capacity and recording status.

28.5.1 Storage Capacity

View statistics on server storage capacity to prevent server overload and potential malfunctions when the
number of storage channels is excessively high.

Tip: 1.Storage capacity display is for the local server.

2.The number of storage channels oceupied refers to the cumulative total of all cameras with configured storage plans at the corresponding time points each week.
3.Different servers have different specifications for storage channels.
Belongs to Server:

Server Resource Storage Capacity:
M Fully Occupied [l Available Unoccupied

Occupied: 1
Available: 249

Monday

Tuesday

Wednesday

Thursday

Friday

Saturday
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In the chart, the vertical axis represents the days of the week (Sunday to Saturday), and the horizontal axis
represents the time of day (0:00 to 24:00, divided into 24 segments).

e Different servers have varying specifications for the number of storage channels. Hover the mouse over the
chart to view the occupied and available storage capacity for the corresponding time period.

e Three colors indicate three different statuses:

¢ Red: Indicates no available storage capacity during the corresponding time period. It is not recommended
to configure recording schedules at this time.

e Green: Indicates available storage capacity during the corresponding time period. Recording schedules can
be configured.

e White: Indicates no storage capacity is being used during the corresponding time period. Recording
schedules can be configured.

28.5.2 Recording Status

View statistics on the storage information of cameras under the server.

Search Type: Camera name Storage Plan: Al Storage Status: All Sub-organizations Included m Reset

ISR ot nauce atocsed resource

Refresh

Camera name al-time Bitrate(..  Configure Capacity(G)  Home Device ~Storage Device Data Management Server  Store as planned Storage Plan Storage Status

172.20123.123_1 3072 2 pC Video_User Video_User Ves ves Recording

e Search criteria: Supports querying storage information by camera name, storage plan, storage status, etc.

e List: Displays information such as real-time storage bitrate, configured storage capacity, and storage status for
each camera.

28.6 Video Diagnosis

Note:
A valid license is required to enable this feature.

Diagnose the quality of camera videos. The results are displayed in visual charts for easy understanding of the
video service status.

Diagnosis items include offline, image capture, video loss, high/low brightness, color, contrast, screen frozen,
image blurry, noise interference, reinforced cross-gain, scrolling, video masking, scene change, black and white
image, drastic changes in a video, video jitter, real-time usage time, packet loss rate, PTZ control.

28.6.1 Diagnosis Configuration

Configure diagnosis standards and create diagnosis tasks.

28.6.1.1 Diagnosis Standard

You can customize different diagnosis standards based on the actual needs for flexibility and convenience. For
example, different standards for indoor and outdoor, day and night, sunny and rainy conditions, etc.

Add Standard

1. Click
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DiagnosisTask  Diagnosis Standard

[A4) Diagnosis Configuration

Diagnosis Standard *Standard
Name: New standard
[§) Diagnosis Result
= Standard
Description:
[ Diagnosis Statistics Default standard
MNew standard 2 W Settings for ® Abnormal Warning @ Normal
Diagnosis
New standard 2 T Items: LowBrigh.. 0 100
High Brig.. 0 100
Col 0 ) o — 100
Contrast 0 ) O — 100
Sereenfr. 0 » o — 100
Image Blu... 0 O o — 100
Noise Int... 0 O o — 100
Reinforce... 0 . O — 100
0 o C—— 100
Video Man 0 O — 100
Scene Ch.. 0 » o —— 100
PTZ Contr. 0 O C— 100
Blackand.. 0 100
DrasticCu 0 100
Video Jitter 0 100
‘Reaktime.. 4
‘Packetlo. 1
N

Standard Description

Settings for diagnosis | Set the threshold for abnormal, warning, and normal.

Items Hover the mouse over the white block on the ratio bar __; to display the ratio value
and drag left/right to adjust the value.

Higher values for abnormal and warning settings indicate stricter standards.

Real-time Usage Time | Set the live view retrieval time. An alarm is reported if the value is exceeded.
Enter an integer in the range of 1-60.

Packet Loss Rate Set the packet loss rate, which is the loss ratio of the camera video stream. An
alarm is reported if the value is exceeded.
Enter a number in the range of 0.01-100, with up to 2 decimal places.

2. Click Save.

Other Operations

e View/Edit: Select a standard in the left-side list to display its details on the right. Click Edit to modify diagnosis
standard parameters. Click Save to save the settings.

* Delete: Select a standard in the left-side list and click Ti].

Note:
The default standard cannot be edited or deleted.

28.6.1.2 Diagnosis Task
Create video diagnosis tasks for cameras.

Diagnosis Task  Diagnosis Standard

{7 Diagnosis Configuration

+ add ) Refresh
() Diagnosis Result
7 Task Name Task T.. Number of Cam.. Diagnosis . Intelligent Diag... Task Progress Start/Stop Task Description Create User Operation
F) Diagnosis Statistics .
= Taskl Imme... 2 Defaultst. 127001 — loadmin = 2z o
Task2 Imme... 2 Defaultst. 127001 — loadmin = 2

Add Task
1. Click Add.
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2. Enter the task name and description, and then select a diagnosis standard.

Back Add a new diagnosis task

| Basic Information

Task Name

Disgnosis St |

andard Default standard

Task Descript
ion

Diagnosis Pr |
gject

: (@) Video-related

Select Diagnasis Camera Selected : 2

Intelligent Diagnosis,

: | 127.00.1-Online " o xuni_LAPI_0005_2

Server Address -
= xuni_LAPI_0006_T

PTZ-related Inspection Captured

Al Offline Image Capture Video Loss High/low /bri.. Color
@ Contrast 2 Screen Frozen Image Blurry Noise Interfe... (@ Reinforced C.. @ Scrolling
Video Masking Scene Change Black and W.. Drastic Chan... [ Video Jitter
Real-time Us... Packet Lass R.

TaskType : (®) Immediate Type By Day By Week

3. Diagnosis items including video-related, PTZ-related and inspection captured. Select diagnosis item(s) as
needed by referring to the following table.

Diagnosis Item

Description

Offline

Detects the camera's online status on the video management platform, possibly
due to power outage or network disconnection.

Image Capture

Detects anomalies where the camera fails to capture images, possibly due to
power outages network disconnection, camera obstruction, or excessively live view
retrieval time.

Video Loss

Detects intermittent or persistent video loss, possibly due to camera malfunction,
poor contact of video transmission cable, lens detachment, malicious tempering, or
video transmission failure.

High/Low Brightness

Detects images with excessively high/low contrast, possibly due to camera settings,
lens aging, or environmental factors.

Color Detects discoloration in the video image, possibly due to external interference or
camera malfunctions.
Contrast Detects image with excessively high or low contrast, possibly due to camera

settings, lens aging, or environmental factors.

Screen Frozen

Detects image freezing, possibly due to video transmission or camera malfunctions.

Image Blurry

Detects blurry images, possibly due to camera lens damage or improper focus.

Noise Interference

Detects noise or snow-like interference on the video image, possibly due to line
aging, transmission fault, poor contact, or electromagnetic interference.

Reinforced Cross-gain

Detects prominent horizontal stripe interference on the video image, possibly due
to line aging, transmission fault, poor contact, or electromagnetic interference.

Scrolling

Detects rolling of the video image, possibly due to line aging, transmission fault,
poor contact, or electromagnetic interference.

Video Masking

Detects partial or complete occlusion of the camera lens, possibly due to deliberate
obstruction.

Scene Change

Detects changes in the scene, such as object moving/moving out or partial human
interference, possibly due to deliberate object movement.

Black and White
Image

Detects absence of color in the video image, possibly due to infrared mode or color
rendering failure.

Drastic Changes in a
Video

Detects significant changes in the image over a period, possibly due to continuous
PTZ movement, line aging, transmission fault, or electromagnetic interference.
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Diagnosis Item

Description

Video lJitter

Detects abnormal video jitter, possibly due to unstable installation or significant
ground vibrations. Suitable for high-attitude or elevated camera installations.

Real-time Usage Time

Detects the time the camera retrieves live video. An alarm is reported if the set
value is exceeded.

Packet Loss Rate

Detects the size of video packet loss. If the loss ratio exceeds the set value or there
is no video stream, an alarm is reported.

PTZ Control

Detects abnormalities in PTZ control.

Inspection Captured

Offline detection and image capture detection are enabled by default (see previous
description).

¢ If Patrol is enabled and a patrol interval (5-360 minutes) is configured,
inspections will be performed at the specified interval.

e If Patrol is not enabled, the task defaults to an immediate type, executed only
once.

D_iagtnms . Video-related PTZ-related (@ Inspection Captured
ajec
Offline Image Capture
I:I Enable the patrol with interval between patrols minute(s)
Task Type Immediate Type By Day By Week

4. Select a task type.

Item Description

Immediate Executes immediately after task creation and complete at once.

By Day Executes every day. You need the set the task start and end time. Default is

00:00:00-23:59:59 everyday.
By Week Executes every week with specified time periods. You need to configure each day

from Monday to Sunday separately, with up to 4 different time periods per day.

[ Note:
When finished the settings for a day, you can sync the settings for other days by
selecting the corresponding day and clicking Copy.

5. Click Select Diagnosis Camera, select camera(s) to be diagnosed from the organization tree.

@ Note:

For random sampling, enter the number of cameras to be sampled in the Random Spot Check column
and select organizations, and then the system will automatically select the corresponding number of
cameras for diagnosis. If the set value exceeds the existing cameras under the camera, all cameras under
the organization will be diagnosed.
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Select Camera X

Select Camera: Manually Select (®) Random Spot Check
In the following organizations | 5 cameras | )
Random 5pot-check of Resource List 5 devices selected.
Please enter resource name Please enter
& m o xuni_LAPI 0788 1

> i_LAPI_0769_1
|— | 1000_cam_org_lapi oy auni - -

Bz Y xuni_LAPI_0887 1
[ testorg ‘o xuni_LAPI_0266_1
Yo xuni_LAPI 0535 2
6. Click Save.
Other Operations

® Start/Pause task: Click [>/ || to start/pause the task.
¢ Re-diagnose: Click for the task to restart the diagnosis task, the task progress will reset to 0.
* View/edit task configuration: Click .,/ for the task to view or edit task details.

* Delete: Click i for the task or select task(s) and click Delete.

e Refresh task: Click Refresh to refresh the task.

28.6.2 Diagnosis Result

Search and export diagnosis results by organization or diagnosis task.

¢ Search by Monitoring Organization: On the By Monitoring Organization tab, select an organization in the
left-side list, and set search criteria on the right-side. Click Search, and the video diagnosis results under the
organization are displayed.
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By Monitoring By Diagnosis

Comprehensive Evaluation: Camera Status: Camera Name:
Organization  Task
[A=) Diagnosis Configuration Al
_ Select Date
(4] Diagnosis Result
(&) Ps o Latest Contain Sub-organization m Reset
1000_cam_org_lapi
) Diagno:
- e | Diagnosis Resuit Statistics | Diagnosis Abnormal item Statistics
test org
0% (Exception Count: times)
5
50% 50%
0% I
® Normal @ Abnormal Waming @ Failed Offline Vides Loss Color Contrast Sereen Frozen  Image Blurry
D, Export All
No. Oniin.. Camera Name Camera ID Organization Diagnosis Time DiagnosisR..  Comp..  Abnormal ltems Operati,
1 0. ~ 172202950E.  59563796702..  UG-I500-H16..  2025-12-041..  Failureto..  [aiked
2 ® o AIBOX29.51_... 59565952951... UG-1500-H16... 2025-12-04 1... Diagnosis ... [aene.. | Offline

e Search by Diagnosis Task: On the By Diagnosis Task tab, select a task in the left-side list, and set search criteria

53' E‘ag o Comprehensive Evaluation: Camera Status: Camera Name:
ffg] Diagnosis Configuration Al v
_ Select Date
[@ Diagnosis Result . e .
test o et

Taskl Diagnosis Completed

[ Diagnosis Statistics

Search Criteria Description

;’;p";g'“'e = | Diagnosis Result Statistics | Diagnosis Abnormal Item Statistics
Task2 Disgnosis Completed
0% (Exception Count: times)
——
s
50% 50%
2
0%
& Normal @ Abnormal Warning @ Failed Offline  Video Loss  Contrast Screen Frozefmage Blugise InteRisrdceed Cross-g&irolling Video Masking
2, Export Al
No. Onlin..  Camera Name Camera ID Organization Diagnosis Time DiagnosisR..  Comp..  Abnormalltems Operati..
1 O..  172202950E.  59563796702..  UG-IS00-H16..  2025-12-041..  failwreto..  [aid
2 eo AIBOX29.51.... 59565952951..  UG-IS00-H16.. ~ 2025-12-041..  Diagnosis..  [bno.. ] Offine

e Comprehensive evaluation: Camera's overall evaluation, including normal, abnormal, warning, and failure.
You can select one or more items.

e Camera status: Including online, offline, and all.

e Camera name: Search by keywords.

e Camera ID: Search by keywords.

e Failure error code: Search diagnosis failures based on error codes, e.g., 9498 for network packet loss.

e Abnormal items: Search by offline, video loss, low brightness, high brightness, color, contrast, screen frozen,
image blurry, noise interference, reinforced cross-grain, scrolling, video masking, scene change, black and
white screen, drastic changes in a video, video jitter, PTZ control, real-time usage time, image capture, and
packet loss rate. You can select one or more items.

e Select date: Select Latest or customize a time period as needed. When customizing, you can specify a start
and end date.

¢ Include subordinate organizations: Select to include results from subordinate organizations.

Statistical Chart

¢ Diagnosis result statistical chart: Displays the number of cameras for each evaluation and their percentage of
all cameras.
¢ Diagnosis abnormal item statistical chart: Displays the occurrences of 16 types of video anomalies under the

search criteria. You can adjust the displayed anomalies by dragging the horizontal slider.
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Detailed Data

Detailed data includes online status, camera ID, camera name, organization, diagnosis time, diagnosis results,
comprehensive evaluation, abnormal items, and diagnosis details.

e Export: Click Export All to export all diagnosis results locally.

* View details: Click [Z to view the diagnosis result, diagnosis image, live video for the camera.

Diagnosis Result X

Diagnosis Image Live Video
Comprehensive Result: bh ]

Diagnasis Time:
2025-12-04 17:34:45

Offline o [Ebnor.]
Video Loss 0 J
Color 0 J
Contrast 0 )
Screen Frozen 0 )

Image Blurry 0

Noise Interfe... 0

Reinforced C... 0

Scrolling 0

Video Masking 0

Camera Name: MEFZEINN]_THUSAR Image Size: --
Camera ID: 595659520518055970-0-2 File Location: --
Organization: UG-1500-H16-IN

Scene Change 1]

NTT Cmmbonl n

28.6.3 Diagnosis Statistics

Perform statistics and analyze video diagnosis results. The results can be displayed in statistics chart or data list.

By Organization Area

Statistical Method: Diagnosis Task: Select Date:

fAs] Diagnosis Configuration ® By Organizational Area By Time Please select 2025-12-01 2025-12-05  [5)| Today Last3Days last7Days CurrentMonth
_ Organization Area: Diagnosis Project
) B : - =l -
{? Diagnosis Statistics
| statistical Chart 2, Export All

(Exception Count: times)

test_org
| Detailed Data
No. Organization .. Total Offline. Video Loss High Brightness  Low Brightness Color Contrast Sereen Frozen Image Blurry Noise
1 - 5 5 0 o 0 0 0 0 0 o
2 test_org 4 4 0 0 0 0 0 0 0 0

e Search criteria: Diagnostic task, custom time period, organization area, and diagnostic item.
e Statistical chart: Displays the exception count under each organization in a chart.

¢ Detailed data: Displays the exception count under each organization is a list. Click Export All to export the
retrieved results locally.
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Statistical Method: Diagnosis Task: Select Date:

ﬁ}ff‘ Diagnosis Configuration By Organizational Area  (® By Time

2025-12-01 2025-12-05 Today Last3Days last7Days Current Month
Organization Area:
Diagnosis Result N R Reset
[? Diagnasis Statistics
| Statistical Chart 1, Export All
(Exception Count; times)
5
4 .
3
2
1 .
[
2025-12-03 2025-12-04
| Detailed Data
No. Date Organization Name Total
1 2025-12-03 4
2 2025-12-04 1

e Search criteria: Diagnostic task, custom time period, and organization area.
e Statistical chart: Displays the exception trend in a chart.

¢ Detailed data: Displays the exception count at each time point in a list. Click Export All to export the retrieved
results locally.
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